Note
Before using this information and the product it supports, read the information in “Notices” on page 311.
# Contents

**About this PDF**

**Chapter 1. CICSPlex SM overview**
- Features of CICSPlex SM................................................................. 1
- The CICSPlex SM environment......................................................... 4
- The CICSpex.................................................................................. 6
- The managed application system (MAS)......................................... 7
- CICSPlex SM address space (CMAS)........................................... 8
- Environment Services System Services (ESSS)............................... 8
- CICSPlex SM objects..................................................................... 8
- The data repository......................................................................... 9
- CICS management client interface (CMCI)...................................... 10

**Chapter 2. Setting up CICSPlex SM.**
- Designing your CICSPlex SM environment...................................... 19
- Designing your CICSpexes............................................................... 19
- Locating CMASs........................................................................... 20
- Planning the location of WUI servers............................................ 26
- Naming your CICSPlex SM entities................................................ 31
- A staged implementation............................................................... 33
- Security planning for CICSPlex SM ............................................ 35
- Defining time zones...................................................................... 35
- Reuse of CICSPlex SM object definitions...................................... 36
- Defining the CICSPlex SM configuration and topology................. 37
- Defining the CMAS configuration................................................ 37
- Defining CICSpex topology............................................................ 38
- Setting up a CICSPlex SM address space (CMAS)...................... 38
- Before you set up a CMAS............................................................. 41
- CICSPlex SM auxiliary storage usage............................................ 42
- Preparing to transmit generic alerts to IBM Tivoli NetView............ 43
- Preparing to start a CMAS........................................................... 43
- Creating and managing the CICSPlex SM data repository............ 45
- Editing CICSPlex SM system parameters.................................... 52
- CMAS-related CICS system initialization parameters................... 52
- Controlling tasks in a CMAS......................................................... 55
- Creating and customizing CMAS data sets................................. 56
- Controlling CICS storage in a CMAS.......................................... 57
- START command for a CMAS...................................................... 58
- CMAS journaling.......................................................................... 58
- Shutting down a CMAS............................................................... 61
- Restarting a CMAS...................................................................... 62
- Setting up a CICS managed application system (MAS)............... 63
- Before you set up a MAS.............................................................. 63
- Using CICS global user exits and user-replaceable modules......... 63
- Controlling the use of modules from the LPA............................. 63
- Preparing to start a z/OS MAS..................................................... 64
- Stopping and restarting management of a CICS system.............. 71
- Controlling the number of long running tasks in a MAS............... 72
- Configuring CICSPlex SM.......................................................... 72
Creating a CICSPlex.......................................................................................................................... 73
Creating a CICS system definition........................................................................................................ 73
Creating a CICS system group................................................................................................................ 74
Adding a CICS system to a CICS system group.................................................................................... 74
Assigning a CMAS to a CICSPlex........................................................................................................... 75
Establishing CMAS to CMAS connections............................................................................................ 75
Setting up a CICSPlex SM Web User Interface server........................................................................ 76
Preparing a CICS system to act as the Web User Interface server....................................................... 77
Reviewing CICS system initialization parameters for the WUI.............................................................. 78
Specifying language and code page information for the WUI............................................................. 78
Preparing the code page conversion table for the WUI......................................................................... 79
Creating the Web User Interface server repository (EYUWREP).......................................................... 80
Creating and customizing the WUI data set............................................................................................ 81
Specifying the WUI customizable view and menu help data set............................................................ 82
Specifying Web User Interface server initialization parameters............................................................ 83
Creating transient data queue definitions for the WUI.......................................................................... 83
Specifying the JCL DD statements for the WUI.................................................................................... 91
Starting and stopping the Web User Interface..................................................................................... 92
Setting up CMCI..................................................................................................................................... 93
Setting up CMCI with CICSPlex SM..................................................................................................... 94
Setting up CMCI in a stand-alone CICS region...................................................................................... 114
CICSPlex SM system parameters........................................................................................................... 117
Creating resources with BAS.................................................................................................................. 131
Working with BAS ATOMSERVICE resource definitions................................................................. 131
Working with BAS BUNDLE resource definitions................................................................................ 133
Working with BAS Db2 connection resource definitions........................................................................ 135
Working with BAS Db2 entry resource definitions.............................................................................. 136
Working with BAS Db2 transaction resource definitions...................................................................... 138
Working with BAS document template resource definitions............................................................... 140
Working with FEPI node list resource definitions................................................................................ 142
Working with FEPI pool resource definitions...................................................................................... 143
Working with FEPI property set resource definitions.......................................................................... 145
Working with FEPI target list resource definitions............................................................................. 147
Working with BAS FILE resource definitions...................................................................................... 149
File key segment resource definitions..................................................................................................... 150
Working with BAS enqueue model definitions.................................................................................... 152
Working with BAS IPCCONN resource definitions.............................................................................. 154
Working with BAS ISC/MRO connection resource definitions............................................................ 156
Working with BAS journal model resource definitions.......................................................................... 158
Working with BAS JVMSERVER resource definitions.......................................................................... 160
Working with BAS LIBRARY resource definitions............................................................................... 161
Working with BAS LSR pool resource definitions................................................................................ 163
Working with BAS map set resource definitions.................................................................................. 165
Working with BAS MQCONN resource definitions.............................................................................. 167
Working with BAS MQMONITOR resource definitions........................................................................ 169
Working with BAS partition set resource definitions........................................................................... 170
Working with BAS partner resource definitions................................................................................... 172
Working with BAS pipeline resource definitions................................................................................... 174
Working with BAS PROCESSTYPE definitions.................................................................................... 175
Working with BAS profile resource definitions.................................................................................... 177
Working with BAS PROGRAM resource definitions............................................................................ 179
Working with BAS session resource definitions................................................................................... 180
Working with BAS TCPIPSERVICE resource definitions...................................................................... 181
Working with BAS transient data queue resource definitions............................................................. 183
Working with BAS terminal resource definitions.................................................................................. 185
Working with BAS transaction resource definitions............................................................................. 187
Working with BAS transaction class definitions.................................................................................. 189
Working with BAS temporary storage model definitions..................................................................... 190
This PDF provides a general introduction to CICSPlex SM. It is for system designers, planners, and programmers responsible for preparing an enterprise for the introduction of CICSPlex SM.

It describes:

• At a high level, how CICSPlex SM works, and introduces some new concepts
• The main functions and benefits of CICSPlex SM as a CICS system management tool
• How to approach the design of a CICSPlex SM configuration
• How to start defining your CICSPlex SM environment
• How to plan for use of CICSPlex SM Business Application Services, workload management, real-time analysis, and monitoring functions
• How to prepare for the installation of CICSPlex SM.

These tasks are done in conjunction with the Program Directory.

For details of the terms and notation used, see Conventions and terminology used in the CICS documentation in IBM Knowledge Center.

**Date of this PDF**

This PDF was created on June 20th 2019.
Chapter 1. CICSPlex SM overview

The CICSPlex® System Manager element of CICS Transaction Server for z/OS is a system management tool that enables you to manage multiple CICS systems from a single control point.

Enterprises in which CICSPlex SM might be needed range from those running 10 or 15 CICS regions, to those running two or three hundred (or more) CICS regions: in the latest z/OS sysplex environment, having such large numbers of CICS regions to support a transaction processing workload is becoming increasingly common.

CICSPlex SM has the following key aspects:

**CICSPlex SM conforms to the IBM strategy for system management**
- It provides consistent creation and management of system management data.
- It is an enterprise-wide system management application.
- It supports increased automation of system management tasks.
- It is structured into manager and agent components, has an enterprise information base, a coordination information base, and is based on a data model.

**CICSPlex SM has many reliability, availability, and serviceability (RAS) features**
For example:
- User application CICS regions are managed by a discrete controlling region that has no associated terminals or use application elements or components. There can be multiple instances of this managing region.
- User access to CICSPlex SM functions is provided using a separate address space, of which there can also be multiple instances in an enterprise.
- System management data is held separately in data-space caches, so that it is unaffected by what happens in both managing and managed CICS systems.

**CICSPlex SM is secure**
Even though CICSPlex SM has the potential to allow access to all of an enterprise's CICS resources from a single session, it ensures that security is not compromised. You can use a SAF-compliant external security manager to prevent unauthorized access to:
- CICSPlex SM procedures and data
- CICSPlex SM system management functions and the CICS resources they manage

Security checks that are usually performed by CICS (that is, CICS command checking and CICS resource checking) are performed instead by CICSPlex SM.

**Features of CICSPlex SM**

CICSPlex SM incorporates a number of system management functions, including a real-time single-system image, a single point of control, business application management, and operations for the entire CICSpex.

- **A real-time, single-system image (SSI)**
  CICSPlex SM provides a real-time, single-system image (SSI) of all CICS regions and resources that make up the transaction processing environment of your enterprise. CICSPlex SM creates an inventory of the CICS systems and resources and maps the relationships between them; this process is called the CICSPlex SM **topology**. The operator no longer needs to know the location of a resource before working with it. The SSI is provided by the CICSPlex SM **operating** function and applies to all CICSPlex SM applications: operations, monitoring, real-time analysis (RTA), and workload management (WLM).

- **A single point of control**
The CICSPlex SM operator can manage all of the enterprise CICS systems and their resources from a single session. That is, CICSPlex SM can provide a single point of control for the enterprise, which in turn means that the CICSPlex SM operator is able to manage large and complex configurations of CICS resources. Furthermore, you can have multiple points of control, so that multiple CICS operators in multiple locations can each have a complete view of the enterprise CICS systems and resources, or a view of those systems and resources that is tailored to their individual requirements. Finally, because the physical location of these points of control is irrelevant, you have total flexibility in appointing control locations.

- **Management of your business applications**
  
  CICSPlex SM enables you to manage your enterprise in terms of your business applications rather than your CICS systems. **Business Application Services (BAS)** enables you to manage your resources at the application level, by providing:
  
  - A single point of definition for your resources. All the resources for the CICSpex, and the relationships between them, are held in one place, on the CICSPlex SM data repository, giving a single-system image for the CICSpex. CICSPlex SM produces local and remote instances of a resource from a single definition.
  
  - Logical scoping, which enables you to link and manage your resources according to their business relationship, rather than by their physical location in a CICS system.
  
  - Installation of those resources, either automatically when the CICS system is started, or dynamically, as required, into a running CICSpex.
  
  BAS provides an alternative to resource definition online (RDO). RDO is based on a structure in which definitions are tied to a single group, and groups are processed sequentially from a group list. BAS frees resource definitions from associations with only one group. You can reuse a resource definition and associate it with more than one group as needed. BAS enables you to associate your resources according to their use in your enterprise. You can manage individual resources, rather than a group. For example, you could disable all the files associated with your payroll system, without affecting any other files in the CICSpex.

  See Managing resources using Business Application Services (BAS).

- **Operations for the entire CICSpex**
  
  From any point of control, the operator can take advantage of the SSI to perform tasks, either across the entire CICSpex or across a selected subset. You can display information about the status of one or more instances of a CICS resource in an enterprise, and you can also change the status of the resources with a single entry.

  You use the Web User Interface action buttons to affect the status of the displayed resources. The responses are displayed in panels known as operations views, that can summarize related facts and provide access, using links, to other, related information. The operations views mirror the functionality currently provided for CICS systems. Operators can therefore work in essentially the same way as they are used to, without any change to their basic approach to daily system activities.

  See CICS operations views and The CICSPlex SM Web User Interface for more information about operations views.

- **Management of your workloads**
  
  CICSPlex SM workload management (WLM) uses the dynamic routing program EYU9XLOP to route eligible work requests from a requesting region to a suitable target region selected at the time the transaction is initiated.

  EYU9XLOP handles the dynamic routing of:
  
  - Transactions initiated at a terminal
  - Eligible EXEC CICS START requests that are associated with a terminal
  - Eligible EXEC CICS START requests that are not associated with a terminal
  - Dynamic program link (DPL) requests that are received using:
- The CICS Web Interface
- The CICS Gateway for Java
- External CICS interface (EXCI) client programs
- Any CICS client workstation products using the External Call Interface (ECI)
- Open Network Computing (ONC) RPCs
- Any function that issues an EXEC CICS LINK PROGRAM request
- Transactions associated with CICS business transaction services (BTS) activities

CICSPlex SM provides management support for BTS by dynamically routing BTS work across a BTS-set, and by monitoring the management of data in a distributed environment. For full details, see Overview of BTS.

You do not have to use CICSPlex SM workload management to route BTS activities, but using CICSPlex SM can offer many benefits:

- Management of distributed data
- Workload separation and workload routing functions of workload management
- User replaceable dynamic routing program EYU9XLOP
- Reduction in link definitions if you also use BAS
- Cooperation between BAS and BTS in the management of your business environment

You can write your own program to replace EYU9XLOP, and use it with the CICS-supplied user-replaceable programs DFHDYP and DFHDSRP, to handle your dynamic routing requirements.

See Managing workloads through CICSPlex SM for more information about dynamic routing and workload management.

- **Automated exception reporting for CICS resources**

CICSPlex SM Real Time Analysis (RTA) function provides automatic, external notification of conditions in which you have expressed an interest. The notification can take the form of a console message, or of a generic alert to NetView®, or both. Real time analysis is not concerned solely with commonly recognized error conditions: you can ask to be notified about any aspect of the status of a resource. With real time analysis you can take actions without having to use a separate automation product.

The RTA functions of CICSPlex SM are described in greater detail in Monitoring using real-time analysis (RTA). For full details, see Real-time analysis in Monitoring.

- **Monitoring functions for the collection of statistical data for CICS resources**

The CICSPlex SM monitoring functions support the collection of performance-related data, at user-defined intervals, for named resource instances in a set of CICS systems.

The monitoring functions of CICSPlex SM are described in more detail in Collecting statistics using CICSPlex SM monitoring. For full details, see Real-time analysis in Monitoring.

- **An application programming interface (API)**

CICSPlex SM provides an application programming interface (API) that enables applications to:

- Access information about CICS and CICSPlex SM resources.
- Invoke the services of CICSPlex SM.

A command-level interface is available to programs that are written in these languages:

- Assembly
- PL/I
- COBOL
- C

In addition, a REXX runtime interface is available.
You can use the CICSPlex SM API to write external programs that automate the management of CICSPlex SM and CICS resource definitions. Such programs could be used to integrate the CICSPlex SM system management functions into your enterprise-wide change management process. For example, you could write an API program to coordinate resource definition changes with database or file updates, or the standard life cycle of an application. For a complete description of the API, see CICSPlex SM commands overview.

- **Management of the CICSPlex SM environment**
  
  You manage the CICSPlex SM environment using:

  - **CICSPlex SM objects**
    
    To define the configuration of your CICS systems to CICSPlex SM (and to define your BAS, WLM, RTA, and monitoring requirements), you create **CICSPlex SM objects**, and associate them with each other. For each object, and for each association or link between them, a record is created in a CICSPlex SM data repository. CICSPlex SM objects are described in “CICSPlex SM objects” on page 8.

  - **Data repository**
    
    The data repository contains the objects that define the CICSPlex SM components, resources, system management requirements, and the relationships between them. The definitions can be created using the Web User Interface, the CICSPlex SM API, or the batched repository-update facility.

  - **The batched repository-update facility**
    
    With the batched repository-update facility you can create and update large numbers of CICSPlex SM and CICS resource definitions by submitting one command that is used as the template for other definitions. The batched repository-update facility is also used for migrating your definitions from one platform to another, and for backing up the data repository. For details, see Administering CICSPlex SM.

- **Management of time-dependent activity**
  
  Much of CICSPlex SM activity is time-dependent. For example, you can specify on your RTA and monitoring definitions when you want the definition to be active. Also, you might want CICS systems running in the same CICSplox but different time zones to run as if they were in the same time zone. You are able to create time-period definitions that control:

  - Exactly when any part of your enterprise is operational, regardless of the local time zone
  - The times you want certain system management functions to be operational

  The international standard for time zones is used, based on Greenwich Mean Time (GMT). You select the time zone in which you want your CICSplox to run. You can then make adjustments, either for locations that have implemented times that are not different from GMT by 60 minute multiples, and for daylight saving.

  Details of time-period definition are in Administering CICSPlex SM.

---

**The CICSPlex SM environment**

Before you begin to define your CICSPlex SM environment, you must understand the components of CICSPlex SM, either because you have to define them or because they can affect the design of your environment.

**What is a CICSplox?**

A **CICSplox** is any grouping of CICS systems that you want to manage and manipulate as if they were a single entity. That is, a CICSplox is a management domain, made up of those CICS systems for which you want to establish a single system image (SSI).

Read more...

**What is a MAS?**

Each CICS region that is managed by CICSPlex SM is called a **managed application system** (MAS). You define and manage MASs as part of a CICSplox. Every MAS in a CICSplox is managed by a CICSPlex SM.
address space (CMAS). More than one CMAS can manage the MASs in a CICSpex, but a MAS can connect only to one CMAS at any given time.

Read more...

What is a CMAS?

In every CICSpex, there is one CICSpex SM address space (CMAS) that is defined as the maintenance point. The maintenance point CMAS is responsible for maintaining the data integrity of the objects in every data repository by synchronizing its data repository with the data repository of other CMASs. It performs this synchronization by using CMAS-to-CMAS links, which are typically used for routing management commands and data between CMASs.

Read more...

What is CMCI?

The CICS management client interface (CMCI) is a system management application programming interface for use by HTTP client applications including IBM CICS Explorer. You can use this interface to develop HTTP client applications that manage installed and definitional CICS and CICSpex SM resources in CICS regions in a CICSpex or CICS resources in stand-alone CICS regions.

Read more...

What are the tools that you can use to administer CICSpex SM?

All CICSpex SM components, resources, system management requirements, and the relationships between them, are held as objects in a data repository. You can manage these objects using one or more of the provided interfaces:

- **CICS Explorer®**

  CICS Explorer is an Eclipse-based tool that you can use to create, install, and manage the objects in the data repository. It requires a CMCI or SM Data connection to connect to CICS regions.

  Read more...

- **The CICSpex SM Web User Interface (WUI)**

  The CICSpex SM WUI provides a customizable, platform-independent web interface to create, install, and manage the objects in the data repository. With the WUI, you can access CICSpex SM through standard web browser software to perform operational and administrative tasks such as monitoring and controlling the resources of CICS systems, defining and maintaining the CICSpex SM configuration, specifying BAS, WLM, RTA, and monitoring requirements, and so on. The web browser client contacts a WUI server by an HTTP request via the CICS Web Interface.

  The WUI server is a dedicated CICS region that runs as a CICSpex SM local MAS and communicates with the managed resources via the CMAS to which it is connected. You can have more than one WUI server active; for example, you might have a requirement for different languages to be used or different systems available to different servers.

  **Note:** The Web User Interface server code must be at the same release level as the CICS region on which it runs and the CMAS to which it is connected.

  All the menu and view definitions are stored on a server repository. There is one repository for each WUI server. The menu and view definitions can be exported for backup purposes, for distributing definitions to other servers, and for transferring menus and views when upgrading to a new product release.

  Read more...

- **The batched repository-update facility**

  The batched repository-update facility provides a batch job to create CICSpex SM resource definition objects.

  The batched repository-update facility can help you in the migration of your CICS definitions to CICSpex SM. You can use the EXTRACT command of the CICS DFHCSDup utility to read CSD
records. CICSPlex SM provides an exit routine EYU9BCSD that generates, from the DFHCSDUP output, equivalent resource definitions for input to the batched repository-update facility.

The batched repository-update facility is also useful for migrating your definitions from one platform to another. You can use it to retrieve existing resource definitions from the CICSPlex SM data repository then, after making any required changes to the definitions, input the changes to another batched repository-update facility run that creates resource definitions on the new platform.

Figure 1. Key components of a CICSPlex SM configuration

**Related information**

*Setting up CICSPlex SM*

**The CICSp lex**

A CICSp lex managed by CICSPlex SM could include every CICS system in your enterprise. Alternatively, you could define multiple CICSp lexes, each of which would include a logical grouping of CICS systems.

For example, a CICSp lex could comprise all CICS systems on a particular MVS image, or all CICS systems accessible by a subset of your users, or all CICS systems serving a particular geographical area. Furthermore, the composition of a CICSp lex can be altered without affecting the functions of the underlying CICS systems. The CICS systems in a single CICSp lex managed by CICSPlex SM do not have to be explicitly connected to each other for management purposes.

The most significant facts about a CICSp lex managed by CICSPlex SM are:

- The CICSp lex is the largest unit you can work with. That is, you cannot group CICSp lexes and manipulate such a group as a single entity.
• You cannot copy CICSPlex SM data from one CICSplex to another. For system management purposes, the CICSplex is "sealed" against other CICSplexes.
• CICSplexes are mutually exclusive, so no CICS system can belong to more than one CICSplex.

CICSPlex SM enables you to define subsets of a CICSplex, which are known as CICS system groups. CICS system groups are not mutually exclusive, and can reference the same CICS systems. Thus, if you decide to include every CICS system in your enterprise in a single CICSplex, there are mechanisms for managing groups of CICS systems within the CICSplex in a single system image manner.

You can assign an unlimited number of CICS systems and CICS system groups to an existing CICSplex. Although you can define a CICS system to only one CICSplex, you can assign a CICS system to multiple CICS system groups within the CICSplex. You can also assign the CICS system group to any number of other CICS system groups.

The managed application system (MAS)
Each running CICS system that is being managed by CICSPlex SM is known as a managed application system (MAS).

For details of the supported CICS releases that CICSPlex SM can manage, see the information about upgrading CICSPlex SM in Upgrading.

All the MASs within a CICSplex are managed by the same CICSPlex SM Address Space (CMAS) or the same group of CMASs.

Each MAS contains CICSPlex SM agent code that implements CICSPlex SM function, such as data collection, for the CMAS by which it is managed. For example, if resource monitoring is active for a particular MAS, agent code in the MAS monitors the selected resources and feeds the resulting data to the CMAS.

The MASs within a single CICSPlex do not have to be explicitly connected to each other for CICSPlex SM-specific communication. However, CICS connections required in support of transaction routing and function shipping are still required.

MASs can be defined and managed as individual CICS systems or grouped into system groups within the CICSPlex. Each system group is one or more CICS systems that you want to manage as a unit subset of the CICSPlex. System groups are described in Identifying system groups.

All MASs are local, that is they run on the same MVS image as the CMAS by which they are managed. You do not need to define an explicit link between the CMAS and the local MAS. For local MASs, system-management data is accumulated in data-space caches (as shown in Figure 1 on page 6) and is communicated to the CMAS via the Environment Services System Services (ESSS) address space (which is described in Environment Services System Services (ESSS)).

A MAS can be set up as a CICSPlex SM Web User Interface server. In this case, the CICS release level of the MAS and the CICSPlex SM Web User Interface server must be the same.
**CICSPlex SM address space (CMAS)**

The CICSPlex SM address space (CMAS) is the hub of any CICSPlex SM configuration, because it is responsible for most of the work involved in managing and reporting on CICS systems and their resources. Every CICSPlex is managed by at least one CMAS. The CMAS is responsible for the single system image (SSI) that enables the operator to manage a CICSPlex as if it were a single CICS system, regardless of the number of CICS systems defined as belonging to the CICSPlex, and regardless of their physical location.

The CMAS implements the BAS, WLM, RTA, and monitoring functions of CICSPlex SM, and maintains configuration information about the CICSPlexes it is managing. It also holds information about its own links with other CMASs. It stores this information in its data repository. (See Figure 2 on page 7).

A CMAS is a CICS Transaction Server for z/OS system. Most CMAS components run as CICS tasks, and CMAS connections to other components are implemented using CICS intercommunication methods.

**Note:** The CMAS does not support user applications or terminals, and its resources should not be considered available for non-CMAS tasks, including (without limitation) the use of any monitoring and performance tool other than those supplied as a part of CICSPlex SM.

A CMAS cannot be running a lower release of CICS than its MASs. Also, both the CMAS and the MASs must be running the same release of CICSPlex SM.

A CMAS is not part of any CICSPlex: a single CMAS can participate in the management of multiple CICSPlexes, but belongs to none of them.

If a CICSPlex is managed by multiple CMASs:

- The CMASs are connected to each other by CMAS-to-CMAS links defined to CICSPlex SM. These links ensure that each CMAS can access data held by other CMASs, and a single-system image can be presented to the operators.
- One of the CMASs is designated the maintenance point CMAS. That CMAS is responsible for maintaining all the CICSPlex SM definitions relating to a CICSPlex and keeping all the data repositories in synchronization.

CICSPlex SM can issue SNA generic alerts to NetView, provided that a CMAS is installed on the same MVS™ image as the NetView instance with which CICSPlex SM is working.

**Environment Services System Services (ESSS)**

*Environment Services System Services* (ESSS) is a limited-function, MVS system address space that provides z/OS services to CICSPlex SM components. In particular, ESSS owns all of the MVS/ESA data spaces on an z/OS image, so that they can exist independently of CMASs and MASs, yet remain accessible by both.

The benefit of this arrangement is that the CICSPlex SM data accumulating in the data spaces is not vulnerable to events in the MAS and CMAS components. ESSS also plays a part in some aspects of communication between a CMAS and any NetView instance on the same z/OS image as the CMAS.

There is one instance of ESSS for each version or level of CMAS on any z/OS image.

**CICSPlex SM objects**

To define the configuration of your CICS systems to CICSPlex SM, and to define your BAS, WLM, RTA, and monitoring requirements, you create *CICSPlex SM objects*, and associate them with each other.

For each object, and for each association or link between them, a record is created in a CMAS data repository. Figure 3 on page 9 shows how the CICSPlex SM objects relate to each other.
These objects can be split into three categories:

1. **CICSplex and CICS system** objects, used for defining the CICSplexes and CICS systems to be managed by CICSPlex SM. This includes defining the links between CICS systems and creating CICS system groups. These objects are described in Designing your CICSPlex SM environment; information on defining these objects is in Defining the CICSPlex SM configuration and topology.

2. **BAS** objects, used for logical scoping and managing the CICS resource definition and installation processes. You can look on the objects in this category as defining what resources you want your CICS systems to use. These CICSPlex SM objects are described in Multiple versions of a resource definition. Information on defining BAS objects is in Using full-function form BAS.

3. **Operation** objects are those objects used for operating the CICS resources that exist in running CICS systems. You can look on the objects in this category as identifying the resources you want to monitor at run-time, for automated workload management, automated exception reporting, and collection of statistical data. These CICSPlex SM objects are described in Managing monitoring functions, Workload management resources, and Managing RTA.

**The data repository**

The single-system image of a CICS system or group of CICS systems is provided by the CMAS using the CICSPlex SM and resource definitions held in the data repository.

Each CMAS has its own data repository. The data repository is a VSAM KSDS that is created using a CICSPlex SM post-installation job. As with all data sets, you need to take regular backups of each data repository in your environment.
CICSPlex SM definitions and CICS resource definitions held on the data repository can be managed in the following ways:

- Using CICS Explorer. See Working with resources in the CICS Explorer product documentation.
- Using WUI views. See The CICSPlex SM Web User Interface.
- Using the EYU9XDBT CICSPlex SM definition utility.
- Using the batched repository-update facility (BATCHREP); see The batched repository-update facility.
- Using the API

You can generate a visual map of the definitions in your data repository. The map can be of business application services, resource monitoring, real-time analysis, or workload monitoring. You select a starting point for the map, which might be for example, a CICS system group or an individual resource, from a WUI detail or tabular view. CICSPlex SM displays the starting point and all the definitions that either refer to that definition or are referred to by it. See How to map CICSPlex SM definitions.

CICS management client interface (CMCI)

The CICS management client interface (CMCI) is a system management application programming interface for use by HTTP client applications such as IBM CICS Explorer. The CMCI provides the CMCI REST API and the CMCI GraphQL API for CICS system management clients that manage installed and definitional system resources. It also provides support for client authentication.

You can use the CMCI either in a CICSPlex SM environment or in a stand-alone CICS region (SMSS).

**CMCI in a CICSPlex SM environment**

If you use the CMCI with CICSPlex SM, you can manage definitional, operational, and CSD resources in all of the CICS regions managed by CICSPlex SM.

**CMCI in a SMSS environment**

If you use the CMCI in a stand-alone CICS region, you can manage only the operational and CSD resources associated with that region, and the context is specified as the application ID of that CICS region.

**What is the CMCI JVM server?**

The CMCI JVM server is a Liberty server. It is an optional, but highly recommended component of the CMCI that enhances support for CMCI requests. This component performs client authentication, including the support for multifactor authentication (MFA), and provides support for the CMCI GraphQL API.

Table 1 on page 10 compares functions that are available to the CMCI configured with the CMCI JVM server with those available to the basic CMCI (that is, without the CMCI JVM server).

<table>
<thead>
<tr>
<th>Function</th>
<th>CMCI with the CMCI JVM server</th>
<th>CMCI (basic)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication support</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User ID / password</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Certificate</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PassTicket</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>MFA</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>API support</td>
<td></td>
<td></td>
</tr>
<tr>
<td>REST API</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GraphQL API</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>
The enablement of the CMCI JVM server is controlled by feature toggle com.ibm.cics.cmci.jvmserver.

**Note:** Stand-alone CICS regions (SMSS) do not support the CMCI JVM server.

**CMCI REST API versus CMCI GraphQL API: What is it? And what's the difference?**

The CMCI REST API and the CMCI GraphQL API are both HTTP-based application programming interfaces that can be used to develop HTTP client applications that manage installed and definitional CICS and CICSPlex SM resources on CICS regions being managed by CICSPlex SM.

The CMCI REST API is designed based on Representational State Transfer (RESTful) principles, so you need to retrieve data from multiple endpoints with fixed data structures. In comparison, the GraphQL API exposes only a single endpoint with more flexibility. This means that in a single query request, a client can query many types of CICS resources across CICSPlexes, and specify exactly what data it needs with explicitly expressed inherent relationships.

For example, the GraphQL query in Figure 4 on page 11 retrieves data about the local transactions and associated programs, including use counts, in all regions in all connected CICSPlexes. To achieve the same effect with the CMCI REST API, you might first access an endpoint that returns the list of local transactions available, and then an endpoint that returns all the programs. Then your client code must be written to post-process these results to match up the local transactions and programs. With GraphQL, relationships within the queried resources are also more explicitly shown through the CMCI GraphQL API than through the CMCI REST API.

```gql
{
  ciscplexes {
    cicsResources {
      loctran {
        records {
          name
          to_program {
            name
            useCount
          }
        }
      }
    }
  }
}
```

*Figure 4. CMCI GraphQL API Query requesting programs associated with local transactions*

**How it works: CMCI REST API**

The CICS management client interface (CMCI) provides a REST application programming interface (API) for system management clients such as IBM CICS Explorer.

The CMCI REST API is supported through HTTP. The client initiates an HTTP request to the CMCI. If the interface determines that the request is valid, it constructs a CICSPlex SM API command or, in the case of a stand-alone CICS region, a CICS system command. After running the command, the CMCI creates an HTTP response. If the request is successful, this takes the form of an HTTP 200 (OK) response and an XML feed containing a result set, which it passes back to the client. If the request is not successful, the response consists of a non-OK HTTP response code with details of the failure.

The format for CMCI HTTP requests and responses is based on the HTTP/1.1 protocol. See The HTTP protocol for more information about this protocol.

**How to make CMCI HTTP requests**

A CMCI request takes the form of an HTTP header followed by a URI (Universal Resource Identifier) and, where appropriate, an XML body containing details of any changes to be made to CICS or CICSPlex SM resources.

The header incorporates one of the following HTTP methods:
DELETE
Removes resources from the CICSPlex SM data repository, removes resources from the CSD, or
discards installed resources.

GET
Retrieves information about resources in the CICSPlex SM data repository, retrieves information
about resources on the CSD, or retrieves information about installed resources.

POST
Creates resources on the CICSPlex SM data repository or resources in the CSD.

PUT
Updates existing resources in the CICSPlex SM data repository, updates existing resources in the
CSD, or sets attributes and performs actions on installed resources. Also performs actions on
CICSPlex SM and CSD resources.

The URI includes the name of a CICS or CICSPlex SM resource, and
specifies a series of parameters that
refine the scope and nature of the query to identify one or more instances of the specified resource. In a
GET request, the URI also specifies whether the API retains or discards a set of results. If the API retains
the results, a new request can act on the retained results without having to repeat the retrieval operation.
You can also use subsequent requests to page through the retained results selecting one or more records
at a time.

POST and PUT requests include an XML body. In a PUT request the body contains either details of the
changes to be made to resource attributes, or the action to be performed on the targeted resources. In a
POST request, the body incorporates the attribute values you want to give to the new resource instance.

GET and DELETE requests do not require an XML body. If additional parameters are required for a DELETE
request, those parameters must be included in the URI and can optionally be added to the XML body.

Find out more
CMCI RESTful API programming reference gives your details on the DELETE, GET, POST, and PUT
methods, CMCI resource names, CMCI XML body elements, diagnostic aids, and so on.

How it works: CMCI GraphQL API
The CICS management client interface (CMCI) provides a GraphQL application programming interface
(API) for system management clients such as IBM CICS Explorer. The CMCI GraphQL API is supported
through HTTP. With the GraphQL API, a client can query many types of CICS resources across CICSPlexes
in a single request. In the single query request, the client can specify exactly what data it needs about
multiple CICS resources, with explicitly expressed inherent relationships between the CICS resources.

The aggregation function in CICS Explorer 5.5 requires the CMCI GraphQL API. The CMCI GraphQL API
requires the CMCI JVM server to be used with the CMCI. For more information about GraphQL, see
Introduction to GraphQL.

What is a GraphQL query?
A simple GraphQL query request looks like this:

```json
{
  cicsplexes {
    name
  }
}
```

Figure 5. Simple query requesting CICSPlex names

At the root of the query is the cicsplexes field, which finds all the CICSPlexes that the WUI server is
connected to. The name field nested in the cicsplexes field requests the name of each CICSPlex.

Query responses are returned as JSON objects, with the requested data enclosed in the value of the data
field. The structure of the response follows that in the query.
To retrieve more information, add more fields to the query, including nested ones. See “Sample queries” on page 13.

**How to make GraphQL API requests**

The GraphQL API endpoint is at:

```
https://host:port/graphql
```

where `host` and `port` are the host name and the port number of your CMCI JVM server.

The GraphQL API accepts GET and POST requests.

**For GET requests:**

A `Content-Type: application/json` header must be sent. The query is supplied by the `query` query parameter. The operation is supplied by the optional `operationName` query parameter.

For example, the simple query in Figure 5 on page 12 can be sent by using the following URL:

```
https://host:port/graphql?query={cicsplexes{name}}
```

**For POST requests:**

A `Content-Type: application/json` header must be sent. The body of the request must be a JSON-encoded object.

```
{
  "query": "query_body",
  "operationName": "operation_name"
}
```

where only the query field is mandatory.

Alternatively, a `Content-Type: application/graphql` header can be sent on POST requests. In this case, the body of the request must be the GraphQL query itself, and no operation name can be specified.

See “Sample queries” on page 13 for sample code of GraphQL queries.

**Sample queries**

You can use GraphiQL, an online GraphQL visualization editor, to test your GraphQL queries or the samples. The URL to GraphiQL is:

```
https://host:port/graphiql
```

where `host` and `port` are the host name and the port number of your CMCI JVM server.

**GraphiQL tips:**
• GraphQL provides auto-completion and a built-in documentation explorer for GraphQL schema reference. You can display available field names by pressing Ctrl+Space.

• To easily differentiate queries in GraphiQL history, you can specify a unique query name by prefixing the query with query QueryName.

The following example queries the count of local files of all regions in all the connected CICSplexes, and the name of each CICSplex and region. It also has a query name LocalFilesInRegionsInCICSplexes.

```graphql
query LocalFilesInRegionsInCICSplexes {
  cicsplexes {
    name
    regions {
      name
      cicsResources {
        locfile {
          count
        }
      }
    }
  }
}
```

You can add more attributes to be queried. This example queries all CICSplexes and all the regions in each CICSplex. Within each region, it retrieves the name, useCount, and status fields of all the local transactions.

```graphql
{
  cicsplexes {
    name
    regions {
      name
      cicsResources {
        loctran {
          records {
            name
            useCount
            status
          }
        }
      }
    }
  }
}
```

You can specify which CICSplex or CICS region to be queried. This example queries Region AORRGN in CICSplex PLEX1, retrieving the name, useCount, and status fields of all the local transactions in the region.

```graphql
{
  cicsplex(name: "PLEX1") {
    name
    region(name: "AORRGN") {
      name
      cicsResources {
        loctran {
          records {
            name
            useCount
            status
          }
        }
      }
    }
  }
}
```

Removing the CICSplex and region specifications, this example queries all connected CICSplexes and the name, useCount, and status fields of all the local transactions in those CICSplexes.

```graphql
{
  cicsplexes {
    name
    
```
This example is similar to the previous one, except that it uses a filter to retrieve only transactions starting with CED.

```
{ cicsplexes {
  name
  cicsResources {
    loctrans(filter: {name: {value: "CED*"}}) {
      records {
        name
        useCount
        status
      }
    }
  }
}
```

You can also query CICS definitions. This request queries the name and update attributes for all file definitions in the CICSplex data repository.

```
{ cicsplex(name: "PLEX1") {
  drep {
    cicsDefinitions {
      filedef {
        records {
          name
          update
        }
      }
    }
  }
}
```

Similarly, this request queries the name for all pipeline definitions in the CSD for Region AORRGN in CICSplex PLEX1.

```
{ cicsplex(name: "PLEX1") {
  region(name: "AORRGN") {
    csd {
      cicsDefinitions {
        pipedef {
          records {
            name
          }
        }
      }
    }
  }
}
```

This query performs aggregation of all local files in each CICSplex, grouping them by common values of the name attribute and retrieving the count of aggregated records within each aggregation group, the name of each group, and the average, minimum, and maximum readCount within each group.

```
{ cicsplexes {
  name
  cicsResources {
```
CMCI security features: How CMCI authenticates clients
When an HTTP system management client such as CICS Explorer attempts to sign on, the CMCI verifies the user credentials. The user credentials can be a user ID and password, a PassTicket, an MFA token or a certificate. If the CMCI JVM server is enabled, it handles the authentication process. Authentication through a PassTicket or an MFA token is only available with the CMCI JVM server.

How the CMCI JVM server authenticates clients
Figure 7 on page 16 illustrates the client authentication workflow based on CICS Explorer.

![Figure 7. CMCI HTTP client authentication workflow](image)

1. When a user logs on from CICS Explorer, CICS Explorer passes the user credentials to the CMCI JVM server. The user credentials can be a user ID and password, a PassTicket, an MFA token or a certificate.

2. The CMCI JVM server validates the user credentials by using SAF interfaces to the external security manager (ESM) and generates an LTPA token.

3. The CMCI JVM server replies to CICS Explorer with the response and the LTPA token.

In subsequent requests, CICS Explorer will use the LTPA token to authenticate the user.

**Note:**
- The LTPA token is a cookie; therefore, the HTTP client must accept cookies.
- Although a JVM server is used for the transport and authentication of the CMCI, most of the processing still occurs in the CICS core; therefore, do not expect increased specialty engine offload from the CMCI JVM server.
LTPA timeout
An LTPA token has a fixed lifetime. It cannot be extended or renewed, even if a user is active in a session. Upon timeout, the user is logged out and must provide login credentials again to get a new token. The expiration time of the LTPA token is configurable. For instructions, see Configuring LTPA in Liberty.

Sharing LTPA tokens
With the single sign-on (SSO) configuration support in Liberty, you can set up Liberty to allow the sharing of LTPA tokens among multiple regions. HTTP client users can authenticate once and have access to other regions that share the same LTPA keys. For more information, see .

How CMCI without the CMCI JVM server authenticates clients
If the CMCI JVM server is not used with the CMCI, the user is authenticated using a certificate or a basic authenticator in the HTTP header.
One-time-use tokens (such as MFA tokens and PassTickets) are not supported.

Find out more
gives you an overview of the authentication process in Liberty and describes LTPA and SSO in details. Setting up CMCI gives you configuration instructions.
Chapter 2. Setting up CICSPlex SM

CICSPlex SM is the system management component of CICS and can provide a single-image view of your CICS regions. Set up CICSPlex SM if you have to manage a large number of regions, want to implement workload management, or use platforms, applications, and policies in CICS.

Designing your CICSPlex SM environment

Map out your enterprise to design a CICSPlex SM environment that meets your system management requirements. Your design must include topology information, such as identifying the CICSplices, CMASs, and WUI server regions that are required, as well as making other design decisions such as what naming convention to follow.

Before you begin

To design a CICSPlex SM environment, you must be familiar with the concepts and components of CICSPlex SM.

Be aware of some considerations that can help to avoid issues with the set-up or maintenance of CICSPlex SM:

- When you apply service to CICSPlex SM, PTFs that are applied to the ESSS are not intended to be downward-compatible with earlier maintenance levels at the same release. This means that all CMASs, MASs, WUI Server regions and API programs must run at the same maintenance level as the ESSS for their release. Otherwise, abends, data corruption, and unexpected results might occur. When you apply PTFs to CICSPlex SM, it is essential that all ++HOLD ACTION items associated with the SMP/E maintenance are followed carefully.

- Additionally, consider the following guidelines when you design a CICSPlex SM topology:

  1. Avoid running Production and non-Production (for example, test, development, or QA) regions on the same LPAR. All regions that run the same CICSPlex SM release use one copy of the ESSS: that is, they share the ESS. As a result, applying a PTF to this shared ESSS requires an outage of both the Production and the non-Production regions.

  2. Connect the WUI server directly to the maintenance point CMAS (MP CMAS), so that they are both at the at the highest CICSPlex SM release level. This configuration ensures that the WUI server uses the latest resource tables and WUI views, and simplifies upgrading procedures.

  When you run a mixed release environment, you might need more than one WUI server. In that case, this advice still applies. Have one WUI server at the latest release level and connected directly into the latest release CMAS, and any other earlier release WUI servers connected into the appropriate release CMAS, if required.

  3. Connect the MP CMAS only to other CMASs and a WUI server. If MASs are connected directly into the MP CMAS, this configuration prevents the MP CMAS from being easily moved to a different LPAR if an outage occurs.

  4. Use a single MP CMAS to prevent complexity during upgrades. For example, this helps avoid a potential conflict of CICSPlex SM release levels, which can cause CMASs to be isolated from the management of a CICSp Plex during an upgrade.

Procedure

1. Decide how to group your CICS regions into system groups to identify what CICSplices are required. The CICSp lex is the largest unit that you can manage in your CICSPlex SM configuration.

2. Decide how many CMASs are required for each CICSp lex and how to link them together.
The CMAS is the component of the CICSpIex SM topology that is responsible for most of the work involved in managing and reporting on CICS regions and their resources. Each CICSpIex must have at least one CMAS.

3. Decide how many WUI servers are required and how to link them to the correct CMAS.

4. Decide on a naming convention for the CICSpIex SM components.
   The naming convention must be meaningful and extendable.

5. Decide on an implementation strategy.

**Results**

Following these steps results in a detailed topology map of your enterprise.

**What to do next**

After you complete your map of the enterprise, you are ready to plan the installation of CICSpIex SM to create your proposed configuration. Make sure that you keep your map up-to-date as you add more system groups or regions or make changes to the topology, because an accurate map makes it easier to maintain the CICSpIex SM configuration and topology data.

**Designing your CICSpIexes**

The CICSpIex is the largest unit that you can manipulate in your CICSpIex SM configuration. A CICSpIex is made up of an association of CICS systems and CICS system groups. This section gives guidance on deciding how to group your CICS systems into system groups, and then to identify CICSpIexes.

**Identifying your CICS systems and regions**

The first action when planning to install CICSpIex SM is to identify the CICS systems or regions in your enterprise. You might already have a clear picture of the systems you have, and of where they are installed. However, in the larger enterprises, where CICS systems are numbered in the hundreds, it's possible that no one individual has this complete view.

The goal is to document the current arrangement of your CICS systems in a graphical form. The "map" you produce should be a logical representation of your CICS systems rather than a physical one, so you do not need to record details such as where specific processors are located. When you record the map, for example by using a graphics tool, ensure that you leave plenty of space so that you can update the map with CICSpIex SM components as you work through this exercise.

In your initial map of the enterprise CICS systems, include every operating environment in which CICS is installed. Also show the following information:

- The current version and release of the operating systems in use
- The CICS systems running in each environment, and the CICS platform, version, and release of each one
- The resource-manager role of each CICS system, if applicable

If you cannot fit all this detail on your map, record it separately from the graphical representation of the CICS systems.

**Figure 8 on page 21** shows an example of the type of map you should be aiming to produce.
Figure 8. A map of the enterprise CICS systems
CICSPlex SM can manage all supported CICS releases. The CICS systems become your managed application systems (MASs).

How many CICSplices are there in your enterprise?
When you have identified those CICS systems or regions in your enterprise that can be managed by CICSPlex SM, your next task is to decide how many CICSplices you want to define to CICSPlex SM, and which of your CICS systems should belong to each CICSplice.

You can have any number of CICSplices. For example, you could define one CICSplice for:

- The entire enterprise
- Each geographical location
- Each business unit in the enterprise
- Each existing TOR-AOR-FOR configuration
- Each processor

If you do not plan to use workload management facilities, there are no restrictions on how you combine CICS systems and CICS system groups to form a CICSplice. For example, you might associate CICS systems by:

- Geographic area in the CICSplice
- Function, such as all CICS systems that are application-owning regions (AORs), file-owning regions (FORs), or terminal-owning regions (TORs)
- Application, such as the CICS systems serving as AORs, FORs, and TORs that are used by a specific application or group of applications
- Time period, such as all CICS systems that are normally active during specific hours of the day or night

If you do plan to use workload management facilities, you must ensure that:

- Each CICS system that is to act as a target for specific workload processing must be in the same CICSplice as the CICS systems acting as routing regions. (The routing regions and target regions associated with a CICSplice can be in the same or different MVS images.)
- CICS systems acting as the routing regions must be CICS TS systems.

If you plan to use the logical scoping, resource management, or installation functions of BAS, keep a business application in one CICSplice.

If you plan to use CICS BTS, you should keep a BTS-set with one CICSplice.

The question is, how do you decide what to do? There are no hard-and-fast rules governing the number of CICSplices you define, but there are some guidelines that will help you select the most suitable configuration for your enterprise. These guidelines are presented in the form of a three-step process:

1. Decide to have a single CICSplice for the entire enterprise.
2. Look for reasons why a single CICSplice might not be feasible.
3. Confirm your decision.

Step 1: Have a single CICSplice for the entire enterprise
The majority of enterprises find that having a single CICSplice best suits their system management goals.

The CICSplice is the largest single entity that CICSPlex SM can manage. None of the CICSPlex SM definitions or specifications can cross a CICSplice boundary. Furthermore, CICSplices are mutually exclusive. No CICS system can belong to more than one CICSplice. Therefore, having a single CICSplice for the enterprise brings several advantages. For example:

- Providing the greatest opportunity for sharing and reusing BAS, WLM, RTA, and monitoring specifications and definitions.
- Giving you the most flexibility in managing the CICS workload when using the CICSPlex SM workload routing functions.
• Giving a single system image (SSI) of the entire enterprise. Also, the CICS operator is able to have a complete view of the enterprise CICS resources from a single CICSPlex SM window. (Because any CICSPlex SM window can display data from only a single context—that is, a single CICSPlex—multiple windows would have to be displayed in a multi-CICSPlex environment.)

In summary, having one CICSPlex means that there are no system management barriers between one group of the enterprise CICS systems and another.

**Step 2: Look for reasons why a single CICSPlex might not be feasible**

The single CICSPlex solution is not the best approach in every enterprise, either because implementation is not possible, or because it does not accord with other system management goals.

Firstly, you must ask whether the organization of your enterprise lends itself to a single CICSPlex. For example, if you have processors in different geographical locations, are there connections between those processors, or are they managed as separate entities, each with its own workload? If you have these separate units in your enterprise, it is likely that you will need to define multiple CICSPlexes, and so manage the enterprise CICS systems as if they belonged to more than one enterprise.

Similarly, is your enterprise organized and run as multiple, separate business units? For example, if you are running a bureau that provides computing services to a variety of customers, the absolute separation of one set of regions from another, even in a single processor, might simplify other processes, such as security management, customer billing, or workload management. If you have similar reasons for wanting to keep the management of some regions entirely separate from the management of others, consider defining multiple CICSPlexes instead of one.

If you have decided that you need to define more than one CICSPlex, it is probably obvious to you already which CICS system or CICS systems should belong to each. If it is not, consider revisiting your decision to have multiple CICSPlexes because it suggests that you are trying to erect artificial barriers. As a final check, ensure that the way you separate the regions is not disruptive to your other system management goals. For example, if you want to use CICSPlex SM WLM functions, both routing regions and the target regions to which they route transactions must belong to the same CICSPlex, unless you are planning to customize the supplied dynamic routing program.

**Step 3: Confirm your decision**

When you have decided whether to have one CICSPlex or many, check your decision against these other considerations:

• Does your CICSPlex organization mirror your enterprise organization? If your enterprise is structured as multiple, independent units, having multiple CICSPlexes is probably the better approach. If it is structured as a single entity, the single-CICSPlex solution is likely to be the more suitable.

• Does your decision conflict with your enterprise's plans, either for its business or its information systems? For example, if your enterprise currently operates as multiple, separate entities, are there plans to unify them?

• Is your proposed configuration as simple as it could be? For example, are you planning to define four CICSPlexes when two would support your system management goals?

• If you are planning multiple CICSPlexes, have you considered whether CICS system groups could be used to achieve your goals? CICS system groups, unlike CICSPlexes, are not mutually exclusive. This can be an advantage or a disadvantage, depending on your reasons for having multiple CICSPlexes.

Remember that you can alter your decision. Ideally, you will discover the best possible configuration at your first attempt. However, if you decide after a while that a different CICSPlex configuration would be better, you can make the necessary changes.

In Figure 9 on page 24, the example enterprise operates as two discrete units: the first three MVS images process a different workload from the remaining two, and there is no sharing of resources between those two groups. Accordingly, the enterprise CICS systems are divided between two CICSPlexes.
Figure 9. Identifying the CICSplices in the example enterprise
Identifying system groups

You can identify one or more subsets of the CICS systems within a CICSplex as a CICS system group, which can be manipulated as a single entity and independently of the rest of CICSplex.

For example, if you define a CICSplex made up of TOR, AOR, and FOR CICS systems, you might want to define the AORs as a CICS system group, so that you can use a single CICSplex SM command to make changes to, or request data from, all CICS systems in that category.

Alternatively, you could define a single group for any of the following:

- Particularly heavily loaded CICS systems
- CICS systems that have different security requirements from the other CICS systems in the CICSplex
- CICS systems in which particular applications run

CICS system groups, unlike CICSplexes, do not have to be mutually exclusive: a CICS system can belong to any number of groups in a CICSplex. However, because the CICS system group is a subset of the CICSplex, a system group cannot cross CICSplex boundaries.

In the example configuration in Figure 9 on page 24, some suggested CICS system groups are as follows:

- **CICSplex 1**
  - Group 1: TOR 1 and TOR 2
  - Group 2: AOR 1 through AOR 5
  - Group 3: FOR 1
  - Group 4: All CICS systems on System A
  - Group 5: All CICS systems on System B
  - Group 6: All CICS systems on System C
  - Group 7: Group 4 and Group 5
  - Group 8: All CICS systems in CICSplex 1

- **CICSplex 2**
  - Group 1: TOR 3
  - Group 2: AOR 6 through AOR 9
  - Group 4: All CICS systems on System E
  - Group 5: All CICS systems on System F
  - Group 6: Group 4 and Group 5
  - Group 7: All CICS systems in CICSplex 2

Notice that Group 7 in CICSplex 1 and Group 6 in CICSplex 2 comprise of other groups. Defining groups within groups is very efficient, both for you (because it means less effort) and for CICSplex SM.

Group 8 in CICSplex 1 and Group 7 in CICSplex 2 include the same set of CICS systems as the CICSplex to which it belongs. These are often useful groups to define because the scope value (as specified for a monitor specification, for example) can be a CICS system or a CICS system group name only: it cannot be the name of a CICSplex.

This is merely an initial list of system groups. It is likely to be added to (or altered) when BAS, WLM, RTA, and monitoring requirements are identified.

Groups within groups

You can create CICS system groups from other groups. For example, if you want a single group to contain all AORs and all TORs in CICSplex, you can define its members as:

- The CICS system group comprising all AORs
- The CICS system group comprising all TORs
Any duplication of CICS system names that occurs in this way (for example, if a particular CICS system belongs to more than one constituent group) is accommodated by CICSPlex SM. When a CICS system group is the target of a CICSPlex SM command, CICS systems appearing in the group more than once are acted on only once.

**Locating CMASs**

The CMAS is the component of the CICSPlex SM topology that is responsible for most of the work involved in managing and reporting on systems and their resources.

It is the CMAS that is responsible for presenting the SSI to the operator. Each CICSplice is managed by at least one CMAS. This section gives you guidance on deciding where to put CMASs and how many to have.

**Where to install CMASs**

After you decide which CICS systems will be managed by CICSPlex SM, and how they will be organized into CICSplices, you should think about where CMASs are required.

The rules and recommendations governing where a CMAS can, and must, be installed are as follows:

- Each CICSplice must be managed by at least one CMAS.
- Each CICSplice must have a maintenance point CMAS.
- A CMAS can participate in the management of multiple CICSplices.
- The SDFH* libraries and the SEYU* libraries in the CMAS must be the same level, and the CMAS must be appropriate to the level of CICSPlex SM that you are running. See, Upgrading CICSPlex SM.
- If you want CICSPlex SM to issue SNA generic alerts to a NetView instance, a CMAS must be installed on the same MVS image as the NetView instance.
- Install one CMAS on each MVS image on which managed CICS systems are running.
- You can have more than one production CMAS in an MVS image, but it is unlikely to be necessary.

You should also consider the performance implications of your decision. Each CMAS has its space requirements and its own data repository.

If these rules and recommendations are applied to the example enterprise, you can see that:

- You must have at least one CMAS in the enterprise.
- NetView is installed on System C; to send SNA alerts to that NetView instance, you must install a CMAS on the same MVS image.

Figure 10 on page 27 shows the example map updated to show the application of these CMAS rules and recommendations. A CMAS is to be installed on each MVS image. CMAS 4 can issue SNA generic alerts to the NetView instance on the same MVS image. CMAS 4 is the maintenance point CMAS (MP CMAS) for CICSplice 1, and CMAS 7 is the MP CMAS for CICSplice 2. That is, CMAS 4 will be the context CMAS when you define CICSplice 1, and CMAS 7 will be the context CMAS when you define CICSplice 2 to CICSPlex SM.)
CMAS-to-CMAS links
When a CICSplex crosses multiple MVS images, multiple CMASs are likely to be involved in managing that CICSplex. The CMASs must be connected to each other (by using CICS intercommunication methods) so...
that data relating to the CICS systems belonging to the CICSpex is accessible by all relevant CMASs, and a single system image (SSI) can be presented to the CICS operator.

The minimum requirement is that CMASs managing the same CICSpexes be linked to form an open chain of CMASs, so that each CMAS is linked, if only indirectly, to every other CMAS. Meeting this requirement ensures that there is at least one path from each CMAS to every other CMAS involved in managing the same CICSpex. To achieve the best performance and availability, link every CMAS directly to every other CMAS.

The links between multiple CMASs involved in managing the same CICSpex are responsible for the SSI of the CICS systems or systems that belong to that CICSpex. However, you do have a degree of choice regarding the number of links you define. First, here's a reminder of the rules and recommendations concerning CMAS-to-CMAS links:

- To establish an SSI of a CICSpex, the CMASs managing that CICSpex should at the very least be linked to form an open chain.
- The more links you establish, the better the performance. The best performance is achieved when every CMAS is directly connected to every other CMAS involved in the management of a single CICSpex.
- A multiplicity of CMAS-to-CMAS links is also better for availability: if CMAS 1 is at the end of the chain and is connected to CMAS 2 only, the failure of CMAS 2 breaks the chain and leaves no connection to CMAS 1.

Figure 11 on page 28 illustrates the concept of direct and indirect CMAS-to-CMAS links. This CICSpex comprises six CICS systems; three systems are managed by CMAS 1, and three systems are managed by CMAS 5. Without a direct link between the two CMASs, CICSpex SM can navigate dynamically around its "network" to gather information relevant to the CICSpex. It could go through CMAS 4 or, if CMAS 4 is unavailable, it could go through CMAS 2 and CMAS 3. However, for optimum performance, a direct link should be added between CMAS 1 and CMAS 5.

![CMAS-to-CMAS links in a CICSpex](image)

In the example enterprise configuration in Figure 12 on page 30, full CMAS-to-CMAS connectivity is established for each of the two CICSpexes. That is, for management of CICSpex 1, CMASs 1, 2, 3 and 4 are directly connected to each other; for management of CICSpex 2, CMASs 5, 6, and 7 are directly connected to each other. Thus, the following CMAS-to-CMAS links must be defined:
<table>
<thead>
<tr>
<th>CICSplex 1</th>
<th>CICSplex 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMAS1 to CMAS2</td>
<td>CMAS5 to CMAS6</td>
</tr>
<tr>
<td>CMAS1 to CMAS3</td>
<td>CMAS5 to CMAS7</td>
</tr>
<tr>
<td>CMAS1 to CMAS4</td>
<td>CMAS6 to CMAS5</td>
</tr>
<tr>
<td>CMAS2 to CMAS1</td>
<td>CMAS6 to CMAS7</td>
</tr>
<tr>
<td>CMAS2 to CMAS3</td>
<td>CMAS7 to CMAS5</td>
</tr>
<tr>
<td>CMAS2 to CMAS4</td>
<td>CMAS7 to CMAS6</td>
</tr>
<tr>
<td>CMAS3 to CMAS1</td>
<td></td>
</tr>
<tr>
<td>CMAS3 to CMAS2</td>
<td></td>
</tr>
<tr>
<td>CMAS3 to CMAS4</td>
<td></td>
</tr>
<tr>
<td>CMAS4 to CMAS1</td>
<td></td>
</tr>
<tr>
<td>CMAS4 to CMAS2</td>
<td></td>
</tr>
<tr>
<td>CMAS4 to CMAS3</td>
<td></td>
</tr>
</tbody>
</table>

If you decided to not link CMAS 1 to CMAS 3 directly, this arrangement would meet the minimum CMAS-to-CMAS link requirement (by having an open chain of CMASs) and you would need to define two less links. Some information would be obtained indirectly. For example, information requested from System C about CICS resources on System A would be obtained indirectly through the adjacent CMAS, CMAS 2. Wherever full connectivity is not established among a group of CMASs, CICSPlex SM works out the quickest route to the requested data dynamically.

The performance impact is slightly higher when information is obtained indirectly, but you must balance this against the overhead of setting up and maintaining the CMAS-to-CMAS links. In fact, if the example enterprise configuration had one CICSpex rather than two, full connectivity among the CMASs would be feasible. That is, you would need 42 CMAS-to-CMAS links, because the number of links required is \( n^2 - n \), where \( n \) is the number of CMASs to be connected. However, if you have ten CMASs managing a single CICSpex, the number of links required is 90; for 15 CMASs, 210 links. So you must decide how many direct links you are prepared to define, and where indirect links can be accommodated, always remembering that the minimum requirement is for an open chain of CMAS-to-CMAS links.

Figure 12 on page 30 shows the CMAS-to-CMAS links in the example enterprise configuration. 18 links are defined, giving full connectivity among CMASs managing the same CICSpexes.
When there are multiple CMASs on the same MVS system, managing the same CICSPlex, a local MAS that specifies only the CICSPLEX(name) CICSPlex SM system parameter, and not the CMASSYSID(name).
CICSPlex SM system parameter, will connect to the last CMAS to initialize on the MVS image that manages the named CICSPlex for a specific release of CICSPlex SM.

**CMAS-to-CMAS links for multiple CICSPlexes**

The example enterprise configuration has two CICSPlexes. To enable the CICSPlex SM operator to access CICSPlex 2 data from System B, for example, you could establish a link between any one (or more) of the CMASs involved in managing CICSPlex 1 and any one (or more) of the CMASs involved in managing CICSPlex 2. For example, you could establish a link from CMAS 1 to CMAS 5, thus forming a chain of all of the enterprise CMASs.

**Locating the maintenance point CMAS**

When a single CICSPlex is managed by multiple CMASs, one of them is designated the *maintenance point CMAS (MP CMAS)*.

The MP CMAS is responsible for maintaining all CICSPlex SM definitions relating to a CICSPlex, and for distributing up-to-date information to the other CMASs involved in managing the same CICSPlex, so that no data repository is out of step with any other.

The MP CMAS is the CMAS that has the context value when the CICSPlex is defined to CICSPlex SM. Each CICSPlex can have only one MP CMAS, but a single CMAS can be the MP CMAS for more than one CICSPlex. If the MP CMAS is unavailable at any time, no changes to any CICSPlex SM definitions can be made.

An MP CMAS can also function as a non-maintenance point CMAS for other CICSPlexes.

**Note:** The CICSPlex SM single point of control means that changes to the MP CMAS can be made from any system on which the CICSPlex SM WUI is available.

Ideally, connect the MP CMAS only to other CMASs and a Web User Interface (WUI) server. Do not connect the MP CMAS to other CICS regions. This configuration means that the MP CMAS can easily be moved between MVS images, or have maintenance applied, without affecting other regions.

**Planning the location of WUI servers**

The location and number of WUI server regions in your enterprise depend on your availability requirements and globalization support.

**Before you begin**

You must have planned where to install the CMASs and how to link them together before planning where to install the WUI server regions.

**About this task**

The WUI server is a CICS region that acts as a CICSPlex SM application, using the API to view and manage objects in the data repositories of CMASs.

**Procedure**

1. Decide if you want a WUI server to be available in every MVS image.
   - If you have a WUI server on each MVS image, you do not have to connect the WUI servers directly to the CMAS on each MVS image.
   - **Tip:** If you define a separate CICSPlex for the WUI servers, the number of CMAS maintenance points across your enterprise are kept to a minimum. It also separates the WUI servers from statistics generated from CICSPlexes that are running CICS applications.
2. Decide what national languages the WUI must support.
   - If you want to display the WUI in more than one language, you require a WUI server for each language.
3. Decide what connections are required from each WUI server region to the CMASs.
• The CMAS to which the WUI server connects must be managing all the CICSplices to which the WUI server requires access. However, it is not necessary for the CMAS to which the WUI connects to be managing any of the MASs in these CICSplices.
• The CMAS and the WUI server that you want to connect must be at the same release level of CICS Transaction Server.

4. Update your topology map to include the WUI server regions.

Example
On system F, a WUI server is connected to the maintenance point, CMAS 7, and is in a separate CICSplice called CICSplice 4. The WUI server and CMAS 7 are both at the same level of CICS Transaction Server. CMAS 7 is the maintenance point for both CICSplice 2 and CICSplice 4.
Naming your CICSPlex SM entities

All the entities that you have defined, and entered on to your CICSPlex SM map, have to be named. You must devise a convention for naming those entities that is both meaningful and extendable.

The rules governing the naming of CICSPlex SM elements are as follows:
• Each element name can be up to 8 characters.
• The element name must begin with an alphabetic (or national) character, and must have no embedded blanks. Subsequent characters can be alphabetic or numeric.
• Names of CICSPlexes and of CMASs must be unique in the enterprise.
• Names of CICS systems and CICS system groups must be unique in the CICSpexion.
• All other names must be unique for their type in the CICSpexion.

The entity types, for each instance of which a name is required, are:

• CICSpexion SM components and CICSpexion entities
  – CMAS, CICSpexion, MAS (CICS system or WUI server), CICS system group, and time-period definition.
• BAS entities
  – Resource assignments, resource descriptions, resource definitions, and resource groups.

  Application resource definitions are:
  - Db2® transactions, files, map sets, partition sets, programs, transient data queues, transactions, CICS BTS process types, document templates, FEPI nodes, FEPI pools, FEPI property sets, FEPI targets, file and key file segment definitions, LIBRARY definitions, map sets, sysplex enqueue models, TCP/IP services, temporary storage models

  Region resource definitions are:
  - Db2 entries, enterprise beans, journals, journal models, local shared resource (LSR) pools, profiles, temporary storage queue models, transaction classes, terminals, typeterms

  System–system connectivity resource definitions are:
  - Connections, Db2 connections, IPIC connections, partners, sessions

• Monitor entities
  – Monitor definition, monitor group, and monitor specification

• Analysis entities
  – Analysis definition, analysis group, analysis point specification, analysis specification, action definition, evaluation definition, and status definition

• Workload management entities
  – Transaction group, workload definition, workload group, and workload specification.

Ensure that any convention you select can accommodate all of these entity types.

Generic names

CICSpexion SM supports the use of generic names in many of its commands. For example, you can specify that all transactions whose names begin with the letters "DNW" are monitored once every 300 seconds. You do not need to name each transaction individually.

The rules governing the use of generic names are as follows:

• The asterisk character (*) can be used in place of one or more characters. It can appear once only in any name, and must appear at the end of any partial string. For example, the string "DNW*" means all names beginning with the letters DNW.

• The plus sign (+) can replace any single character and can occur in any position in the name. For example, "DNW+++L" means any name of 7 characters starting with the letters DNW and ending with the letter L.
A staged implementation

If you have a very large number of CICS systems, or if you have decided to create multiple CICSplices, you might want to consider implementing CICSPlex SM in stages.

You can install CICSPlex SM on a subset of your systems and use it to manage a single CICSplice or, if you have defined a single CICSplice for the enterprise, you can use it to manage particular system groups. Additional CICS systems can be added to the configuration gradually.

If you opt for the gradual approach, you will need to revisit your final map of the enterprise CICS systems and identify those you plan to start with. For example, if a staged implementation were adopted for your example map, you could decide to begin by implementing CICSPlex 2 only. The CMAS-to-CMAS links would be much reduced in number (six CMAS-to-CMAS links, rather than 18), but the other decisions made about CICSPlex 2 are still valid. That is, the same CICS system groups can be defined, and the CMAS installations are still required.

Planning CICSPlex SM setup

CICSPlex SM is installed as part of the product. To set up CICSPlex SM you must plan the security that is required, and which time zones to use in the CICSplice.

To implement CICSPlex SM in your existing environment, you can use the samples that are supplied with CICS to get started.

Security planning for CICSPlex SM

CICSPlex SM uses a SAF-compliant external security manager, such as RACF® to prevent unauthorized access to CICSPlex SM functions and CICS resources, and to control the simulation of CICS command checking and CICS resource checking.

In both cases, security checking is handled by the CMASs managing the CICS systems that are the target of any request to access a resource. For example, if a CICSplice is managed by two CMASs, and a request is made to access a resource in all CICS systems belonging to that CICSplice, the security check is performed in both CMASs.

To activate security checking, you must modify the JCL used to start the CMAS or its managed CICS systems. If security checking is switched off for the CICS system, no checking occurs, regardless of the CMAS setting. However, if security checking is switched off for the CMAS but switched on for the CICS system, the CICS system is not able to connect to the CMAS.

Begin by deciding how much security checking you need. In particular, identify those users who need access to CICSPlex SM, and ensure that an individual user has the same user ID across all systems on which a CMAS is installed. The user ID against which the security check is performed is the RACF ID that has been used to sign on to CICSPlex SM. Consider also the type of security checking you want to implement.

See Implementing CICSPlex SM security for more information about how to set up CICSPlex SM security.

Protecting access to CICSPlex SM functions and CICS resources

To prevent unauthorized access, you create security profiles for combinations of CICSPlex SM functions, and CICS resources that are to be protected. In most cases, the security provided by CICSPlex SM security profiles is adequate.

An external security manager is also used to protect CICSPlex SM libraries, procedures and Web User Interface resources. Full details of how to protect CICSPlex SM libraries and procedures are provided in Implementing CICSPlex SM security. In order to protect Web User Interface views, menus, help information and the View Editor, you need to create an appropriate profile in the FACILITY class. See Controlling access to Web User Interface resources for more information.
Special considerations for BAS

Take special care in the protection of the BAS views, so that unauthorized users cannot create and administer resources. The equivalent in RDO terms is leaving your CSD unprotected.

Also take care if you use the EXEC CICS CREATE command to build new resources. Any definition created with the CICSpex as the context is automatically distributed to all CMASs in the CICSpex. Therefore, giving a user authority to create BAS objects is equivalent to giving authority to install resources on any CICS system in the CICSpex. When the CICS system starts, there is no check on who installed the resource in the system.

CICS command and resource checking

CICS command and resource checking is simulated by CICSpex SM in the CMASs to which a request is directed. This allows you to protect CICS systems that do not support your external security manager. It also allows for a level of consolidation of your security checking.

Determine where CICS resource and command checking is in effect, and decide whether it needs to be retained along with other CICSpex SM security checking.

Defining time zones

Much of the activity of CICSpex SM is time dependent.

For example, you can specify that a monitor definition or an analysis definition is to be active during a particular time period. CICSpex SM does not require every MAS in a single CICSpex to be running in the same time zone, and so must be able to accommodate any time-zone differences between entities. Therefore:

- Whenever you create a time-period definition (using the CICSpex SM Time period definitions view), you must specify a time zone in the definition. For example, you could create a time-period definition called "MORNING" for the hours 0800 through 1159 Eastern standard time.
- You must specify a time zone for each CMAS in its data-repository initialization job, EYU9XDUT. A permanent change to the CMAS time-zone value can be made, even while the CMAS is running, via the CICSpex SM Web User Interface.
- A time zone must be established for each managed CICS system. When you define a CICS system to CICSpex SM, you can specify the time zone in which the system is running. Alternatively, if you don't specify a time zone in the CICS system definition, the CICS system is assumed to be running in the time zone that is the default for the CMAS to which it connects. You are recommended to allow the time zone of a managed CICS system to default to that of its CMAS. The time zone of a managed CICS system can be altered subsequently while the CICS system is running. Any change made in this way lasts for the lifetime of the CICS system, or until it is next changed, whichever is sooner.
- A time zone must be specified for every CICSpex when it is first defined. This time zone is used by the CICSpex SM monitor function to determine the actual time at which the monitor interval for the CICSpex expires. The CICSpex time zone can be altered via the CICSpex SM end-user interface.

Time zones are specified using single-character codes in the range B through Z. For example, code "S" represents Mountain Standard Time, code "T" represents Central Standard Time, and code "C" represents Eastern Europe time. For a complete list of the codes, see Time zone setting in a period definition.

CICSpex SM allows offsets (known as "time zone adjustments") in the range 0 through 59 minutes to be specified to accommodate regions that are not running in the standard time zones. Also, daylight saving time can be specified.

Because multiple CICSpex SM entities require a time zone to be specified, there is obvious potential for conflicting time-zones to be specified. For example, it is quite possible that a CMAS and a MAS in the same CICSpex could be in different time zones. CICSpex SM always honors the time zone of the MAS. For example, if:
• The time-period definition time zone is S
and
• The CMAS time zone is B
and
• The MAS time zone is C
time zone C is used by the MAS, and the CMAS makes any necessary adjustments between time zones B, C, and S to ensure that the time zone is honored.

Reuse of CICSPlex SM object definitions
CICS does not provide identical support for resources and functions across all of its platforms or releases.

For example, a resource, such as FEPI, that is supported in the CICS TS environment might not be supported on other platforms. Similarly, the amount or type of data available for a resource can vary among CICS platforms and releases. These variations in support pose a special challenge to CICSPlex SM, which offers a SSI of multiple and varied CICS systems.

Here are some examples that illustrate how CICSPlex SM handles variations in support for resources and functions throughout a CICSpex that includes CICS TS.systems.

• Example 1: monitoring of transient data queues
You create a monitor definition for transient data queues, add it to a monitor group, and associate the monitor group with a monitor specification. The scope of the monitor specification is every CICS system in the CICSpex. As each CICS system starts, CICSPlex SM determines whether it can install the monitor definition in that system. If not, CICSPlex SM issues a message to inform you that the monitor definition could not be installed. Both the monitor function and transient data queue resources are supported under CICS TS, so CICSPlex SM installs the monitor definition in those environments and monitoring begins.

• Example 2: RTA of monitored programs
You create an evaluation definition and name MPROGRAM (monitored programs) as the resource to be evaluated by the CICSPlex SM RTA function. The evaluation definition is named in an analysis definition, which is linked, via an analysis group, to an analysis specification. The scope of the analysis specification is every CICS system in the CICSpex. The analysis definition is installed in the CICS TS systems. If an analysis definition names multiple evaluation definitions, CICSPlex SM installs those that are supported in the target environment.

In summary, if you request a function that isn’t available in a particular CICS environment, CICSPlex SM issues a warning message. You do not have to respond to the message and, more importantly, you do not have to take variations in support into account when creating CICSPlex SM object definitions: you should always consider CICSPlex SM object definitions to be reusable.

Defining the CICSPlex SM configuration and topology
Once CICSPlex SM has been installed, and you have a map of your CICSPlex SM environment, you can define the configuration and topology.

Defining the CMAS configuration
For each CMAS you have defined, you must provide certain information to CICSPlex SM.

The following information must be provided:
• The name of each CICSpex that it is to manage, if it is a maintenance-point CMAS
• Link definitions for each CMAS to which it is connected
To enter this information, you can use the appropriate **CMAS configuration administration** views, accessed from the **CMAS configuration administration** menu, or the batched repository-update facility.

**Managing the CMAS configuration**
The following WUI view sets and related objects are used to manage your CMAS configuration:

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batched repository-update requests</td>
<td>BATCHREP</td>
<td>To create, update, remove, list, or dump one or more definitions from the data repository associated with the local CMAS.</td>
</tr>
<tr>
<td>CMAS to CMAS link definitions</td>
<td>CMTCMDEF</td>
<td>To display information about the direct LU6.2 and MRO communication links between the local CMAS and any other CMASs.</td>
</tr>
<tr>
<td>CICSPlex definitions</td>
<td>CPLEXDEF</td>
<td>To define a CICSPlex to the local CMAS and to administer CICSPlex definitions for the local CMAS.</td>
</tr>
<tr>
<td>CMAS in CICSPlex definitions</td>
<td>CPLXCMAS</td>
<td>To administer information about CMASs associated with a CICSPlex, where the local CMAS is the maintenance point for that CICSPlex.</td>
</tr>
</tbody>
</table>

CICSPlex SM also provides the following WUI view sets and resource objects that you can use to manage CMAS configuration definitions when the associated CMASs are active.

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMASs managing CICSPlex</td>
<td>CICSPLEX</td>
<td>To display information about the CMASs associated with a CICSPlex known to the local CMAS.</td>
</tr>
<tr>
<td>CMASs known to local CMAS</td>
<td>CMAS</td>
<td>To display information about CMASs known to the local CMAS, shut down a CMAS, and alter CMAS component trace settings.</td>
</tr>
<tr>
<td>CICSPlexes managed by CMAS</td>
<td>CMASPLEX</td>
<td>To display information about the CICSPlexes being managed by the local CMAS and to remove the CMAS from managing CICSPlexes when the MPSTATE is INVALID or NOTCONNECTED.</td>
</tr>
<tr>
<td>CMAS to CMAS links</td>
<td>CMTCMLNK</td>
<td>To display information about all or specific CMASs linked to the local CMAS and to discard a CMAS-to-CMAS link.</td>
</tr>
<tr>
<td>CMAS to MAS links</td>
<td>CMTPMLNK</td>
<td>To display information about all or specific MASs linked to the local CMAS and to discard the CMAS-to-MAS link.</td>
</tr>
</tbody>
</table>

**Defining CICSPlex topology**
When you have identified your CICSPlexes and MASs, you need to create the definition objects that will identify them to CICSPlex SM. You should be aware that you will not have all the information required at this point; more information will emerge as the design of your CICSPlex SM system proceeds.

More information about designing CICSPlexes is given in “Designing your CICSPlexes” on page 20.
Preparing CICSpux definitions
Each CICSpux must be defined to CICSpux SM by a name that is unique within the enterprise.

Naming conventions are given in “Naming your CICSpux SM entities” on page 33. You also should be aware that you will need other information for the CICSpux definition, which will become available as you proceed with the design of your CICSpux SM system. This information includes:

- The name of the CMAS to which the CICSpux is to be defined. (This is the maintenance point CMAS for the CICSpux.)
- The names of any other CMASs that are to participate in management of the CICSpux.
- A time zone for the CICSpux SM monitor function.
- Whether CICS command checking is to be simulated.
- Whether CICS resource checking is to be simulated.

Managing the CICSpux definitions
You identify a CICSpux identified to CICSpux SM with the CICSpux definitions view (CPLEXDEF object).

To enter this information, you can use either the appropriate CMAS configuration administration views, accessed from the CMAS configuration administration menu, or the batched repository-update facility.

When you have created a CICSpux definition, you can associate CICS systems (MASs) and CICS system groups with the CICSpux. See “Planning CICSpux system definitions” on page 39.

Planning CICSpux system definitions
To manage a CICS region with CICSpux SM, you must associate the CICS region with a CICSpux that is defined to CICSpux SM. The definition that establishes this association also contains information about how the CICS system is to use the BAS, WLM, RTA, and monitoring components of CICSpux SM.

About this task
For every CICS region that is to be managed by CICSpux SM, you must gather the following information:

Procedure
1. Gather the basic information about your CICS region to create a definition.
   a) Decide the name by which this CICS region is to be known to CICSpux SM.
      This name can be up to 8 characters in length.
   b) Find the APPLID, that is, the z/OS Communications Server application identifier of the CICS region.
   c) Find the SYSID, that is, the CICS system identifier of the CICS region.
      This information is sufficient to add the definition to the data repository. If you have special BAS, WLM, RTA, or monitoring requirements for any CICS region, you can gather the information before adding the definition or update the definition later.
2. Optional: Gather additional information about your CICS region for the definition.
   a) If you are implementing system availability monitoring (SAM), find the name of the primary CMAS and the hours of operation of the CICS region.
      The primary CMAS is the CMAS that the CICS region usually connects to.
   b) Decide whether or not to simulate CICS command checking.
   c) Decide whether or not to simulate CICS resource checking.
   d) Decide what types of connections are required to other CICS regions and how many sessions to allow on each connection.
      If you want to create IP interconnectivity (IPIC) connections, you must also the port number, the host name, and network ID of the CICS region.
   e) Decide what time zone of the CICS region is to use, if it is not to be the same as that of its CMAS.
What to do next
When you have gathered the information necessary to create a system definition, you can use the CICS Explorer or the Topology administration views in the Web User Interface to create the definition in the data repository.

Preparing CICS system group definitions
For each CICS system group to be defined to CICSPlex SM, you need provide only a name for the group, which may be unique within the CICSPlex.

The CICS system group must be defined before you can add CICS systems to it. To define a CICS system group, you use the Topology administration (ADMTOPOL) views.

Defining CICS system groups, perhaps more than any other part of the design stage, is an iterative process and a cumulative one. It might be obvious to you already that there are natural groupings of CICS systems within your CICSPlexes, and that you will want to manipulate each of those groups as a single entity. If this is the case, start to document the groups now. Because groups do not have to be mutually exclusive, and because a CICS system can belong to any number of groups, you can add CICS system group definitions as new requirements emerge.

To create CICS system groups, you use the System group definitions view (CSYSGRP object).

You can display information about the CICS system groups, and the CICS systems associated with them, that are known to the CICSPlex identified as the current context, by using the System group definitions view (CSYSGRP object).

CICS system definition views
The Web User Interface provides a number of views to help you define, install, and manage CICS system definitions. You can also use the CICS Explorer to perform the same tasks.

These views are described in detail in CPSM administration views.

Table 4. View sets to manage CICS system definitions

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISC/MRO connection definitions</td>
<td>CONNDEF</td>
<td>To create and administer connection definitions that identify remote systems that a CICS region communicates with using intersystem communication (ISC) or multiple region operation (MRO).</td>
</tr>
<tr>
<td>CICS system definitions</td>
<td>CSYSDEF</td>
<td>To create and administer the definition that associates a CICS system with a CICSPlex. The definition also contains information about how the CICS system is to use the WLM, real-time analysis, resource monitoring, and business application services components of CICSPlex SM.</td>
</tr>
<tr>
<td>System group definitions</td>
<td>CSYSGRP</td>
<td>To create and administer CICS system groups within a CICSPlex, including adding CICS regions to CICS system groups.</td>
</tr>
<tr>
<td>IPIC connection definitions</td>
<td>IPCONDEF</td>
<td>To create and administer TCP/IP connection definitions that describe the outbound attributes of connections between CICS regions that communicate using IP interconnectivity (IPIC) connections.</td>
</tr>
<tr>
<td>Time period definitions</td>
<td>PERIODEF</td>
<td>To create and administer time period definitions, which identify specific ranges of hours and minutes to be used with resource monitoring and real-time analysis.</td>
</tr>
</tbody>
</table>
Table 4. View sets to manage CICS system definitions (continued)

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session definitions</td>
<td>SESSDEF</td>
<td>To create and administer session definitions that describe the nature of logical connections between regions that communicate using intersystem communication (ISC) or multiple region operation (MRO).</td>
</tr>
<tr>
<td>CICS system links</td>
<td>SYSLINK</td>
<td>To create and administer the links between CICS regions in the CICSPlex.</td>
</tr>
<tr>
<td>TCP/IP service definitions</td>
<td>TCPIPS</td>
<td>To create and administer TCP/IP connection definitions that describe the inbound attributes of connections between CICS regions.</td>
</tr>
</tbody>
</table>

CICSPlex SM provides the **Runtime MAS display** (MAS) view set that you can use to manage configuration definitions when the associated CICS regions are active.

Table 5. View set to manage configuration definitions in an active CICS region

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Runtime MAS display</td>
<td>MAS</td>
<td>To manage information about active CICS regions known to a CICSPlex or connected to the designated CMAS involved in managing the CICSPlex.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Display information about the active CICS regions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Browse or temporarily update the general, WLM, real-time analysis, resource monitoring, and MAS trace attributes of an active CICS region.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Stop MAS agent code in an active CICS region.</td>
</tr>
</tbody>
</table>

**Note:** Using the **CICS system definitions** view (CSYSDEF object) and the **Time period definitions** view (PERIODEF object) to update definitions affects both a currently running system and the definitions in the data repository. Updates made using the **Runtime MAS display** view (MAS object), however, are not included in the data repository.

**Where next?**
You have a working CICSPlex SM environment, with your configuration and topology defined, and with the links between the entities defined.

The entities can communicate with each other and you can run transactions. However, to optimize the operation of your enterprise and to take full advantage of the facilities offered by CICSPlex SM, you need to set up your BAS, WLM, RTA, and monitoring requirements. For guidance, go to Managing resources using Business Application Services (BAS), Managing workloads, Monitoring using real-time analysis (RTA), or Collecting statistics using CICSPlex SM monitoring, as appropriate.

### Setting up a CICSPlex SM address space (CMAS)

Perform these steps to make a CICSPlex SM address space (CMAS) operational.

For a summary of the CMAS setup tasks that you use while performing them, see CICSPlex SM setup checklist and worksheets.
Before you set up a CMAS

Check your initialization values, changes between releases, release level compatibility and maintenance you might need to apply to your system.

Check the considerations for setting up CMAS, described in “Designing your CICSPlex SM environment” on page 19.

Check the IEASYSxx member of SYS1.PARMLIB that you use for MVS initialization and make note of the initialization values that are referenced during installation. For details about the initialization values, see Noting IEASYSxx values for CICSPlex SM.

If you are converting your CICSPlex SM system or systems from a previous release to CICSPlex SM for CICS TS for z/OS, Version 5.5, read the upgrading information for your level of CICSPlex SM.

A CICSPlex SM CMAS runs only in a CICS system at the same release level. For example, a CICS TS 5.5 CMAS runs only in a CICS TS 5.5 region. During startup, the CMAS checks the CICS release level and ends with message EYUXL0142 if the releases do not match. Managed CICS systems do not have the same restriction.

For details about applying corrective or preventive maintenance to CICSPlex SM, see .

Note the information in CICSPlex SM address space (CMAS) about appropriate uses of a CMAS.

CICSPlex SM auxiliary storage usage

When a CMAS is initialized, a number of MVS data spaces are created.

CICSPlex SM uses these data spaces to allow quick access to data from a CMAS and the MASs attached to it. Although the data spaces are logically owned by the CMAS, they are physically owned by the ESSS address space (EYUX550). The data spaces are deleted when the CMAS that logically owns the data spaces, and all local MASs, and batch jobs, that are attached to that CMAS are stopped. The data spaces are re-created when the CMAS is initialized again.

The number of data spaces created depends on the CACHEDSNUM value for the CMAS. This setting controls the number of data spaces allocated for each component, except the data cache manager, which has only one data space. Therefore, the number of SCOPE=ALL data spaces required for a CMAS can be calculated as follows:

number of SCOPE=ALL data spaces = ( 9 * CACHEDSNUM ) + 1

The default value of the CACHEDSNUM parameter is 2, and normally you do not change it unless advised to do so by IBM Support. Therefore, each CMAS typically requires 19 SCOPE=ALL data spaces.

The size of the data spaces depends on the amount of work (such as end-user interface, workload management, MAS resource monitoring, and real-time analysis processing) that the CMAS is performing, and the number of MASs connected to the CMAS. The size ranges from 20 MB of storage in a relatively idle CICSPlex SM configuration to well over 100 MB of storage in a configuration that is complex in both the number of MASs and the amount of work requested. If you do not prepare for such an increase in storage usage, you might encounter auxiliary storage shortages when you first start to use CICSPlex SM.

To avoid such auxiliary storage shortages, ensure that your auxiliary storage can handle an increase of 100 MB of storage in the environment. Additionally, you can monitor the CICSPlex SM data space use by using an external monitor package to determine the amount of storage the EYUX550 job uses.

If you contact IBM support personnel because of auxiliary storage shortages, you might be asked to use CICSPlex SM online debugging transactions (COD0 and CODB) to evaluate the storage use of EYUX550. For information about the COD0 and CODB transactions, see Using the interactive debugging transactions (COD0 and CODB).

If auxiliary storage shortages do occur, you can alleviate the problem by either dynamically increasing your auxiliary storage capability, or causing CICSPlex SM to free the allocated data spaces:

1. To dynamically increase auxiliary storage capacity, allocate an additional page data set, then use the MVS console command PAGEADD to make the new page data set available.
2. To cause CICSPlex SM to free the allocated data spaces, first stop the CICSPlex SM agent in all local MASs connected to the CMAS. To stop the agent, use the COSH transaction for each MAS or, if the MAS is a WUI server, use the COVC and COSH transactions.

If a local MAS is acting as a CICSPlex SM WLM TOR, and the DTR program is specified as EYU9XLOP for that MAS, you must change the DTR program from EYU9XLOP before you can use the COSH transaction against that MAS. For example, you can change it to the IBM default program DFHDYP.

3. After the CICSPlex SM agent is stopped in all local MASs, stop the CMAS itself using the COSD transaction.

4. After the auxiliary storage capability is increased, you can restart the CMAS. To reconnect any local MASs that remained active after the CICSPlex SM agent was stopped, run the COLM transaction in those CICS regions.

You can run COLM using a modify command from the CONSOLE.

### Preparing to transmit generic alerts to IBM Tivoli NetView

You can have the real-time analysis (RTA) component of CICSPlex SM transmit generic alerts to an IBM Tivoli® NetView system when one or more user-defined conditions occur during analysis.

To be sure that an IBM Tivoli NetView system is ready to receive the alerts, use the NPDA command:

| DFILTER AREC |

This command verifies that the Event Type record IMPD is being passed to the IBM Tivoli NetView database in the IBM Tivoli NetView system.

The resulting list shows an ACTION of PASS for ETYPES of IMPD and RSLV.

If you need to add these record types to the filter, you can issue the following NPDA commands:

| SRFILTER AREC PASS E IMPD  
| SRFILTER AREC PASS E RSLV |

If the name of the IBM Tivoli NetView Alert Receiver has been changed from the default value (NETVALRT), you can use the CICSPlex SM system parameter ALERTRCVR to specify the required name. See “CICSPlex SM system parameters” on page 117 for details of the ALERTRCVR parameter.

### Preparing to start a CMAS

You can start a CICSPlex SM address space (CMAS) during the IPL of an MVS system, from the system console, or as a batch job.

- **To start a CMAS during the IPL of an MVS system**, complete the following steps:
  - Verify that the CMAS startup procedure is in a system procedure library, such as SYS1.PROCLIB.
  - Verify that the CMAS startup procedure is in the 'Started Tasks' table of the external security manager (ESM).
  - Change the COMMNDaa member that is referenced by the IEASYSxx member of SYS1.PARMLIB, as described in Noting IEASYSxx values for CICSPlex SM, to include a START command for the CMAS. The START command to be included is described in “START command for a CMAS” on page 58.

- **To start a CMAS from the system console**, complete the following steps:
  - Verify that the CMAS startup procedure is in a system procedure library, such as SYS1.PROCLIB.
  - Verify that the CMAS startup procedure is in the 'Started Tasks' table of the external security manager (ESM).
  - Have the operator issue the START command described in “START command for a CMAS” on page 58.

- **To start a CMAS as a batch job**, complete the following steps:
  - Verify that the CMAS startup procedure is in a system procedure library, such as SYS1.PROCLIB.
- Construct a job stream to invoke the CMAS procedure.
- Submit the job to invoke a CMAS.

Whichever method you use to start a CMAS, you must verify that the procedure references the appropriate parameters:

- CICS SIT parameters, as described in “CMAS-related CICS system initialization parameters” on page 52.
- CICSPlex SM startup parameters, as described in “CICSPlex SM system parameters” on page 117.

The purpose of the CMAS is to manage a CICSPlex SM managed application system (MAS), so it is important that the CMAS runs at a higher dispatching priority than any MAS in the sysplex. The CMAS communicates with other CMASs that it is connected to; these CMASs need to run at an equal dispatching priority, so that a CMAS on one LPAR does not process and send information out faster than other CMASs that need to receive that data. Therefore, define the CMAS jobs to the MVS service class SYSSTC. Failure to do so can result in severe performance problems for CICSPlex SM.

After you start a CMAS for the first time, you must configure the CMAS to your environment. This configuration includes establishing the CICSPlexes that the CMAS is to manage, and any communication links that are required between this CMAS and another CMAS.

A sample procedure that you can use to start a CMAS is supplied in the EYUCMASP member. This member was generated when you ran the DFHISTAR job. The member is stored in the library that you specified on the LIB parameter of the DFHISTAR job.

You must create the data sets for this CICS region. JCL to create the CICS region data sets for the CMAS is supplied in the EYUCMSDS member of CICSTS55.CPSM.XDFHINST. This member was generated when you ran the DFHISTAR job.

Figure 14 on page 44 illustrates segments of the EYUCMASP procedure that highlight the additional CICSPlex SM requirements.

```plaintext
//EYUCMASP PROC DSN=CICSTS55.CPSM.CMAS01.DFHCS, CSD Data Set name
//             DSNTBL=CICSTS55.CPSM.RGNLOAD, CICS Table Module library
//             RGNHLQ=CICSTS55.CPSM.CMAS01,              CICS Region DSN qualifier
//             CICSHLQ=CICSTS55.CICS
//             CPSMHLQ=CICSTS55.CPSM
//             ACTHLQ=CICSTS55.CICS
//             PRMLIB=CICSTS55.XDFHINST
//             ACTIVATE=SDFHIC,
//             CICSPRM=EYUCMSSP,                CICS Parameters
//             CPSMPRM=EYUCMS0P,                CPSM Parameters
//CICS    EXEC PGM=EYU9XECS,               CMAS Startup program
//             PARM='SYSIN',               CICS Parameters location
//             REGION=0K                   Region Size
//*
//STEPLIB  DD DISP=SHR,DSN=&CPSMHLQ..SEYUAUTH
// DD DISP=SHR,DSN=&CICSHLQ..SEYAUTH
// DD DISP=SHR,DSN=&ACTHLQ..DFHAUTH
// DD DISP=SHR,DSN=&ACTHLQ..SDFHIC
//DDHRPL DD DISP=SHR,DSN=&CPSMHLQ..SEYULOAD
// DD DISP=SHR,DSN=&CICSHLQ..SDFHLOAD
//SYSIN    DD DISP=SHR,DSN=&PRMLIB,(&CICSPRM)
//*
//EYULOG   DD SYSOUT=*
//*
//EYUDREP  DD DISP=SHR,DSN=CICSTS55.CPSM.EYUDREP.cmasname
//EYPARM   DD DISP=SHR,DSN=&PRMLIB(&CPSMPRM)
```

*Figure 14. CMAS-specific JCL requirements*

Review the following statements in the sample JCL that are illustrated in Figure 14 on page 44. Verify that the JCL has been modified as follows:

**EXEC PGM=EYU9XECS statement**

Starts the CMAS and either verifies the existence of, or creates, the ESSS. EYU9XECS, the CMAS startup program, must be run so that the CMAS initializes.
**STEPLIB DD statement**
Includes the CICSTS55.CPSM.SEYUAUTH authorized load library, and the mandatory SDFHLIC license file.

**DFHRPL DD statement**
Includes the CICSTS55.CPSM.SEYULOLOAD load library. Include the load library that contains the CICS resource definition table load modules. These must be link-edited into a user-supplied load library, which you specify in the DFHRPL concatenation.

Do not include application load libraries in the DFHRPL concatenation.

**SYSIN DD statement**
Identifies the library member that contains the CICS system initialization override parameters.

**EYULOG DD statement**
Identifies the log to which messages from the CMAS and its associated managed application systems (MASs) are to be directed.

When you are using a sequential data set for the EYULOG, allocate three primary cylinders and one secondary cylinder.

**EYUDREP DD statement**
Identifies the library to be used as the data repository by the CMAS, where cmasname is the name you specified for the CMASNAME parameter on the DFHISTAR job. The CMASNAME value is used by EYU9XDUT to create the CICSPlex SM data repository.

**EYUPARM DD statement**
Identifies the library that contains the CICSPlex SM system parameters.

---

**Creating and managing the CICSPlex SM data repository**
Use the EYUCMSDS postinstallation job to create the CICSPlex SM data sets. The EYUCMSDS job is generated when you run the DFHISTAR job.

CICSPlex SM postinstallation members describes how to create a simple CICSPlex SM configuration. The EYUCMSDS job is stored in the library that you specified on the LIB parameter of the DFHISTAR job.

The alternate data repository file definition, EYUDREPN, is used by the CMAS in situations where logging are not needed. The current functions that bypass logging are importing or adding a CICSplex, and removing or deleting a CICSplex. In these situations, no backout is necessary, therefore no logging is required. Do not modify the recovery attributes of the EYUDREPN file definition.

The EYUDREP file definition is created dynamically during PLTPI by EYU9XLCD in the CMAS and specifies attribute LSRPOOLID(1). The CMAS does not create LSRPOOL 1, and if it does not exist, CICS file control DFHFCL calculates the size of LSRPOOL 1 and dynamically creates it when the EYUDREP is first opened in the CMAS. You can choose instead to define your own specifications for LSRPOOL 1 in the DFHCSD. If you choose to define your own LSRPOOL 1, monitor LSRPOOL 1 usage statistics to ensure adequate performance for the CMAS.

**Creating the CICSPlex SM data repository**
The CMAS-related data set is the data repository. Each CMAS must have a unique data repository associated with it. The data repository contains the CICSPlex SM administration definitions applicable to its associated CMAS.

The data repository is a critical component of CICSPlex SM system management. You must take regular backups that are associated with each CMAS in your environment.

The data repository is defined to CICS as being a recoverable file that participates in SYNCPOINT and SYNCPOINT ROLLBACK operations. The CMAS must have a CICS system log so that these operations work correctly. Therefore, do not run a CMAS with a system log that is defined as type DUMMY because you will compromise data integrity on the CICSPlex SM data repository.

To create the data set that contains the data repository, you can use the EYUCMSDS postinstallation job.

If you are running multiple CMASs in the same MVS image, you must create a data repository for each CMAS. You can edit and resubmit the DFHISTAR job, which generates the EYUCMSDS postinstallation job.
To ensure that you do not overwrite your existing customized jobs, you can use the SELECT parameter, as described in “Setting up a CICSPlex SM address space (CMAS)” on page 41. Alternatively, if you prefer not to resubmit DFHISTAR, you can edit the EYUCMSDS job, giving the SYSIDNT and CMASNAME parameters unique names each time you run the job.

**Note:** If you run the DREP CNVT step to upgrade an existing CMAS DREP to the latest version, use the DREP dataset itself as input and not a copy of it. Otherwise, CMAS isolation issues might occur when the CMAS is restarted.

The EYUCMSDS job includes the following steps that relate to creating the data repository:

**DELDREP**
This step deletes the data repository set. It allows you to resubmit the job.

**DEFDREP**
This step allocates the VSAM KSDS cluster for the data repository data set:

```
dsindex.EYUDREP.cmasname
```

- **dsindex**
  Is defined by the DSINFO parameter of the DFHISTAR job.
- **cmasname**
  Is defined by the CMASNAME parameter of the DFHISTAR job.

CICSPlex SM does not support VSAM records that span control intervals. Make sure that the IDCAMS job that you use to create a CICSPlex SM data repository does not specify the SPANNED parameter. Accept the IDCAMS default of nonspanned records.

**DREPINIT**
This step is used to set up the data repository for a CICS TS for z/OS, Version 5.5 CMAS.

The DREPINIT step is generated in the EYUCMSDS job if you did not specify a value with the OLDDREP parameter when you ran the DFHISTAR job. This step runs EYU9XDUT to initialize the new data repository that was allocated by step DREPALOC. The new data repository does not contain any records from a previous version of CICSPlex SM. The EYU9XDUT utility uses the following parameters for step DREPINIT:

- **CMASNAME=xxxxxxxx**
  - You cannot change this name after the data repository is initialized.
  - This name must be unique in the CICSPlex SM environment. Do not use the same name as that of another CMAS, a CICSpex, a CICS system, or a CICS system group.
  - Position 1 must be alphabetic or national, and cannot be numeric.
  - Positions 2 through 8 can be alphabetic, national, or numeric.

- **SYSID=xxxx**
  - You cannot change this identifier after the data repository is initialized.
  - This value must match the SYSIDNT (SIT parameter) for the CMAS; see “CMAS-related CICS system initialization parameters” on page 52.
  - This value must not be the same as the SYSID for any other CMAS or CICS system that is defined to CICSPlex SM.
  - Positions 1 through 4 can be alphabetic, national, or numeric.

- **TIMEZONE=x**
  - x must be a single alphabetic character (B through Z), representing one of the Greenwich time zone codes.

- **ZONEOFFSET=nn**
  - nn must be a two-digit numeric value (00 through 59), representing an adjustment (offset) to the TIMEZONE.
DAYLIGHT=x
   x must be a single character (Y or N), representing daylight saving time.

The DREPINIT step requires a DD statement for EYUXDPRM, which sets up the WUI parameters:

WUI=YES|NO
   The default of WUI=YES creates the CICSPlex SM resource definitions required to start a WUI
   server and its CICSPlex. This parameter allows you to create the resource definitions required to
   start a WUI server and its CICSPlex when you create the data repository. To add a WUI to an
   existing system, use the EYU9XDBT or BATCHREP utilities.

WUIAPPLID=xxxxxxxx
   xxxxxxxxxx must be alphabetic, national, or numeric characters, specifying the APPLID allocated
   to a WUI. The first character must be alphabetic or national. This parameter is mandatory if
   WUI=YES is specified.

WUINAME=xxxxxxxx
   xxxxxxxxxx must be alphabetic, national, or numeric characters, specifying the name allocated to a
   WUI. The first character must be alphabetic or national. If WUINAME is not specified, it takes the
   value specified for WUIAPPLID.

WUIPLEX=xxxxxxxx
   xxxxxxxxxx must be alphabetic, national, or numeric characters, specifying the name allocated to a
   WUI CICSPlex. The first character must be alphabetic or national. The default is created from the
   characters WUIP, followed by the CMSSYSID. For example, using the default CMSSYSID, CM01,
   the default WUIPLEX name is WUIPCM01.

WUISYSID=xxxx
   xxxx must be alphabetic, national, or numeric characters, specifying the name allocated to a WUI
   system identifier. The first character must be alphabetic or national. This parameter is mandatory
   if WUI=YES is specified.

DREPCNVT
   This step is generated if you specified the name of an existing data repository on the OLDDREP
   parameter. This step runs EYU9XDUT to convert existing data repository records from a previous
   release of CICSPlex SM for use by CICSPlex SM for CICS TS for z/OS, Version 5.5.
   
   **Note:** If you run the DREPCNVT step to upgrade an existing CMAS DREP to the latest version, use
   the DREP dataset itself as input and not a copy of it. Otherwise, CMAS isolation issues might occur
   when the CMAS is restarted.

   All the records from the input data repository specified on the OLDDREP parameter are added to the
   new data repository that was allocated by step DREPALOC. The input data repository is not
   modified.

   The EYU9XDUT utility uses the following parameter for step DREPCNVT:

   TARGETVER=0550
   0550 represents the version of the new output data repository.

   **Note:** The EYU9XDUT utility is also used to back out a data repository. For details, see [Upgrading
   CICSPlex SM](#).

Populating the CICSPlex SM data repository

You can use the CICSPlex SM-supplied extract routine EYU9BCSD to generate CICSPlex SM resource
definition records for each CSD record identified in your input file.

The output from EYU9BCSD is used to populate the data repository.

CMAS-related CICS system initialization parameters

The EYUCMSSP member is supplied, uncustomized, in TDFHINST and, customized by DFHISTAR, in
XDFHINST. This contains the CICS system initialization parameters for a CMAS.

Table 6 on page 48 identifies the CMAS-related CICS system initialization parameters and their default
settings.
1. When the second column in the table contains an asterisk, before you start a CMAS supply your own value for the parameter listed in the first column.
2. When the second column of the table does not contain an asterisk, do not change the value of the parameter in the first column.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Your value</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIEXIT=DFHZATDX</td>
<td></td>
<td>z/OS Communications Server terminal autoinstall program.</td>
</tr>
<tr>
<td>APPLID=</td>
<td>*</td>
<td>z/OS Communications Server application ID for this CICS, which is acting as</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a CMAS. Used as CMAS name when NAME(value) is not specified as a CICSPlex SM</td>
</tr>
<tr>
<td>AUXTR=ON</td>
<td></td>
<td>Auxiliary trace - exception records.</td>
</tr>
<tr>
<td>AUTORESETTIME=YES</td>
<td></td>
<td>Time-of-day synchronization.</td>
</tr>
<tr>
<td>AUXTRSW=NEXT</td>
<td></td>
<td>No continuous auxiliary trace switching.</td>
</tr>
<tr>
<td>CICSSVC=216</td>
<td>*</td>
<td>CICS SVC installed in LPA.</td>
</tr>
<tr>
<td>CPSMCONN=CMAS</td>
<td></td>
<td>Initialize this region as a CMAS.</td>
</tr>
<tr>
<td>CSDACC=READWRITE</td>
<td></td>
<td>Enable read and write updates to CSD.</td>
</tr>
<tr>
<td>CSDRECOV=ALL</td>
<td></td>
<td>CSD forward recovery and backout.</td>
</tr>
<tr>
<td>DFLTUSER=CICSUSER</td>
<td>*</td>
<td>Non-CESN RACF user ID.</td>
</tr>
<tr>
<td>DSALIM=5M</td>
<td></td>
<td>Limit of DSA storage below 16 MB. 5 MB is a minimum initial value.</td>
</tr>
<tr>
<td>DUMPDS=A</td>
<td>*</td>
<td>Transaction dump data set.</td>
</tr>
<tr>
<td>DUMPSW=NEXT</td>
<td>*</td>
<td>Switch to next transaction dump data set.</td>
</tr>
<tr>
<td>EDSALIM=800M</td>
<td></td>
<td>Limit of EDSA storage above 16 MB but below 2 GB. See &quot;Controlling CICS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>storage in a CMAS&quot; on page 57 for additional information.</td>
</tr>
<tr>
<td>FCT=NO</td>
<td></td>
<td>No file control table.</td>
</tr>
<tr>
<td>GMTTEXT='CICSPlex System</td>
<td>*</td>
<td>Default logon message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manager CICS Transaction Server for z/OS’</td>
</tr>
<tr>
<td>GRPLIST=DFHLIST</td>
<td></td>
<td>CICS group list. See Overriding the dynamically created CICS resource</td>
</tr>
<tr>
<td></td>
<td></td>
<td>definitions for CICSPlex SM for additional information.</td>
</tr>
<tr>
<td>ICV=100</td>
<td></td>
<td>Region exit interval.</td>
</tr>
<tr>
<td>ICVR=20000</td>
<td></td>
<td>Runaway task interval. For a CMAS running on a small processor and having a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>large number of resources defined through BAS, this value can be increased</td>
</tr>
<tr>
<td></td>
<td></td>
<td>to about 90000.</td>
</tr>
<tr>
<td>ICVTSD=0</td>
<td></td>
<td>Terminal scan delay interval.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Your value</td>
<td>Explanation</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>INTTR=ON</td>
<td></td>
<td>Activate main storage trace.</td>
</tr>
<tr>
<td>IRCSTRT=YES</td>
<td></td>
<td>IRC started at system initialization.</td>
</tr>
<tr>
<td>ISC=YES</td>
<td></td>
<td>Load programs required for interregion or intersystem communications during initialization.</td>
</tr>
<tr>
<td>MXT=500</td>
<td></td>
<td>Maximum tasks to exist. See “Controlling CICS storage in a CMAS” on page 57 for additional information.</td>
</tr>
<tr>
<td>PSTYPE=NOPS</td>
<td></td>
<td>No persistent sessions for CMAS</td>
</tr>
<tr>
<td>RENTPGM=PROTECT</td>
<td></td>
<td>Specifies that CICS allocates ERDSA from readonly key 0 protected storage.</td>
</tr>
<tr>
<td>SEC=NO</td>
<td>*</td>
<td>Indicates whether CICS external security checking is performed for this CMAS. The CICS security checking is independent of the CICSPlex SM external security checking, which is controlled with the CICSPlex SM SEC system parameter, as specified in the EYUPARM DD. For information about the SEC CICSPlex SM system parameter for CMAS, see “CICSPlex SM system parameters” on page 117. You can specify the CICS external security checking system initialization parameter in the normal way, with the other CICS security related options; for example, XTRAN and XCMD. CICS command or resource security is not appropriate in a CMAS. The XTRAN system initialization parameter is typically used to control access to the various CICSPlex SM transactions used in a CMAS. No CICSPlex SM supplied transaction definitions have CMDSEC=YES or RESSEC=YES. If this definition is changed, or the CMDSEC=ALWAYS or RESSEC=ALWAYS system initialization parameters are set in a CMAS, and a CICSPlex SM transaction receives a NOTAUTH response, results are unpredictable.</td>
</tr>
<tr>
<td>SIT=6$</td>
<td></td>
<td>System initialization table suffix.</td>
</tr>
<tr>
<td>SPOOL=YES</td>
<td></td>
<td>System spooling interface. Required when you are going to use the CICSPlex SM batched repository-update facility.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Your value</td>
<td>Explanation</td>
</tr>
<tr>
<td>---------------</td>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>START=AUTO</td>
<td></td>
<td>You can normally specify START=AUTO and let CICS initialization decide the type of start to perform. The first time that you start a CMAS, ensure the CICS global and local catalog data sets are newly initialized. Use DFHRMUTL and DFHCCUTL respectively, with AUTOINIT on the SET_AUTO_START parameter of DFHRMUTL, to make sure that the CMAS performs an initial start, which installs the necessary CICS resource definitions and establishes CMAS-to-CMAS connections. Subsequently, you can change the type of start for a CMAS by resetting the global catalog data set, using DFHRMUTL to specify either AUTOINT or AUTOCOLD. For more information, see “Restarting a CMAS” on page 62.</td>
</tr>
<tr>
<td>SYSIDNT=</td>
<td>*</td>
<td>CICS System ID. The SYSIDNT value must match the EYU9XDUT SYSID parameter value used to initialize the data repository that is being referenced by the EYUDREP DD statement.</td>
</tr>
<tr>
<td>SYSTR=OFF</td>
<td></td>
<td>No system activity trace.</td>
</tr>
<tr>
<td>TCT=NO</td>
<td></td>
<td>No terminal control table required.</td>
</tr>
<tr>
<td>TST=NO</td>
<td></td>
<td>No temporary storage table required.</td>
</tr>
<tr>
<td>USERTR=ON</td>
<td></td>
<td>Enable user trace facility.</td>
</tr>
<tr>
<td>WRKAREA=2048</td>
<td></td>
<td>Bytes for Common Work Area.</td>
</tr>
<tr>
<td>XAPPCC=NO</td>
<td></td>
<td>RACF checking of APPC sessions.</td>
</tr>
<tr>
<td>XCMD=NO</td>
<td></td>
<td>For a CMAS you must specify NO for CICS commands.</td>
</tr>
<tr>
<td>XDB2=NO</td>
<td></td>
<td>RACF checking of Db2 resources.</td>
</tr>
<tr>
<td>XDCT=NO</td>
<td></td>
<td>RACF checking of transient data queues.</td>
</tr>
<tr>
<td>XFCT=NO</td>
<td></td>
<td>For a CMAS you must specify NO for files.</td>
</tr>
<tr>
<td>XHFS=NO</td>
<td></td>
<td>Security checking of Web client access to z/OS UNIX files. For a CMAS, you must specify XHFS=NO.</td>
</tr>
<tr>
<td>XJCT=NO</td>
<td></td>
<td>RACF checking of journals.</td>
</tr>
<tr>
<td>XPCT=NO</td>
<td></td>
<td>CMAS must have NO for started transactions.</td>
</tr>
<tr>
<td>XPPT=NO</td>
<td></td>
<td>CMAS must have NO for PPT entries.</td>
</tr>
<tr>
<td>XPSB=NO</td>
<td></td>
<td>RACF checking of DL/I PSBs.</td>
</tr>
<tr>
<td>XRES=NO</td>
<td></td>
<td>RACF checking of CICS document templates.</td>
</tr>
<tr>
<td>XRF=NO</td>
<td></td>
<td>No XRF support. The extended recovery facility (XRF) is not supported because of the way in which a CMAS uses MVS data spaces.</td>
</tr>
<tr>
<td>XTRAN=NO</td>
<td></td>
<td>RACF checking of transaction-attach.</td>
</tr>
<tr>
<td>XTST=NO</td>
<td></td>
<td>RACF checking of temporary storage queues.</td>
</tr>
</tbody>
</table>
Expanding the CICSPlex SM data repository

The CICSPlex SM data repository might fill up and require expansion. To expand the CICSPlex SM data repository, use the IDCAMS utility REPRO function. An example of the JCL to do this is in the EYUJXDRP member of the CICSTS55.CPSM.SEYUSAMP library.

In that JCL, on the RECORDS (xx, yy) statement, specify a primary (xx) and a secondary (yy) value that are appropriate for your environment. The initial values are 500 and 3000.

Taking backups of the CICSPlex SM data repository

The CICSPlex SM data repository is defined to CICS as a VSAM file called EYUDREP. Because the data set is accessed using CICS File Control, all the normal CICS methods of taking backups of VSAM data sets for disaster recovery purposes are available for use with the data repository.

You can use the following techniques for taking copies of the data repository and for restoring the data repository after a data set failure.

- Use HSM, or DSS, or other utilities to take copies while the associated CMAS is not running, possibly using the Concurrent Copy technique to reduce the time during which the repository is unavailable.
- Use HSM or DSS to take copies while the associated CMAS is running using the Backup While Open technique, and possibly also using the Concurrent Copy technique, which improves the ease of use of Backup While Open. This procedure requires a forward recovery log; see “Defining a forward recovery log for the data repository” on page 51.
- Use HSM or DSS to restore the data set after a data set failure.
- Use a Forward Recovery product, such as CICS VSAM Recovery (CICS/VR), to reapply updates that were made to the data set after the most recent copy was taken. This procedure requires a forward recovery log.
- Use remote site recovery techniques if you require an up-to-date copy of the data set at a remote site for disaster recovery purposes. This requires a forward recovery log.

Defining a forward recovery log for the data repository

You define the data repository in the CMAS as a VSAM file called EYUDREP.

CICSPlex SM provides a default definition that defines this file without an associated forward recovery log, and therefore as not eligible for forward recovery.

If you use forward recovery, you require a journal log stream. Defining and setting up CICS log streams is described in Planning log streams for use by your forward recovery logs.

If you want to use forward recovery, Backup While Open, or remote site recovery, change the definition of EYUDREP. Specify the following keywords on the definition of EYUDREP to define it as having a forward recovery log:

```
RECOVERY(ALL)
FWDRECOVLOG(nn)
```

where nn is a number between 1 and 99.

See Overriding the dynamically created CICS resource definitions for CICSPlex SM for an example of how to do this.

The default definition of EYUDREP also does not define the repository as being eligible for Backup While Open. To make the repository eligible for Backup While Open, specify the following keywords:

```
RECOVERY(ALL)
FWDRECOVLOG(nn)
BACKUPTYPE(DYNAMIC)
```

where nn is a number between 1 and 99.

The RECOVERY, FWDRECOVLOG, and BACKUPTYPE parameters of DEFINE FILE are described in FILE attributes.
1. Do not change any keywords on the EYUDREP definition other than RECOVERY, FWDRECOVLOG, and BACKUPTYPE. In addition, you must not set RECOVERY(NONE). Setting RECOVERY(NONE) causes repository corruption after transaction or CMAS failures.

2. Do not change the recovery options of the EYUDREPN FILE definition. This definition is used when CICSPlex SM determines that Data Repository file operations do not require logging. It is usual to receive LSR pool messages for EYUDREPN during CMAS initialization and ignore them. Make sure that the CICS JCL does not have a DD statement for EYUDREPN, and do not associate EYUDREPN with a data set name.

3. If CICSPlex SM Data Repository initialization fails (as reported by message EUlXDO105E) because the EYUDREP data set requires Batch Backout (for example, CICS issues message DFHFC0921), you must recover the EYUDREP data set and then delete and redefine the CMAS Local and Global catalogs in order to reset the CICS backout required status for the data set.

4. Requesting Backup While Open for the CICSPlex SM data repository data set using the IDCAMS DEFINE CLUSTER definition in the ICF catalog is not supported.

**Editing CICSPlex SM system parameters**

The EYUCMSSP member, in the CICSTS55.CPSM.XDFHINST or TDFHINST data set, contains sample parameters for a CMAS; you must edit this member.

“CICSPlex SM system parameters” on page 117 gives a detailed description of each parameter.

When the CMAS is to connect to a MAS for which security is active (the CICS system initialization parameter for the MAS is SEC=YES), the CMAS must have CICSPlex SM security active. When CICSPlex SM security is not activated in the CMAS, the connection between the CMAS and the MAS cannot be established. If the connection is attempted, the following message is issued to the console, the CMAS joblog, and the CMAS EYULOG:

```
EYUCR0007E  Security mismatch between CMAS cmasname and MAS masname. Connection terminating.
```

To activate CICSPlex SM security in the CMAS, specify the CICSPlex SM system parameter SEC(YES). The default is SEC(NO). For more information about the SEC parameter, see “CICSPlex SM system parameters” on page 117. Specifying SEC=YES in the CICS system initialization parameters for the CMAS does not affect CICSPlex SM security.

**CMAS-related CICS system initialization parameters**

The EYUCMSSP member is supplied non-customized in TDFHINST, and customized by DFHISTAR in XDFHINST. The member contains the CICS system initialization parameters for a CMAS.

Table 7 on page 52 identifies the CMAS-related CICS system initialization parameters and their default settings.

- If the second column in the table contains an asterisk, before you start a CMAS, you must supply your own value for the parameter listed in the first column.
- If the second column of the table does not contain an asterisk, do not change the value of the parameter in the first column.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Your value</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIEXIT=DFHZATDX</td>
<td></td>
<td>z/OS Communications Server terminal autoinstall program.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Your value</td>
<td>Explanation</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>APPLID=</td>
<td>*</td>
<td>z/OS Communications Server application ID for this CICS, which is acting as a CMAS. Used as CMAS name when NAME(value) is not specified as a CICSPlex SM system parameter.</td>
</tr>
<tr>
<td>AUXTR=ON</td>
<td></td>
<td>Auxiliary trace exception records.</td>
</tr>
<tr>
<td>AUTORESETTIME=IMMEDIATE</td>
<td></td>
<td>Time-of-day synchronization.</td>
</tr>
<tr>
<td>AUXTRSW=NEXT</td>
<td></td>
<td>No continuous auxiliary trace switching.</td>
</tr>
<tr>
<td>CICSSVC=216</td>
<td>*</td>
<td>CICS SVC installed in LPA.</td>
</tr>
<tr>
<td>CPSMCONN=CMAS</td>
<td></td>
<td>Initialize this region as a CMAS.</td>
</tr>
<tr>
<td>CSDACC=READWRITE</td>
<td></td>
<td>Enable read and write updates to CSD.</td>
</tr>
<tr>
<td>CSDRECOV=ALL</td>
<td></td>
<td>CSD forward recovery and backout.</td>
</tr>
<tr>
<td>DFLTUSER=CICSUSER</td>
<td>*</td>
<td>Non-CESN RACF user ID.</td>
</tr>
<tr>
<td>DSALIM=5M</td>
<td></td>
<td>Limit of DSA storage below 16 MB. 5 MB is a minimum initial value.</td>
</tr>
<tr>
<td>DUMPDS=A</td>
<td>*</td>
<td>Transaction dump data set.</td>
</tr>
<tr>
<td>DUMPSW=NEXT</td>
<td>*</td>
<td>Switch to next transaction dump data set.</td>
</tr>
<tr>
<td>EDSALIM=800M</td>
<td>*</td>
<td>Limit of EDSA storage above 16 MB but below 2 GB. For more information see “Controlling CICS storage in a CMAS” on page 57.</td>
</tr>
<tr>
<td>FCT=NO</td>
<td></td>
<td>No file control table.</td>
</tr>
<tr>
<td>GMTTEXT='CICSPlex System Manager CICS Transaction Server for z/OS'</td>
<td>*</td>
<td>Default logon message.</td>
</tr>
<tr>
<td>GRPLIST=DFHLIST</td>
<td></td>
<td>CICS group list. For more information see Overriding the dynamically created CICS resource definitions for CICSPlex SM.</td>
</tr>
<tr>
<td>ICV=100</td>
<td></td>
<td>Region exit interval.</td>
</tr>
<tr>
<td>ICVR=20000</td>
<td></td>
<td>Runaway task interval. For a CMAS running on a small processor and having a large number of resources defined through BAS, this value can be increased to about 90000.</td>
</tr>
<tr>
<td>ICVTSD=0</td>
<td></td>
<td>Terminal scan delay interval.</td>
</tr>
<tr>
<td>INTTR=ON</td>
<td></td>
<td>Activate main storage trace.</td>
</tr>
<tr>
<td>IRCSTRT=YES</td>
<td></td>
<td>IRC started at system initialization.</td>
</tr>
<tr>
<td>ISC=YES</td>
<td></td>
<td>Load programs required for interregion or intersystem communications during initialization.</td>
</tr>
<tr>
<td>MXT=500</td>
<td></td>
<td>Maximum tasks to exist. See “Controlling CICS storage in a CMAS” on page 57 for additional information.</td>
</tr>
<tr>
<td>PSTYPE=NOPS</td>
<td></td>
<td>No persistent sessions for CMAS.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Your value</td>
<td>Explanation</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RENTPGM=PROTECT</td>
<td></td>
<td>Specifies that CICS allocates ERDSA from readonly key 0 protected storage.</td>
</tr>
<tr>
<td>SEC=NO</td>
<td>*</td>
<td>Indicates whether CICS external security checking is performed for this CMAS. The CICS security checking is independent of the CICSPlex SM external security checking, which is controlled with the CICSPlex SM SEC system parameter, as specified in the EYUPARM DD. For information about the SEC CICSPlex SM system parameter for CMAS, see “CICSPlex SM system parameters” on page 117. You can specify the CICS external security checking system initialization parameter in the normal way, with the other CICS security related options; for example, XTRAN and XCMD. CICS command or resource security is not appropriate in a CMAS. The XTRAN system initialization parameter is typically used to control access to the various CICSPlex SM transactions used in a CMAS. No CICSPlex SM supplied transaction definitions have CMDSEC=YES or RESSEC=YES. If this definition is changed, or the CMDSEC=ALWAYS or RESSEC=ALWAYS system initialization parameters are set in a CMAS, and a CICSPlex SM transaction receives a NOTAUTH response, results are unpredictable.</td>
</tr>
<tr>
<td>SIT=6$</td>
<td></td>
<td>System initialization table suffix.</td>
</tr>
<tr>
<td>SPOOL=YES</td>
<td></td>
<td>System spooling interface. Required when you are going to use the CICSPlex SM batched repository-update facility.</td>
</tr>
<tr>
<td>START=AUTO</td>
<td></td>
<td>You can normally specify START=AUTO and let CICS initialization decide the type of start to perform. The first time that you start a CMAS, ensure the CICS global and local catalog data sets are newly initialized. Use DFHRMUTL and DFHCCUTL respectively, with AUTOINIT on the SET_AUTO_START parameter of DFHRMUTL, to make sure that the CMAS performs an initial start, which installs the necessary CICS resource definitions and establishes CMAS-to-CMAS connections. Subsequently, you can change the type of start for a CMAS by resetting the global catalog data set, using DFHRMUTL to specify either AUTOINT or AUTOCOLD. For more information see “Restarting a CMAS” on page 62.</td>
</tr>
<tr>
<td>SYSIDNT=</td>
<td>*</td>
<td>CICS System ID. The SYSIDNT value must match the EYU9XDUT SYSID parameter value used to initialize the data repository that is being referenced by the EYUDREP DD statement.</td>
</tr>
<tr>
<td>SYSTR=OFF</td>
<td></td>
<td>No system activity trace.</td>
</tr>
</tbody>
</table>
### Table 7. CICS system initialization parameters for a CMAS (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Your value</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCT=NO</td>
<td>No terminal control table required.</td>
<td></td>
</tr>
<tr>
<td>TST=NO</td>
<td>No temporary storage table required.</td>
<td></td>
</tr>
<tr>
<td>USERTR=ON</td>
<td>Enable user trace facility.</td>
<td></td>
</tr>
<tr>
<td>WRKAREA=2048</td>
<td>Bytes for Common Work Area.</td>
<td></td>
</tr>
<tr>
<td>XAPPC=NO</td>
<td>RACF checking of APPC sessions.</td>
<td></td>
</tr>
<tr>
<td>XCMD=NO</td>
<td>For a CMAS you must specify NO for CICS commands.</td>
<td></td>
</tr>
<tr>
<td>XDB2=NO</td>
<td>RACF checking of Db2 resources.</td>
<td></td>
</tr>
<tr>
<td>XDCT=NO</td>
<td>RACF checking of transient data queues.</td>
<td></td>
</tr>
<tr>
<td>XFCT=NO</td>
<td>For a CMAS you must specify NO for files.</td>
<td></td>
</tr>
<tr>
<td>XHFS=NO</td>
<td>Security checking of Web client access to z/OS UNIX files. For a CMAS, you must specify XHFS=NO.</td>
<td></td>
</tr>
<tr>
<td>XJCT=NO</td>
<td>RACF checking of journals.</td>
<td></td>
</tr>
<tr>
<td>XPSB=NO</td>
<td>RACF checking of DL/I PSBs.</td>
<td></td>
</tr>
<tr>
<td>XRES=NO</td>
<td>RACF checking of CICS document templates.</td>
<td></td>
</tr>
<tr>
<td>XRF=NO</td>
<td>No XRF support. The extended recovery facility (XRF) is not supported because of the way in which a CMAS uses MVS data spaces.</td>
<td></td>
</tr>
<tr>
<td>XTRAN=NO</td>
<td>RACF checking of transaction-attach.</td>
<td></td>
</tr>
<tr>
<td>XTST=NO</td>
<td>RACF checking of temporary storage queues.</td>
<td></td>
</tr>
</tbody>
</table>

### Controlling tasks in a CMAS

Many operations in a CMAS are run by multiple asynchronous tasks, in particular a number of tasks that are performed between CMASs in a CMAS network.

Operations such as data repository synchronization, workload management state sharing and single system image can result in a number of interdependent asynchronous tasks being established or used to run the request. The number of tasks that can be used is based on other factors, such as the size of a CMAS network, how many MASs are being managed, how many CICSplexes are defined, how much API activity is performed, the scope of WUI/API/RTA requests and all the major functions offered by CICSPlex SM.

Although a CMAS can self-regulate its tasking model and has tolerance of delayed requests and responses through timeout mechanisms, maximum user tasks (MXT) does not apply to controlling an interdependent multitasked asynchronous tasking model. Set inappropriately, you might also experience WUI hanging for long durations if one or more of the asynchronous tasks required to run the requested function is delayed waiting for an MXT slot. Set MXT to avoid delays in task attachment.

As task usage in a CMAS grows with the additional requirements that are placed on it, for example, increased use of the API, more CMASs, more MASs, and new function use, set the MXT value to a level that continues to avoid MXT delays.

Monitor any MXT value for its relationship against the task activity in each CMAS at regular intervals. If the CMAS is starting to experience MXT delays, adjust the MXT value to avoid these delays.

To monitor the tasking activity in an individual CMAS, collect and study the statistics generated by the CICS system that underlies the CMAS that it hosts. CICS transaction manager global statistics contain information on the effect the MXT value has on task attachment.
Creating and customizing CMAS data sets

DFHISTAR allows you to create and customize your CMAS data sets, according to the parameters you set when you submit the DFHISTAR job.

DFHISTAR postinstallation members for a CMAS

When you run DFHISTAR, with a SCOPE of POST or ALL, it creates the following postinstallation members for a CMAS in the XDFHINST library:

- EYUCMDS – creates and initializes all the data sets for a CMAS. EYUCMDS includes steps to delete the data sets so that you can rerun the job, if required. These deletions are expected to fail the first time you run the job. EYUCMDS contains the following steps:
  1. DELDREP and DEFDREP delete and define a new CMAS data repository.
  2. DREPINIT is included if you do not specify the DFHISTAR OLDDREP parameter. It initializes the new CMAS data repository using the EYU9XDUT utility. EYU9XDUT creates records on the data repository to define the CMAS and, by default, a WUI CICSpex. A WUI CICSpex is not created if you specify the DFHISTAR WUI=NO option.
  3. DREPCNVT is included if you specify the name of an existing data repository using the DFHISTAR OLDDREP parameter. It copies all the records from the existing repository to the new data repository, upgrading them to a format suitable for the CICS TS for z/OS, Version 5.5 release.
  4. DELREGDS deletes the CICS data sets.
  5. DEFTRACE defines the CICS auxiliary trace data sets, DFHAUXT and DFHBUXT.
  6. DEFHTML defines the CICS DFHHTML data set.
  7. DEFDMPS defines the CICS transaction dump data sets, DFHDMPA and DFHDMPB.
  8. DEFTSTD defines the CICS auxiliary temporary storage data set, DFHTEMP.
  9. DEFINTD defines the CICS intrapartition transient data set, DFHINTRA.
  10. DEFLCD defines the CICS local catalog, DFHLCD.
  11. INITLCD uses the DFHCCUTL utility to initialize the CICS local catalog.
  12. DEFGCD defines the CICS global catalog, DFHGCD.
  13. INITGCD uses the DFHRMUTL utility to initialize the CICS global catalog.
  14. DEFLRQ defines the CICS local request queue data set, DFHLRQ.
  15. JES3DELA and JES3DELB are included if you specify the DFHISTAR JES=JES3 option. They delete and define the CICS DFHCSD data set.
  16. DELCSD deletes the CICS DFHCSD data set.
  17. DEFCSD defines the CICS DFHCSD data set.
  18. INITCSD uses the DFHCSDUP utility to initialize the DFHCSD data set.

- EYUCMSSP – CICS system initialization overrides for a CMAS.
- EYUCMS0P – EYUPARM parameters for a CMAS.
- EYUCMASP – starts a CMAS.
- EYUCMASJ – JCL to start a CMAS. It runs EYUCMASP.

If you use the default values for the CICSPLEX SM parameters, the EYUCMASP PROC statement is shown in the following code sample:

```
EYUCMASP  PROC DSNCSD='CICSTS55.CPSM.CMAS01.DFHCSD',
          RGNHLQ='CICSTS55.CPSM.CMAS01',
          CICSHLQ='CICSTS55.CICS',
          CPSMHLQ='CICSTS55.CPSM',
          PRMLIB='CICSTS55.XDFHINST'
          ACTHLQ=CICSTS55.CICS
          ACTIVATE=SDFHLIC,
```
Customizing postinstallation jobs using DFHISTAR
You can use DFHISTAR to generate copies of the CMAS postinstallation jobs for a different CMAS. DFHISTAR has a SELECT parameter that allows you to specify a new name for a copy of a postinstallation job. It has the format:

```
SELECT jobname newname
```

**jobname**
Is the name of the job you want to regenerate.

**newname**
Is the name for the new copy.

You can specify more than one SELECT parameter to select multiple jobs to be regenerated in a single run of the DFHISTAR job. When you include a SELECT parameter in the DFHISTAR job, only those jobs specified by the SELECT are generated.

For a CMAS with the name CMAS02 and a CICS system identifier of CM02, you can change your DFHISTAR parameters to specify the following values:

```
CMASNAME CMAS02
CMSSYSID CM02
WUI YES
WUIPLEX WUIPCOM02
WUINAME WUINCM02
WUISYSID WU02
SELECT EYUCMSDS CM02CMDS JCL to create the data sets for CMAS02
SELECT EYUCMSSP CM02CMSP CICS SIT overrides for CMAS02
SELECT EYUCMS0P CM02CM0P CICSPlex SM EYUPARM parameters for CMAS02
```

Using these parameters, CM02CMDS includes a step to initialize the CMAS data repository with the definitions for a WUI called WUINCM02, in a CICSPlex called WUIPCOM02. You can then start CMAS CMAS02, using the procedure EYUCMASP, to specify these parameters:

```
START EYUCMASP, DSNCSD='CICSTS55.CPSM.CMAS02.DFHCSD',
RGNHLQ='CICSTS55.CPSM.CMAS02', CICSHLQ='CICSTS55.CICS',
CPSMHLQ='CICSTS55.CPSM', PRMLIB='CICSTS55.XDFHINST'
ACTHLQ=CICSTS55.CICS
ACTIVATE=SDFHLIC, CICSPRM=CM02CMSP, CPSMPRM=CM02CM0P
```

If you are using EYUCMASJ to start the WUI, edit it to specify these values:

```
CICSPRM=CM02CMSP, CPSMPRM=CM02CM0P
```

Controlling CICS storage in a CMAS
A CICSPlex SM address space (CMAS) uses both MVS dataspace storage and storage provided by the CICS system that hosts the CMAS. You must set the EDSALIM value and monitor the CICS storage use in a CMAS to ensure that the CMAS operates effectively.

A CMAS is a special application dedicated to the management and control of managed application systems (MASs). A CMAS does not have a typical tasking model and uses MVS dataspace storage extensively. However, it also uses the storage provided by the CICS system that hosts the CMAS.

With an interdependent multitasked asynchronous tasking model, a CMAS relies on shared storage to communicate between the tasks and the functions being performed. Also, depending on the requirements of a CMAS, it relies heavily on shared storage to buffer requests and responses to be transmitted using CMAS-to-CMAS and CMAS-to-MAS links. The CICS system that hosts the CMAS manages this shared storage.

CICS storage use in a CMAS grows with the additional requirements that are placed on it. For example, CICS storage use increases with increased use of the API, more CMASs, more MASs, increased CMAS-to-CMAS network traffic, and new function uses.
The overall limit for the extended dynamic storage area (EDSA) is specified by the EDSALIM value. Set EDSALIM to a value that provides the CMAS with enough storage to operate unimpeded. In particular, sufficient storage for CMAS-to-CMAS and CMAS-to-MAS network traffic is critical to WUI response times, because large amounts of data might be awaiting shipment on any of the links on which a CMAS communicates.

Monitor any EDSALIM value for its effect on the storage use in each CMAS at regular intervals. If the CMAS experiences short on storage (SOS) conditions or storage fragmentation, or there is a trend towards such conditions, consider increasing the EDSALIM value to meet the storage requirements of the CMAS. Storage fragmentation below a largest free area of 64 KB can adversely affect throughput and response times.

To monitor the storage use in an individual CMAS, collect and study the statistics generated by the CMAS CICS system. CICS storage manager global statistics contain information about the overall usage of CICS storage by the CMAS that it hosts.

**START command for a CMAS**

The syntax of the command that you can use to start a CMAS is explained.

```
START procname [,DSNCSD=dsn][,RGNHLQ=idx][,CICSHLQ=idx] [,CPSMHLQ=idx] [,PRMLIB=lib] [,CICSPRM=mem][,CPSMPRM=mem]
```

- **procname**
  - Is the 1- to 8-character name of the procedure. EYUCMASP is the name of the sample procedure. It is supplied, uncustomized, in the TDFHINST library and, customized by DFHISTAR, in the XDFHINST library.

- **DSNCSD=dsn**
  - Specifies the name of the data set that contains the CSD file for the CMAS.

- **RGNHLQ=idx**
  - Specifies the high-level qualifier that is used with the DFHxxxx data sets that are unique to this CMAS.

- **CICSHLQ=idx**
  - Specifies the high-level qualifier that is used with the SDFHAUTH and SDFHLOAD libraries.

- **CPSMHLQ=idx**
  - Specifies the high-level qualifier that is used with the SEYUAUTH and SEYULOAD libraries.

- **PRMLIB=idx**
  - Specifies the name of the library containing the members identified by CICSPRM and CPSMPRM.

- **CICSPRM=mem**
  - Identifies the member that contains the CICS system initialization parameters. The EYUCMSSP sample is supplied, uncustomized, in the TDFHINST library and, customized by DFHISTAR, in the XDFHINST library.

- **CPSMPRM=mem**
  - Identifies the member that contains the CICSPlex SM system parameters. The EYUCMS0P sample is supplied, uncustomized, in the TDFHINST library and, customized by DFHISTAR, in the XDFHINST library.

**CMAS journaling**

A CMAS can produce CICS journal records to track a variety of activities in the CICSplex. These journal records provide an audit trail that can aid in the recovery of data or the reconstruction of events that affected the CICSplex.

A journal record can be written under these circumstances:

- A definition in the data repository is added, removed, or updated.
- An operations action is issued against a MAS.
- A real-time analysis event is generated.
The journal records are stored in a 32 KB buffer and are flushed to the corresponding log streams when
the buffer becomes full or when a normal shutdown of the CICS region is initiated.

To force the buffer to be flushed to a log stream when the CICS region is still active, you can specify the
WAIT option on the WRITE JOURNALNAME command using EXEC CICS or the CECI transaction.

To request one or more of the record types, specify the appropriate CICSPlex SM system parameters in
the startup JCL of a CMAS:

**JRNLDEFCH(YES)**
For data repository definition changes

**JRNLPOPACT(YES)**
For operations actions

**JRNLRTAEV(YES)**
For real-time analysis events

For more information on these parameters, see “CICSPlex SM system parameters” on page 117.

If you do not want to use the default log stream name of EYUJRNL, define a JOURNALMODEL resource in
the CSD that has the required log stream name.

- To make the JOURNALMODEL resource definition available during CMAS initialization, include the
  JOURNALMODEL resource definition in a CSD group list. Include this group list in your CMAS startup
  using the system initialization GRPLIST parameter.

- To add the JOURNALMODEL resource to the CSD, either edit and run the JCL contained in sample
  member CICSTS55.CPSM.SEYUSAMP(EYUJRNE$) to run batch utility DFHCSDUP or use the CICS CEDA
  transaction.

- You must also update the CICS system initialization parameters used to start the CMAS by setting the
  GRPLIST parameter to reference the new group list.

The journal records produced by a CMAS contain data mapped by a DSECT called EYUBCPJR. Each record
consists of a standard prefix and a variable data area. The contents of the data area are specific to the
type of journal record being written.

Figure 15 on page 61 shows the format of EYUBCPJR.
**EYUBCPJR DSECT Prefix**

EYUBCPJR

CPJR_PREFIX DS 0D
Prefix of record

CPJR_CMASNAME DS CL8
CMAS Name which produced record

CPJR_CONTEXT DS CL8
Plex Name

CPJR_SCOPE DS CL8
Scope Name

CPJR_USER DS CL8
User Name

CPJR_STCK DS D
Store clock

CPJR_VERSION DS H
Current record version

CPJR_VER_ZERO EQU 0000
Version 0

CPJR_VER_ONE EQU 0001
Version 1

CPJR_VER_CURR EQU CPJR_VER_ONE
Current Version

CPJR_TYPE DS H
Record type

CPJR_TYPE_DEFCH EQU 0001
Definition Add/Change/Delete

CPJR_TYPE_RTAEV EQU 0002
Rta Event

CPJR_TYPE_OPACT EQU 0003
Operation action

CPJR_LENGTH DS F
Length of entire record plus x
prefix area

DS FL8
Available for use

CPJR_LEN EQU *-CPJR_PREFIX
Length of Prefix area

CPJR_DATA_AREA DS 0H
Data area

**Data record for RTA Events**

CPJR_RTA_DATA DS 0H
Record type

CPJR_RTA_TYPE DS X
Event Created

CPJR_RTA_TYPE_REM EQU 0002
Event Removed

CPJR_RTA_TYPE_UPD EQU 0003
Event Updated

CPJR_RTA_TYPE_RES EQU 0004
Event Resolved

CPJR_RTA_TYPE_SAM EQU 0001
Event produced by Sam

CPJR_RTA_TYPE_APM EQU 0002
Event produced by Apm

CPJR_RTA_TYPE_MRM EQU 0003
Event produced by Mrm

CPJR_RTA_EVENT DS CL8
Event Name

CPJR_RTA_MSGSTRT DS CL30
External Entry Message

CPJR_RTA_MSGEND DS CL30
External Exit Message

CPJR_RTA_EVENTXT DS CL30
Event Text

CPJR_RTA_SEVERITY DS CL3
Severity Level

CPJR_RTA_DATA_L EQU *-CPJR_RTA_DATA
Length of the record
Figure 15. The EYUBCPJR DSECT

For information about writing a program to access and format CICS journal records, see The CICS log manager.

Shutting down a CMAS

You can shut down a CMAS using the WUI shutdown action button or the COSD transaction.

You can use the CMASSTOP command of the CODB system-level debugging transaction to shut down the CMAS, but CODB is restricted and must be used only at the request of IBM customer support personnel. Do not attempt to shut down a CMAS in these ways:

• Issue the CEMT PERFORM SHUTDOWN command against a CMAS
• Cancel the CMAS job from MVS

If you take either of these actions, the CMAS cannot shut itself down properly.

If you shut down more than one CMAS at the same time, you might receive message EYUCP0205S. In this situation, the message does not indicate a problem, and CICSPlex SM does not produce a diagnostic SVC dump as it normally would when this message is issued. You can avoid the message by staggering your CMAS shutdowns.

Using the Shutdown button

1. • From the main menu, click CICSpLex SM operations views > CMASs known to local CMAS to open the CMASs known to local CMAS tabular view.
   • Select the record check box beside the CMAS and click Shutdown.... The Shutdown confirmation view is displayed.
Click **Yes** to confirm. The **CMASs known to local CMAS** tabular view is displayed again, showing a status of INACTIVE for that CMAS.

2. From the main menu, click **CICSPlex SM operations views > MASs known to CICSpex** to display the **MASs known to CICSpex** tabular view.
   - Click the CMAS name to display the **CMAS detail** view.
   - Click **Shutdown...**. The **Shutdown** confirmation view is displayed.
   - Click **Yes** to confirm. The **MASs known to CICSpex** tabular view is displayed again.

**Using the COSD transaction**

You can issue the transaction ID, COSD, from any terminal, including an MVS console:

```plaintext
COSD
```

**Restarting a CMAS**

You can restart a CMAS automatically, by performing a cold restart, or by doing an emergency restart.

**Automatic restart**

You can perform an automatic restart for a CMAS that you stopped normally either with the COSD transaction, or the WUI SHUTDOWN button. Automated restart is the preferred way of restarting a CMAS because it delegates the decision on whether to do an initial, cold, warm or emergency restart to CICS. CICS makes the decision by inspecting two records in the global catalog: the recovery manager control record, and the recovery manager autostart override record.

To do an automatic restart:

- Specify the AUTO option on the **START** system initialization parameter.

**Cold restart**

A manual cold restart is necessary if you have modified any of the CICS resource definitions that are used by the CMAS. You must also perform a manual cold restart if you have added or removed any of the CMAS-to-CMAS (CMTCMDEF) connection definitions.

To do a cold restart:

- Specify the COLD option on the **START** system initialization parameter.

**Emergency restart**

A manual emergency restart is necessary if a CMAS ends abnormally (in any way other than from the COSD transaction, or from using the WUI SHUTDOWN button). During an emergency restart, CICS performs essential backout processing. If the CMAS is registered with the MVS automatic restart manager (ARM), an emergency restart occurs automatically. If the CMAS is not registered with ARM you must perform the emergency restart yourself.

To do an emergency restart:

- Specify the AUTO option on the **START** system initialization parameter.

A CMAS initializes and functions properly after an emergency restart, provided that you have made no changes to the CICS resource definitions or CICSpex SM connection definitions.

If you have made changes since the last run of the CMAS (that is, the run that ended abnormally), the CMAS might not function properly. In this situation, you must shut down the CMAS using either the COSD transaction, or the WUI SHUTDOWN button and restart the CMAS, specifying the **START=COLD** option. For information about shutting down a CMAS, see “Shutting down a CMAS” on page 61.
Setting up a CICS managed application system (MAS)

There are a number of steps you must perform so that a CICS system can be known as a managed application system (MAS) to CICSPlex SM.

Note: If a MAS specifies a CMASSYSID and the CMAS is active but does not manage the CICSplex, the MAS waits until the specified CMAS is managing the CICSplex before it joins the CICSplex. This behavior is the same as when CMASSYSID is not specified.

Before you set up a MAS

Check your initialization values, changes between releases and maintenance you might need to apply to your system.

Check the considerations for setting up a MAS, described in “Designing your CICSPlex SM environment” on page 19.

Check the IEASYSxx member of SYS1.PARMLIB that you use for MVS initialization and note the initialization values that are referenced during installation. For details about initialization values, see Noting IEASYSxx values for CICSPlex SM.

If you are converting your CICSPlex SM system or systems from a previous release to CICSPlex SM for CICS Transaction Server for z/OS, Version 5 Release 5, read the upgrading information for your level of CICSPlex SM.

Using CICS global user exits and user-replaceable modules

You can use CICS global user exits and the user replaceable module, DTRPROG to monitor a MAS.

The way these exits are used by CICSPlex SM conforms to the standard described in Customizing with user-replaceable programs in Developing system programs. CICSPlex SM uses these exits only to acquire information; the application environment is not altered.

The XMNOUT and XSTOUT exits are used when monitoring services are enabled for a CICSPlex SM managed application system (MAS):

• The XMNOUT exit obtains task and CICS monitoring data. XMNOUT is used only with a local MAS.
• The XSTOUT exit obtains statistical data before the data is reset by CICS.

These exits obtain monitoring and statistics information and always return a "continue processing" return code. They are not available when a shutdown request for the MAS is received.

The XMEOUT, XDUREQ, XDUREQC, XRSINDI, XSNOFF, and XDUOUT exits are used when topology requests are enabled for a local MAS:

• The XMEOUT exit detects short-on-storage events.
• The XDUREQ exit detects system dump and transaction dump events.
• The XDUREQC exit detects the completion of dump action.
• The XRSINDI exit detects topology resource changes.
• The XSNOFF exit detects user sign-off events.
• The XDUOUT exit detects transaction dump events.

CICSPlex SM uses the dynamic routing program user replaceable module (DTRPROG) as part of workload balancing.

Controlling the use of modules from the LPA

You can control whether CICS uses modules from the LPA, either by specifying the LPA and PRVMOD CICS system initialization parameters, or by including or excluding the SYS1.CICSTS55.CPSM.SEYULPA library (defined to MVS as an LPA library) in the STEPLIB or DFHRPL concatenations.

1. A module that is link-edited with the RMODE(ANY) attribute is loaded into the ELPA.
2. It is important to remember that the LPA-resident version of a module that is usually loaded from STEPLIB is not used from the LPA if it is left in the STEPLIB DD concatenation of libraries. If a module is found in the STEPLIB concatenation, it is loaded into the private area of the address space, and the LPA version ignored. You can avoid this situation by moving the LPA-eligible modules into an LPA library, as described in Installing CICSPlex SM modules into the LPA.

For further information about controlling the use of LPA-eligible modules, see Installing CICSPlex SM modules in the MVS link pack area, taking particular note of information concerning:

- The module-not-found warning message DFHLD0109I
- CICS system initialization parameters related to LPA modules

Preparing to start a z/OS MAS

Before you start a MAS, create your data sets, change startup JCL, activate external connections, review system initialization parameters, and prepare your logs.

Start any MASs (that is, the CICS systems the CMAS is to manage) after the CMAS, because a CICS system is unknown to CICSPlex SM until the CMAS with which the CICS system is associated is started.

**Note:** If a MAS specifies a CMASSYSID and the CMAS is active but does not manage the CICSpex, the MAS waits until the specified CMAS is managing the CICSpex before it joins the CICSpex. This behavior is the same as when CMASSYSID is not specified.

Creating and customizing MAS data sets

Use DFHISTAR to create and customize your managed CICS system (MAS) data sets, according to the parameters that you set when you submit the DFHISTAR job.

DFHISTAR postinstallation members for a MAS

When you run DFHISTAR, with a SCOPE of POST or ALL, it creates the following postinstallation members for a managed CICS system (MAS) in the XDFHINST library:

- EYUCSYDS – creates and starts all the data sets for a MAS. EYUCSYDS includes steps to delete the data sets so that you can rerun the job, if required. These deletions are expected to fail the first time that you run the job. EYUCSYDS contains the following steps:
  1. DELHIST and DEFHIST delete and define CICSPlex SM history data sets EYUHISTA and EYUHISTB.
  2. HISTINIT uses the EYU9XHID utility to start the history data sets.
  3. JES3DELA and JES3DEFA are included if you specify the DFHISTAR JES=JES3 option. They delete and define the CICS local catalog, the global catalog, and the local request queue.
  4. DELREGDS deletes the CICS data sets.
  5. DEFTSTD defines the CICS auxiliary temporary storage data set, DFHTEMP.
  6. DEFINTD defines the CICS intrapartition transient data set, DFHINTRA.
  7. DEFLCD defines the CICS local catalog, DFHLCD.
  8. DEFGCD defines the CICS DFHCSD data set.
  9. INITLCD uses the DFHCCUTL utility to start the CICS local catalog.
10. INITGCD uses the DFHRMUTL utility to start the CICS global catalog.
11. DEFLRQ defines the CICS local request queue data set, DFHLRQ.
12. JES3DEFA and JES3DELB are included if you specify the DFHISTAR JES=JES3 option. They delete and define the CICS DFHCSD data set.
17. DEFCSD defines the CICS DFHCSD data set.

18. INITCSD uses the DFHCS Dup utility to start the DFHCSD data set.

- EYUJHIST creates a pair of CICSPlex SM history data sets. EYUCSYDS includes steps to create two history data sets, EYUHISTA and EYUHISTB. You can use EYUJHIST if you want to add more history data sets (up to a maximum of 26). It contains the following steps:
  - DELHIST and DEFHIST delete and define a pair of CICSPlex SM history data sets.
  - HISTINIT uses the EYUXHID utility to start the history data sets.

- EYULMSSP provides CICS system initialization overrides for a managed CICS system.

- EYULMS0P provides CICSPlex SM EYPARM parameters for a managed CICS system.

- EYUCSYSP starts a managed CICS system.

- EYUCSYSJ starts a managed CICS system. It runs EYUCSYSP.

If you use the default values for the CICSPlex SM parameters, the EYUCSYSP PROC statement is shown in the following code sample:

```plaintext
EYUCSYSP  PROC DSNCSD='CICSTS55.CPSM.CSYS01.DFHCSD',
           RGNHLQ='CICSTS55.CPSM.CSYS01',
           CICSHLQ='CICSTS55.CICS',
           CPSMHLQ='CICSTS55.CPSM',
           PRMLIB='CICSTS55.XDFHINST',
           CICSPRM=EYULMSSP,  CICS Parameters
           CPSMPRM=EYULMS0P,  CPSM Parameters
```

Customizing postinstallation jobs using DFHISTAR

You can use DFHISTAR to generate copies of the managed CICS system postinstallation jobs for a different CICS region. Use the DFHISTAR SELECT parameter to specify a new name for a copy of a postinstallation job. It has this format:

```
SELECT jobname newname
```

- **jobname** is the name of the job that you want to regenerate
- **newname** is the name for the new copy.

You can specify more than one SELECT parameter to select multiple jobs to be regenerated in a single run of the DFHISTAR job. When you include a SELECT parameter in the DFHISTAR job, only those jobs specified by the SELECT are generated.

For a MAS with the name CSYS02 and a CICS system identifier of CS02, you can change your DFHISTAR parameters to specify these options:

```plaintext
CMASNAME name of the MAS to which this managed system connects
CMSSYSID CICS system identifier of the MAS to which this managed system connects
CSYSPLEX name of the CICSplex to which this managed system is to be associated
CSYSNAME CSYS02
CSYSID CS02
SELECT EYUCSYDS CS02CSDS JCL to create the data sets for CSYS02
SELECT EYULMSSP CS02CSSP CICS system initialization overrides for CSYS02
SELECT EYULMS0P CS02CS0P CICSPlex SM EYPARM parameters for CSYS02
```

You can then start the managed CICS system, CSYS02, using the procedure EYUCSYSP:

```plaintext
START EYUCSYSP, DSNCSD='CICSTS55.CPSM.CSYS02.DFHCSD',
       RGNHLQ='CICSTS55.CPSM.CSYS02', CICSHLQ='CICSTS55.CICS',
       CPSMHLQ='CICSTS55.CPSM', PRMLIB='CICSTS55.XDFHINST'
       CICSPRM=CM02CSSP, CPSMPRM=CM02CS0P
```

If you are using EYUCSYSJ to start the WUI, edit it to specify these options:

```plaintext
CICSPRM=CS02CSSP, CPSMPRM=CS02CS0P
```
Changing startup JCL before starting a MAS

Change the startup JCL for the system by modifying your DD statements to include the CICSPlex SM data sets and verifying that the appropriate CICS system initialization parameters are included.

The DD statements that you must modify are shown in Figure 16 on page 66.

Figure 16. z/OS MAS-specific JCL requirements

```plaintext
... 
//STEPLIB DD DSN=CICSTS55.CPSM.SEYUAUTH,DISP=SHR
//DFHRPL DD DSN=CICSTS55.CPSM.SEYULOAD,DISP=SHR
//EYUPARM DD DSN=(Any PO or PS data set with LRECL=80)
//EYUHISTA DD DSN=(Optional 1st history data set)
//EYUHISTB DD DSN=(Optional 2nd history data set)
//EYUHISTn DD DSN=(Optional nth history data set)
... 
```

When you change these DD statements in the startup JCL for a CICS system, code these statements as follows:

**STEPLIB DD statement**
Includes the CICSTS55.CPSM.SEYUAUTH authorized load library.

**DFHRPL DD statement**
Includes the CICSTS55.CPSM.SEYULOAD load library.

**EYUPARM DD statement**
Identifies the library containing the CICSPlex SM parameters.

- Member EYULMSOP, in the CICSTS55.CPSM.SEYUPARM data set, contains sample system parameters for a local MAS; you must edit this member. See “CICSPlex SM system parameters” on page 117 for a detailed description of each parameter. EYULMSOP is supplied, uncustomized, in TDFHINST and customized in XDFHINST.

- If you want to use Business Application Services to install CICS resources in a MAS, you must specify the CICSPlex SM system parameter MASPLTWAIT(YES) for that system. This parameter suspends CICS PLT processing until all CICS resources are installed and the CICSPlex SM MAS is fully initialized.

- If you want to include a MAS in a platform, you must also specify the CICSPlex SM system parameter MASPLTWAIT(YES) for that system. This parameter is required to automatically install CICS resources for an application or platform when the CICS region is initialized.

**EYUHISTx DD statement**
Identifies the history data sets for the MAS. Each MAS must have its own set of CICSPlex SM history data sets. You allocate the data sets to the MAS region by means of DD cards in the JCL with DD names of the form EYUHISTx, where x is a character suffix taking values A through Z. Dynamic allocation is not supported. Allocate the data sets with a disposition of OLD. Use the suffix letters in ascending sequence and omit no letters. For example, if four history data sets are required, use DD names EYUHISTA, EYUHISTB, EYUHISTC, and EYUHISTD. See “Preparing the MAS for history recording” on page 70.

Activating Db2 and IBM MQ connections during CICS startup

If you are using Db2 or IBM MQ with CICS, you must make special arrangements to define and activate your connections.

If you are using the CICS system initialization parameter CPSMCNON=NO with the PLTPI to initialize CICSPlex SM, see Upgrade PLTPI in Upgrading CICSPlex SM for further recommendations.

Db2 connections

When you use CICS systems with the CICS Db2 attachment facility, you can use BAS to install a Db2 connection defined to CICSPlex SM.

Activate a Db2 connection during CICS startup as follows:
1. Ensure that you can install an appropriate DB2CDEF resource definition for CICSPlex SM, and that the definition is set up for automatic installation.

2. Ensure one of the following configurations is implemented:
   - Specify the CICS system initialization parameters `CPSMCNN=LMAS` and `DB2CONN=YES`.
   - Specify the CICS system initialization parameters `CPSMCNN=LMAS` and `DB2CONN=NO`. You must start the CICS Db2 attachment facility by using the correct PLT program.
   - Specify the CICS system initialization parameter `CPSMCNN=NO` and `DB2CONN=NO`. You must start both CICSPlex SM and the CICS Db2 attachment facility by using the correct PLT program. In the PLT, the CICS Db2 attachment facility PLT program must be ordered to execute after the CICSPlex SM PLT program.

3. Specify the `MASPLTWAIT(YES)` CICSPlex SM parameter, which causes the DB2CDEF resource definition (as well as all other BAS resource definitions) to be installed during PLT processing.

After the BAS resource installation step, the Db2 PLT program will run to start the Db2 connection.

**IBM MQ connections**

When you use CICS systems with the CICS-MQ adapter, you can use BAS to install a CICS-MQ connection defined to CICSPlex SM.

Activate a CICS-MQ connection during CICS startup as follows:

1. Ensure that you can install an appropriate MQCONDEF resource definition for CICSPlex SM, and that the definition is set up for automatic installation.

2. Ensure one of the following configurations is implemented:
   - Specify the CICS system initialization parameters `CPSMCNN=LMAS` and `MQCONN=YES`.
   - Specify the CICS system initialization parameters `CPSMCNN=LMAS` and `MQCONN=NO`. You must start the CICS-MQ adapter by using the correct PLT program.
   - Specify the CICS system initialization parameter `CPSMCNN=NO` and `MQCONN=NO`. You must start both CICSPlex SM and the CICS-MQ adapter by using the correct PLT program. In the PLT, the CICS-MQ adapter PLT program must be ordered to execute after the CICSPlex SM PLT program.

3. Specify the `MASPLTWAIT(YES)` CICSPlex SM parameter, which causes the MQCONDEF resource definition (as well as all other BAS resource definitions) to be installed during PLT processing.

After the BAS resource installation step, the CICS-MQ adapter PLT program will run to start the CICS-MQ connection.

**z/OS MAS-related CICS system initialization parameters**

Verify that the sequential data set or partitioned data set member identified by the CICS SYSIN statement includes the appropriate CICS system initialization parameters.

Table 8 on page 68 describes the parameters in more detail.

Review all of the listed parameters for each MAS, to ensure that the values specified are appropriate. When you specify YES for a specific resource type (XCMD, XFCT, XPCT, or XPPT), a CICSPlex SM security profile must exist for that resource type. See the CICSPlex SM security for information about creating security profiles.

**Note:** To get all data available for the TASK and MLOCTRAN views, MCT must have a value specified, CICS monitoring for performance classes must be activated, and you must be collecting performance class data. See the note for MCT, MONITOR, MN, and MNPER parameters in the following table.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLID=</td>
<td>z/OS Communications Server application ID for this CICS system. Used as MAS name when NAME(value) is not specified as a CICSPlex SM system parameter.</td>
</tr>
<tr>
<td>AIXEXIT=DFHZATDX</td>
<td>z/OS Communications Server terminal autoinstall program.</td>
</tr>
<tr>
<td>AUTORESEETTIME=IMMEDIATE</td>
<td>Time-of-day synchronization.</td>
</tr>
<tr>
<td>AUXTR=ON</td>
<td>Auxiliary trace - exception records.</td>
</tr>
<tr>
<td>AUXTRSW=NEXT</td>
<td>No continuous auxiliary trace switching.</td>
</tr>
<tr>
<td>CPSMCONN=LMAS</td>
<td>Initialize the region as a local MAS.</td>
</tr>
<tr>
<td>DFLTUSER=userid</td>
<td>Specify the user identifier that is to be used for security checking when a user is not defined to the ESM.</td>
</tr>
<tr>
<td>DSALIM=5M</td>
<td>Limit of DSA storage in 24-bit (below-the-line) storage. Set this value to at least 5 MB.</td>
</tr>
<tr>
<td>EDSALIM=800M</td>
<td>Limit of EDSA storage in 31-bit (above-the-line) storage.</td>
</tr>
<tr>
<td>DSRTPGM=EYU9XLOP</td>
<td>Distributed START routing program.</td>
</tr>
<tr>
<td>DTRPGM=EYU9XLOP</td>
<td>Dynamic routing program.</td>
</tr>
<tr>
<td>DUMPDS=A</td>
<td>Transaction dump data set.</td>
</tr>
<tr>
<td>DUMPSW=NEXT</td>
<td>Switch to next transaction dump data set.</td>
</tr>
<tr>
<td>FCT=NO</td>
<td>A file control table is not used.</td>
</tr>
<tr>
<td>GMTEXT='CICSPlex System Manager - CICS Transaction Server for z/OS'</td>
<td>Default logon message.</td>
</tr>
<tr>
<td>GRPLIST=DFHLIST</td>
<td>Add group lists for your application resource definitions. See CICS resource definitions for CICSPlex SM for additional information.</td>
</tr>
<tr>
<td>ICV=100</td>
<td>Region exit interval.</td>
</tr>
<tr>
<td>ICVR=5000</td>
<td>Runaway task interval.</td>
</tr>
<tr>
<td>ICVTSD=0</td>
<td>Terminal scan delay interval.</td>
</tr>
<tr>
<td>INTTR=ON</td>
<td>Activate main storage trace.</td>
</tr>
<tr>
<td>IRCSTRT=YES</td>
<td>IRC started at system initialization.</td>
</tr>
<tr>
<td>ISC=YES</td>
<td>Code YES to include the CICS programs that are required for interregion and intersystem communications.</td>
</tr>
<tr>
<td>MCT=</td>
<td>Monitoring control table. If you have CICS performance class monitoring active, you must specify a value for this parameter. You can use 2$ (the default) or an existing table. See note.</td>
</tr>
<tr>
<td>MN=ON</td>
<td>Activates CICS Monitor. See note.</td>
</tr>
<tr>
<td>MNFREQ=001500</td>
<td>Writes performance class data every 15 minutes.</td>
</tr>
<tr>
<td>MNPER=ON</td>
<td>Tells CICS to monitor performance classes. See note.</td>
</tr>
</tbody>
</table>
Table 8. CICS system initialization parameters for a z/OS MAS (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note for MCT, MONITOR, MN, and MNPER parameters:</strong> To obtain all data available for the TASK and MLOCTRAN views, MCT must have a value specified, CICS monitoring for performance classes must be activated, and you must be collecting performance class data. If you do not want this data written to an SMF data set, you can suppress the monitor records. See the description of the SUPPRESSCMF parameter in “CICSPlex SM system parameters” on page 117.</td>
<td></td>
</tr>
<tr>
<td>MXT=500</td>
<td>Maximum tasks. Increase by 20 from your normal value for the CICS region to accommodate the CICSPlex SM MAS tasks. CICSPlex SM rarely uses all 20 of these additional tasks. If you are using the MXT value alone to control application transactions, increasing this value can allow more application transactions to run concurrently. To prevent this situation from occurring, you can define a transaction class for the application. Then, set a class maximum task (CMXT) value that limits the number of concurrent transactions.</td>
</tr>
</tbody>
</table>
| SEC= {YES|NO}  | Indicate whether external security checking is to be performed for this CICS system:  
**YES**  
When READ access is granted:  
• READ is permitted  
• UPDATE is refused.  
When UPDATE access is granted:  
• READ is permitted  
• UPDATE is permitted.  
**NO**  
Security checking is not performed.  
1. For CICS security, the value specified with SEC= for a CMAS overrides the value specified with SEC= for a MAS.  
2. For CICSPlex SM security to be active, set SEC=YES for a MAS. The CMAS to which it connects must have the CICSPlex SM system parameter SEC(YES). When CICSPlex SM security is not activated in the CMAS, the connection between the CMAS and the MAS cannot be established. If the connection is attempted, message EYUCR0007E is issued to the console, the CMAS joblog, and the EYULOG.  
For more information about the SEC parameter for the CMAS, see “CICSPlex SM system parameters” on page 117. |
<p>| SECPRFX={YES | NO | prefix}  | Specify whether the user ID is used as the prefix that is added to the beginning of all resource names to distinguish this CICS system from other CICS systems. |
| SIT=6$  | System initialization table suffix. |
| SPOOL=YES  | System spooling interface. |
| START=AUTO  | Cold start overriding other options. |
| SYSIDNT=  | Indicate the ID of the CICS system. This name must be unique in a CICSplex. |
| SYSTR=OFF  | Auxiliary trace - no system activity. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCT=NO</td>
<td>A terminal control table is not used.</td>
</tr>
<tr>
<td>TS=(COLD,3)</td>
<td>Cold start temporary storage.</td>
</tr>
<tr>
<td>TST=NO</td>
<td>A temporary storage table is not used.</td>
</tr>
<tr>
<td>USERTR=ON</td>
<td>Auxiliary trace - enable user trace.</td>
</tr>
<tr>
<td>XAPPC=NO</td>
<td>RACF checking of APPC sessions.</td>
</tr>
<tr>
<td>TCPIP=YES</td>
<td>Activate CICS TCPIP services.</td>
</tr>
<tr>
<td>XCMD= {YES</td>
<td>name</td>
</tr>
<tr>
<td>XDB2= {No</td>
<td>name}</td>
</tr>
<tr>
<td>XDCT=NO</td>
<td>RACF checking of transient data queues.</td>
</tr>
<tr>
<td>XFCT= {YES</td>
<td>name</td>
</tr>
<tr>
<td>XHFS=NO</td>
<td>Security checking of Web client access to z/OS UNIX files.</td>
</tr>
<tr>
<td>XPCT= NO</td>
<td>RACF checking of EXEC-started transactions.</td>
</tr>
<tr>
<td>XPPT= {YES</td>
<td>name</td>
</tr>
<tr>
<td>XRES=NO</td>
<td>Security checking of access to CICS resources subject to XRES security checks. For a list of resources subject to XRES security checks, see Security using the XRES resource security parameter.</td>
</tr>
<tr>
<td>XRF=NO</td>
<td>XRF support is not generated.</td>
</tr>
<tr>
<td>XPSB=NO</td>
<td>RACF checking of DL/I PSBs.</td>
</tr>
<tr>
<td>XTRAN=NO</td>
<td>RACF checking of transaction-attach.</td>
</tr>
<tr>
<td>XTST=NO</td>
<td>RACF checking of temporary storage queues.</td>
</tr>
<tr>
<td>XUSER={YES</td>
<td>NO}</td>
</tr>
</tbody>
</table>

**Preparing the MAS for history recording**

With CICSPlex SM, you can save and view data for completed tasks; that is, historical task data.

When an active task completes, its data is stored in a historical data store. The data store is made up of a number of VSAM KSDS data sets. You need a minimum of two data sets and a maximum of twenty six data sets.

Each MAS must have its own set of CICSPlex SM history data sets. Allocate the data sets to the MAS region by means of DD cards in the JCL with DD names of the form EYUHISTx, where x is a character suffix taking values A through Z. Dynamic allocation is not supported. Allocate the data sets with a disposition of OLD. Use the suffix letters in ascending sequence with no letters omitted. For example, if four history data sets are required, use DD names EYUHISTA, EYUHISTB, EYUHISTC, and EYUHISTD.

Define the CICSPlex SM history data sets with the REUSE keyword. Task history recording uses the least recently used data set, or, when starting for the first time, EYUHISTA. When EYUHISTA becomes full, it switches to use EYUHISTB and so on in sequence. Each full data set remains open with its data available until the history recorder has filled all data sets and starts reusing the data sets. At this time, EYUHISTA is set closed, emptied, reopened, and reused first, followed by EYUHISTB and so on in sequence. If a data set is reused, its previous contents are destroyed.
Until the history recorder has to empty a data set to reuse it, the historical task data is available for use. The data is maintained across CMAS and MAS restarts. You do not have to define the history data sets as recoverable because unit-of-work recoverability is not required. However, the CICSPlex SM history recorder does require files to be defined as nonrecoverable to avoid unnecessary logging in the MAS region.

In addition, do not define the history data sets to use VSAM compression. The CICSPlex SM history function initializes the data sets to calculate how many records fit in the data set, so that it can safely use sequential writes to the data set, thereby reducing I/O use. Use of VSAM compression spoils that calculation and causes data to be lost when the data set becomes full and a data set switch is required.

CICSPlex SM provides a tuning aid, the HISTRECSMSG EYUPARM parameter, to determine the optimum size for history data sets. HISTRECSMSG can activate the periodic output of messages detailing how many thousand records have been written to the data set. Each completed task has one record. Because CICS file control supports extended format KSDS data sets, you can define large history data sets over 4 GB in size. However, when considering the use of very large data sets, take into account that when the CICSPlex SM history recorder reuses a data set by emptying it, a large amount of data is lost and not available for subsequent queries. An alternative approach to a small number of very large data sets is to spread the data over more data sets. For example, by having 25 data sets, each one capable of holding one hour's worth of completed task data, at least one day's worth of data can always be maintained.

When the oldest data set is reused, only one hour's worth of data is lost.

CICSPlex SM provides a sample job, EYUJHIST, for defining and initializing two history data sets. It is supplied, non-customized, in TDFHINST, and customized by DFHISTAR in XDFHINST.

**Stopping and restarting management of a CICS system**

You can stop and restart management of a MAS in an active CICS system. You can also check that MAS shutdown processing is properly installed.

**Stopping management of a CICS system**

You can stop the MAS agent code in an active CICS system in two ways:

- From the WUI Main menu, click **CICSPlex SM operations > MASs known to CICSPlex >**, select the CICS systems and click **Stop**, or
- Run transaction COSH in the MAS. You start COSH at a 3270 terminal, at a console, or using ATI.

When you stop the MAS agent, CICSPlex SM cannot access the MAS until either the CICS system is restarted (see “Preparing to start a z/OS MAS” on page 64) or the COLM or CORM transaction is issued.

When a MAS is active as a CICSPlex SM workload management routing region, and the dynamic routing program is set to EYU9XLOP, the STOP command is not run. In this situation, before you issue the STOP command, you must use the WUI CICS regions operations view to change the dynamic routing program from EYU9XLOP to the CICS default dynamic routing program, DFHDYP, or another valid dynamic routing program.

**Restarting management of a CICS system**

To reactivate a running CICS system as a MAS, issue the CICS COLM transaction.

If you want a local MAS to be recognized as a workload management routing region when CICSPlex SM resumes managing the system, set the dynamic routing program to EYU9XLOP. To change the dynamic routing program, use the CICS CEMT transaction before you reactivate the local MAS.

**Terminating a MAS**

To verify that the CICSPlex SM SM MAS shutdown processing is properly installed, you can end the CICS system and check the log for the following shutdown message.

```
EYUXL0016I  MAS shutdown complete
```
To end a CICS system running the MAS agent code:
1. From the WUI Main menu, click **CICS regions**.
2. Select one or more CICS systems.
3. Click **Shutdown**.

**Controlling the number of long running tasks in a MAS**

The MAS agent contains one primary long running system task (LRT), which runs under transaction CONL. By default, this task handles most requests directed to the MAS through the API, WUI, and RTA. The CONL system task also handles internal requests for the MAS, including collecting information on dynamically installed resources and delivering this information to the CMAS. If the LRT becomes busy handling one request, all subsequent requests directed to the MAS are delayed until the current request ends.

Alternate LRTs, which run under a system task that uses the CONA transaction ID, can be requested by specifying a non-zero value for the MASALTLRTCNT EYUPARM. If activated, the alternate LRTs handle the API, WUI, and RTA requests normally handled by the primary LRT. Only one alternate LRT is active at a given time. If the active alternate LRT becomes busy for longer than the value specified by the MASALLTRTTIM EYUPARM, subsequent API, WUI, and RTA requests directed to the MAS are directed to another CONA system task.

Using alternate LRTs allows subsequent requests to be processed even though a previous request has yet to be completed. This also allows the primary LRT to process internal requests without being delayed by the processing of a WUI, API, or RTA request.

The number of alternate long running system tasks (MASALTLRTCNT) can be tuned based on the EYUNL0911I, EYUNL0912I, and EYUNL0913I messages issued when a MAS terminates or goes into restart mode. EYUNL0911I displays the number of active CONA system tasks for this execution. EYUNL012I displays the maximum number of concurrently busy CONA system tasks. If this value is less than the value displayed by EYUNL0911I, you might want to lower the MASALTLRTCNT so that it equals or is one greater than the value displayed by EYUNL0912I. If the value of EYUNL0912I is equal to the value displayed by EYUNL0911I, the value displayed by EYUNL0913I, which is the number of times all active CONA system tasks were busy at the same time, is non-zero. Based upon this value, you can increase the value of MASALTLRTCNT.

The priority of the alternate LRTs can be controlled by the MASALTLRPRI EYUPARM. Specifying a MASALTLRPRI value that is less than the default value of 255 can adversely affect the response time of API and WUI users, and might result in RTA EVENTs not being created or resolved in a timely manner.

**Note:** Specifying different values for MASALTLRTCNT for multiple WLM target regions might result in an uneven distribution of transactions to those regions because of differing long running task counts.

**Configuring CICSPlex SM**

To configure CICSPlex SM you must create a CMAS and data repository, create a WUI server, and configure your CICS regions. You can organize your regions into groups that logically belong together. You can also create more than one CMAS to provide a highly available environment and create connections between the CMASs.

**About this task**

To create a single-system image of the CICS regions comprising a CICSpex, you have to create topology definitions. These definitions associate CICS regions with a CICSpex, and optionally identify subsets of those regions as CICS system groups. The names of the CICS regions and system groups must be unique in each CICSpex.
Creating a CICSpex

To create a CICSpex, use the CICS Explorer or Web User Interface to create a definition in the data repository.

About this task

The CMAS that is identified as the current context when you define the CICSpex becomes the maintenance point CMAS for the CICSpex. You can associate as many CICSpexes as you want with a CMAS.

Procedure

1. Create a CICSpex definition, setting the context to the CMAS that you want as the maintenance point.
   - In CICS Explorer, open the SM Administration perspective and click Definitions > CICSpex definitions.
   - In the Web User Interface, open the CICSpex definitions tabular view and click Create.
2. Enter the name for the CICSpex.
   - You can enter a name up to 8 characters. You can also set additional options such as security settings.
3. Create the definition.

Results

The CICSpex is defined in the data repository that is associated with selected CMAS. The CICSpex becomes available as soon as the definition is added to the data repository.

What to do next

Define the CICS regions that comprise the CICSpex. You can assign an unlimited number of CICS regions to the CICSpex.

Creating a CICS system definition

To add a CICS region to a CICSpex, you must configure the region to support CICSPlex SM and create a system definition in the data repository. You can use CICS Explorer or the Web User Interface to create the definition.

About this task

A CICS region that is managed by CICSPlex SM is called a MAS. A MAS is local to the CMAS with which it is associated. A local MAS resides in the same MVS image as the CMAS and uses the Environment Services System Services (ESSS) to communicate with the CMAS. The ESSS is the component that owns all the data spaces used by CICSPlex SM in an MVS image.

Procedure

1. Update the JCL for the CICS region to add the EYUPARM parameters and restart the CICS region.
2. Create the CICS system definition, setting the context to the CICSpex.
   - In the CICS Explorer, open the SM Administration perspective and click Definitions > System definitions.
   - In the Web User Interface, click Topology administration > System definitions and click Create.
3. Enter the name for the system definition.
   - The name must be unique in the CICSpex and not exceed 8 characters in length. The name can match any name that is not assigned by CICSPlex SM, such as the VTAM APPLID. You can also set whether security checking is required and the time zone in which the CICS region is running.

Results
Creating a CICS system group
You can optionally create one or more CICS system groups to logically group similar CICS regions together. CICS system groups can be useful if you want to use workload management or deploy resources into a set of CICS regions using a scope.

About this task
You can create a CICS system group using the CICS Explorer or the Web User Interface. There is no limit to the number of system groups that you can associate with a CICSpix.

Procedure
1. Create the CICS system group definition, setting the context to the CICSpix.
   - In the CICS Explorer, open the SM Administration perspective and click Definitions > System group definitions.
   - In the Web User Interface, click Administration > Topology administration > System groups and click Create.
2. Enter the name of the system group.
   The name can be up to 8 characters in length and must be unique to the CICSpix.
3. Save the definition to the data repository.

Results
The CICS system group is associated with the CICSpix.

What to do next
After you create the CICS system groups for your CICSpix, assign the CICS systems to the appropriate groups.

Adding a CICS system to a CICS system group
You can assign a CICS system to one or more system groups to logically group similar regions together. You can also implement workload management using system groups, so assigning the systems to appropriate groups is important.

About this task
If you do not want to use workload management, you can organize CICS systems into CICS system groups as required. For example, you might group all application-owning regions (AORs) together, all file-owning regions (FORs) together, and all terminal-owning regions (TORs) together.

If you do want to use workload management, you must ensure that each CICS system that acts as a target region for specific workload processing is in the same CICSpix as the CICS systems acting as routing regions. The routing regions associated with a CICSpix can be in the same or different MVS images. Also CICS systems acting as routing regions must be locally attached to a CMAS.

You can add CICS systems to a system group using CICS Explorer or the Web User Interface.

Procedure
- Using the CICS Explorer, open the SM perspective and click Window > Show View > System definitions to list the system definitions.
  a) Right-click the system definition that you want to assign and click Add to Group.
  b) Select the system group.
- Using the Web User Interface, click Topology administration > System definitions.
  a) Select a CICS system definition and click Add to CICS system group.
  b) Specify the name of an existing system group and click Yes.
Results
The CICS system is added to the specified system group.

What to do next
After you have created a basic topology, you can add additional CMASs to create a highly available environment.

Assigning a CMAS to a CICSpex
You can create additional CMASs to manage a CICSpex to provide a highly available environment. You have to associate these additional CMASs with the CICSpex.

About this task
When you create a CICSpex, the CMAS that is the context when you create the definition becomes the maintenance point CMAS for that CICSpex. There is no restriction on the number of CMASs that can be involved in the management of a single CICSpex.

You can assign a CMAS to a CICSpex using CICS Explorer or the Web User Interface.

Procedure
- Using the Web User Interface, open the CICSpex definitions view to select the CICSpex.
  a) Click Assign.
  b) Specify the name of the CMAS that you want to associate with the specified CICSpex.
  c) Click Yes to confirm.

Results
The specified CMAS is added to the CICSpex definition in the data repository.

What to do next
Connect the CMASs together. After communication is established, the maintenance point CMAS informs the other CMASs that they are involved in managing the CICSpex. The maintenance point CMAS also synchronizes the data repositories to ensure that they contain the same information.

For additional information about working with multiple CMASs, see Working with maintenance point CMASs.

Establishing CMAS to CMAS connections
If more than one CMAS is to be involved in the management of a CICSpex, you are recommended to create links between those CMASs. This example describes how to define links between two CMASs, CMSSYS1 and CMSSYS2, which will both be involved in managing the CICSpex PLXPROD1.

Note that you must define the CMAS to CMAS links before defining CICSpex PLXPROD1 to the CMASs. If you define PLXPROD1 to the CMASs before creating the CMAS to CMAS links, a duplicate maintenance point condition is raised and the CMAS to CMAS connection is terminated.

The CMASs are running on separate MVS images. You have to create two links, one from CMSSYS1 to CMSSYS2, and one from CMSSYS2 back to CMSSYS1. Both CMASs should be running while you define these links.

1. Log on to the WUI connected directly to CMAS CMSSYS1.
2. Display any existing CMAS to CMAS links defined from CMSSYS1.
   a. From the main menu click Administration views > CMAS configuration administration views > CMAS to CMAS link definitions to open the CMAS to CMAS link definitions tabular view.
   b. The context, which is displayed near the top of the tabular view, must be the CMAS for any configuration task. Start with CMSSYS1, if the context is not CMSSYS1, specify CMSSYS1 in the
**CMAS context** field and click **Refresh**. The context is then fixed for all subsequent views and menus until changed.

3. Create a new CMAS to CMAS link.
   a. Click **Create** to open the **CMAS to CMAS link definition** create view.
   b. Provide the following information:
      - **Target CMAS**
        CMSSY2
      - **Description**
        Link to CMSSY2 on system 2
      - **Target VTAM application ID**
        CMSSYS2
        **Note:** VTAM is now z/OS Communications Server.
      - **Target system ID**
        CM2B
      - **Link protocol**
        LU62
      - **Send buffer size**
        4060
      - **Receive buffer size**
        4060
      - **Type of attach-time security to be used**
        LOCAL
        Other fields can remain blank.
   c. Click **Yes** to confirm.
      The **CMAS to CMAS link definition** view is redisplayed, and includes an entry for the link you have just created. This confirms that the link from CMSSYS1 to CMSSYS2 has been defined in the data repository of CMSSYS1. Now you have to create the corresponding link from CMSSYS2 to CMSSYS1.

4. Log on to a WUI that is connected directly to CMAS CMSSYS2.

5. Repeat step “2” on page 75 and “3” on page 76, using appropriate data for a link from CMSSYS2 to CMSSYS1.

A two-way link has now been created between CMSSYS1 and CMSSYS2. The link is available immediately: you do not have to restart the CMASs first. When the CMASs are restarted the required definitions are created automatically during the CMAS startup.

**Note:** With MRO connections, this can result in a transient error (message DFHIR3788, return code X'68') if the connection has not yet been created on the remote CMAS. The error should resolve itself automatically once the connection has been created.

### Setting up a CICSPlex SM Web User Interface server

To use the CICSPlex SM Web User Interface, you work through a number of tasks, including specifying parameters, creating data sets, and so on.

**About this task**

You should also set up security for the CICSPlex SM Web User Interface. This includes user security access, Secure Sockets Layer (SSL) support, and access to MVS data sets. For details, see [CICSPlex SM Web User Interface security access overview](#).
Preparing a CICS system to act as the Web User Interface server

High-level planning guidance and steps are provided to help you set up your CICS system to act as your Web User Interface server and to enable web support.

- The CICS system that you select to act as your Web User Interface server must be a dedicated CICS Transaction Server for z/OS, Version 5 Release 5 CICSPlex SM MAS connected to a CICS Transaction Server for z/OS, Version 5 Release 5 CMAS. For information about how to set up a MAS, see “Setting up a CICS managed application system (MAS)” on page 63.
- Check the considerations for setting up a WUI server, described in “Designing your CICSPlex SM environment” on page 19.
- Decide how many Web User Interface servers you require:
  - If you intend to support more than one national language, you require a Web User Interface server for every language you want to support.
  - You can have Web User Interface servers on multiple MVS images.
  - You can have more than one Web User Interface server for availability reasons.
  - The Web User Interface server creates and maintains state data when a user signs on using a web browser (or when an application using the data interface DATA/CONNECTs). Because of this state data, an affinity between the web browser or the application using the data interface and the server is created.

  The use of techniques like dynamic virtual IP addresses (DVIPA) or distributed DVIPA might not be able to preserve this affinity. If this affinity is not preserved, web browsers usually redisplay the sign-on screen, or data interface applications receive a BADSTUB status.

  - If the Web User Interface server has a different local IP address or name from the one used by users in their web browsers, for example, because of a firewall or another reason that causes network address translation, you can use the TCPIPHTTPHOST Web User Interface server initialization parameter to control the way the Web User Interface server generates web addresses sent to web browsers.

To set up your CICS system to act as a Web User Interface server, follow these steps:

1. Create the CICS system and confirm that it is operational using the CICS-supplied installation verification procedures.
2. Configure a separate CICSpex for your Web User Interface servers.
3. Ensure that the CMAS to which the Web User Interface connects is managing all CICSpexes to which the Web User Interface server requires access, because the Web User Interface server acts as a CICSpex SM API application. However, the CMAS, to which the Web User Interface connects, does not have to manage any of the MASs in these CICSpexes.

  If more than one CMAS is on the MVS image on which the Web User Interface server runs, consider which CMAS the Web User Interface connects to depending on which CICSpexes the CMAS is managing. You have two ways to control this connection:

  • Ensure that the CICSpex to which the Web User Interface server local MAS belongs is managed only by the CMAS or CMASs to which the Web User Interface connects, or
  • Ensure that the Web User Interface server connects to a specific CMAS by specifying the CMASSYSID EYUPARM for the server local MAS.
4. Define the Web User Interface server CICS system to CICSpex SM as a local MAS and ensure that the CICS system has been set up correctly using the CICSpex SM installation verification procedures.
5. Consider basic monitoring of your Web User Interface servers. You can use standard CICSpex SM monitoring because the Web User Interface server is defined as a MAS.

Configuring CICS web support

You can configure the Web User Interface to provide web support.
1. On Web User Interface initialization, a TCPIPSERVICE resource definition is created and opened for you by the Web User Interface. However, you must create a temporary TCPIPSERVICE resource definition to run the CICS web support sample applications. Discard this temporary TCPIPSERVICE resource definition after CICS web support has been tested and before Web User Interface initialization has begun.

2. For SSL, the Web User Interface can either use the default certificate in the key database or a named certificate. However, it can only use a named certificate only if the label contains only alphanumeric characters and is a maximum of 32 characters.

Configuring CICS web support components explains how to set up the base components of CICS web support and verify its operation using the supplied sample programs.

Configuring CICS to use SSL explains the additional configuration that is required if you want to use the secure sockets layer (SSL).

Reviewing CICS system initialization parameters for the WUI
Review these system initialization parameters when setting up a CICSPlex SM Web user Interface server to ensure that CICS is properly configured.

1. Specify the storage key for the CICS common work area (CWA) and the amount of storage required for the CWA on the CWAKEY and WRKAREA CICS system initialization parameters.

   Use the following format:

   ```
   CWAKEY=CICS
   WRKAREA=2048
   ```

2. To ensure that Web User Interface exception trace entries are written to the CICS auxtrace data set, as required to achieve first failure data capture, specify the USERTR, SYSTR, and AUXTR CICS system initialization parameters:

   ```
   USERTR=ON
   SYSTR=OFF
   AUXTR=ON
   ```

3. Specify the CPSMCONN CICS system initialization parameter to start CICSPlex SM code automatically during CICS initialization and initialize the region as a CICSPlex SM Web User Interface server. Using the system initialization parameter is the alternative to specifying the CICSPlex SM WUI initialization and shutdown programs in initialization and shutdown program list tables (PLTPI and PLTSD).

   ```
   CPSMCONN=WUI
   ```

4. Specify the action CICS takes if, at the next local midnight, the CICS time-of-day differs from the system time-of-day by more than 30 minutes (for example, after setting clocks forward or back to adjust for Summer and Winter time):

   ```
   AUTORESETTIME=IMMEDIATE
   ```

Clients continue to issue the CEMT PERFORM RESET command.

See Handling daylight saving time changes for CICSPlex SM for advice on how to set up and administer your CICSPlex SM for daylight saving.

5. In addition to specifying the necessary CICS system initialization parameters for running CICSPlex SM local MAS, specify the appropriate CICS system initialization parameters to provide CICS Web Interface support, for your release of CICS.

Specifying language and code page information for the WUI
The Web User Interface requires an INITPARM system initialization parameter to specify the server language and the client code page.

Code EYU9VKEC to represent the language of the Web User Interface server and EYU9WVAN to represent the code page of the client on the INITPARM parameter.
You can select the server language and the client code page from Table 9 on page 79 and specify them on the INITPARM parameter:

\[
\text{INITPARM=}(\text{EYU9VKEC}='xxx', \text{EYU9VWAN}='yyy')
\]

xxx is the language identifier of the Web User Interface server and yyy is the code page identifier of the client.

<table>
<thead>
<tr>
<th>Language</th>
<th>Language identifier (EYU9VKEC)</th>
<th>Client code page</th>
<th>Default client code page identifier (EYU9VWAN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>US English</td>
<td>ENU</td>
<td>ISO-8859-1 (819)</td>
<td>ENU1</td>
</tr>
<tr>
<td>Japanese</td>
<td>JPN</td>
<td>Shift-JIS (943)</td>
<td>JPN1</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>CHS</td>
<td>GB2312 (1381)</td>
<td>CHS1</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>CHS</td>
<td>GB18030 (05488)</td>
<td>CHS2</td>
</tr>
</tbody>
</table>

For example, if your chosen language is English, code the INITPARM parameter:

\[
\text{INITPARM=}(\text{EYU9VKEC}='ENU', \text{EYU9VWAN}='ENU1')
\]

1. You can override the code page identifier for individual user requests by placing it in the web address used to access the Web User Interface, as shown in this example:

   \[
   \text{http://hostname:port/CICSPlexSM/code page}
   \]

   *hostname* is the name specified on the TCPIPHOSTNAME Web User Interface server initialization parameter and *port* is the value specified on the TCPIPPORT Web User Interface server initialization parameter. For information about the Web User Interface server initialization parameters, see “Specifying Web User Interface server initialization parameters” on page 83.

2. If the INITPARM system initialization parameter is not specified or if a value is not specified for EYU9VKEC or EYU9VWAN, the default values are ENU for the language and ENU1 for the code page. However, operator messages are issued every time default values are used.

3. A simplified Chinese WUI server can support client Web browsers using either GB2312 (CHS1) or GB18030 (CHS2). For GB2312 clients, the server uses the EBCDIC code page, 935. For GB18030 clients, the server assumes a second EBCDIC code page, 1388, which is a superset of code page 935.

   View sets and menus edited using a GB2312 client Web browser are stored in 935 and can be used in either client code page. However, if a view set or menu is edited using a GB18030 client and characters not available in 935 are used, the resulting views set or menu are not displayed correctly on GB2312 clients.

4. Some Web browsers do not support all the available client code pages. For example, many older Web browsers do not support GB18030.

**Preparing the code page conversion table for the WUI**

You can use the default version of DFHCNV, provided in the SDFHLOAD library, which includes the CICSPlex SM code pages automatically.

If you use your own version of the DFHCNV source module, assemble and link-edit it using the CICS procedures for maintaining conversion table load modules.

A sample copybook is provided in CICSTS55.CPSM.SEYUSAMP called EYU$CNV1, to show which entries are automatically added to DFHCNV when you assemble the table. This copybook contains an entry for every language and client code page combination that is supported:

**EYUENU1**

Entry for English
You do not have to include a copy statement for EYU$CNV1 in the DFHCNV source.

**Note:** You should use the DFHCNVW $ sample not the EYU$CNV1 sample. The EYU$CNV1 sample is included just to show what the CICSPlex SM conversion definitions are. However, the DFHCNV macro generates the definitions and they do not have to be explicitly added to any DFHCNV table. The DFHCNV table included with CICS also contains entries for DFHWBUD and DFHWBHH, but the only time you should modify these particular entries is when using different code pages.

Creating the Web User Interface server repository (EYUWREP)

The Web User Interface server repository, EYUWREP, contains the Web User Interface server view and menu definitions.

You can use the IDCAMS utility to create a VSAM file for these definitions:

```plaintext
DEFINE CLUSTER (                                      -
   NAME( dsname )                         -
   VOLUMES( dsvol )                       -
   RECORDS( 5000 5000 )                   -
   RECORDSIZE( 8192 32000 )               -
   CONTROLINTERVALSIZE( 8192 )            -
   SPANNED                                -
   INDEXED                                -
   KEYS( 20 20 )                          -
   SHAREOPTIONS( 2 )                      -
 )
```

*Figure 17. Sample definition to create a Web User Interface repository*

By default, each Web User Interface server has its own Web User Interface server repository that is not shared with any other Web User Interface server.

Upgrade definitions using the import and export functions. For information, see Administering the WUI.

Back up the Web User Interface server repository data as the repository is updated whenever changes are made using the View Editor or when definitions are imported using the COVC transaction. You can back up the Web User Interface repository by using IDCAMS, DFSMSdss, or an equivalent utility.

Sample JCL, EYUJWREP, creates the Web User Interface repository. The sample JCL is provided, uncustomized, in TDFHINST and customized by DFHISTAR in XDFHINST.

Sharing the Web User Interface server repository (EYUWREP) across servers

The Web User Interface server repository can be shared across WUI servers running at the same CICSPlex SM release, if the repository is accessed using VSAM RLS. Follow these steps to allow sharing of the WUI server repository:

1. Add the parameter **RLS=YES** to the DFHSIT table or when you override system initialization parameters.
2. Add the **LOG(UNDO)** parameter to the repository file definition when you use the IDCAMS facility to create the VSAM file.

During initialization, the Web User Interface server determines whether RLS should be enabled for the Web User Interface server repository and sets the appropriate attributes for the EYUWREP file and enqmodel definition.

The Web User Interface server caches objects in memory to improve performance. If a user logged on to one server creates or updates an object using the View Editor, the User Editor, or the Favorites Editor,
users logged on to other servers which share the server repository might not see the changes until their local cache is reloaded. Cache is reloaded by restarting the server.

Creating and customizing the WUI data set

Use DFHISTAR to create and customize your Web User Interface (WUI) server data sets, according to the parameters that you set when you submit the DFHISTAR job.

DFHISTAR postinstallation members for a WUI

When you run DFHISTAR, with a SCOPE of POST or ALL, it creates the following postinstallation members for a CICSPlex SM Web User Interface (WUI) server in the XDFHINST library:

- EYUWUIDS – creates and starts all the data sets for a WUI. EYUWUIDS includes steps to delete the data sets so that you can rerun the job, if required. These deletions are expected to fail the first time that you run the job. EYUWUIDS contains the following steps:
  - DELWREP deletes the CICSPlex SM WUI data repository, EYUWREP.
  - DEFWREP defines the CICSPlex SM WUI data repository, EYUWREP.
  - DELCOVDS deletes the WUI import and export data sets, EYUCOVI and EYUCOVE.
  - DEFCOVDS defines the WUI import and export data sets, EYUCOVI and EYUCOVE.
  - JES3DELA and JES3DEFA are included if you specify the DFHISTAR JES=JES3 option. They delete and define the CICS local catalog, the global catalog, and the local request queue.
  - DELREGDS deletes the CICS data sets.
  - DEFTRACE defines the CICS auxiliary trace data sets, DFHAUXT and DFHBUXT.
  - DEFHTML defines the CICS DFHHTML data set.
  - DEFTSTD defines the CICS auxiliary temporary storage data set, DFHTEMP.
  - DEFINTD defines the CICS intrapartition transient data set, DFHINTRA.
  - DEFLCD defines the CICS local catalog, DFHLCD.
  - INITLCD uses the DFHCCUTL utility to start the CICS local catalog.
  - DEFGCD defines the CICS global catalog, DFHGCD.
  - INITGCD uses the DFHRMUTL utility to start the CICS global catalog.
  - DEFLRQ defines the CICS local request queue data set, DFHLRQ.
  - JES3DELA and JES3DELB are included if you specify the DFHISTAR JES=JES3 option. They delete and define the CICS DFHCSD data set.
  - DELCSD deletes the CICS DFHCSD data set.
  - DEFCSD defines the CICS DFHCSD data set.
  - INITCSD uses the DFHCSDUP utility to start the DFHCSD data set.

- EYUJWREP – creates the WUI data repository, EYUWREP. EYUWUIDS includes steps to delete and define EYUWREP. You can run EYUJWREP if you want to delete and define only EYUWREP but none of the other data sets for a WUI.
  - DELWREP: delete the CICSPlex SM WUI data repository, EYUWREP.
  - DEFWREP: define the CICSPlex SM WUI data repository, EYUWREP.

- EYUWUISP – CICS system initialization parameter overrides for a WUI.
- EYUWUI0P – CICSPlex SM EYUPARM parameters for a WUI.
- EYUWUIIN – CICSPlex SM EYUWUI parameters for a WUI.
- EYUWUIP – starts a WUI.
- EYUWUIJ – invokes EYUWUIP.
If you use the default values for the CICSPlex SM parameters, the EYUWUIP PROC statement is shown in the following code sample:

```
EYUWUIP  PROC DSNCSD='CICSTS55.CPSM.WUINCM01.DFHCSD',
         RGNHLQ='CICSTS55.CPSM.WUINCM01',
         CICSHLQ='CICSTS55.CICS',
         CPSMHLQ='CICSTS55.CPSM',
         PRMLIB='CICSTS55.XDFHINST',
         CICSPRM=EYUWUISP,                  CICS Parameters
         CPSMPRM=EYUWUI0P,                  CPSM Parameters
         WUIPRM=EYUWUIIN                   WUI Parameters
```

**Customizing postinstallation jobs using DFHISTAR**

You can use DFHISTAR to generate copies of the WUI postinstallation jobs for a different CICS region. Use the DFHISTAR SELECT parameter to specify a new name for a copy of a postinstallation job. It has this format:

```
SELECT jobname newname
```

- **jobname**
  Is the name of the job you that want to regenerate

- **newname**
  Is the name for the new copy.

You can specify more than one SELECT parameter to select multiple jobs to be regenerated in a single run of the DFHISTAR job. When you include a SELECT parameter in the DFHISTAR job, only those jobs specified by the SELECT are generated.

For a WUI with the name WUINCM02 and a CICS system identifier of WU02, which connects to a CMAS with the name CMAS02 and CICS system identifier CM02, you can change your DFHISTAR parameters to specify these options:

```
CMASNAME CMAS02
CMSSYSID CM02
WUIPLEX WUIPCM02
WUINAME WUINCM02
WUISYSID WU02
TCPIPHST TCP/IP host name for this WUI
TCPIPPRT TCP/IP port number for this WUI
SELECT EYUWUIDS WU02WUDS             JCL to create the data sets for WUINCM02
SELECT EYUWUI0P WU02WU0P             CICSPlex SM EYUPARM parameters for WUINCM02
SELECT EYUWUIIN WU02WUIN             WUI Parameters
SELECT EYUWUIJ CW02WUIJ             WUI Parameters
```

You can then start the WUI WUINCM02, using the procedure EYUWUIP with these commands:

```
START EYUWUIP, DSNCSD='CICSTS55.CPSM.WUINCM02.DFHCSD',
         RGNHLQ='CICSTS55.CPSM.WUINCM02',
         CICSHLQ='CICSTS55.CICS',
         CPSMHLQ='CICSTS55.CPSM',
         PRMLIB='CICSTS55.XDFHINST',
         CICSPRM=WU02WUSP, CPSMPRM=WU02WU0P,
         WUIPRM=WU02WUIN
```

If you are using EYUWUIJ to start the WUI, edit it to specify these values:

```
CICSPRM=WU02WUSP, CSMPRM=WU02WU0P, WUIPRM=WU02WUIN
```

**Specifying the WUI customizable view and menu help data set**

The Web User Interface allows a site to provide customized help for individual views and menus.

This help takes the form of HTML documents that can be served by the Web User Interface server or by an external server. If the Web User Interface is to serve the HTML documents, you must provide a partitioned data set to contain the HTML documents.

82  CICS TS for z/OS: CICSPlex SM Concepts and Planning
You can use the View Editor to customize your views and menus to include a link to the customizable view and menu help data set. With the View Editor you can specify these options:

- No help to be available for this view or menu
- Member name of a help page to be served by the Web User Interface from DFHHTML
- Web address of an external help page to be served by another HTTP server

For information about the View Editor, see Customizing the Web User Interface.

The customizable view and menu help data set (DFHHTML) must be a single data set and not concatenated with any other data set.

Specifying Web User Interface server initialization parameters

You can specify the Web User Interface (WUI) server initialization parameters in the startup job or in a fixed block 80 data set.

For a summary of changes by release to CICSpex SM WUI server initialization parameters, see Changes to CICSpex SM.

See “Specifying the JCL DD statements for the WUI” on page 92 for the DD name. All of these parameters are subject to the following conditions unless otherwise stated:

- Lines with an asterisk in column 1 are comments and are ignored.
- Values must not contain lowercase characters.
- Values must be specified in parentheses immediately following the parameter.
- Values must not be greater than 32 characters.

Example

* An EYUWUI parameter data set
DEFAULTMENU(OURHOME)
TCPIPHOSTNAME(MVSXX.COMPANY.COM)
TCPIPPORT(4445)
CMCIPORT(4446)

Required parameters for the WUI

Set the TCPIPHOSTNAME and TCPIPPORT parameters to initialize the Web User Interface server. The Web User Interface supports names up to 44 characters in length for all parameters.

**TCPIPHOSTNAME(name)**

Specify the TCP/IP host name of this Web User Interface server. This name is normally the host name and domain name of the MVS system; that is, a fully-qualified name, but can be a specific IP address in colon hexadecimal or dotted decimal format. The host name is normally used by the Web User Interface to construct Web addresses, depending on the client HTTP version and the value of the TCPIHTTPHOST Web User Interface server parameter.

This value is always returned in the TCPIPHOSTNAME header of a DATA/CONNECT Web User Interface Data Interface request.

**TCPIPPORT(value)**

Specify the TCP/IP port number of the port that you have allocated for the Web User Interface.

Optional parameters for the WUI

You can specify a number of optional initialization parameters when setting up your Web User Interface server. Certain parameters are required in certain circumstances. For example, if you want to use the CICS management client interface (CMCI) with CICSpex SM, you must set the CMCIPORT parameter.

TCP/IP options

You can specify additional TCP/IP parameters to configure your TCP/IP connections. The Web User Interface supports names up to 44 characters in length for all options:
**TCPIPADDRESS(name | INADDR_ANY)**
Specifies the dotted decimal or colon hexadecimal IP address on which the Web User Interface listens for incoming requests. If INADDR_ANY is specified (the default), the Web User Interface listens on any of the addresses known to the TCP/IP for z/OS host.

You do not normally have to specify the TCPIPADDRESS parameter unless the z/OS host has multiple TCP/IP addresses.

**TCPIPHTTPHOST(NO|YES)**
Indicates whether you require the TCP/IP host name used to construct Web addresses to be generated based on the incoming HTTP request for HTTP version 1.1 requests or later.

This option has no effect on HTTP requests sent before 1.1 to the Web User Interface server. The Web User Interface server always constructs Web addresses using the host name specified in the TCPIPHOSTNAME parameter for HTTP 1.0 (and earlier) requests.

**NO**
For HTTP 1.1 (or later) requests, the host name used in Web addresses constructed by the Web User Interface server is based on the value specified in the TCPIPHOSTNAME parameter.

**YES**
For HTTP 1.1 (or later) requests, the host name used in Web addresses constructed by the Web User Interface server is based on the incoming URI or HTTP 'Host' header, according to the HTTP 1.1 specification.

When HTTP 1.1 clients are used with a Web User Interface server running TCPIPHTTPHOST(YES), the IP address or name used on the server, does not have to be the same as that used by the HTTP 1.1 client. In this way the Web User Interface can be used when name address translation (NAT) is performed, perhaps because of a firewall.

If TCPIPSSL(YES) is used with TCPIPHTTPHOST(YES) and HTTP 1.1 clients are used with different IP address names, you might receive SSL certificate warnings because of host name mismatches.

**TCPIPSSL(NO|YES|ATTLSBASIC)**
Indicates whether you require data encryption between the Web User Interface server and the web browser.

**NO**
No data encryption between the Web User Interface server and the web browser is required.

**YES**
If you select YES, specify the appropriate system initialization parameters to enable SSL support in the CICS Web Interface. For information, see SSL with CICS web support.

In addition, the TCPIPSSLCERT and TCPIPSSLCIPHERS settings will always apply, unless the optional CMCISSL parameter is set with the NO or ATTLSAWARE value.

**ATTLSBASIC**
If you select ATTLSBASIC, you must specify the TCPIPPORT parameter to identify a port that is configured to run as an AT-TLS port by the z/OS Communications Server. For more information about AT-TLS, see z/OS Communications Server: Application Transparent Transport Layer Security (AT-TLS).

**TCPIPSSLCERT(name)**
Specifies the label for the SSL certificate that is to be used for the connection between the Web User Interface and the web browser. If you specify an explicit certificate, the label must be no longer than 44 characters.

The default is the default certificate in the key ring. This field is case-sensitive and is not converted to uppercase.

**TCPIPSSLCIPHERS(cipher_list)**
The TCPIPSSLCIPHERS attribute can be specified in either of two ways:
• A string of up to 44 hexadecimal digits that is interpreted as a list of up to 22 2-digit cipher suite codes.

• The name of the SSL cipher suite specification file, which is a z/OS UNIX file in the security/ciphers subdirectory of the directory that is specified by the US$CONFIG system initialization parameter. For example if US$CONFIG is set to /var/cicsts/dfhconfig and TCPIPSSL_CIPHERS is set to strongciphers.xml, the fully qualified file name is /var/cicsts/dfhconfig/security/ciphers/strongciphers.xml.

The cipher suite codes are used to describe the set of algorithms that are supported by the Web User Interface server for SSL communications. If the TCPIPSSL_CIPHERS parameter is not specified, the cipher suite is set using the ENCRYPTION system initialization option that the Web User Interface server is using.

For details, see Cipher suites and cipher suite specification files.

CMCI options

You can specify additional parameters to enable the use of the CMCI with CICSPlex SM. The defaults for the CMCI are derived from the SEC CICS system initialization parameter and the TCPIPSSL WUI server initialization parameter. If TCPIPSSL is set to YES, the CMCI will use the TCPIPSSL_CERT and TCPIPSSL_CIPHERS parameters.

If the optional CMCI_AUTH and CMCI_SSL parameters are specified, then the CMCI will use these parameters to define the level of security. If CMCI_SSL is set to YES or CLIENTAUTH, the CMCI will use the TCPIPSSL_CERT and TCPIPSSL_CIPHERS parameters. For more information on the TCPIP_SERVICE attributes affected by CMCI_AUTH and CMCI_SSL, see TCPIP_SERVICE attributes.

CMCI_PORT(value)

Specifies the TCP/IP port number allocated to the CICS management client interface (CMCI). This parameter is required so that you can use the CMCI in a CICSPlex SM environment. Specify a number in the range 1 - 65535 but do not use the same port number as specified for the WUI in the TCPIP_PORT parameter. When you set this parameter, TCPIP_SERVICE and URIMAP definitions are autoinstalled to support the CMCI, or, if the CMCI JVM server is configured, it is instructed to use this port.

CMCI_AUTH(NO | BASIC | CERTIFICATE | AUTOREGISTER | AUTOMATIC)

Specifies the settings for the CMCI TCPIP_SERVICE AUTHENTICATE attribute or for the CMCI JVM server authentication configuration. If CMCI_AUTH is specified, CMCI_SSL must also be specified.

CMCI_SSL(NO | YES | CLIENTAUTH | ATTLSAWARE)

Specifies the settings for the CMCI TCPIP_SERVICE SSL attribute or for the CMCI JVM server SSL configuration. If CMCI_SSL is specified, CMCI_AUTH must also be specified.

Note: TCPIPSSL_CERT and TCPIPSSL_CIPHERS settings are ignored when this parameter is set with the NO or ATTLSAWARE value.

Import options

The import options allow you to automatically import WUI data repository definitions from the Web User Interface. The WUI data repository includes view sets and menus, WUI map objects, user objects, and user group profiles. Definitions can be imported from a specified transient data queue or a data set, or both.

Auto-import is an alternative to the import function of the COVC transaction. When you use auto-import, you can use all three parameters to specify a transient data queue and a data set. When using COVC, you are restricted to specifying either a transient data queue or a data set in one import operation.

AUTOIMPORT_DSN(dsn_name)

Specifies the name of the data set containing IBM-supplied view and menu definitions. Currently, the supplied set of WUI view and menu definitions is in the SEYUVIEW data set. If you specify an AUTOIMPORT_DSN name, you must specify the name of a data set member using the AUTOIMPORT_MEM parameter.
Use the AUTOIMPORTDSN and AUTOIMPORTMEM parameters when you want to import specific IBM-supplied view set and menu definitions as a result of service (by a PTF).

**AUTOIMPORTMEM(member_name)**

Specifies the name of the data set member containing the specific IBM-supplied view and menu definitions that you want to import. You can use an asterisk at the end of the name to specify a group of data set members that begin with the same characters. For example, specifying AUTOIMPORTMEM(EYUEA*) with the IBM-supplied SEYUVIEW data set in AUTOIMPORTDSN imports all of the members beginning with the characters EYUEA.

Use the AUTOIMPORTDSN and AUTOIMPORTMEM parameters when you want to import specific IBM-supplied view set and menu definitions as a result of service (by a PTF).

**AUTOIMPORTTDQ(tdq_name)**

Specifies the name of the CICS extrapartition transient data queue from which you want the server to import a complete set of WUI data repository definitions during server initialization. To use this option, you enter a value explicitly. There is no automatic default; however, queue name COVI (DD name EYUCOVI) is defined as shown in sample EYUEWDEF.

You use the AUTOIMPORTTDQ parameter when starting a WUI server for the first time or if you are already a CICSPlex SM user and want to import other data repository definitions, including your own customized definitions, into an existing data set. Avoid using this parameter at other times because of the resources required to perform the import operation.

**Data formatting options**

These options determine how data appears on Web User Interface displays.

**CVDASTYLE(MIXED | UPPER)**

Indicates whether the CVDAs and EYUDAs are displayed in uppercase or mixed case characters.

- **MIXED**
  
  Mixed case text, that is, the first character uppercase and the rest lowercase, for example, 'Enabled'.

- **UPPER**

  Text is displayed in uppercase only.

**DATEFORMAT (format | MMDDYY)**

Specifies the format to be used to display the date on Web User Interface displays:

- **YYMMDD**
- **DDMMYY**
- **MMDDYY**
- **YYYYMMDD**
- **DDMMYYYY**
- **MMDDYYYY**

where:

- **DD** is the day.
- **MM** is the month.
- **YY** is the year in two-digit format.
- **YYYY** is the year in four-digit format.

**DATESEPARATOR(character | / )**

Specifies the character to be used to separate the date elements on Web User Interface displays.

**DECIMALSEPARATOR(character | , )**

Specifies the character to be used to denote the decimal point on Web User Interface displays.
GMMTEXTMSG(NO | YES | BEFORE | AFTER)
Specifies how the CICS "good morning" message is handled.

NO
The message is not issued

YES
The message is issued before and after sign-on.

BEFORE
The message is issued before sign-on only.

AFTER
The message is issued after sign-on only.

MSGCASE (MIXED | UPPER)
Indicate whether messages destined for the operator or EYULOGs should be displayed in mixed case or uppercase characters.

MIXED
Mixed case text is displayed, that is, the first character uppercase and the rest lowercase, for example, 'Enabled'.
If you specify MIXED, output may be displayed incorrectly on Katakana display terminals, where lowercase characters are displayed as Katakana symbols.

UPPER
Text is displayed in uppercase only.
Note that while MSGCASE(MIXED) is the default, it takes effect after all the EYUWUI parameters have been read. Certain EYUWUI parameters such as TCPIPSSLCERT may contain values that are in mixed case. They will be echoed back in the EYULOG in uppercase unless MSGCASE(MIXED) is the first parameter in the EYUWUI input stream.

THOUSNDSEPARATOR(character | , )
Specifies the character to be used to separate thousands on Web User Interface displays, when required. For example, 100 000 is displayed as 100,000 if the default is used.
1. The space character (hex 40) is a valid THOUSNDSEPARATOR value, allowing digits to be grouped by a space.
2. Use 0 (zero) to suppress the THOUSNDSEPARATOR value.
3. The THOUSNDSEPARATOR value is used only when required by the individual view definition.

TIMESEPARATOR(character | : )
Specifies the character to be used to separate hours, minutes, and seconds on Web User Interface displays.

Environment options
These options specify the context and scope values, the home menu and navigation frame, default map objects, and the appearance of newly opened maps.

AUTOREFRESH(YES | NO)
Disables the automatic refresh option for a WUI server. The default setting, YES, displays automatic refresh control, based on the view definition. When NO is specified, automatic refresh control is not displayed, even if automatic refresh control is set on the view definition. For more information about the automatic refresh option, see Refreshing views.

DEFAULTCMASCTXT(name | EYUCMS1A)
Specifies the CMAS context that is set when the user signs on to the Web User Interface.

DEFAULTCONTEXT(name | EYUPLX01)
Specifies the context that is set when the user signs on to the Web User Interface.
DEFAULTMAPBAS(name | EYUSTARTMAPBAS)
Specifies the name of the map object used to generate maps of business application services definitions.

DEFAULTMAPCOLL(value | 0)
Specifies the number of rows in a generated map below which a map opens in the expanded state. If the number of rows to be displayed is above this number, the map opens in a fully collapsed state. The default value of 0 means that in every generated map all of the rows are visible when opened.

DEFAULTMAPMON(name | EYUSTARTMAPMON)
Specifies the name of the map object used to generate maps of monitoring definitions.

DEFAULTMAPRTA(name | EYUSTARTMAPRTA)
Specifies the name of the map object used to generate maps of real-time-analysis definitions.

DEFAULTMAPWLM(name | EYUSTARTMAPWLM)
Specifies the name of the map object used to generate maps of workload management definitions.

DEFAULTMENU(name | EYUSTARTMENU)
Specifies the name of the menu that is presented to users after sign-on to the Web User Interface.

DEFAULTNAVIGATE(name | EYUSTARTNAVIGATE)
Specifies the name of the navigation frame that is presented to users after sign-on to the Web User Interface.

DEFAULTSCOPE(name | EYUPLX01)
Specifies the scope that is set when the user signs on to the Web User Interface.

DEFAULTWARNCNT(value)
Specifies the number of records required to trigger the record count warning mechanism. This integer value is in the range of 0 to 99999999, the default value is 0 meaning that no warnings are issued. This option affects the behavior of both the WUI and the CICS management client interface (CMCI).

For the WUI only, you can also set a record count warning value applying to a group of users when setting up a WUI user group; setting DEFAULTWARNCNT in a user group applies to the WUI only if the WUI is running with security switched on. A value set in a user group takes precedence over a value set in the DEFAULTWARNCNT parameter for the users in that group.

GLOBALPREFILTER(YES | NO)
Specifies filter parameters the first time that a view is displayed; that is, before data is collected. You can also specify this parameter when setting up a WUI user group if the WUI is running with security enabled. A value set in a user group takes precedence, for users in that group, over the value set in the GLOBALPREFILTER parameter.

RESOURCENULL(WARNING | FAIL)
Specifies whether a warning or failure is issued when the resource limit is reached.

WARNING
For the WUI only, the default setting, WARNING, issues message EYUVC1258W, and the user can select OK to bypass the warning threshold.
For the CMCI only, the CMCI responds with an HTTP 403 response including message DFHWU4302. The user can bypass the warning threshold by using the CMCI request URI option OVERRIDEWARNINGCOUNT.

FAIL
For the WUI only, specify FAIL to issue message EYUVC1267E and deny the new resource request.
For the CMCI only, the CMCI responds with an HTTP 403 response including message DFHWU4302 denying the new resource request.

Operation options
These options name the default view set to be used if the Web User Interface receives an external request that does not specify a view set name but specifies an object name. The view sets that you name
in these options must represent the objects that can be specified. For more information, see Providing access to WUI views and menus.

You can ignore these parameters if you do not intend to launch Web User Interface displays in this manner.

**DEFAULTCICSPLEX(name | EYUSTARTCICSPLEX)**  
Specifies the name of the default CICSpex view set.

**DEFAULTCICSREGN(name | EYUSTARTCICSREGN)**  
Specifies the name of the default CICS region view set.

**DEFAULTCONNECT(name | EYUSTARTCONNECT)**  
Specifies the name of the default connection view set.

**DEFAULTCSYSGRP(name | EYUSTARTCSYSGRP)**  
Specifies the name of the default CICS system group view set.

**DEFAULTDB2SS(name | EYUSTARTDB2SS)**  
Specifies the name of the default Db2 subsystem view set.

**DEFAULTEJCOBEAN(name | EYUSTARTEJCOBEAN)**  
Specifies the name of the default enterprise bean in a CorbaServer view set.

**DEFAULTEJDJBEAN(name | EYUSTARTEJDJBEAN)**  
Specifies the name of the default enterprise bean in a CICS-deployed JAR file view set.

**DEFAULTEVENT(name | EYUSTARTEVENT)**  
Specifies the name of the default event view set.

**DEFAULTLOCFILE(name | EYUSTARTLOCFILE)**  
Specifies the name of the default local file view set.

**DEFAULTLOCTRAN(name | EYUSTARTLOCTRAN)**  
Specifies the name of the default local transaction view set.

**DEFAULTPROGRAM(name | EYUSTARTPROGRAM)**  
Specifies the name of the default program view set.

**DEFAULTREMFILE(name | EYUSTARTREMFILE)**  
Specifies the name of the default remote file view set.

**DEFAULTREMTRAN(name | EYUSTARTREMTRAN)**  
Specifies the name of the default remote transaction view set.

**DEFAULTTASK(name | EYUSTARTTASK)**  
Specifies the name of the default task view set.

**User options**  
These options specify user settings that you can configure.

**INACTIVETIMEOUT(value | 30)**  
Specifies the period, in minutes, after which inactive user sessions are ended. The maximum period allowed is 10080 minutes (7 days).

**MAXUSERS(value | 20)**  
Specifies the maximum number of concurrent users of the Web User Interface. The maximum number of concurrent users allowed is 50.

**SIGNONPANEL(BASIC | ENHANCED)**  
Specifies, if the Web user Interface server has CICS security active (SEC=YES in the system initialization parameter), whether the Web User Interface sign on panel takes one of the following actions:

- Displays a GROUP option
- Saves previously used USER and GROUP values
- Positions the cursor in the sign-on field requiring input
When the default value, ENHANCED, is specified, the GROUP option is displayed on the sign-on screen and the following events occur:

- If the user enters a value, sign on proceeds and if:
  - The user ID is connected to the specified group, the group is used for the WUI user group profile
  - The user ID is not connected to the specified group or the group name is not valid, sign on continues, but the WUI group profile is set to the default group of the user, and message EYUVCl227W is issued to the WUI user after sign on is complete. Message EYUVS0024W is written to the WUI server’s EYULOG.
- If the user does not enter a value, the user group profile is set to the default group of the user

The GROUP option does not change the current connect group of the user being signed on. The security environment built by the WUI is always based on the default group of the user. The group option on the WUI sign-on screen specifies which WUI user group profile the user should be associated with and does not change any security decisions that might be made by the External Security Manager.

When the SIGNONPANEL(ENHANCED) option is set and JavaScript is enabled in the web browser, the sign-on process performs the following actions:

- Saves the user ID and group values in a cookie, so that when the sign-on process next runs, the form is filled with previously entered values
- Positions the cursor to the sign-on field requiring input

When the value, BASIC, is specified, the GROUP option is not displayed on the sign-on screen, and the user group profile is set to the default group of the user. Values are not saved and the cursor is not positioned on the sign-on panel.

Whether the Web User Interface user group profile is set based on the default group, or specified on the GROUP option, if no matching Web User Interface group profile is found, the values usually set using a user group profile are set to the system default.

The SIGNONPANEL option is ignored if the Web User Interface server is running with CICS Security inactive (SEC=NO in the system initialization parameter).

**Accessibility options**
These options specify the default colors for the Web User Interface displays.

The accessibility options are not normally changed as they affect all users of the Web User Interface server. If you want to change these options for reasons of accessibility, take care to ensure that the Web User Interface displays do not become unreadable.

Each option specifies a color as six hexadecimal digits. The first 2 digits describe the red component. The second 2 digits describe the green component. The last 2 digits describe the blue component. For example, FFFFFF represents white, 000000 represents black, FF0000 represents bright red, 00FF00 represents bright green, and 0000FF represents bright blue.

**COLORPAPER(color)**
Main work frame background color.

**COLORPAPERHEAVY(color)**
Navigation and assistance frame background color.

**COLORPAPERLIGHT(color)**
Background color used for many interface items; for example, information messages, table column headings, detail view labels, view selection and refresh area.

**COLORPAPERWARN(color)**
Background color for warning messages.

**COLORPAPERERROR(color)**
Background color for error messages.
Problem determination option
This option allows you to specify the level of tracing you require for the Web User Interface server.

Attention: Only activate trace at the request of IBM Support Center personnel.

WUITRACE(trace levels)
Specifies the level of tracing for the Web User Interface server.
The trace levels that you specify must be separated by a comma, as shown in this example:

WUITRACE(8,11,13,15,18)

You can define a range of trace levels as shown in these examples:

WUITRACE(1:5)
activates trace levels 1 through 5

WUITRACE(1:5,13,28:31)
activates trace levels 1 through 5, 13, and 28 through 31

Creating transient data queue definitions for the WUI
You require definitions for the COVP, COLG, COVI and COVE transient data queues (TDQs).

COVP
The Web User Interface server initialization parameters data set, EYUWUI. This data set is a fixed block 80 input data set.

COLG
The CICSPlex SM output log, EYULOG. This data set is a variable-length output data set.

COVI
Sample definition for the Web User Interface import data set, EYUCOVI. This data set is a variable-length input data set.

COVE
Sample definition for the Web User Interface export data set, EYUCOVE. This data set is a variable-length output data set.

CICS Transaction Server definitions
The transient data queue (TDQ) definitions are provided in the EYU$WDEF sample, which is supplied in the SEYUSAMP library. COVI and COVE are provided as samples that can be used to create additional import and export transient data queues.
Specifying the JCL DD statements for the WUI
Add DD statements to the Web User Interface server for the EYUWUI, EYUWREP, EYULOG, DFHHTML, EYUCOVI and EYUCOVE data sets.

EYUWUI
The Web User Interface server initialization parameters data set. See “Specifying Web User Interface server initialization parameters” on page 83.

EYUWREP
The Web User Interface server repository data set. See “Creating the Web User Interface server repository (EYUWREP)” on page 80.

EYULOG
The CICSPlex SM output log.

DFHHTML
The customizable view and menu help data set. See “Specifying the WUI customizable view and menu help data set” on page 82. This statement is optional.

EYUCOVI
The Web User Interface server import data set. For more information, see “Creating transient data queue definitions for the WUI” on page 91. This statement is optional.

EYUCOVE
The Web User Interface server export data set. For more information see “Creating transient data queue definitions for the WUI” on page 91. This statement is optional.

Here is an example:

```/*
//DFHHTML DD DISP=SHR,DSN=data set name
//EYUWREP DD DISP=SHR,DSN=data set name
//EYUCOVI DD DISP=SHR,DSN=data set name
//EYULOG DD SYSOUT=* ,
//EYUWUI DD *
DEFAULTMENU(OURHOME)
TCPIPHOSTNAME(MVSXX.COMPANY.COM)
TCPIPPORT(4445)
*/```

Starting and stopping the Web User Interface
After you have set up the Web User Interface, you must complete some additional tasks.

Submitting startup JCL
Submit the startup JCL for the Web User Interface server to start it for the first time.

Messages on the job log are displayed to confirm that the Web User Interface server has started successfully.

```
08.52.33 JOB03331 +EYUVS0001I IYCQCTA5 CICSPLEX SM WEB USER INTERFACE INITIALIZATION STARTED.
08.52.37 JOB03331 +EYUVS0002I IYCQCTA5 CICSPLEX SM Web User Interface initialization complete.
```

If you choose not to start the Web User Interface server during PLTPI processing, you can start it using the COVC transaction Start command.

Checking the web browser connection
Check the connection between the Web User Interface and the web browser by typing in the web address: http://hostname:port/CICSPlexSM.

hostname is the name specified on the TCPIPHOSTNAME Web User Interface server initialization parameter and port is the value specified on the TCPIPPORT Web User Interface server initialization parameter.
For information about the Web User Interface server initialization parameters, see “Specifying Web User Interface server initialization parameters” on page 83. You are presented with the Web User Interface server Welcome panel containing a **Begin Signon** button.

### Obtaining view and menu definitions

When the Web User Interface has been started, you can obtain some view and menu definitions. You can obtain these views in two ways:

- Log in to the CICS terminal and run the COVC transaction. Use the Import option of the COVC transaction to import the starter set views and menus. The starter set views and menus are provided in CICSTS55.CPSM.SEYUVIEW. For information about the COVC transaction, see The CICSPlex SM Web User Interface transaction (COVC).
- Use the View Editor, which is described in Using the view editor in Configuring.

### Shutting down the Web User Interface server

You can shut down the Web User Interface server by shutting down the CICS system in which the Web User Interface server is running, or by using the COVC transaction. For more information about the COVC transaction, see The CICSPlex SM Web User Interface transaction (COVC).

### Setting up CMCI

To configure and manage CICS regions from an HTTP system management client such as CICS Explorer, you must set up the CICS management client interface (CMCI) in your CICS environment.

#### About this task

You can set up the CMCI in a CICSPlex SM environment or in a stand-alone CICS region (SMSS).

If you use the CMCI with CICSPlex SM, with an HTTP client such as CICS Explorer, users can manage definitional, operational, and CSD resources in all of the CICS regions managed by CICSPlex SM.

If you use the CMCI in a stand-alone CICS region (SMSS), with an HTTP client such as CICS Explorer, users can manage only the operational and CSD resources associated with that region, and the context is specified as the application ID of that CICS region.

#### Setting up CMCI with CICSPlex SM

To install the CICS management client interface (CMCI) in a CICSPlex SM environment, you must configure the CMCI in a WUI region.

#### Planning for CMCI setup

1. For high availability, you can have multiple CICSPlex SM WUI regions.
2. Although users can access the CMCI and the WUI from the same region. It is recommended to set up separate regions for them.
3. To use enhanced client authentication in the CMCI such as multifactor authentication (MFA) and the CMCI GraphQL API feature, you must use the CMCI JVM server with the CMCI.
4. Based on your environment, estimate storage requirements for the CMCI.

**Note:** This CMCI configuration procedure assumes that you use the CMCI JVM server with the CMCI. If you do not want to use this, use the instructions in Setting up CMCI with CICSPlex SM in the CICS TS 5.4 product information.
Before you begin

You must have configured one or more CICSPlex SM WUI regions. To set up a CICSPlex SM WUI region, follow Setting up a CICSPlex SM Web User Interface server.

Setup guide

Scenario 1: You want to set up the CMCI in a WUI region that does not have CMCI configured

Follow the instructions in “Configuring CMCI in a WUI region” on page 94.

Scenario 2: You have a WUI region that is already set up with the CMCI but it does not use the CMCI JVM server. You want to upgrade the WUI region to use the CMCI JVM server.

For instructions, see “Configuring a WUI region to use the CMCI JVM server” on page 99.

Scenario 3: You want to have several CMCI JVM servers running in a CICSp lex

If you have several CMCI JVM servers running in a CICSp lex, you can configure the single sign-on (SSO) support in Liberty to enable HTTP client users to authenticate once with one CMCI JVM server, thus having access to other CMCI JVM servers in the same CICSp lex without re-authentication. For instructions, see “Setting up for multiple CMCI JVM servers in a CICSp lex” on page 102.

Configuring CMCI in a WUI region

If a WUI region does not have the CMCI, you can set up the CMCI in this WUI region. This procedure assumes that you will use the CMCI JVM server with the CMCI. The CMCI JVM server is a Liberty server that provides support for enhanced client authentication in the CMCI and support for the GraphQL API.

If you opt not to use the CMCI JVM server, follow the instructions in Setting up CMCI with CICSPlex SM in the CICS TS 5.4 product information.

Before you begin

System requirements for the CMCI JVM server

1. Verify that all of the required Java components are installed. You can follow the Java components checklist.
2. Ensure that Java support is set up in the region. For instructions, see Setting up Java support.

Additional requirements for enabling connections with multi-factor authentication (MFA) credentials

• You must have IBM Multi-Factor Authentication for z/OS or an equivalent product configured with RACF to support multi-factor authentication. If you use an alternative external security manager (ESM), refer to your vendor for details.
• MFA is supported by CICS TS V5.4 with APAR PI87691 or later. Ensure that the region where the CMCI JVM server will be running, and the CMAS to which it connects are at the same CICS level that is CICS TS V5.4 with APAR PI87691 or later. For information about CICS level considerations for setting up your CICSPlex SM topology, see Designing your CICSPlex SM environment.

Additional requirements for the GraphQL API feature

• The region is at CICS TS 5.5 or later.

Procedure

1. Specify appropriate levels of 64-bit (above-the-bar) storage in the region, and auxiliary storage, as follows:
   • Use the z/OS MEMLIMIT parameter to set the limit for 64-bit storage in the region
   • Use the MAXAUXCP and MAXAUXTOTL CICSPlex SM system parameters, to set auxiliary storage for the CMAS.

See “Estimating storage requirements for CMCI” on page 111 for guidance about setting these values to avoid possible storage problems.
2. Ensure that the CICS system initialization parameter \texttt{CSDSTRNO} is at least four (CSDSTRNO=4) so that CICS Explorer can inquire on CICS resources on the CSD, for example, programs, files, or transactions.

If \texttt{CSDSTRNO} is lower than four, the request might fail with CNX0591E \texttt{RESP=CSDERR RESP2=5} (insufficient VSAM strings).

3. Review the values of \texttt{KEYRING}, \texttt{NISTSP800131A}, and \texttt{SEC} system initialization parameters.

These system initialization parameters, together with \texttt{APPLID} and \texttt{DFLTUSER}, are mapped to the CMCI JVM server configuration parameters. Be aware that in some cases, additional configuration might be required in the CMCI JVM server. For more information, see “Configuration parameter mapping between CICSPlex SM WUI server and CMCI JVM server” on page 103.

4. Specify WUI server initialization parameters to enable the use of the CMCI with CICSPlex SM.

These parameters include CMCI options, TCP/IP options, environment options, and so on.

When you specify the WUI server initialization parameters, consider the following issues:

- You must specify a unique value for the \texttt{CMCIPORT} parameter. This parameter allocates a TCP/IP port number to the CMCI. Setting a value for the \texttt{CMCIPORT} parameter ensures that the CMCI is installed on the WUI region. The CMCI must use a different port to the Web User Interface.

- By default, URIMAP, and TCPIPSERVICE resource definitions are autoinstalled with security settings derived from the \texttt{SEC} CICS system initialization parameter and the \texttt{TCPIPSSL} WUI server initialization parameter. You can override the default CMCI TCPIPSERVICE settings by using the optional \texttt{CMCAUTH} and \texttt{CMCSSL} parameters to enable SSL certification for greater security. See CICSPlex SM SM Web User Interface security access overview for more information about setting up security for the WUI.

- Consider setting a nonzero value for the \texttt{DEFAULTWARNCNT} WUI server initialization parameter. Setting an appropriate value for this parameter prevents the retrieval of unacceptable amounts of data and can avoid long waits and potential storage problems when making requests on CICS resources. See “Record count warnings in CMCI” on page 106 for guidance about the warning count mechanism in the CMCI.

For detailed instructions, see Web User Interface server initialization parameters.

**Note:** It is helpful to know how the WUI server initialization parameters such as the CMCI options and TCP/IP options are mapped to the CMCI JVM server configuration parameters. Be aware that some values are not compatible with the CMCI JVM server. For more information, see “Configuration parameter mapping between CICSPlex SM WUI server and CMCI JVM server” on page 103.

5. Ensure that resource definition group DFHWU is installed.

Group DFHWU contains the resource definitions that are required for a CMCI environment.

**Configuring the CMCI JVM server**

6. Add the following system initialization parameters to the region:

- \texttt{JVMPROFILEDIR}
- \texttt{START=INITIAL}
- \texttt{EDSALIM}

7. Create the JVM profile for the CMCI JVM server.

   a) Copy \texttt{EYUCMCIJ.jvmprofile} from /usr/lpp/cics55/JVMProfiles to the location that is specified in the \texttt{JVMPROFILEDIR} system initialization parameter.

   b) Validate or update the values of \texttt{JAVA_HOME} and \texttt{WORK_DIR} in the JVM profile.

   For details, see Symbols used in the JVM profile.

8. Establish the storage requirements for the CMCI JVM server.

The supplied \texttt{EYUCMCIJ.jvmprofile} file disables the use of the shared library region, which reduces the amount of non-CICS 31-bit storage required. By default, the JVMSERVER resource that is automatically created for the CMCI JVM server has a value of 15 for the \texttt{THREADLIMIT} attribute. Therefore, you can use the following values as an initial estimate for storage requirements:
• 24-bit storage: 512 KB
• 31-bit storage: 100 MB

Continue to monitor and review storage requirements as described in Calculating storage requirements for JVM servers.

9. Configure the Liberty angel process started task for the CMCI JVM server.

a) If you don't have a Liberty angel process running, follow the steps in The Liberty server angel process to create one.

b) If you already have a Liberty angel process running, ensure the version of Liberty specified in the ROOT symbolic parameter in the angel JCL is at the same or a higher level to the version of Liberty supplied with CICS.

Example: Identifying the Liberty version from the started task system log

If the Liberty angel process is running Liberty 18.0.0.2 or above, the started task system log contains a message that indicates the Liberty version:

CWWKB0079I THE ANGEL BUILD LEVEL IS 18.0.0.2 20180619-0654 2018.7.0.0 20180619-0654

Example: Identifying the Liberty version from message DFHSJ1405

The version of a Liberty running in a CICS JVM server is available in the following message:

DFHSJ1405I 08/22/2018 17:04:39 IYK3ZDRI JVMSERVER EYUCMCIJ is running WebSphere Application Server Version 18.0.0.2 Liberty - (18.0.0.2-cll180220180619-0403) process ID 67174497.

Example: Identifying the Liberty version by running scripts

Suppose that the angel JCL specifies the following ROOT parameter:

// SET ROOT='/usr/lpp/zosmf/wlp'

To find out what the version of Liberty is, run the following script:

/usr/lpp/zosmf/wlp/bin/productInfo version --verbose

For CICS, run the following script:

/usr/lpp/cicsts55/wlp/bin/productInfo version --verbose
c) If the version of Liberty is at a lower level to the version of Liberty supplied with CICS, configure a named angel process using the CICS Liberty install:

1) Uncomment the following line in the JVM profile for the CMCI JVM server, EYUCMCIJ.jvmprofile:

```
#-Dcom.ibm.ws.zos.core.angelName=<named_angel>
```

2) Specify the angel name in the -Dcom.ibm.ws.zos.core.angelName property.

This property enables the CMCI JVM server to connect to the named angel process. For details, see The Liberty server angel process.

d) Ensure that the Liberty angel process is ready before starting the region.

10. Configure security for the WUI region to use the Liberty angel process.

If you are using RACF, you can use the sample CLIST EYUS$ANGL in SEYUSAMP to create RACF definitions for the WUI region to use the Liberty angel process, as follows:

a) Take a copy of the CLIST EYUS$ANGL in SEYUSAMP.

b) Update the copy by specifying the following variables:

**WUI_REGION_USERID**
Specify the user ID under which the WUI region runs.

**ANGEL_NAME**
If you are using a named angel process, the value is ANGEL.name where name is the value of the -Dcom.ibm.ws.zos.core.angelName property.

If you are not using a name angel process (-Dcom.ibm.ws.zos.core.angelName is not specified), the value is ANGEL.

c) Run the CLIST.

If you are using an external security manager other than RACF, refer to the documentation of the external product for instructions.
11. Tasks that emanate from the CMCI JVM server run under the CJSU transaction by default. If transaction security is active in the WUI region, give the CICS default user access to the CJSU transaction.

Alternatively, you can create a new user ID based on the CICS default user, with additional access to the CJSU transaction. You must specify the user ID in the com.ibm.cics.jvmserver.unclassified.userid property.

You can also use a duplicate transaction of CJSU for unclassified work that is run in a JVM server. In this case, you must specify the transaction ID in the com.ibm.cics.jvmserver.unclassified.tranid property, and give required access to this transaction.

For more information about JVM system properties, see JVM system properties.

For more information about Liberty JVM server security configuration, see Configuring security for a Liberty JVM server.

12. Update the region JCL to include new DD statements for CMCI diagnostics.

```plaintext
//JVMOUT   DD SYSOUT=*,LRECL=1024
//JVMERR   DD SYSOUT=*,LRECL=1024
//JVMTRACE DD SYSOUT=*,LRECL=1024
//MSGLOG   DD SYSOUT=*,LRECL=1024
```

13. Set the following feature toggle to enable the use of the CMCI JVM server.

```plaintext
com.ibm.cics.cmci.jvmserver=true
```

For detailed instructions, see Specifying feature toggles.

14. Enable users to authenticate through the CMCI JVM server.

You must give users access to authenticate with the CMCI JVM server, including the authority to use the CMCI.

If you are using RACF, you can use the sample CLIST EYU$CMCI in SEYUSAMP to create RACF definitions for users to authenticate through the CMCI JVM server, as follows:

a) Take a copy of the CLIST EYU$CMCI in SEYUSAMP.
b) Update the copy by specifying the following variables:

- **WUI_REGION_USERID**
  Specify the user ID under which the WUI region runs.

- **WUI_APLID**
  Specify the APPLID of the WUI region.

- **CMCIUSER_ACCESS_LIST**
  Specify the list of users or groups of users that will access the CMCI through CICS Explorer.

c) Run the CLIST.

If you are using an external security manager other than RACF, refer to the documentation of the external product for instructions.

**What to do next**

If you want to limit clients that can connect to the CMCI JVM server, you can define a client whitelist to the CMCI JVM server. For instructions, see “Defining a client whitelist to CMCI JVM server” on page 112.
Configuring a WUI region to use the CMCI JVM server
If a WUI region has the CMCI configured but the CMCI JVM server disabled, you can upgrade the WUI region to use the CMCI JVM server. The CMCI JVM server is a Liberty server that provides support for enhanced client authentication in the CMCI and support for the GraphQL API.

Before you begin
System requirements for the CMCI JVM server
1. Verify that all of the required Java components are installed. You can follow the Java components checklist.
2. Ensure that Java support is set up in the region. For instructions, see Setting up Java support.

Additional requirements for enabling connections with multi-factor authentication (MFA) credentials
- You must have IBM Multi-Factor Authentication for z/OS or an equivalent product configured with RACF to support multi-factor authentication. If you use an alternative external security manager (ESM), refer to your vendor for details.
- MFA is supported by CICS TS V5.4 with APAR PI87691 or later. Ensure that the region where the CMCI JVM server will be running, and the CMAS to which it connects are at the same CICS level that is CICS TS V5.4 with APAR PI87691 or later. For information about CICS level considerations for setting up your CICSPlex SM topology, see Designing your CICSPlex SM environment.

Additional requirements for the GraphQL API feature
- The region is at CICS TS 5.5 or later.

About this task
You must configure and enable the use of the CMCI JVM server in the WUI region.

Procedure
1. Add the following system initialization parameters to the region:
   - JVMPROFILEDIR
   - START=INITIAL
   - EDSALIM
2. Review the values of KEYRING, NISTSP800131A, and SEC system initialization parameters. These system initialization parameters, together with APPLID and DFLTUSER, are mapped to the CMCI JVM server configuration parameters. Be aware that in some cases, additional configuration might be required in the CMCI JVM server. For more information, see “Configuration parameter mapping between CICSPlex SM WUI server and CMCI JVM server” on page 103.
3. Review your WUI server initialization parameters such as CMCI options and TCP/IP options. You might need to change some values that are incompatible with the CMCI JVM server. For details, see “Configuration parameter mapping between CICSPlex SM WUI server and CMCI JVM server” on page 103.
4. Create the JVM profile for the CMCI JVM server.
   a) Copy EYUCMCIJ.jvmprofile from /usr/lpp/cics55/JVMProfiles to the location that is specified in the JVMPROFILEDIR system initialization parameter.
   b) Validate or update the values of JAVA_HOME and WORK_DIR in the JVM profile. For details, see Symbols used in the JVM profile.
5. Establish the storage requirements for the CMCI JVM server.
   The supplied EYUCMCIJ.jvmprofile file disables the use of the shared library region, which reduces the amount of non-CICS 31-bit storage required. By default, the JVMSERVER resource that is automatically created for the CMCI JVM server has a value of 15 for the THREADLIMIT attribute. Therefore, you can use the following values as an initial estimate for storage requirements:
• 24-bit storage: 512 KB
• 31-bit storage: 100 MB

Continue to monitor and review storage requirements as described in Calculating storage requirements for JVM servers.

6. Configure the Liberty angel process started task for the CMCI JVM server.
   a) If you don't have a Liberty angel process running, follow the steps in The Liberty server angel process to create one.
   b) If you already have a Liberty angel process running, ensure the version of Liberty specified in the ROOT symbolic parameter in the angel JCL is at the same or a higher level to the version of Liberty supplied with CICS.

**Example: Identifying the Liberty version from the started task system log**

If the Liberty angel process is running Liberty 18.0.0.2 or above, the started task system log contains a message that indicates the Liberty version:

```
CWWKB0079I THE ANGEL BUILD LEVEL IS 18.0.0.2 20180619-0654 2018.7.0.0 20180619-0654
```

**Example: Identifying the Liberty version from message DFHSJ1405**

The version of a Liberty running in a CICS JVM server is available in the following message:

```
DFHSJ1405I 08/22/2018 17:04:39 IYK3ZDRI JVMSERVER EYUCMCIJ is running WebSphere Application Server Version 18.0.0.2 Liberty - (18.0.0.2-cl180220180619-0403) process ID 67174497.
```

**Example: Identifying the Liberty version by running scripts**

Suppose that the angel JCL specifies the following ROOT parameter:

```plaintext
// SET ROOT=/usr/lpp/zosmf/wlp
```

To find out what the version of Liberty is, run the following script:

```
/usr/lpp/zosmf/wlp/bin/productInfo version --verbose
```

For CICS, run the following script:

```
/usr/lpp/cicstsS5/wlp/bin/productInfo version --verbose
```
WebSphereApplicationServer.properties:
com.ibm.websphere.productId=com.ibm.websphere.appserver
com.ibm.websphere.productOwner=IBM
com.ibm.websphere.productVersion=16.0.0.3
com.ibm.websphere.productName=WebSphere Application Server
com.ibm.websphere.productInstallType=Archive
com.ibm.websphere.productEdition=zOS
com.ibm.websphere.productLicenseType=IPLA

WebSphereApplicationServerZOS.properties:
com.ibm.websphere.productId=com.ibm.websphere.appserver.zos
com.ibm.websphere.productOwner=IBM CORP
com.ibm.websphere.productVersion=16.0.0.3
com.ibm.websphere.productName=WAS FOR Z/OS
com.ibm.websphere.productPID=5655-WAS
com.ibm.websphere.productQualifier=WAS Z/OS
com.ibm.websphere.productReplaces=com.ibm.websphere.appserver
com.ibm.websphere.productEdition=
com.ibm.websphere.gssp=true

zOSMF.properties:
com.ibm.websphere.productId=com.ibm.zoszmf
com.ibm.websphere.productOwner=IBM
com.ibm.websphere.productVersion=2.2.0
com.ibm.websphere.productName=z/OSMF
com.ibm.websphere.productPID=5650-ZOS
com.ibm.websphere.productQualifier=z/OSMF
com.ibm.websphere.productReplaces=com.ibm.websphere.appserver.zos
com.ibm.websphere.productEdition=N/A

Figure 19. Example output

C) If the version of Liberty is at a lower level to the version of Liberty supplied with CICS, configure a named angel process using the CICS Liberty install:

1) Uncomment the following line in the JVM profile for the CMCI JVM server, EYUCMCIJ.jvmprofile:

```
#-Dcom.ibm.ws.zos.core.angelName=<named_angel>
```

2) Specify the angel name in the -Dcom.ibm.ws.zos.core.angelName property.
   This property enables the CMCI JVM server to connect to the named angel process. For details, see The Liberty server angel process.

d) Ensure that the Liberty angel process is ready before starting the region.

7. Configure security for the WUI region to use the Liberty angel process.

If you are using RACF, you can use the sample CLIST EYU$ANGL in SEYUSAMP to create RACF definitions for the WUI region to use the Liberty angel process, as follows:

a) Take a copy of the CLIST EYU$ANGL in SEYUSAMP.
b) Update the copy by specifying the following variables:

   **WUI_REGION_USERID**
   Specify the user ID under which the WUI region runs.

   **ANGEL_NAME**
   If you are using a named angel process, the value is ANGEL . *name* where *name* is the value of the -Dcom.ibm.ws.zos.core.angelName property.
   If you are not using a name angel process (-Dcom.ibm.ws.zos.core.angelName is not specified), the value is ANGEL.

c) Run the CLIST.

If you are using an external security manager other than RACF, refer to the documentation of the external product for instructions.
8. Tasks that emanate from the CMCI JVM server run under the CJSU transaction by default. If transaction security is active in the WUI region, give the CICS default user access to the CJSU transaction. Alternatively, you can create a new user ID based on the CICS default user, with additional access to the CJSU transaction. You must specify the user ID in the com.ibm.cics.jvmserver.unclassified.userid property.

You can also use a duplicate transaction of CJSU for unclassified work that is run in a JVM server. In this case, you must specify the transaction ID in the com.ibm.cics.jvmserver.unclassified.tranid property, and give required access to this transaction.

For more information about JVM system properties, see JVM system properties. For more information about Liberty JVM server security configuration, see Configuring security for a Liberty JVM server.

9. Update the region JCL to include new DD statements for CMCI diagnostics.

```java
//JVMOUT   DD SYSOUT=*,LRECL=1024
//JVMERR   DD SYSOUT=*,LRECL=1024
//JVMTRACE DD SYSOUT=*,LRECL=1024
//MSGLOG   DD SYSOUT=*,LRECL=1024
```

10. Set the following feature toggle to enable the use of the CMCI JVM server.

```
com.ibm.cics.cmci.jvmserver=true
```

For detailed instructions, see Specifying feature toggles.

11. Enable users to authenticate through the CMCI JVM server.

You must give users access to authenticate with the CMCI JVM server, including the authority to use the CMCI.

If you are using RACF, you can use the sample CLIST EYU$CMCI in SEYUSAMP to create RACF definitions for users to authenticate through the CMCI JVM server, as follows:

a) Take a copy of the CLIST EYU$CMCI in SEYUSAMP.
b) Update the copy by specifying the following variables:

- **WUI_REGION_USERID**
  
  Specify the user ID under which the WUI region runs.

- **WUI_APPLID**
  
  Specify the APPLID of the WUI region.

- **CMCIUSER_ACCESS_LIST**
  
  Specify the list of users or groups of users that will access the CMCI through CICS Explorer.

c) Run the CLIST.

If you are using an external security manager other than RACF, refer to the documentation of the external product for instructions.

**What to do next**

If you want to limit clients that can connect to the CMCI JVM server, you can define a client whitelist to the CMCI JVM server. For instructions, see “Defining a client whitelist to CMCI JVM server” on page 112.

**Setting up for multiple CMCI JVM servers in a CICSpex**

You can have several CMCI JVM servers running in a CICSpex. However, to enable HTTP client users to authenticate once with one CMCI JVM server, thus having access to other CMCI JVM servers in the same CICSpex without re-authentication, you must configure the single sign-on (SSO) support in Liberty.

SSO enables a user to authenticate with one CMCI JVM server and access the other CMCI JVM servers in the CICSpex without getting prompted again. When a user is authenticated with one CMCI JVM server, the SSO token that is created for the user during the authentication process is transported to the client in
a cookie. The cookie is used to propagate the authentication information to the other CMCI JVM servers in the same CICSp Plex.

Only the authentication is shared. CMCI cached result sets are not shared.

For an overview of Liberty support for LTPA and SSO, see Authentication.

About this task
To make SSO work across CMCI JVM servers, the CMCI JVM servers running in the CICSp lex must use the same LTPA keys and share the same user registry.

You can configure SSO to support CMCI JVM servers that are in different domains.

Procedure
• Configure LTPA in Liberty.
  Follow the instructions in Configuring LTPA in Liberty. See LTPA Token (ltpa) for LTPA properties that you can set in the Liberty server configuration.
• Customize the SSO configuration support to use LTPA cookies in Liberty.
  Follow the instructions in Customizing SSO configuration using LTPA cookies in Liberty.

Configuration parameter mapping between CICSp lex SM WUI server and CMCI JVM server
During setup, the CMCI JVM server reads the CICSp lex SM WUI configuration properties and configures its JVM configuration properties accordingly. The mapping from WUI server initialization parameters (such as CMCI options and TCP/IP options) and WUI region SIT parameters to the CMCI JVM server configuration parameters is listed. For some parameters, additional configuration is required in the CMCI JVM server.

Table 10 on page 104 shows how CICSp lex SM WUI server initialization parameters are mapped to the CMCI JVM server configuration parameters and indicates any additional configuration that is required in the CMCI JVM server.
## Table 10. Mapping between CICSPlex SM WUI server initialization parameters and CMCI JVM server configuration parameters

<table>
<thead>
<tr>
<th>CICSPlex SM WUI parameter name</th>
<th>WUI parameter value</th>
<th>Effect on CMCI</th>
<th>CMCI JVM server configuration element</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMCIAUTH</td>
<td>AUTOMATIC</td>
<td>The CMCI supports both basic authentication and client certificate authentication.</td>
<td>clientAuthenticationSupported= &quot;true&quot; in the ssl element allowFailOverToBasicAuth=&quot;true&quot; in the webAppSecurity element Basic authentication and client authentication are supported.</td>
</tr>
<tr>
<td>AUTOREGISTER</td>
<td>Not supported. Configured as AUTOMATIC.</td>
<td>Not supported. Configured as AUTOMATIC.</td>
<td></td>
</tr>
<tr>
<td>BASIC</td>
<td>The CMCI requires basic authentication. This is the default when SEC=YES is in effect.</td>
<td>clientAuthentication=&quot;false&quot; and clientauthenticationSupported=&quot;false&quot; in the ssl element allowFailOverToBasicAuth=&quot;false&quot; in the webAppSecurity element Only basic authentication is supported.</td>
<td></td>
</tr>
<tr>
<td>CERTIFICATE</td>
<td>The CMCI requires client certificate authentication.</td>
<td>clientAuthentication=&quot;true&quot; in the ssl element set to true allowFailOverToBasicAuth=&quot;false&quot; in the webAppSecurity element Only client authentication is supported.</td>
<td></td>
</tr>
<tr>
<td>NO</td>
<td>The CMCI does not require client authentication. This is the default when SEC=NO is in effect.</td>
<td>No security configured.</td>
<td></td>
</tr>
<tr>
<td>CMCIPORT (Required)</td>
<td>value</td>
<td>Sets the HTTP or HTTP port for the CMCI.</td>
<td>httpPort or httpsPort in the httpEndPoint element</td>
</tr>
<tr>
<td>CMCISSL (overrides TCPIPSSL)</td>
<td>ATTLSAWARE</td>
<td>Non-HTTPS connections to the CMCI are used.</td>
<td>Do not configure the CMCI JVM server to use SSL and disable the httpsPort in the httpEndPoint element.</td>
</tr>
<tr>
<td></td>
<td>CLIENTAUTH</td>
<td>HTTPS connections to the CMCI are used. The CMCI requires client certificate authentication.</td>
<td>clientAuthentication=&quot;true&quot; in the ssl element Configure the CMCI JVM server to use SSL and disable the httpPort in the httpEndPoint element.</td>
</tr>
<tr>
<td></td>
<td>NO</td>
<td>Non-HTTPS connections to the CMCI are used.</td>
<td>Do not configure the CMCI JVM server to use SSL and disable the httpsPort in the httpEndPoint element.</td>
</tr>
<tr>
<td></td>
<td>YES</td>
<td>HTTPS connections to the CMCI are used.</td>
<td>Configure the CMCI JVM server to use SSL and disable the httpPort in the httpEndPoint element.</td>
</tr>
<tr>
<td>CICSPlex SM WUI parameter name</td>
<td>WUI parameter value</td>
<td>Effect on CMCI</td>
<td>CMCI JVM server configuration element</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------</td>
<td>----------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>TCPIPADDRESS (Overrides TCPIPHOSTNAME)</td>
<td>name</td>
<td>Allows client connections to the CMCI by using only the provided TCP/IP address.</td>
<td>host in the httpEndPoint element</td>
</tr>
<tr>
<td>INADDR_ANY</td>
<td></td>
<td>Allows client connections to the CMCI by using any TCP/IP address associated with the LPAR.</td>
<td>host=&quot;*&quot; in the httpEndPoint element</td>
</tr>
<tr>
<td>TCPIPHOSTNAME (Required)</td>
<td>name</td>
<td>Provides the host name for client connections to the CMCI.</td>
<td>host in the httpEndPoint element</td>
</tr>
<tr>
<td>ALL</td>
<td></td>
<td>Allows client connections by using any host name associated with the LPAR.</td>
<td>host=&quot;*&quot; in the httpEndPoint element</td>
</tr>
<tr>
<td>TCPIPHTTPHOST</td>
<td>YES</td>
<td>NO</td>
<td>Not used by the CMCI.</td>
</tr>
<tr>
<td>TCPIPSSL (Can be overridden by CMCISSL)</td>
<td>YES</td>
<td>HTTPS connections to the CMCI are used.</td>
<td>Configure the CMCI JVM server to use SSL and disable the httpPort in the httpEndPoint element.</td>
</tr>
<tr>
<td>NO</td>
<td></td>
<td>Non-HTTPS connections to the CMCI are used. This is the default.</td>
<td>Do not configure the CMCI JVM server to use SSL and disable the httpsPort in the httpEndPoint element.</td>
</tr>
<tr>
<td>TCPIPSSLCERT</td>
<td>name</td>
<td>Takes effect when TCPIPSSL=YES is in effect, or when CMCISSL is set a value other than NO.</td>
<td>Not used. Liberty will use the default certificate.</td>
</tr>
<tr>
<td>TCPIPSSLCIPHERS</td>
<td>cipher_list</td>
<td>Takes effect when TCPIPSSL=YES is in effect, or when CMCISSL is set a value other than NO. Provides the list of ciphers available to the CMCI.</td>
<td>enabledCiphers in the ssl element Only used when SSL is active.</td>
</tr>
</tbody>
</table>

**Note:**

1. Valid when **SEC=YES** is in effect.
2. The **KEYRING** system initialization parameter must be in effect.
3. Ensure that a default SSL certificate is configured in Liberty. For more information, see SSL defaults in Liberty.
4. If the list contains any invalid ciphers, CICS removes invalid ciphers and continues as long as at least one valid cipher remains. If there are no valid ciphers, access to the CMCI will be rejected. Liberty allows invalid ciphers to be configured but rejects connections with message Unsupported ciphersuite in the Liberty logs. In such cases, the following messages help you identify the cause of the problem:
   - DFHSO0145W indicates that invalid ciphers have been supplied.
   - DFHSO0146I lists the invalid ciphers that were removed by CICS.

**Liberty references:**

Chapter 2. Setting up CICSPlex SM 105
For information about the attributes in the `ssl` element, see SSL configuration attributes in Liberty.


For information about the attributes in the `httpEndPoint` element, see HTTP Endpoint (httpEndpoint) in Liberty.

Table 11 on page 106 shows how the WUI region system initialization parameters are mapped to the CMCI JVM server configuration parameters and indicates what additional configuration is required in the CMCI JVM server.

<table>
<thead>
<tr>
<th>CICSPlex SM WUI region SIT parameter name</th>
<th>WUI region SIT parameter value</th>
<th>Effect on CMCI</th>
<th>CMCI JVM server configuration element</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLID</td>
<td>applid</td>
<td>Sets the prefix for CMCI security profiles.</td>
<td>profilePrefix in the safCredentials element</td>
</tr>
<tr>
<td>DFLTUSER</td>
<td>userid</td>
<td>Sets the CMCI unauthenticated default user.</td>
<td>unauthenticatedUser in the safCredentials element Used when security is active.</td>
</tr>
<tr>
<td>KEYRING</td>
<td>keyring-name</td>
<td>Provides the name of the Keyring used for HTTPS or client certificate authentication.</td>
<td>location in the keyStore element Used when SSL or client certification is active.</td>
</tr>
<tr>
<td>MINTLSLEVEL</td>
<td></td>
<td>Not used by the CMCI.</td>
<td>You can configure sslProtocol in the ssl element to set the SSL protocol.</td>
</tr>
<tr>
<td>NISTSP800131A</td>
<td>NOCHECK</td>
<td>CHECK</td>
<td>Instructs the CMCI to check for conformance to the NIST SP800-131A standard.</td>
</tr>
<tr>
<td>SEC</td>
<td>NO</td>
<td>Disables authentication.</td>
<td>Disables Liberty security.</td>
</tr>
<tr>
<td></td>
<td>YES</td>
<td>Enables basic authentication in the CMCI, unless overridden by CMCIAUTH.</td>
<td>Enables Liberty security.</td>
</tr>
</tbody>
</table>

**Liberty references:**

For information about the attributes in the `safCredentials` element, see Interface SAFCredential in Liberty.

For information about the attributes in the `ssl` element, see SSL configuration attributes in Liberty.

**Record count warnings in CMCI**

Setting up record count warnings causes a CICS management client interface (CMCI) request to fail if a request is likely to result in the retrieval of an unacceptably large amount of data. You set up record count warnings by specifying a nonzero value for the `DEFAULTWARNCNT` initialization parameter during WUI server configuration when setting up the CMCI.

`DEFAULTWARNCNT` can take an integer value in the range 0 - 99999999. The default value is 0, meaning that no warnings are issued.
If the warning mechanism determines that the number of records to be returned is greater than the value of the warning count, the request fails with an HTTP 403 response code. Users must issue a new request with different values for the SCOPE, CRITERIA and, in some cases, PARAMETER options to retrieve any results. If the returned value is less than or equal to the warning count value, the request is processed, in the usual way.

**Note:** In CMCI requests, the options count, index and SUMMONLY can be used to limit or prevent the display of records. However, these options do not influence the number of records requested and have no affect on the record count warning mechanism.

**How to allow users to bypass record count warnings**

If DEFAULTWARNCNT is set to a nonzero value, a warning count limit is in effect. Users can bypass the warning count limit by using the CMCI URI option OVERRIDEWARNINGCOUNT in their requests. For the CMCI URI option OVERRIDEWARNINGCOUNT to take effect, when setting up the CMCI, you must set the RESOURCELIMIT initialization parameter to WARNING during WUI server configuration. If you want to prevent users from bypassing the warning count limit, set RESOURCELIMIT to FAIL.

When RESOURCELIMIT(WARNING) is in effect, if a request results in the retrieval of an amount of data larger than the warning count limit, a 403 HTTP response is returned and indicates that the errorInfo attribute override_warning_count_allowed is set to yes. The user can then bypass the warning count limit by using the CMCI URI option OVERRIDEWARNINGCOUNT in the request.

However, when RESOURCELIMIT(FAIL) is in effect, such requests are denied, and in the 403 HTTP response, the errorInfo attribute override_warning_count_allowed is set to no. Issuing a request with the OVERRIDEWARNINGCOUNT option will still result in the same 403 HTTP response.

**Which CMCI resources are applicable**

This feature does not apply to all resources. In the CMCI, record count warnings apply only to CMCI requests associated with the following resources:

<table>
<thead>
<tr>
<th>CMCI Resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIMODEL</td>
</tr>
<tr>
<td>ATOMSERV</td>
</tr>
<tr>
<td>BRFACIL</td>
</tr>
<tr>
<td>BUNDLE</td>
</tr>
<tr>
<td>BUNDPART</td>
</tr>
<tr>
<td>CFDTPPOOL</td>
</tr>
<tr>
<td>CICSDSA</td>
</tr>
<tr>
<td>CICSPAGP</td>
</tr>
<tr>
<td>CICSRGN</td>
</tr>
<tr>
<td>CICSSTOR</td>
</tr>
<tr>
<td>CLCACHE</td>
</tr>
<tr>
<td>CMDT</td>
</tr>
<tr>
<td>CONNECT</td>
</tr>
<tr>
<td>DBCTLSS</td>
</tr>
<tr>
<td>DB2CONN</td>
</tr>
<tr>
<td>DB2ENTRY</td>
</tr>
<tr>
<td>DB2TRN</td>
</tr>
<tr>
<td>CMCI Resources</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>DOCTEMP</td>
</tr>
<tr>
<td>DOMSPPOOL</td>
</tr>
<tr>
<td>DSNAME</td>
</tr>
<tr>
<td>DSPGBL</td>
</tr>
<tr>
<td>DSPMODE</td>
</tr>
<tr>
<td>DSPPOOL</td>
</tr>
<tr>
<td>EJCOBEAN</td>
</tr>
<tr>
<td>EJCOSE</td>
</tr>
<tr>
<td>EJDJAR</td>
</tr>
<tr>
<td>EJDJBEAN</td>
</tr>
<tr>
<td>ENQUEUE</td>
</tr>
<tr>
<td>ENQMODEL</td>
</tr>
<tr>
<td>EPADAPT</td>
</tr>
<tr>
<td>EPADSET</td>
</tr>
<tr>
<td>EPAINSET</td>
</tr>
<tr>
<td>EVCSDATA</td>
</tr>
<tr>
<td>EVCSINFO</td>
</tr>
<tr>
<td>EVCSOPT</td>
</tr>
<tr>
<td>EVCSPEC</td>
</tr>
<tr>
<td>EVNTBIND</td>
</tr>
<tr>
<td>EVNTGBL</td>
</tr>
<tr>
<td>EXCI</td>
</tr>
<tr>
<td>EXITGLUE</td>
</tr>
<tr>
<td>EXITTRUE</td>
</tr>
<tr>
<td>EXTRATDQ</td>
</tr>
<tr>
<td>FEPICONN</td>
</tr>
<tr>
<td>FEPINODE</td>
</tr>
<tr>
<td>FEPIPOOL</td>
</tr>
<tr>
<td>FEPIPROP</td>
</tr>
<tr>
<td>FEPITRGRT</td>
</tr>
<tr>
<td>HOST</td>
</tr>
<tr>
<td>HTASK</td>
</tr>
<tr>
<td>INDTDQ</td>
</tr>
<tr>
<td>INTRATDQ</td>
</tr>
<tr>
<td>IPCCONN</td>
</tr>
<tr>
<td>CMCI Resources</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>IPFACIL</td>
</tr>
<tr>
<td>JRNLMODL</td>
</tr>
<tr>
<td>JRNLNAME</td>
</tr>
<tr>
<td>JVM</td>
</tr>
<tr>
<td>JVMPOOL</td>
</tr>
<tr>
<td>JVMPROF</td>
</tr>
<tr>
<td>JVMSERV</td>
</tr>
<tr>
<td>LIBDSN</td>
</tr>
<tr>
<td>LIBRARY</td>
</tr>
<tr>
<td>LOADACT</td>
</tr>
<tr>
<td>LOADER</td>
</tr>
<tr>
<td>LOCFIILE</td>
</tr>
<tr>
<td>LOCTRAN</td>
</tr>
<tr>
<td>LSRPBUF</td>
</tr>
<tr>
<td>LSRPOOL</td>
</tr>
<tr>
<td>MASHIST</td>
</tr>
<tr>
<td>MODENAME</td>
</tr>
<tr>
<td>MONITOR</td>
</tr>
<tr>
<td>MQCON</td>
</tr>
<tr>
<td>MQCONN</td>
</tr>
<tr>
<td>MQINI</td>
</tr>
<tr>
<td>MVSESTG</td>
</tr>
<tr>
<td>MVSTCB</td>
</tr>
<tr>
<td>MVSTCBGL</td>
</tr>
<tr>
<td>MVSWLM</td>
</tr>
<tr>
<td>OSGIBUND</td>
</tr>
<tr>
<td>OSGISERV</td>
</tr>
<tr>
<td>PARTNER</td>
</tr>
<tr>
<td>PIPELINE</td>
</tr>
<tr>
<td>PROCTYP</td>
</tr>
<tr>
<td>PROFILE</td>
</tr>
<tr>
<td>PROGRAM</td>
</tr>
<tr>
<td>RECOVERY</td>
</tr>
<tr>
<td>REMFILE</td>
</tr>
<tr>
<td>REMTDQ</td>
</tr>
<tr>
<td>CMCI Resources</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>REMTRAN</td>
</tr>
<tr>
<td>REQID</td>
</tr>
<tr>
<td>RPLLIST</td>
</tr>
<tr>
<td>RQMODEL</td>
</tr>
<tr>
<td>RULE</td>
</tr>
<tr>
<td>STREAMNM</td>
</tr>
<tr>
<td>SYSDUMP</td>
</tr>
<tr>
<td>SYSPARM</td>
</tr>
<tr>
<td>TASK</td>
</tr>
<tr>
<td>TASKASSC</td>
</tr>
<tr>
<td>TASKESTG</td>
</tr>
<tr>
<td>TASKFILE</td>
</tr>
<tr>
<td>TASKRMI</td>
</tr>
<tr>
<td>TASKTSQ</td>
</tr>
<tr>
<td>TCPIPGBL</td>
</tr>
<tr>
<td>TCPIPS</td>
</tr>
<tr>
<td>TDQGBL</td>
</tr>
<tr>
<td>TERMNL</td>
</tr>
<tr>
<td>TRANCLAS</td>
</tr>
<tr>
<td>TRANDUMP</td>
</tr>
<tr>
<td>TSKSPOLS</td>
</tr>
<tr>
<td>TSKPOOL</td>
</tr>
<tr>
<td>TSMODEL</td>
</tr>
<tr>
<td>TSPool</td>
</tr>
<tr>
<td>TSQGBL</td>
</tr>
<tr>
<td>TSQNAME</td>
</tr>
<tr>
<td>TSQSHR</td>
</tr>
<tr>
<td>UOW</td>
</tr>
<tr>
<td>UOWDSNF</td>
</tr>
<tr>
<td>UOWENQ</td>
</tr>
<tr>
<td>UOWLINK</td>
</tr>
<tr>
<td>URIMAP</td>
</tr>
<tr>
<td>URIMPGBL</td>
</tr>
<tr>
<td>WEBSERV</td>
</tr>
<tr>
<td>WORKREQ</td>
</tr>
</tbody>
</table>
Estimating storage requirements for CMCI

To avoid possible storage problems when you use the CICS management client interface, you must specify appropriate levels of 64-bit (above-the-bar) storage in the CICS region, and auxiliary storage. Use the z/OS MEMLIMIT parameter to set the limit for 64-bit storage in your WUI region or CICS region, and the MAXAUXCPSTM and MAXAUXTOTL CICSPlex SM system parameters to set auxiliary storage for the CMAS.

About this task

Running the CMCI with large workloads can lead to short-on-storage situations on the WUI server and possible CMAS shutdowns caused by running out of auxiliary storage.

The CMCI stores retained results sets for the WUI server in 64-bit storage in the CICS region, in subpool WU_64 in the GCDSA.

During a CMCI request, the CMAS collects and stores the requested resource records, which are then backed up in auxiliary storage. Running requests concurrently through the CMCI multiplies the number of records held by the CMAS with each request.

If you are using the CMCI JVM server with the CMCI in the WUI region, the JVM server uses storage in addition to the retained result sets. Ensure that you include the storage requirement of the CMCI JVM server in your estimation.

Procedure

1. Calculate the storage requirement for a typical request.
   Select the resource that is likely to generate the largest number of records in a request and multiply the number of records by the size of each record. See the appropriate table in CICSPlex SM resource tables in Reference to determine the record size.

2. Calculate your total requirements for 64-bit storage for retained result sets.
   Estimate your expected maximum number of retained result records for a single request and multiply this figure by your estimate of the storage required for each request. For example, if you can have 100,000 CICS terminals in a single request, multiply this figure by the size of the resource record as determined in step 1.

3. If you are setting up the CMCI in a CICSPlex SM environment, estimate your auxiliary storage requirements for your CMAS.
   Estimate the maximum number of concurrent requests that you can expect and multiply this figure by your estimate of the storage required for each request as calculated in step 2. You can derive your estimate of concurrent requests from the total number of users that you expect to be using the CMCI at any one time and how many simultaneous requests they are likely to make.

4. Consider adding more storage for metadata.
   The CMCI stores all requested resource records for each request for a new retained result. For the initial request of a new resource type, for example, a first request for CICS programs, a small amount of attribute metadata is also stored. For large requests, the size of the attribute metadata and any other storage used while making the request is negligible compared to the storage required for records themselves. Consider adding an extra 2% to your final estimate to cover any extra metadata used internally by the CMCI on the WUI server. This extra metadata is not necessary for the CMAS calculation.

Storage requirements for the CMCI JVM server

5. The CMCI JVM server is a Liberty JVM server running in the WUI region. To calculate storage requirements for JVM servers, see Calculating storage requirements for JVM servers.

   The recommended maximum heap size for the CMCI JVM server is at least 2 GB.
What to do next

• If the CMCI is installed in a CICSpex SM environment, use your estimate of auxiliary storage to set values for the `MAXAUXCP` and `MAXAUXTOTL` parameters on the CMAS associated with your WUI server.

• Use your estimate of the 64-bit storage required for retained result sets plus the maximum heap size to help determine the z/OS `MEMLIMIT` value for your WUI region, or your CICS region if you are running the single server version of the CMCI. You must allow for the other CICS facilities that use 64-bit storage.

For information about the `MEMLIMIT` value for CICS, and instructions to check the value of `MEMLIMIT` that currently applies to the CICS region, see Estimating, checking, and setting `MEMLIMIT` in Improving performance. For further information about `MEMLIMIT` in z/OS, see Limiting the use of private memory objects in the z/OS MVS Programming: Extended Addressability Guide.

Defining a client whitelist to CMCI JVM server

You can use a client whitelist to limit clients that can connect to the CMCI JVM server. For example, you can limit which levels of CICS Explorer or a browser can connect to the CMCI JVM server.

**Note:** This capability allows you to manage clients that are allowed to connect to the CMCI, but do not expect this to secure the CMCI.

Before you begin

The CMCI JVM server must be set up and running in your CMCI configuration. To set up the CMCI JVM server, follow the instructions in “Configuring CMCI in a WUI region” on page 94 or “Configuring a WUI region to use the CMCI JVM server” on page 99.

About this task

The client whitelist is an ASCII file that contains a list of valid User-agent HTTP headers that are sent by a client such as CICS Explorer or a browser.

You use the `com.ibm.cics.jvmserver.cmci.user.agent.white.list` JVM property to specify the location to the whitelist file. If the property is not defined in the JVM profile of the CMCI JVM server, all clients are accepted.

If a user-agent is not in the file, the request is rejected with HTTP code 403, and message DFHSJ1412 is issued. You can specify an alternative response text to return to the user by using the `com.ibm.cics.jvmserver.cmci.user.agent.white.list.reject.text` JVM property.

For more information about these JVM system properties, see JVM system properties.

**Note:** The CICS Explorer user-agent encodes the versions of several CICS Explorer components and therefore can change when components are updated. With CICS Explorer Version 5.4.0.5 or later, you can discover the user-agent that a running CICS Explorer installation presents by clicking Help > About > Installation Details > Configuration. The CMCI User Agent string is listed in the Configuration tab of the Installation Details dialog box.

Procedure

1. Define a client whitelist file.

   In the file, you can use a number sign (#) at the start of a line to specify a comment. You can also use an asterisk (*) as the last character in an entry as a wild card. The file must be saved in the ASCII file encoding.
Figure 20. Examples of client whitelist files where CICS Explorer is the client

Mozilla/5.0 (Windows NT 10.0; Win64; x64; rv:65.0) Gecko/20100101 Firefox/65.0

Mozilla/5.0 (Windows NT 10.0; Win64; x64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/71.0.3578.98 Safari/537.36

Mozilla/5.0 (Macintosh; Intel Mac OS X 10_14_2) AppleWebKit/605.1.15 (KHTML, like Gecko) Version/12.0.2 Safari/605.1.15

Figure 21. Examples of client whitelist files where a browser is the client

2. Specify the file location as follows:

Uncomment the following line in the JVM profile for the CMCI JVM server, EYUCMCIJ.jvmprofile, and specify the file location.

-Dcom.ibm.cics.jvmserver.cmci.user.agent.white.list=/var/userAgentWhiteList

If a user attempts to connect to the CMCI JVM server from a client that is not in the whitelist, the request is rejected with HTTP code 403. If you want to return a custom response text to the user, continue with step “3” on page 113.

3. Optional: In the JVM profile for the CMCI JVM server, EYUCMCIJ.jvmprofile, add the following line, where response_text is your message to the user:

-Dcom.ibm.cics.jvmserver.cmci.user.agent.white.list.reject.text=response_text

Results

For each valid user-agent that is processed in the whitelist, message DFHSJ1410I is issued. Only user-agents that are defined in the whitelist are allowed to connect to the CMCI.

Troubleshooting: If no user-agents are allowed access to the CMCI, there might be an issue with the client whitelist configuration. For example, the file specified in the com.ibm.cics.jvmserver.cmci.user.agent.white.list JVM property cannot be found, or the file contains invalid values. In such cases, message DFHSJ1408 is issued to CSMT, and message DFHWU4303 is issued to the user who attempts to connect to the CMCI.

What to do next

Updating the whitelist

The whitelist values in this file are held in a cache, which by default is refreshed by Liberty cache file monitoring. Liberty cache file monitoring checks whether the file has changed every 10 seconds by default.

If you need to update the list, you might want to override the default by setting the following Java system property in the JVM profile of the CMCI JVM server:

-Dcom.ibm.cics.jvmserver.cmci.user.agent.white.list.monitor.interval=20s
Setting up CMCI in a stand-alone CICS region

You can set up the CICS management client interface (CMCI) in a stand alone region (SMSS). The CMCI JVM server is not supported for this configuration.

About this task

Sample resource definitions are provided for setting up the CMCI in an SMSS. The samples are included in the CICS system definition file (CSD) in group DFH$WU.

- DFH$WUUR is a sample URIMAP definition.
- DFH$WUTC is a sample TCPIPSERVICE definition.

You can install these resources as they are, or more typically you can copy and modify them to tailor them for your environment. However, you must always specify the URIMAP path as CICSSystemManagement/*.

The supplied procedure by default does not activate security on the interface. If security is not active, messages that are produced by auditing system programming interface commands contain the default user ID of the region.

To set up security for the CMCI in an SMSS, you can tailor the supplied samples as instructed in “Configuring security for CMCI in a stand-alone CICS region” on page 116.

Use the following procedure to set up the CMCI in an SMSS by using the samples provided.

Procedure

1. Change your CICS startup JCL:
   a) Add the hlq.CPSM.SEYUAUTH library to the STEPLIB concatenation, where hlq is your high-level qualifier; for example CICSTS55
   b) Add the hlq.CPSM.SEYULOAD library to the DFHRPL concatenation, where hlq is your high-level qualifier; for example CICSTS55
   These libraries must be at the same CICS TS level as those for CICS; that is, the same as the CICS hlq.CICS.SDFHAUTH and CICS hlq.CICS.SDFHLOAD libraries in the STEPLIB concatenation.
2. Ensure that the system initialization parameter CPSMCONN is set to NO for your CICS region. CPSMCONN must be set to NO for CICS Explorer to connect to a CMCI standalone region.
3. Ensure that the RDO group DFHFEPI is being installed in a list that is included in the group list (GRPLIST) at CICS startup. The DFHFEPI group is included in the default CICS startup list DFHLIST. The group contains resources that are required by the CMCI.
4. Start your CICS region.
5. Install the sample URIMAP definition, DFH$WUUR.
   This sample URI map uses transaction CWWU and calls program DFHWBA to analyze the CICS web request. DFH$WUUR includes the following attribute values:

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Attribute value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Sample System Management Interface URI map</td>
</tr>
<tr>
<td>Group</td>
<td>DFH$WU</td>
</tr>
<tr>
<td>Host</td>
<td>*</td>
</tr>
<tr>
<td>Path</td>
<td>CICSSystemManagement/*</td>
</tr>
<tr>
<td>Port</td>
<td>No</td>
</tr>
<tr>
<td>Program</td>
<td>DFHWUIPG</td>
</tr>
<tr>
<td>Scheme</td>
<td>HTTP</td>
</tr>
<tr>
<td>Attribute name</td>
<td>Attribute value</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>Enabled</td>
</tr>
<tr>
<td>TCP/IP service name</td>
<td>DFH$WUTC</td>
</tr>
<tr>
<td>Transaction</td>
<td>CWWU</td>
</tr>
<tr>
<td>URI map</td>
<td>DFH$WUUR</td>
</tr>
<tr>
<td>Usage</td>
<td>Server</td>
</tr>
</tbody>
</table>

Other attributes in the sample definition retain their default values.

**Note:** The TCP/IP service name must match your TCPIPSERVICE definition. If you use a TCPIPSERVICE definition with a name other than DFH$WUTC, ensure that you rename the TCP/IP service name in the URIMAP definition accordingly.

6. Copy and rename the sample TCPIPSERVICE definition, DFH$WUTC and change the port number to a unique value.

DFH$WUTC includes the following attribute values:

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Attribute value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication level</td>
<td>No</td>
</tr>
<tr>
<td>CICS transaction ID</td>
<td>CWXN</td>
</tr>
<tr>
<td>Description</td>
<td>Sample System Management Interface TCPIP service</td>
</tr>
<tr>
<td>Group</td>
<td>DFH$WU</td>
</tr>
<tr>
<td>Host</td>
<td>Any</td>
</tr>
<tr>
<td>Port</td>
<td>1490</td>
</tr>
<tr>
<td>Protocol</td>
<td>HTTP</td>
</tr>
<tr>
<td>Queue backlog limit</td>
<td>0</td>
</tr>
<tr>
<td>SSL</td>
<td>No</td>
</tr>
<tr>
<td>Status</td>
<td>Open</td>
</tr>
<tr>
<td>TCP/IP service name</td>
<td>DFH$WUTC</td>
</tr>
<tr>
<td>Timeout for socket close</td>
<td>No</td>
</tr>
<tr>
<td>User-replaceable module name</td>
<td>DFHWBAAX</td>
</tr>
</tbody>
</table>

Other attributes in the sample definition can retain their default values.

7. Install the TCPIPSERVICE definition.

**Tips:**

- You must define the following transactions to RACF, or an equivalent external security manager, and ensure that CMCI users are authorized to access the transactions: CODB, COD0, COD1, COD2, COSH, COLU, CWWU, and CWXN.
- Ensure that the DFHCNV table used by CICS contains a DFHWBUD entry.
- If you use your own version of the DFHCNV source module, you must assemble and link-edit it using the new macros or ensure that you include the necessary code pages.

**What to do next**

Use CICS Explorer or a browser to check that your setup works correctly.
If necessary, you can use the following checks:

1. Check that the TCPIPSERVICE is OPEN and URIMAP is ENABLED on the stand-alone region. Confirm the port and that the URIMAP references the TCPIPSERVICE with the new name and not the old DFH $WUTC resource that you copied.

2. Try to access the URL by using the following request in your browser. If the browser returns a result, your setup is working as expected. The CMCI URIMAP responds only to requests for URLs that begin as follows:

   http://hostname:port/CICSSystemManagement/CICSTask/

3. Check for any SMSS related messages on the region job log, for example:

   EYUXL0022I xxxxxxx SMSS Phase I initialization complete
   EYUXL0007I xxxxPhase II initialization complete
   EYUNL0099I xxxxxxxx SMSS LRT initialization complete

4. Check for any installation errors in both the job log and the MSGUSR log.

5. Try to connect CICS Explorer to the CMCI port to check whether that connection works.

**Configuring security for CMCI in a stand-alone CICS region**

To configure security for the CMCI in a standalone CICS region (SMSS), you must change the settings in the sample definitions. You can choose to use either HTTP basic authentication, or for a higher level of security, secure sockets layer (SSL) authentication.

**About this task**

See Security for CICS web support for information about the security measures you can use to protect access to the interface.

To set up security for the CMCI in an SMSS, you can tailor the CICS-supplied sample definitions DFH $WUTC and DFH$WUUR, as instructed in the following procedure.

**Procedure**

1. Copy and rename the sample TCPIPSERVICE definition, DFH$WUTC, and the sample URIMAP definition, DFH$WUUR.

   These samples are included in the CICS system definition file (CSD) in group DFH$WU.

2. Change the TCPIPSERVICE definition to incorporate the security features that you want.

   See Creating TCPIPSERVICE resource definitions for CICS web support for guidance about creating TCPIPSERVICE definitions that include security for web clients.

3. Change the TCPIPSERVICE attribute in your URIMAP definition to refer to your renamed TCPIPSERVICE.

   You can also change the SCHEME attribute from HTTP to HTTPS, but this is not essential because this change is made automatically to an installed URIMAP if its associated TCPIPSERVICE has security enabled.

4. Install the definitions into your CICS region.

   See Ways of defining CICS resources for an explanation of the methods that you can use to install these resource definitions.

   **Note:** You must define the CWWU and CWXN transactions to RACF, or an equivalent external security manager, and ensure that CMCI users are authorized to access the transactions.

**Results**

If security is active, messages produced by auditing system programming interface commands contain the user ID that is used to log on to CICS Explorer.
CICSPlex SM system parameters

You can use a number of system parameters to identify or alter CICSPlex SM attributes. An extrapartition transient data queue called COPR specifies these parameters.

You can assign these parameters to a DD * file, sequential data set, or a partitioned data set member. The DD name for the extrapartition transient data queue is EYUPARM.

Code the system parameters as 80-byte records. You can specify multiple system parameters on a single record if they are separated by commas and do not exceed a total of 71 characters in length. The format of the system parameters is as follows:

```
keyword(v)
```

**keyword**

The name of a CICSPlex SM system parameter.

**v**

An alphanumeric data value that you can specify with the system parameter.

Table 12 on page 117 identifies the CICSPlex SM parameters used in the CMAS and MAS and indicates whether these parameters are required or optional.

For CMASs, MASs, and WUI servers, the following members of the TDFHINST and XDFHINST libraries contain samples of these parameters:

**EYUCMS0P**

CMAS parameters

**EYULMS0P**

Local MAS parameters

EYUCMS0P and EYULMS0P are supplied uncustomized in TDFHINST and customized in XDFHINST. Before using these members to start a CMAS, MAS, or WUI server, remove the comments from the samples and supply the appropriate values.

For a summary of changes by release to CICSPlex SM system parameters, see Changes to CICSPlex SM.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>CMAS</th>
<th>MAS and WUI server</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALERTRCVR</td>
<td>Optional</td>
<td>n/a</td>
<td>NETVALRT</td>
</tr>
<tr>
<td>ALERTVER</td>
<td>Optional</td>
<td>n/a</td>
<td>0</td>
</tr>
<tr>
<td>APISIGNMSG</td>
<td>Optional</td>
<td>n/a</td>
<td>YES</td>
</tr>
<tr>
<td>BASASSOCBLK</td>
<td>Optional</td>
<td>n/a</td>
<td>14301</td>
</tr>
<tr>
<td>BASLOGMSG</td>
<td>n/a</td>
<td>Optional</td>
<td>NO</td>
</tr>
<tr>
<td>CACHEDSNUM</td>
<td>Optional</td>
<td>n/a</td>
<td>2</td>
</tr>
<tr>
<td>CICSPLEX</td>
<td>n/a</td>
<td>Required</td>
<td></td>
</tr>
<tr>
<td>CMASSYSID</td>
<td>n/a</td>
<td>Optional</td>
<td>See description</td>
</tr>
<tr>
<td>CMTCMLNKACQ</td>
<td>Optional</td>
<td>n/a</td>
<td>RECONN</td>
</tr>
<tr>
<td>COHTTASKPRI</td>
<td>n/a</td>
<td>Optional</td>
<td>200</td>
</tr>
<tr>
<td>COIRTASKPRI</td>
<td>n/a</td>
<td>Optional</td>
<td>200</td>
</tr>
<tr>
<td>COMMTSBLCKS</td>
<td>Optional</td>
<td>Optional</td>
<td>128 (MAS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>512 (CMAS)</td>
</tr>
<tr>
<td>Parameter</td>
<td>CMAS</td>
<td>MAS and WUI server</td>
<td>Default</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
<td>--------------------</td>
<td>---------</td>
</tr>
<tr>
<td>HISTORYONLY</td>
<td>n/a</td>
<td>Optional</td>
<td>NO</td>
</tr>
<tr>
<td>HISTRECSMSG</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>HISTSECS</td>
<td>n/a</td>
<td>Optional</td>
<td>30</td>
</tr>
<tr>
<td>JRNLDEFCH</td>
<td>Optional</td>
<td>n/a</td>
<td>NO</td>
</tr>
<tr>
<td>JRNLOPACT</td>
<td>Optional</td>
<td>n/a</td>
<td>NO</td>
</tr>
<tr>
<td>JRNLRTEAEV</td>
<td>Optional</td>
<td>n/a</td>
<td>NO</td>
</tr>
<tr>
<td>MASALTRTLTCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>MASALTLPRTPRI</td>
<td>n/a</td>
<td>Optional</td>
<td>255</td>
</tr>
<tr>
<td>MASALTRTTLM</td>
<td>n/a</td>
<td>Optional</td>
<td>10</td>
</tr>
<tr>
<td>MASINITTIME</td>
<td>n/a</td>
<td>Optional</td>
<td>10</td>
</tr>
<tr>
<td>MASPLTWAIT</td>
<td>n/a</td>
<td>Optional</td>
<td>NO</td>
</tr>
<tr>
<td>MASTASKPROT</td>
<td>Optional</td>
<td>n/a</td>
<td>NO</td>
</tr>
<tr>
<td>MAXAUXCPST</td>
<td>Optional</td>
<td>n/a</td>
<td>50</td>
</tr>
<tr>
<td>MAXAUXTOTL</td>
<td>Optional</td>
<td>n/a</td>
<td>70</td>
</tr>
<tr>
<td>MAXHISTRECS</td>
<td>n/a</td>
<td>Optional</td>
<td>1</td>
</tr>
<tr>
<td>MSGBUCKETS</td>
<td>n/a</td>
<td>Optional</td>
<td>1024</td>
</tr>
<tr>
<td>NAME</td>
<td>Optional</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>RESSTATUS</td>
<td>Optional</td>
<td>n/a</td>
<td>NOTIFY</td>
</tr>
<tr>
<td>SEC</td>
<td>Optional</td>
<td>n/a</td>
<td>NO</td>
</tr>
<tr>
<td>SECLOGMSG</td>
<td>Optional</td>
<td>n/a</td>
<td>NO</td>
</tr>
<tr>
<td>SECRPTLVL</td>
<td>Optional</td>
<td>n/a</td>
<td>RESPONSE</td>
</tr>
<tr>
<td>SECTIMEOUT</td>
<td>Optional</td>
<td>n/a</td>
<td>30</td>
</tr>
<tr>
<td>SPOOLCLASS</td>
<td>Optional</td>
<td>Optional</td>
<td>P</td>
</tr>
<tr>
<td>STALLASYTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLASYCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLCONTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLCONCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLDBCTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLDBCCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLDB2TSK</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLDB2CNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLDLITSK</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLDLICNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLDPSKT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>Parameter</td>
<td>CMAS</td>
<td>MAS and WUI server</td>
<td>Default</td>
</tr>
<tr>
<td>---------------</td>
<td>------</td>
<td>--------------------</td>
<td>---------</td>
</tr>
<tr>
<td>STALLDSPCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLEJBTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLEJBCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLENQTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLENQCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLFLETSK</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLFLECNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLILKTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLILKCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLIPCTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLIPCCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLLCTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLLCKCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLLGRSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLLGRCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLITVTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>STALLITVCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>STALLJNLT SK</td>
<td>n/a</td>
<td>Optional</td>
<td>1</td>
</tr>
<tr>
<td>STALLJNLCTN</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLMQSTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLMQSCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLPGMTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLPGMCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLRMTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLRMICNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLSESTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLSESCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLSOCTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLSOCCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLSTGTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>1</td>
</tr>
<tr>
<td>STALLSTGCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLTDQTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLTDQCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLTRMTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
</tbody>
</table>
### Table 12. CICSPlex SM parameters used in CMAS, MAS, and WUI servers. (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>CMAS</th>
<th>MAS and WUI server</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>STALLTRMCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>STALLTSKTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>STALLTSKCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>STALLTSQTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLTSQCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLUSRRTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>STALLUSRCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>0</td>
</tr>
<tr>
<td>STALLWEBTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLWEBCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>3</td>
</tr>
<tr>
<td>STALLXMGTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>4</td>
</tr>
<tr>
<td>STALLXMGCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>STALLXRFTSK</td>
<td>n/a</td>
<td>Optional</td>
<td>1</td>
</tr>
<tr>
<td>STALLXRFCNT</td>
<td>n/a</td>
<td>Optional</td>
<td>2</td>
</tr>
<tr>
<td>SUPPRESSCMF</td>
<td>n/a</td>
<td>Optional</td>
<td>NO</td>
</tr>
<tr>
<td>TOBATCHREQ</td>
<td>Optional</td>
<td>n/a</td>
<td>0</td>
</tr>
<tr>
<td>TOONLINEREQ</td>
<td>Optional</td>
<td>n/a</td>
<td>0</td>
</tr>
<tr>
<td>TOPOLLINT</td>
<td>Optional</td>
<td>n/a</td>
<td>300</td>
</tr>
<tr>
<td>WLMLCUSH</td>
<td>n/a</td>
<td>Optional</td>
<td>20</td>
</tr>
</tbody>
</table>

**Note:** Support for the WLMLOADCOUNT and WLMLOADTHRESH EYUPARM values is discontinued in CICS TS for z/OS, Version 4.1.

**ALERTRCVR** (**NETVALRT | name**)
Identifies the 1-8-character name of the NetView Alert Receiver to be used by the CMAS if the CMAS sends NetView Generic Alerts to NetView.

**ALERTVER** (**0 | 1**)
Identifies the version of the CICSPlex SM generic alert record that the CMAS sends to NetView. See [Generic alert and resolution structures](#) for details about the generic alert Records that CICSPlex SM sends to NetView.

ALERTVER is relevant only for a CMAS that is named in an ACTNDEF as a CMAS that sends generic alerts to NetView.

**APISIGNMSG** (**YES | NO**)
Indicates whether the successful signon and signoff message, EYUXD0807I, is issued when a CICSPlex SM API user connects to, or disconnects (TERMINATE) from, the CICSPlex SM API.

**BASASSOCBLK** (**value | 14301**)
Specifies the number of BAS association blocks that can be acquired from a single association element. The default EYUPARM value creates an association segment size requiring approximately 1.2 MB of storage. If you specify the maximum value of 114597 blocks-per-segment is specified, then the resultant segment size is just over 8 MB.
BASLOGMSG(YES | NO)
Indicates whether CICS resources defined using BAS must have their definitions logged to the CSDL Transient Data Queue of the MAS when they are installed.
If the CICS version used by the MAS does not support the LOGMESSAGE option of the EXEC CICS CREATE command, BASLOGMSG has no effect.

CACHEDSNUM(value | 2)
Specifies the number of data spaces that this CMAS creates for each CICSPlex SM component. At least 1MB is allocated in each data cache when the data space is created. The value must be in the range 1 to 8.
You can change this parameter only on a CPSM CMAS cold start. Normally, do not change this parameter unless advised to do so by IBM Support.

CICSPLEX(name)
Identifies the 1- to 8-character name of the CICSpex to which the local MAS is to be associated.
The name of a CICSpex must not be the same as the name of a CMAS, a CICS system, or a CICS system group.

CMASSYSID(name)
Identifies the 1- to 4-character name of the CMAS to which a MAS is to be attached. If a MAS specifies a CMASSYSID and the CMAS is active but does not manage the CICSpex, the MAS waits until the specified CMAS is managing the CICSpex before it joins the CICSpex.
You can also use this parameter when a local MAS is to attach to a specific CMAS in the same MVS image.
Note: This parameter is optional. However, for a specific release of CICSpex SM, if you do not specify a value for the CMASSYSID parameter and you have multiple CMASs on an MVS system, a local MAS will connect to the last CMAS initialized on the MVS system that manages the CICSpex specified by the CICSPLEX parameter.

CMTCMLNKACQ(ALWAYS | RECONN)
Specifies whether you want the CMAS to attempt to reacquire LU6.2 CMAS to CMAS links (CMTCMLNKs) if the initial acquire attempt made by CICS fails. The initial acquire attempt is made by CICS when a CMAS is started, a z/OS Communications Server ACB is opened, or a CMAS to CMAS definition (CMTCMDEF) is installed. If the initial acquire attempt fails, CICSpex SM network surveillance might attempt to re-acquire the LU6.2 CMAS to CMAS links depending on the value of CMTCMLNKACQ:
- If CMTCMLNKACQ is set to ALWAYS, the CMAS attempts to acquire CMTCMLNKs, independent of whether the links were established in the current CMAS run.
- If CMTCMLNKACQ is set to RECONN, the CMAS attempts to re-acquire CMTCMLNKs only where CMTCMLNKs were established in the current CMAS run.
If the CMTCMLNKs were not acquired in the current CMAS run and the initial acquire attempts fail, CMTCMLNK must manually be acquired.
Depending on the CMTCMLNKACQ option that you are using, repeated failed acquire attempts can produce messages DFHZC3437, DFHZC3462 and DFHZC2405 and z/OS Communications Server IST663 and IST664.
CMTCMLNKACQ can be dynamically changed in a CMAS using the COD0 SET command.

COHTTASKPRI(value | 200)
Specifies the task priority of COHT, in the range 0 - 255. COHT is a CICSpex SM system task that you can use to process evaluation definitions, EVALDEFS, independent of the MAS. COHT is invoked in a MAS when an API or a Web User Interface query for completed task history records (HTASK records) is directed to the MAS. Use this parameter to tune the priority of HTASK requests so that a resource-intensive query does not affect the performance of other tasks in the MAS.
COIR TASKPRI(value | 200)
Specifies the task priority of COIR, in the range 0 - 255. COIR is a CICSPlex SM system task that you can use to process evaluation definitions, EVALDEFs, independent of the MAS.

For each EVALDEF that requests a separate task, an instance of COIR is started at the specified priority. If you specify a priority of 0, no separate COIR system tasks are started; all EVALDEFs are processed by the MAS long running task (LRT).

COMM TSBLOCKS((value | 512/128)
Specifies the number of sets of control blocks allocated at CMAS or MAS startup for CICSPlex SM Communications Transport Services. These control blocks are used when data must be shipped between a CMAS or MAS and other CMASs or MASs.

The default and minimum values for this parameter are 512 in a CMAS and 128 in a MAS. The maximum value is 8192 in either a CMAS or MAS.

Each set requires 1204 bytes of storage allocated in ESDSA in the CMAS or MAS. If the defaults are used, this amount of total storage is allocated:

| CMAS: 512 * 1204 = 616,448 bytes |
| MAS: 128 * 1204 = 154,112 bytes |

If the maximum value is specified, this amount of total storage is allocated:

| CMAS: 8192 * 1204 = 9,863,168 bytes |
| MAS: 8192 * 1204 = 9,863,168 bytes |

If a shortage occurs while running a CMAS or MAS, message EYUCT0105E is issued. At termination of the CMAS or MAS, message EYUCT0106W is issued. The later message includes a value equal to the highest concurrent shortage of sets (high-water mark). Increase the COMM TSBLOCKS parameter for the CMAS or MAS by at least the amount specified by the EYUCT0106W message before restarting the CMAS or MAS.

HISTORYONLY(YES | NO)
Specifies whether history data is collected without collecting normal CICSPlex SM monitoring data as well. For example, if MLOCTRAN and MREMTRAN data is not required set HISTORYONLY(YES) to prevent this data from being collected.

HISTRECMSG(value | 0)
Specifies that message EYUNL0179I 'Task History Recorder data set EYUHISTx has accrued nnnn records' is produced each time 'value' thousand records are written to the history data sets. The maximum allowed value is 1000 which specifies that a message is produced every time 1 million records are written to the history data sets.

The message is an aid to determining the optimum size of the history data sets. A value of 0 means that no EYUNL0179I messages are to be produced.

HISTSECS(value | 30)
Specifies the number of seconds to use as the default when API or Web User Interface users specify a parameter of RECENT(HISTSECS) when requesting completed task (HTASK) resource table records. The maximum allowed value is 86400 seconds (24 hours).

JRNLDEFCH(YES | NO)
Causes a journal record to be written for each data repository add, delete, and update operation.

JRNLOPACT(YES | NO)
Causes a journal record to be written for each successful action command issued against a MAS or CMAS.

JRNLRTAEV(YES | NO)
Causes a journal record to be written each time a real-time analysis (RTA) event is generated.

MAS ALT LRTCNT(0 - 5 | 0)
Indicates the number of alternate long-running system tasks (CONA) started in the MAS during MAS agent initialization. These system tasks remain active until the MAS agent stops or goes into restart mode, and handle all API, WUI, or RTA requests normally handled by the CONL system task, allowing
the CONL system task to perform other processing in the MAS. At any time, only one of the CONA system tasks processes requests. If the CONA system task that is currently processing requests becomes busy (as determined by the value of the MASALTLRTTIM EYUPARM), subsequent requests are directed to another CONA system task.

If you specify zero (0), no CONA system tasks are started and the CONL system task services the API, WUI or RTA requests that are normally directed to the long running system task. Specifying different values for MASAMTLRCDNT for multiple WLM target regions cause an uneven distribution of transactions to those regions because of differing long-running task counts.

**MASALTLRTPRI(0 - 255 | 255)**

Specifies the priority given to the CONA transaction for running the current MAS. If you specify this value as less than 255 you might adversely affect the response time of API and WUI users and stop RTA EVENTS from being created or resolved in a timely manner.

**MASALTLRTTIM(1 - 3600 | 10)**

Specifies the amount of time in seconds for which a CONA task can be busy before subsequent requests are directed to another active CONA task.

**MASINITTIME(value | 10)**

Specifies the number of minutes, from 5 to 59, that CICSPlex SM waits for the MAS to initialize.

- If you specify MASPLTWAIT(YES), the MASINITTIME value is the maximum length of time that PLT processing can be suspended for MAS initialization. (By suspending PLT processing, the chance of completing MAS initialization in a specified time is increased, because you are asking for less work to be done in a given time interval and thereby reducing the scope for contention during that time).
- If you specify MASPLTWAIT(NO), the MASINITTIME value is the maximum length of time that can elapse before MAS initialization is halted if it does not complete.

**MASPLTWAIT(YES | NO)**

Indicates whether CICSPlex SM suspends all PLT processing until the MAS is fully initialized and connected to the CMAS.

- When you specify MASPLTWAIT(YES), no CICS applications can be started and no users can sign on to the system until CICSPlex SM completes the installation of resources and resumes PLT processing.
- If CICSPlex SM does complete the installation of resources and resume PLT processing in the time interval specified by MASINITTIME, message EYUTS0003I is issued.
- If it does not complete in the time interval specified by MASINITTIME, one of two messages will be issued:
  - EYUNL0090W is issued when MAS initialization is halted and PLT processing resumes to allow the region to function as a CICS region without CICSPlex SM control.
  - EYUXL0090W is issued when MAS initialization is halted and PLT processing resumes to allow the region to function as a CICS region without CICSPlex SM control, but the MAS agent continues to wait for the CICSples to be registered with the ESSS subsystem by a starting CMAS. When a CMAS registers the CICSples, MAS agent initialization will continue.
- MAS initialization can be retried by entering the COLM transaction manually.
- When you specify MASPLTWAIT(NO), CICSPlex SM still observes the MASINITTIME value waiting for the MAS agent to complete the topology connect.
- If CICSPlex SM does not complete the topology connect in the time interval specified by MASINITTIME or its default value, message EYUNL0090W is issued, the MAS initialization is halted, and the PLT processing resumes to allow the region to function as a CICS region without CICSPlex SM control.
- MAS initialization can be retried by entering the COLM transaction manually.

If you are including a CICS system in a platform, or if you are using Business Application Services (BAS) to automatically install resources at CICS system initialization, specify MASPLTWAIT(YES) for
that system. MASPLTWAIT(YES) is required to automatically install resources for an application or platform, or BAS resources, when the CICS region is initialized.

If you are using Business Application Services (BAS) to automatically install a Db2 connection, and you want the connection to be activated during CICS startup, see “Activating Db2 and IBM MQ connections during CICS startup” on page 66.

MASTASKPROT (YES | NO)
Controls whether the CICSPlex SM API, Web User Interface (WUI), and CICS Management Client Interface (CMCI) are allowed to perform actions or set attribute values for CICSPlex SM MAS agent system tasks with transaction IDs COIE, COI0, CONA, or CONL.

**Note:** Beginning with CICS TS Version 5.4, CICSPlex SM MAS agent tasks that execute in a MAS that is at CICS TS Version 5.4 cannot be terminated with FORCEPURGE. If the MAS is at a release level earlier than CICS TS Version 5.4, these tasks can be terminated with FORCEPURGE.

- If you specify MASTASKPROT(NO), the default, users of the CICSPlex SM API, WUI, and CMCI are allowed to FORCEPURGE or modify attribute values for CICSPlex SM MAS agent tasks.
- If you specify MASTASKPROT(YES), CICSPlex SM validates the transaction ID of all tasks before allowing actions to be performed, or attribute values to be modified for active tasks. If the transaction ID indicates that the task runs as part of the CICSPlex SM MAS agent, the request is not processed, and a CICS response is set as follows:
  - RESP = TASKIDERR
  - RESP2 = 2 (The task is protected by CICS and is not eligible for modification with this command.)

  The function code (EIBFN) is null, to indicate that the response is simulated and not set by the CICS SPI.

MAXAUXCPSM(value | 50)
Specifies the percentage of total auxiliary storage that can be committed to each CMAS, in the range of 0 to 99. A value of 0 stops CICSPlex SM from checking the amount of space used.

**Important:** Setting a value of 0 might result in a shortage of auxiliary storage, requiring an IPL of the MVS system.

Each CMAS requires 24,160 4 KB pages (94 MB) of cache storage at initialization. If a request for additional cache storage would cause the CMAS to exceed the MAXAUXCPSM threshold, an SDUMP is taken and the CMAS is terminated. If the threshold is exceeded during CMAS initialization, the CMAS was unable to acquire the initial allocations for all required component data cache areas. Either increase the value of MAXAUXCPSM, or increase the total amount of auxiliary storage by adding or expanding external page data sets. If this threshold is reached during an attempt to create or extend a data cache after CMAS initialization has completed, the automatic restart mechanism (ARM) is invoked to attempt to restart the CMAS.

MAXAUXTOTL(value | 70)
Specifies the maximum total auxiliary storage use at which the CMAS allows a request for additional cache storage to be made, in the range of 0 to 99. A value of 0 stops CICSPlex SM from checking the amount of space used.

**Important:** Setting a value of 0 might result in a shortage of auxiliary storage, requiring an IPL of the MVS system.

Setting a nonzero value for MAXAUXTOTL prevents the CMAS from requesting an amount of cache storage that would cause the MVS system to enter a state of auxiliary storage shortage. If a request for additional cache storage causes the CMAS to exceed this threshold, an SDUMP is taken and the CMAS is terminated. This parameter can cause a CMAS to shut down even though the CMAS is not the largest user of auxiliary storage. If such a shutdown occurs during CMAS initialization, the CMAS was unable to acquire the initial allocations for all required component data cache areas. You must increase the total amount of auxiliary storage available by adding or expanding external page data sets. If this threshold is reached during an attempt to create or extend a data cache after CMAS initialization has completed, the automatic restart mechanism (ARM) is invoked to attempt to restart the CMAS.
MAXHISTRECS(value | 1)
Specifies a value in thousands, in the range 1 to 50. This value is a limit on the number of records returned on a completed task query from the MAS. You can limit the amount of data in a request for completed task (HTASK) resource table records. When this limit is reached, the CICSp.lex SM API GET request receives a WARNING response and MAXRECORDS reason.

MSGBUCKETS(value | 1024)
Specifies a value in the range 1 - 32768. This value specifies the number of buffers to be allocated for Topology data collection in the MAS. Each buffer is 64 bytes long. The buffer pool, allocated in the MAS cache data space, is used by CICSp.lex SM XMEOUT and XRSINDI global user exits and by the MAS Heartbeat task. The number of buffers must equal or exceed the total number of connections, DSNAMES, GLUES, TRUEs, and FEPI connections defined in the MAS. If the number of buffers is not sufficient for the Topology mapped resources in the MAS, a trace record with debug text XDATLOST is written at every other heartbeat interval when MAS Topology resource data is collected. Without sufficient buffers, resources are missing from Topology Resource Maps for the MAS in all CMASes in the CICSp lex, and query or action requests entered from the WUI or API for specific resources can fail because the target resources are not known to Topology.

NAME(name)
Identifies the 1- to 8-character name of the CMAS or local MAS that is to be started. If you do not specify this parameter, the default is the z/OS Communications Server application ID.

RESSTATUS(NOTIFY | MSG | CONMSG)
Indicates how the CMAS is to respond when a CICS resource that is being reported to the resource status facility has a change in operational state:

NOTIFY
Issues event notifications in the form of ERESSTAT resource table records.
You can monitor these event notifications by using the LISTEN command of the CICSp lex SM API. For more information, see LISTEN command.

MSG
Writes external messages to EYULOG.
If you specify MSG, event notifications are produced in addition to the messages.

CONMSG
Writes external messages to the job log, console, and EYULOG.
If you specify CONMSG, event notifications are produced in addition to the messages.
Use this option with care. It can cause many messages to be sent to the console.

SEC(YES | NO)
For a CMAS, indicates whether the CMAS is to perform security checking of CICSp lex SM requests directed to the CICS systems it manages.
If you specify NO, all security-related parameters are ignored.
If a CMAS manages any CICS regions that are running with security active (SEC=YES specified as a system initialization parameter), the CMAS must include SEC=YES in EYUPARM. If you do not activate CICSp lex SM security in the CMAS, a connection cannot be established to a CICS system that specifies SEC=YES. If a connection is attempted, the following message is issued to the console, the CMAS job log, and the CMAS EYULOG:

EYUCR0007E Security mismatch between CMAS cmasname and MAS masname. Connection terminating.

If a CMAS that is started with SEC(NO) connects directly or indirectly to a CMAS started with SEC(YES), any request sent to the SEC(YES) CMAS fails.

• If the request originates from the CICSp lex SM API connected to the SEC(NO) CMAS, the API request receives: RESPONSE 1031 NOTPERMIT REASON 1345 USRID
• If the request originates from the CICSp lex SM Web User Interface server connected to a SEC(NO) CMAS, the Web browser receives the message EYUVC1220E
SECLOGMSG(NO | YES | ALL)
Controls whether CICSPlex SM issues message EYUCR0009I to the CMAS EYULOG to record security failures.

When you specify NO, the default, message EYUCR0009I is not issued.
Specify YES, or ALL, to cause message EYUCR0009I to be issued.
SECLOGMSG(YES) can be useful if the External Security Manager (ESM) does not issue messages when it cannot make a decision or when a failure occurs.
When you specify SECLOGMSG(YES), EYUCR0009I is issued only for requests that are to be logged to the ESM.
SECLOGMSG(ALL) causes EYUCR0009I to be issued even when the ESM permits access to the resource. The ALL operand can produce many EYUCR0009I messages and must normally be used only under the direction of IBM Support.

You can change SECLOGMSG dynamically in a CMAS with the CDO SET command.

SECRPTLVL (NONE | RESPONSE | DETAIL)
Controls the level of detail available to a client API task when a response of NOTPERMIT with reason USRID is returned by a request.

When you specify NONE, all indications of a security validation exception are suppressed. A response of OK or NODATA, as appropriate, is returned to the client API task.
Specifying the default, RESPONSE, causes the original API response of NOTPERMIT and reason of USRID to be returned to the client task.
Specifying DETAIL causes a result set of MASQRYER resources to be built, identifying the regions in which the requesting user was denied access to a resource. MASQRYER resources can be retrieved by running a FETCH command, passing the QUERYERROR parameter.

Note: The SECRPTLVL parameter controls the response from the CMAS in which it is processed even though the API request might have originated in a different CMAS. Thus a CMAS which manages MASes containing sensitive resources can be started with SECRPTLVL(NONE), while other CMASes managing MASes with lower sensitivity can be started with SECRPTLVL(RESPONSE) or SECRPTLVL(DETAIL).

SECTIMEOUT(value | 30)
Specifies the time in minutes, in the range of 1 through 1440 (1 day), that idle user IDs are to remain signed on in the CMAS before being considered for timeout.

You can also use this value to control how often the CMAS checks for idle users to timeout. For example, with the default value of 30, the CMAS checks every 30 minutes for users who have not used the CMAS for 30 minutes. However, because the times are not synchronized the user ID might not be timed out for up to double the SECTIMEOUT value. Setting a low value increases the number of calls to the External Security Manager (ESM). Setting a high value means that users might have to wait a long time before automatically picking up security changes that affect the user ID (for example, adding the user to a new group).

You can use the CMAS or CMASLIST PURGE request, available from the API and WUI, to force a CMAS to check for users to time out immediately.
You can use the CMAS or CMASLIST RESET USERID request, available from the API and WUI, to force the CMAS to rebuild the user’s security information the next time it is used. This request is used after adding or removing a user ID to or from a group, and the user does not want to wait to be timed out to pick up the change.

SPOOLCLASS(class | P)
Specifies a SYSOUT class value, from A to Z or 0 to 9, that identifies where CICSPlex SM spool output is to be sent.
Spool output can be generated by these CICSPlex SM functions:
- The online utility transaction COLU
• The PRINT and CAPTURE commands of the interactive debugging transaction COD0

**STALLxxxCNT**

xxx represents a CICSPlex SM suspend class. The values for xxx are shown in Table 13 on page 127.

Identifies the number of consecutive occurrences of an entry in the suspend class required for CICSPlex SM to report a STALL. The value can be 0 - 999. Use 0 to indicate that STALL detection for the xxx suspend class is not active. The default value for each task is shown in Table 12 on page 117.

**Note:**

• From CICS Transaction Server for z/OS V5.4, tasks that are internally initiated in a MAS by CICSPlex SM no longer execute as user tasks. As a result, these tasks no longer qualify for STALL detection.

• From CICS Transaction Server for z/OS V5.4, MQSERIES suspends on the GETWAIT resource are not applicable for STALL detection.

**STALLxxxxTSK**

xxx represents a CICSPlex SM suspend class. The values for xxx are shown in Table 13 on page 127.

Identify the minimum number of concurrent tasks required to enter the suspend class. The value can be 0 - 999. Use 0 to indicate that STALL detection for the xxx suspend class is not active. The default value for each task is shown in Table 12 on page 117.

**Note:**

• From CICS Transaction Server for z/OS V5.4, tasks that are internally initiated in a MAS by CICSPlex SM no longer execute as user tasks. As a result, these tasks no longer qualify for STALL detection.

• From CICS Transaction Server for z/OS V5.4, MQSERIES suspends on the GETWAIT resource are not applicable for STALL detection.

### Table 13. CICSPlex SM suspend classes

<table>
<thead>
<tr>
<th>Suspend class</th>
<th>CICS suspend types</th>
<th>Value in STALLxxx parameters</th>
<th>Text in EYUPNxxxx messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate Session</td>
<td>ALLOCATE SES</td>
<td></td>
<td>ALLCSESS</td>
</tr>
<tr>
<td>Asynchronous services</td>
<td>AS_ANY AS_CHILD ASPARENT</td>
<td>ASY</td>
<td>ASYNC</td>
</tr>
<tr>
<td>Console</td>
<td>CQSYSTEM CON</td>
<td></td>
<td>CONSOLE</td>
</tr>
<tr>
<td>DBCTL</td>
<td>DBCTL DBC</td>
<td>DBCTL</td>
<td></td>
</tr>
<tr>
<td>Db2</td>
<td>CDB2CONN CDB2RDYQ CDB2TCB DB2_INIT DB2 DB2CDISC DB2EDISA</td>
<td>DB2®</td>
<td>DB2</td>
</tr>
<tr>
<td>DLI</td>
<td>DLI DLI</td>
<td>DLI</td>
<td>DLI</td>
</tr>
<tr>
<td>Dispatcher</td>
<td>DS_ASSOC DS_HELD DISPATCH</td>
<td>DSP</td>
<td>DISP</td>
</tr>
<tr>
<td>Suspend class</td>
<td>CICS suspend types</td>
<td>Value in STALLxxx parameters</td>
<td>Text in EYUPNxxxx messages</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------</td>
<td>-------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Enterprise Java™</td>
<td>EJ.ST.DJ.</td>
<td>EJB</td>
<td>EJB</td>
</tr>
<tr>
<td>Enterprise Java</td>
<td>RZRSTRAN</td>
<td>EJB</td>
<td>EJB</td>
</tr>
<tr>
<td>Enterprise Java</td>
<td>RZRSTRIG</td>
<td>EJB</td>
<td>EJB</td>
</tr>
<tr>
<td>Enterprise Java</td>
<td>SHREQUEST</td>
<td>EJB</td>
<td>EJB</td>
</tr>
<tr>
<td>Enterprise Java</td>
<td>SHSYSTEM</td>
<td>EJB</td>
<td>EJB</td>
</tr>
<tr>
<td>Enqueue</td>
<td>KC_ENQ ENQUEUE</td>
<td>ENQ</td>
<td>ENQUEUE</td>
</tr>
<tr>
<td>File</td>
<td>FCxxxxxx CFDTxxxx</td>
<td>FLE</td>
<td>FILE</td>
</tr>
<tr>
<td>File</td>
<td>FCBFSUSP</td>
<td>FLE</td>
<td>FILE</td>
</tr>
<tr>
<td>File</td>
<td>FCWAITQ</td>
<td>FLE</td>
<td>FILE</td>
</tr>
<tr>
<td>Interval Control</td>
<td>ICxxxxxx</td>
<td>ITV</td>
<td>INTV</td>
</tr>
<tr>
<td>Interval Control</td>
<td>TIEXPIRY</td>
<td>ITV</td>
<td>INTV</td>
</tr>
<tr>
<td>IP Interconnectivity</td>
<td>IS xxxx</td>
<td>IPC</td>
<td>IPIC</td>
</tr>
<tr>
<td>Journal</td>
<td>JASUBTAS JCxxxxxx</td>
<td>JNL</td>
<td>JOURNAL</td>
</tr>
<tr>
<td>Lock Manager</td>
<td>LMQUEUE</td>
<td>LCK</td>
<td>LOCK</td>
</tr>
<tr>
<td>Logger</td>
<td>LGxxxxxx</td>
<td>LGR</td>
<td>LOGGER</td>
</tr>
<tr>
<td>Log Manager</td>
<td>LGxxxxxx</td>
<td>LGR</td>
<td>LOGGER</td>
</tr>
<tr>
<td>MQSeries®</td>
<td>MQSERIES WMQ_INIT WMQCDISC</td>
<td>MQS</td>
<td>MQSERIES</td>
</tr>
<tr>
<td>Program Loader</td>
<td>APRDR</td>
<td>PGM</td>
<td>PROGRAM</td>
</tr>
<tr>
<td>Program Loader</td>
<td>CPI</td>
<td>PGM</td>
<td>PROGRAM</td>
</tr>
<tr>
<td>Program Loader</td>
<td>EDF</td>
<td>PGM</td>
<td>PROGRAM</td>
</tr>
<tr>
<td>Program Loader</td>
<td>PROGRAM</td>
<td>PGM</td>
<td>PROGRAM</td>
</tr>
<tr>
<td>Resource manager</td>
<td>DFHPTTW</td>
<td>RMI</td>
<td>RM</td>
</tr>
<tr>
<td>Resource manager</td>
<td>PRM</td>
<td>RMI</td>
<td>RM</td>
</tr>
<tr>
<td>Resource manager</td>
<td>RMCLIENT</td>
<td>RMI</td>
<td>RM</td>
</tr>
<tr>
<td>Resource manager</td>
<td>RMUOWOBJ</td>
<td>RMI</td>
<td>RM</td>
</tr>
<tr>
<td>Resource manager</td>
<td>UNSHUNT</td>
<td>RMI</td>
<td>RM</td>
</tr>
<tr>
<td>Sockets domain</td>
<td>CCACHE</td>
<td>SOC</td>
<td>SOCKETS</td>
</tr>
<tr>
<td>Suspend class</td>
<td>CICS suspend types</td>
<td>Value in STALLxxx parameters</td>
<td>Text in EYUPNxxx messages</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------</td>
<td>------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Sockets domain</td>
<td>SOCKETS</td>
<td>SOC</td>
<td>SOCKETS</td>
</tr>
<tr>
<td>Storage</td>
<td>SMSYSTEM</td>
<td>STG</td>
<td>STORAGE</td>
</tr>
<tr>
<td>Storage</td>
<td>xDSA ExDSA</td>
<td>STG</td>
<td>STORAGE</td>
</tr>
<tr>
<td>Terminal</td>
<td>NOTI</td>
<td>ILK</td>
<td>IRLINK</td>
</tr>
<tr>
<td>Transaction manager</td>
<td>FOREVER</td>
<td>XMG</td>
<td>TRANSACT</td>
</tr>
<tr>
<td>Transaction manager</td>
<td>RESYNC</td>
<td>XMG</td>
<td>TRANSACT</td>
</tr>
<tr>
<td>Transaction manager</td>
<td>SOCBNOTI</td>
<td>XMG</td>
<td>TRANSACT</td>
</tr>
<tr>
<td>Transaction manager</td>
<td>SOCFNOTI</td>
<td>XMG</td>
<td>TRANSACT</td>
</tr>
<tr>
<td>Transaction manager</td>
<td>TRANDEF</td>
<td>XMG</td>
<td>TRANSACT</td>
</tr>
<tr>
<td>Transaction manager</td>
<td>XMCHILD</td>
<td>XMG</td>
<td>TRANSACT</td>
</tr>
<tr>
<td>Transaction manager</td>
<td>XMPARENT</td>
<td>XMG</td>
<td>TRANSACT</td>
</tr>
<tr>
<td>Transient Data</td>
<td>MBCB_xxx MRCE_xxx TDEPLOCK TDIPLOCK TD_INIT TD_READ</td>
<td>TDQ</td>
<td>TSDATA</td>
</tr>
<tr>
<td>Terminal Control</td>
<td>ZCxxxxxx</td>
<td>TRM</td>
<td>TERM</td>
</tr>
<tr>
<td>Task Wait</td>
<td>EKCWAIT KCCOMPAT</td>
<td>TSK</td>
<td>TASKWAIT</td>
</tr>
<tr>
<td>Temporary Storage</td>
<td>TSxxxxxx</td>
<td>TSQ</td>
<td>TEMPSTOR</td>
</tr>
<tr>
<td>Terminal</td>
<td>IRLINK</td>
<td>ILK</td>
<td>IRLINK</td>
</tr>
<tr>
<td>Terminal Control</td>
<td>AITM</td>
<td>TRM</td>
<td>TERM</td>
</tr>
<tr>
<td>Transaction Manager</td>
<td>XM_HELD MXT TCLASS</td>
<td>XMG</td>
<td>TRANSACT</td>
</tr>
<tr>
<td>User wait</td>
<td>USERWAIT EDF</td>
<td>USR</td>
<td>USERWAIT</td>
</tr>
<tr>
<td>Web services</td>
<td>WBALIAS WEB_ECB</td>
<td>WEB</td>
<td>WEBSERV</td>
</tr>
<tr>
<td>Webservices</td>
<td>PIISLSTN</td>
<td>WEB</td>
<td>WEBSERV</td>
</tr>
<tr>
<td>Webservices</td>
<td>PIPELINE</td>
<td>WEB</td>
<td>WEBSERV</td>
</tr>
<tr>
<td>Webservices</td>
<td>RZCBNOTI</td>
<td>WEB</td>
<td>WEBSERV</td>
</tr>
<tr>
<td>XRF</td>
<td>XRxxxxxx</td>
<td>XRF</td>
<td>XRF</td>
</tr>
</tbody>
</table>
EYUPNxxxx messages are issued when a stall condition occurs that generates a real-time analysis system availability monitoring (SAM) event.

**SUPRESSCMF(YES | NO)**

For a local MAS, indicates whether the records collected by the CICS Monitor Facility are written to SMF.

The parameter suppresses only CICS type 3 performance class records. Type 4 exception records and type 5 transaction resource records are not suppressed. The type 3 performance records are suppressed only if the CICS region has an active CICSPlex SM monitor definition installed for the MTRAN monitoring class. You can verify which CICS regions have active monitoring for the MTRAN class by using the WUI Active monitor specifications (POLMON) tabular view.

**TOBATCHREQ(value | 0)**

Specifies the time in seconds before a batch request directed to a MAS is timed out. This time includes RTA requests and API requests initiated from non-CICS programs. Specify zero or a value in the range 10 - 1800.

- If you specify zero, the default value of 240 seconds (4 minutes) is applied. This value is then doubled when the request is transmitted to the MAS.
- If you specify a non-zero value in the range 10 - 1800, that value is used.
- If you specify a non-zero value less than 10, TOBATCHREQ is set to 10.

Depending on the value specified for TOBATCHREQ, more timeouts can be received. You can check in the following ways:

**RTA requests**

No data is processed for any MAS that times out and no external message is displayed. This occurrence might mean that an event is not created or might lead to premature termination of existing events.

**API requests initiated from non-CICS programs**

All API requests initiated from non-CICS programs receive a RESPONSE of ENVIRONERROR (1030) and REASON of REQTIMEOUT (1342) and no data records are returned, regardless of the CONTEXT and SCOPE of the request.

**TOONLINEREQ(value | 0)**

Specifies the time in seconds before an online request directed to a MAS is timed out, including WUI requests and API requests initiated from CICS programs. Specify zero, or a value in the range 10 - 1800.

- If you specify zero, the default value of 240 seconds (4 minutes) is applied. This value is then doubled when a CMAS-to-CMAS link is crossed. For example, you might have a WUI connected to CMAS-1 and MAS-2 is connected to CMAS-2. If you inquire from the WUI to MAS-2, the TOONLINEREQ default value of 240 seconds is doubled to 480 seconds because the request is transmitted from CMAS-1 to CMAS-2.
- If you specify a non-zero value in the range 10 - 1800, that value is used.
- If you specify a non-zero value less than 10, TOONLINEREQ is set to 10.

Depending on the value specified for TOONLINEREQ, more timeouts can be received. You can check in the following ways:

**WUI requests**

All WUI requests receive the following message and no data records are displayed, regardless of the CONTEXT and SCOPE of the request.

**EYUVC1220E**

CICSPlex SM API command (GET) failed. (Environeerror, Reqtimeout)

**API requests initiated from CICS programs**

All API requests initiated from CICS programs receive a RESPONSE of ENVIRONERROR (1030) and REASON of REQTIMEOUT (1342) and no data records are returned, regardless of the CONTEXT and SCOPE of the request.
TOPOLLINT(value | 300)  
Specifies the time in seconds that a CMAS delays between checking all requests to check if they exceed their timeout time. Because polling is used to check when to timeout a request, more reliable timeouts occur if this value is set less than or equal to both TOBATCHREQ and TOONLINEREQ.

When a request is directed to a MAS that is not connected to the originating CMAS, it is transmitted from the originating CMAS to the remote CMAS to which the MAS is connected. In this case, the remote CMAS performs the timeout processing, based on the TOBATCHREQ and TOONLINEREQ values specified in the originating CMAS and the TOPOLLINT value specified in the remote CMAS. For this reason, timeout processing is more consistent if all CMASes in the network have the same TOPOLLINT value.

WMLLCUSH(value | 20)  
Specifies the percentage of additional pre-allocated storage that CICSPlex SM WLM list management uses in addition to the value of MAXTASK at region initialization. This value is in the range of 0 to 100.

Important: If this value is lower than the known variance of MAXTASK from the initial MXT value, additional allocation and deallocation of storage in the routing region occurs, leading to degraded performance. In such circumstances, you must increase the initial values of MXT or WMLLCUSH and restart the routing region.

Creating resources with BAS

You can use the CICS Explorer or Web User Interface to create BAS resource objects to model and install the required CICS resources.

About this task
Creating resource objects is a three stage process.

Procedure
1. Access the appropriate resource definition view.
2. Create the definition.
3. Install the definition.

What to do next
After you install the resource object, you can use the CICS Explorer or Web User Interface to inquire on the resulting resources.

Working with BAS ATOMSERVICE resource definitions

ATOMSERVICE resource definitions specify the resources that CICS uses to produce an Atom service, feed, collection, or category document.

Viewing BAS ATOMSERVICE definitions
You can view information about your existing ATOMSERVICE resource definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents an ATOMSERVICE resource is called ATOMDEF. The Atomservice definitions view in the Web User Interface displays the list of ATOMDEF definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click Resource definitions to display the CICS resource definitions menu.
4. Click **Atomservice definitions**.

**Results**
The Web User Interface displays the list of ATOMDEF definitions for the current context.

**What to do next**
From this view you can create, update, remove, or install ATOMSERVICE resource definitions.

**Related tasks**
Defining ATOMSERVICE resources using BAS
You define a resource definition for an Atom service, feed, collection, or category document by creating a BAS resource object, ATOMDEF.

Installing BAS ATOMSERVICE definitions
Install the BAS resource object for the ATOMSERVICE resource to make the resource available to the CICS region.

**Defining ATOMSERVICE resources using BAS**
You define a resource definition for an Atom service, feed, collection, or category document by creating a BAS resource object, ATOMDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration** > **Basic CICS resource administration** > **Resource definitions** > **Atomservice definitions** to view the list of ATOMDEF resource definitions.
2. Click the **Create...** button.
   - To use an existing definition as the basis for the new definition, click the check box before clicking the **Create...** button.
   - The **Atomservice definitions** view displays.
3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **Atomservice definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
Viewing BAS ATOMSERVICE definitions
You can view information about your existing ATOMSERVICE resource definitions using the CICS Explorer or the Web User Interface.

Installing BAS ATOMSERVICE definitions
Install the BAS resource object for the ATOMSERVICE resource to make the resource available to the CICS region.

**Before you begin**
You must have created the required ATOMDEF resource object in the data repository to install the ATOMSERVICE resource in the CICS region.
About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Atomservice definitions to view the list of ATOMDEF resource definitions.
2. Click the Record check box to select an ATOMDEF definition and click the Install... button.
   Alternatively, click an ATOMDEF definition name and click the Install... button on the ATOMDEF definitions detailed view.

Results
The ATOMSERVICE resource is installed in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource from the main menu by clicking CICS operations > TCP/IP service operations views > Atomservice definitions.

Related tasks
Viewing BAS ATOMSERVICE definitions
You can view information about your existing ATOMSERVICE resource definitions using the CICS Explorer or the Web User Interface.

Defining ATOMSERVICE resources using BAS
You define a resource definition for an Atom service, feed, collection, or category document by creating a BAS resource object, ATOMDEF.

Working with BAS BUNDLE resource definitions
BUNDLE resource definitions describe bundles, the unit of deployment for an application. The BUNDLE resource defines where the bundle is deployed on z/OS UNIX and its status.

Viewing BUNDLE definitions
You can view information about your existing BUNDLE definitions using the IBM CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a BUNDLE is called BUNDDEF. The Bundle definitions view in the Web User Interface displays the list of BUNDDEF definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional resource administration.
3. Click Resource definitions > BUNDLE definitions.

Results
The Web User Interface displays the list of BUNDDEF definitions for the current context.

What to do next
From this view you can create, remove, or install BUNDLE resource definitions.
Defining a bundle using BAS
You define a resource definition for an application bundle by creating a BAS resource object, BUNDDEF.

About this task
You can define the resource object using the IBM CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Bundle definitions to view the list of BUNDDEF resource definitions.
2. Click the Create... button.
   To use an existing definition as the basis for the new definition, click the check box before clicking the Create... button.
   The Bundle definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The Bundle definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Installing BAS bundle definitions
Install the BAS resource object for the bundle to make it available to the CICS region.

Before you begin
You must have created the required BUNDDEF resource object in the data repository to install the bundle in the CICS region.

About this task
You can install the BAS resource object using the IBM CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Bundle definitions to view the list of BUNDDEF resource definitions.
2. Click the Record check box to select a definition and click the Install... button. Alternatively, click on a bundle definition name and click the Install... button on the Bundle definitions detailed view.

Results
The application bundle installs in the specified CICS region. CICS dynamically creates any additional resources that are defined in the bundle manifest.

What to do next
After the resource definition installs successfully, you can inquire about enabled application bundles from the WUI main menu by selecting CICS operations > Application operations views > Bundles. You can view the status of all the resources that are installed as part of the bundle using the IBM CICS Explorer.
Working with BAS Db2 connection resource definitions
A Db2 connection definition establishes the global characteristics of connections between CICS regions and a Db2 subsystem that use the Db2 attachment facility.

Viewing BAS Db2 connection definitions
You can view information about your existing Db2 connection definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a Db2 connection is called DB2CDEF. The DB2 connection definitions view in the Web User Interface displays the list of DB2CDEF definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click Resource definitions to display the CICS resource definitions menu.
4. Click DB2 connection definitions.

Results
The Web User Interface displays the list of Db2 connection definitions for the current context.

What to do next
From this view you can also create, update, remove, or install Db2 connection definitions.

Related tasks
Defining Db2 connections using BAS
You define a resource definition for a Db2 connection by creating a BAS resource object, DB2CDEF.

Installing BAS Db2 connection definitions
Install the BAS resource object for the Db2 connection to make the connection available to the CICS region.

Defining Db2 connections using BAS
You define a resource definition for a Db2 connection by creating a BAS resource object, DB2CDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > DB2 connection definitions to view the list of DB2CDEF resource definitions.
2. Click the Create... button.
   To use an existing definition as the basis for the new definition, click the check box before clicking the Create... button.
   The DB2 connection definitions view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The DB2 connection definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.
Related tasks

Viewing BAS Db2 connection definitions
You can view information about your existing Db2 connection definitions using the CICS Explorer or the Web User Interface.

Installing BAS Db2 connection definitions
Install the BAS resource object for the Db2 connection to make the connection available to the CICS region.

Installing BAS Db2 connection definitions
Install the BAS resource object for the Db2 connection to make the connection available to the CICS region.

Before you begin
You must have created the required DB2CDEF resource object in the data repository to install the Db2 connection in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > DB2 connection definitions to view the list of DB2CDEF resource definitions.
2. Click the Record check box to select a Db2 connection definition and click the Install... button. Alternatively, click a Db2 connection definition name and click the Install... button on the DB2 connection definitions detailed view.

Results
The Db2 connection is installed in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource from the main menu by clicking CICS operations > DB2, DBCTL and IBM MQ operations views > Connections.

Related tasks
Viewing BAS Db2 connection definitions
You can view information about your existing Db2 connection definitions using the CICS Explorer or the Web User Interface.

Defining Db2 connections using BAS
You define a resource definition for a Db2 connection by creating a BAS resource object, DB2CDEF.

Working with BAS Db2 entry resource definitions
A Db2 entry definition specifies the resources required by CICS transactions that use the Db2 attachment facility to access a Db2 subsystem.

Viewing Db2 entry definitions
You can view information about your existing Db2 entry definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a Db2 entry is called DB2EDEF. The DB2 entry definitions view in the Web User Interface displays the list of DB2EDEF definitions.
Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click Resource definitions to display the CICS resource definitions view.
4. Click DB2 entry definitions.

Results
The Web User Interface displays the list of Db2 entry definitions for the current context.

What to do next
From this view you can also create, update, remove, or install Db2 entry definitions.

Related tasks
Defining Db2 entries using BAS
You define a resource definition for a CICS-deployed JAR file by creating a BAS resource object, DB2EDEF.

Installing BAS Db2 entry definitions
Install the BAS resource object for the Db2 entry to make the definition available to the CICS region.

Defining Db2 entries using BAS
You define a resource definition for a CICS-deployed JAR file by creating a BAS resource object, DB2EDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > DB2 entry definitions
2. From the DB2 entry definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The DB2 entry definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The DB2 entry definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing Db2 entry definitions
You can view information about your existing Db2 entry definitions using the CICS Explorer or the Web User Interface.

Installing BAS Db2 entry definitions
Install the BAS resource object for the Db2 entry to make the definition available to the CICS region.

**Installing BAS Db2 entry definitions**

Install the BAS resource object for the Db2 entry to make the definition available to the CICS region.

**Before you begin**

You must have created the required DB2EDEF resource object in the data repository to install the Db2 entry in the CICS region.

**About this task**

You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**

1. From the main menu, click **Administration** > **Basic CICS resource administration** > **Resource definitions** > **DB2 entry definitions** to view the list of DB2EDEF resource definitions.
2. Click the Record check box to select a JAR file definition and click the **Install...** button. Alternatively, click a Db2 entry definition name and click the **Install...** button on the **DB2 entry definitions** detailed view.

**Results**

The Db2 entry resource is installed in the specified CICS region.

**What to do next**

After the resource definition installs successfully, you can inquire about the resource from the main menu by clicking **CICS operations** > **DB2, DBCTL and IBM MQ operations views** > **DB2 operations views** > **Entries**.

**Related tasks**

- **Viewing Db2 entry definitions**
  You can view information about your existing Db2 entry definitions using the CICS Explorer or the Web User Interface.
- **Defining Db2 entries using BAS**
  You define a resource definition for a CICS-deployed JAR file by creating a BAS resource object, DB2EDEF.

**Working with BAS Db2 transaction resource definitions**

A Db2 transaction definition identifies transactions that use the resources specified in a Db2 entry definition.

**Viewing Db2 transaction definitions**

You can view information about your existing Db2 transaction definitions using the CICS Explorer or the Web User Interface.

**About this task**

The BAS resource definition that represents a Db2 transaction is called DB2TDEF. The **DB2 transaction definitions** view in the Web User Interface displays the list of DB2TDEF definitions.

**Procedure**

1. From the main menu, click **Administration**.
2. From the **Administration views** menu, click either **Basic CICS resource administration** or **Fully functional Business Application Services (BAS) administration**.
3. Click **CICS resource definitions** to display the **CICS resource definitions** view.
4. Click **DB2 transaction definitions**.
Results
The Web User Interface displays the list of Db2 transaction definitions for the current context.

What to do next
From this view you can also create, update, remove, or install Db2 transaction definitions.

Related tasks
Defining Db2 transactions using BAS
You define a resource definition for a Db2 transaction by creating a BAS resource object, DB2TDEF.

Installing BAS Db2 transaction definitions
Install the BAS resource object for the Db2 transaction to make the definition available in the CICS region.

Defining Db2 transactions using BAS
You define a resource definition for a Db2 transaction by creating a BAS resource object, DB2TDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > DB2 transaction definitions
2. From the DB2 transaction definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The DB2 transaction definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The DB2 transaction definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing Db2 transaction definitions
You can view information about your existing Db2 transaction definitions using the CICS Explorer or the Web User Interface.

Installing BAS Db2 transaction definitions
Install the BAS resource object for the Db2 transaction to make the definition available in the CICS region.

Installing BAS Db2 transaction definitions
Install the BAS resource object for the Db2 transaction to make the definition available in the CICS region.

Before you begin
You must have created the required DB2TDEF resource object in the data repository to install the Db2 transaction definition in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > DB2 transaction definitions to view the list of DB2TDEF resource definitions.
2. Click the Record check box to select a Db2 transaction definition and click the Install... button. Alternatively, click a Db2 connection definition name and click the Install... button on the DB2 transaction definitions detailed view.

Results
The Db2 transaction installs in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource by clicking CICS operations > DB2, DBCTL and IBM MQ operations views > DB2 operations views.

Related tasks
Viewing Db2 transaction definitions
You can view information about your existing Db2 transaction definitions using the CICS Explorer or the Web User Interface.

Defining Db2 transactions using BAS
You define a resource definition for a Db2 transaction by creating a BAS resource object, DB2TDEF.

Working with BAS document template resource definitions
Document template definitions define document templates for use in managed CICS regions.

Viewing document template definitions
You can view information about your existing document template definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a document template is called DOCDEF. The Document template definitions view in the Web User Interface displays the list of DOCDEF definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Document template definitions.

Results
The Web User Interface displays the list of document template definitions for the current context.

What to do next
From this view you can also create, update, remove, or install document template definitions.

Related tasks
Defining document templates using BAS
You define a resource definition for a document template by creating a BAS resource object, DOCDEF.

Installing BAS document template definitions
Install the BAS resource object for the document template to make the definition available in the CICS region.

Defining document templates using BAS
You define a resource definition for a document template by creating a BAS resource object, DOCDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.
Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Document definitions.
2. From the Document definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The Document template definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The Document definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing document template definitions
You can view information about your existing document template definitions using the CICS Explorer or the Web User Interface.

Installing BAS document template definitions
Install the BAS resource object for the document template to make the definition available in the CICS region.

Installing BAS document template definitions
Install the BAS resource object for the document template to make the definition available in the CICS region.

Before you begin
You must have created the required DOCDEF resource object in the data repository to install the document template in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Document template definitions to view the list of DOCDEF resource definitions.
2. Click the Record check box to select a document template definition and click the Install... button.
   Alternatively, click a document template definition name and click the Install... button on the Document template definitions detailed view.

Results
The document template resource installs in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource by clicking CICS operations > Document template operations views > Document template.

Related tasks
Viewing document template definitions
You can view information about your existing document template definitions using the CICS Explorer or the Web User Interface.

Defining document templates using BAS
You define a resource definition for a document template by creating a BAS resource object, DOCDEF.

**Working with FEPI node list resource definitions**

FEPI node list definitions describe the physical and operational characteristics of FEPI nodes.

**Viewing FEPI node list definitions**

You can view information about your existing FEPI node list definitions using the CICS Explorer or the Web User Interface.

**About this task**

The BAS resource definition that represents a FEPI node list is called FENODDEF. The FEPI node list definitions view in the Web User Interface displays information about existing FEPI node definitions.

**Procedure**

1. From the main menu, click *Administration*.
2. From the *Administration views menu*, click either *Basic CICS resource administration* or *Fully functional Business Application Services (BAS) administration*.
3. Click *CICS resource definitions* to display the *CICS resource definitions* view.
4. Click *FEPI node list definitions*.

**Results**

The Web User Interface displays the list of FEPI node definitions.

**What to do next**

From this view you can also create, update, remove, or install FEPI node list definitions.

**Related tasks**

- Defining FEPI node lists using BAS
- Installing BAS FEPI node list definitions

**Defining FEPI node lists using BAS**

You define a resource definition for a FEPI node list by creating a BAS resource object, FENODDEF.

**About this task**

You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**

1. From the main menu, click *AdministrationBasic CICS resource administrationResource definitionsFEPI node list definitions*.
2. From the *FEPI node list definitions* view, click the *Create...* button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the *Create...* button.
   - The *FEPI node list definitions* create view displays.
3. Complete the relevant fields and click *Yes* to create the definition.

**Results**

The *FEPI node list definitions* view displays showing the new definition.

**What to do next**

To add the definition to a resource group, click the *Add to resource group...* button.
Related tasks

Viewing FEPI node list definitions
You can view information about your existing FEPI node list definitions using the CICS Explorer or the Web User Interface.

Installing BAS FEPI node list definitions
Install the BAS resource object for the FEPI node list to make the definition available in the CICS region.

Before you begin
You must have created the required FENODDEF resource object in the data repository to install the FEPI node list in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > FEPI node list definitions to view the list of FENODDEF resource definitions.
2. Click the Record check box to select a FEPI node list definition and click the Install... button.

Results
The FEPI node list resource installs in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource by clicking CICS operations > FEPI operations views > Nodes.

Related tasks

Viewing FEPI node list definitions
You can view information about your existing FEPI node list definitions using the CICS Explorer or the Web User Interface.

Defining FEPI node lists using BAS
You define a resource definition for a FEPI node list by creating a BAS resource object, FENODDEF.

Working with FEPI pool resource definitions
FEPI pool definitions describe the physical and operational characteristics of FEPI pools.

Viewing FEPI pool definitions
You can view information about your existing FEPI pool definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a FEPI pool is called FEPOODEF. The FEPI pool definitions view in the Web User Interface displays information about existing FEPI pool definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click FEPI pool definitions.

Results
The Web User Interface displays the list of FEPI pool definitions.

What to do next
From this view you can also create, update, remove, or install FEPI pool definitions.

Related tasks
Defining FEPI pools using BAS
You define a resource definition for a FEPI pool by creating a BAS resource object, FEPOODEF.

Installing BAS FEPI pool definitions
Install the BAS resource object for the FEPI pool to make the definition available in the CICS region.

Defining FEPI pools using BAS
You define a resource definition for a FEPI pool by creating a BAS resource object, FEPOODEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration Basic CICS resource administrationResource definitionsFEPI pool definitions.
2. From the FEPI pool definitions view, click the Create... button. To use an existing definition as the basis of the new one, click the check box before clicking the Create... button. The FEPI pool definitions create view is displayed.
3. Complete the relevant fields and click Yes to create the definition.

Results
The FEPI pool definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing FEPI pool definitions
You can view information about your existing FEPI pool definitions using the CICS Explorer or the Web User Interface.

Installing BAS FEPI pool definitions
Install the BAS resource object for the FEPI pool to make the definition available in the CICS region.

Installing BAS FEPI pool definitions
Install the BAS resource object for the FEPI pool to make the definition available in the CICS region.

Before you begin
You must have created the required FEPOODEF resource object in the data repository to install the FEPI pool in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.
Procedure
1. From the main menu, click AdministrationBasic CICS resource administrationResource definitionsFEPI pool definitions to view the list of FEPOODEF resource definitions.
2. Click the Record check box to select a FEPI pool definition and click the Install... button.
   Alternatively, click a FEPI pool definition name and click the Install... button on the FEPI pool definitions detailed view.

Results
The FEPI pool resource installs in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource by clicking CICS operations > FEPI operations views > Pools.

Related tasks
Viewing FEPI pool definitions
You can view information about your existing FEPI pool definitions using the CICS Explorer or the Web User Interface.

Defining FEPI pools using BAS
You define a resource definition for a FEPI pool by creating a BAS resource object, FEPOODEF.

Working with FEPI property set resource definitions
FEPI property set definitions describe the physical and operational characteristics of FEPI property sets.

Viewing FEPI property set definitions
You can view information about your existing FEPI property set definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a FEPI property set is called FEPRODEF. The FEPI property set definitions view in the Web User Interface displays information about existing FEPI property set definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click FEPI property set definitions.

Results
The Web User Interface displays the list of FEPI property set definitions.

What to do next
From this view you can also create, update, remove, or install FEPI property set definitions.

Related tasks
Defining FEPI property sets using BAS
You define a resource definition for FEPI property set by creating a BAS resource object, FEPRODEF.
Installing BAS FEPI property set definitions
Install the BAS resource object for the FEPI property set to make the definition available in the CICS region.

**Defining FEPI property sets using BAS**
You define a resource definition for FEPI property set by creating a BAS resource object, FEPRODEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > FEPI property set definitions**.
2. From the **FEPI property set definitions** view, click the **Create...** button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the **Create...** button.
   - The **FEPI property set definitions** create view displays.
3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **DB2 entry definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
- Viewing FEPI property set definitions
- Installing BAS FEPI property set definitions

Before you begin
You must have created the required FEPRODEF resource object in the data repository to install the FEPI property set in the CICS region.

**Installing BAS FEPI property set definitions**
Install the BAS resource object for the FEPI property set to make the definition available in the CICS region.

**Before you begin**
You must have created the required FEPRODEF resource object in the data repository to install the FEPI property set in the CICS region.

**About this task**
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > FEPI property set definitions** to view the list of FEPRODEF resource definitions.
2. Click the Record check box to select a FEPI node list definition and click the **Install...** button.
   - Alternatively, click a property set definition name and click the **Install...** button on the **FEPI property set definitions** detailed view.

**Results**
The FEPI property set resource installs in the specified CICS region.
What to do next
After the resource definition installs successfully, you can inquire about the resource by clicking CICS operations > FEPI operations views > Property sets.

Related tasks
Viewing FEPI property set definitions
You can view information about your existing FEPI property set definitions using the CICS Explorer or the Web User Interface.

Defining FEPI property sets using BAS
You define a resource definition for FEPI property set by creating a BAS resource object, FEPREODEF.

Working with FEPI target list resource definitions
FEPI target list definitions describe the physical and operational characteristics of FEPI targets.

Viewing FEPI target list definitions
You can view information about your existing FEPI property set definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a FEPI target list is called FETRGDEF. The FEPI target list definitions view in the Web User Interface displays information about existing FEPI target list definitions.

Procedure
1. From the main menu, click Administration views.
2. From the Administration views menu, click either Basic CICS resource administration views or Fully functional Business Application Services (BAS) administration views.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click FEPI target list definitions.

Results
The Web User Interface displays the list of FEPI target list definitions.

What to do next
From this view you can also create, update, remove, or install FEPI target list definitions.

Related tasks
Defining FEPI target lists using BAS
You define a resource definition for FEPI target list by creating a BAS resource object, FETRGDEF.

Installing BAS FEPI target list definitions
Install the BAS resource object for the FEPI target list to make the definition available in the CICS region.

Defining FEPI target lists using BAS
You define a resource definition for FEPI target list by creating a BAS resource object, FETRGDEF.

About this task
You can define the resource object using the Web User Interface. These instructions explain this procedure.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > FEPI target list definitions.
2. From the FEPI target list definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
The **FEPI target list definitions** create view displays.

3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **FEPI target list definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
- Viewing FEPI target list definitions
  You can view information about your existing FEPI property set definitions using the CICS Explorer or the Web User Interface.
- Installing BAS FEPI target list definitions
  Install the BAS resource object for the FEPI target list to make the definition available in the CICS region.

**Before you begin**
You must have created the required FETRGDEF resource object in the data repository to install the FEPI target list in the CICS region.

**About this task**
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration** > **Basic CICS resource administration** > **Resource definitions** > **FEPI target list definitions** to view the list of FETRGDEF resource definitions.
2. Click the Record check box to select a FEPI target list definition and click the **Install...** button.
   Alternatively, click a FEPI target list definition name and click the **Install...** button on the **FEPI target list definitions** detailed view.

**Results**
The FEPI target list resource installs in the specified CICS region.

**What to do next**
After installation of a FEPI target list resource definition, you can enquire about the resultant object using:
- **CICS operations** > **FEPI operations views** > **Targets**

**Related tasks**
- Viewing FEPI target list definitions
  You can view information about your existing FEPI property set definitions using the CICS Explorer or the Web User Interface.
- Defining FEPI target lists using BAS
You define a resource definition for FEPI target list by creating a BAS resource object, FETRGDEF.

Working with BAS FILE resource definitions
FILE resource definitions describe the physical and operational characteristics of files.

Viewing BAS file definitions
You can view information about your existing FILE definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a FILE resource is called FILEDEF. The File definitions view in the Web User Interface displays information about existing FILE definitions.

Procedure
1. From the main menu, click Administration views.
2. From the Administration views menu, click either Basic CICS resource administration views or Fully functional Business Application Services (BAS) administration views.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click File definitions.

Results
The Web User Interface displays the list of FILE definitions.

What to do next
From this view you can also create, update, remove, or install FILE definitions.

Related tasks
Defining files using BAS
You define a resource definition for a file by creating a BAS resource object, FILEDEF.

Installing BAS file definitions
Install the BAS resource object for the FILE definition to make the file available in the CICS region.

Defining files using BAS
You define a resource definition for a file by creating a BAS resource object, FILEDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration->Basic CICS resource administration->Resource definitions->File definitions
2. From the File definitions view, click the Create... button. To use an existing definition as the basis of the new one, click the check box before clicking the Create... button. The File definitions create view is displayed.
3. Complete the relevant fields and click Yes to create the definition.

Results
The File definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.
Related tasks

Viewing BAS file definitions
You can view information about your existing FILE definitions using the CICS Explorer or the Web User Interface.

Installing BAS file definitions
Install the BAS resource object for the FILE definition to make the file available in the CICS region.

Installing BAS file definitions
Install the BAS resource object for the FILE definition to make the file available in the CICS region.

Before you begin
You must have created the required FILEDEF resource object in the data repository to install the FILE resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > File definitions
2. Click the Record check box to select a file definition and click the Install... button.
   Alternatively, click a file definition name and click the Install... button on the File definitions detailed view.

Results
The FILE resource installs in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource by clicking CICS operations > File operations views. Select the file type that you are interested in from the menu.

Related tasks

Viewing BAS file definitions
You can view information about your existing FILE definitions using the CICS Explorer or the Web User Interface.

Defining files using BAS
You define a resource definition for a file by creating a BAS resource object, FILEDEF.

File key segment resource definitions
File key segment definitions describe the parts of a Windows file record that are to be used as the record key.

Key segments are valid only for:
• Entry-sequenced files (type E)
• Key-sequenced files (type K)

Key segments are not valid for:
• Alternate index files (type A)
• Relative-record files (type R)
• Remote files
You cannot install file key segment definitions.
Viewing file segment definitions
You can view information about your existing file segment definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a file segment resource is called FSEGDEF. The File segment definitions view in the Web User Interface displays information about existing file segment definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click File segment definitions.

Results
The Web User Interface displays the list of file segment definitions.

What to do next
From this view you can also create, update, or remove file segment definitions.

Related tasks
Defining file key segments using BAS
You define a resource definition for a file key segment by creating a BAS resource object, FSEGDEF.

Installing file key segment definitions

Defining file key segments using BAS
You define a resource definition for a file key segment by creating a BAS resource object, FSEGDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > File key segment definitions.
2. From the File key segment definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The File key segment definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The File key segment definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing file segment definitions
You can view information about your existing file segment definitions using the CICS Explorer or the Web User Interface.

Installing file key segment definitions
Installing file key segment definitions

About this task
You cannot install file key segment definitions.

Related tasks
Viewing file segment definitions
You can view information about your existing file segment definitions using the CICS Explorer or the Web User Interface.
Defining file key segments using BAS
You define a resource definition for a file key segment by creating a BAS resource object, FSEGDEF.

Working with BAS enqueue model definitions
Enqueue model definitions describe how enqueue models are to run in a CICS region.

Viewing global enqueue model definitions
You can view information about your existing global enqueue model definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a global enqueue model resource is called ENQMDEF. The Global enqueue model definitions view in the Web User Interface displays information about existing global enqueue model definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Global enqueue model definitions.

Results
The Web User Interface displays the list of global enqueue model definitions.

What to do next
From this view you can also create, update, install, or remove global enqueue model definitions.

Related tasks
Defining global enqueue models using BAS
You define a resource definition for a global enqueue model by creating a BAS resource object, ENQMDEF.
Installing BAS global enqueue model definitions
Install the BAS resource object for the global enqueue model definition to make it available in the CICS region.

Defining global enqueue models using BAS
You define a resource definition for a global enqueue model by creating a BAS resource object, ENQMDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Global enqueue model definitions.
2. From the Global enqueue model definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The Global enqueue model definitions create view displays.

3. Complete the relevant fields and click Yes to create the definition.

**Results**
The Global enqueue models definitions view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the Add to resource group... button.

**Related tasks**
Viewing global enqueue model definitions
You can view information about your existing global enqueue model definitions using the CICS Explorer or the Web User Interface.

Installing BAS global enqueue model definitions
Install the BAS resource object for the global enqueue model definition to make it available in the CICS region.

Installing BAS global enqueue model definitions
Install the BAS resource object for the global enqueue model definition to make it available in the CICS region.

**Before you begin**
You must have created the required ENQMDEF resource object in the data repository to install the global enqueue model definition in the CICS region.

**About this task**
Enqueue models forming nested generic enqueue names must be installed either in the disabled state or in order, from the most specific (for example, ABCD) to the least specific (for example, AB*). If another enqueue model with the same or a less specific nested enqueue name is already installed and enabled, the installation fails. You can install disabled enqueue models in any order, but you must enable them in order from most specific to least specific.

You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Global enqueue model definitions
2. Click the Record check box to select a enqueue model definition and click the Install... button.
   Alternatively, click a enqueue model definition name and click the Install... button on the Global enqueue detailed view.

**Results**
The global enqueue model definition installs in the specified CICS region.

**What to do next**
After the resource definition installs successfully, you can inquire about the resource by clicking CICS operations > Global enqueue model operations views > Global enqueue model.

**Related tasks**
Viewing global enqueue model definitions
You can view information about your existing global enqueue model definitions using the CICS Explorer or the Web User Interface.

Defining global enqueue models using BAS
You define a resource definition for a global enqueue model by creating a BAS resource object, ENQMDEF.

**Working with BAS IPCONN resource definitions**

IPCONN resource definitions define the outbound attributes of an IP interconnectivity (IPIC) connection from a local CICS region to a remote CICS region or system.

**Viewing BAS IPIC connection definitions**
You can view information about your existing IPIC connection definitions using the CICS Explorer or the Web User Interface.

**About this task**
The BAS resource definition that represents an IPCONN resource is called IPCONDEF. The IPIC connection definitions view in the Web User Interface displays the list of IPCONDEF definitions.

**Procedure**
1. From the main menu, click **Administration**.
2. From the **Administration views** menu, click either **Basic CICS resource administration** or **Fully functional Business Application Services (BAS) administration**.
3. Click **Resource definitions** to display the **CICS resource definitions** view.
4. Click **IPIC connection definitions** to display a list of the IPIC connections that are defined.

**Results**
The Web User Interface displays the list of IPIC connection definitions.

**What to do next**
From this view you can also create, update, install, or remove IPIC connection definitions.

**Related tasks**

- **Defining IPIC connections using BAS**
  You can define IPIC connections by creating a BAS resource object, IPCONDEF.

- **Installing BAS IPIC connection definitions**
  Install the BAS resource object for the IPCONN resource definition to make the resource available in the CICS region.

- **Defining IPIC connections using BAS**
  You can define IPIC connections by creating a BAS resource object, IPCONDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. The steps in this task use the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > IPIC connection definitions** to view the list of IPCONDEF resource definitions.
2. Click **Create**....
   To use an existing definition as the basis for the new definition, click the check box before clicking **Create**....
   The **IPIC connection definitions** create view is displayed.
3. Complete the relevant fields:
   a) The name of the IPCONDEF must be the same as the SYSID of the partner CICS region.
You can view this information in the **CICS system definitions** view.

**b)** The APPLID of the IPCONDEF must be the APPLID of the partner CICS region.
You can view this information in the **CICS system definitions** view.

**c)** Optional: The host, network ID, and port number of the IPCONDEF are populated from the partner CICS region if defined in the system definition. If the values are not populated, you can specify a host name and network ID if the partner CICS region is in a different network.
The combination of APPLID and the network ID ensures that the remote CICS region is referred to by a unique name. You can also specify a port number for the partner CICS region. If you specify different values from the definitions in the partner region, your values are overridden when the definition is created.

**d)** Specify the name of the TCPDEF resource object on the local CICS region that define the inbound attributes of the IPIC connection.

**e)** Click **Yes** to create the definition.

**Results**
The **IPIC connection definitions** view displays the new definition.

**What to do next**
To add the definition to a resource group, click **Add to resource group**.... You must also create an IPCONDEF resource object for the partner CICS region and ensure there are suitable TCPDEF resource objects for each region.

**Related tasks**
**Viewing BAS IPIC connection definitions**
You can view information about your existing IPIC connection definitions using the CICS Explorer or the Web User Interface.

**Installing BAS IPIC connection definitions**
Install the BAS resource object for the IPCONN resource definition to make the resource available in the CICS region.

**Installing BAS IPIC connection definitions**
Install the BAS resource object for the IPCONN resource definition to make the resource available in the CICS region.

**Before you begin**
You must have created the required IPCONDEF resource object in the data repository to install the IPCONN resource in the CICS region.

**About this task**
You can either install IPIC connection definitions into each CICS region manually, using the CICS Explorer or the Web User Interface, or use the SYSLINK resource object to install the required definitions automatically into target CICS regions. The steps in this task use the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > IPIC connection definitions** to view the list of IPCONDEF resource definitions.
2. Click the **Record** check box to select a CICS system and click **Install**.... Alternatively, click a CICS system name and click **Install...** on the **IPIC connection definitions** detailed view.
3. Install the TCPDEF resource object to create a TCPIPSERVICE resource that references the IPCONN resource.
   You must have both IPCONN and TCPIPSERVICE resources installed in the local and remote CICS regions to establish an IPIC connection.
Results
The IPIC connection is installed in the specified CICS region.

What to do next
After the IPIC connection definition installs successfully, you can inquire about the connection from the main menu by clicking CICS operations > Connection operations views.

Related tasks
Viewing BAS IPIC connection definitions
You can view information about your existing IPIC connection definitions using the CICS Explorer or the Web User Interface.

Defining IPIC connections using BAS
You can define IPIC connections by creating a BAS resource object, IPCONDEF.

Working with BAS ISC/MRO connection resource definitions
ISC/MRO connection definitions identify remote regions or systems that a CICS region communicates with using intersystem communication (ISC) or multiple region operation (MRO).

Viewing BAS ISC and MRO connection definitions
You can view information about your existing ISC and MRO connection definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents an ISC or MRO CONNECTION resource is called CONNDEF. The ISO/MRO connection definitions view in the Web User Interface displays the list of CONNDEF definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click Resource definitions to display the CICS resource definitions view.
4. Click ISC/MRO connection definitions to display a list of the ISC and MRO connections that are defined.

Results
The Web User Interface displays the list of ISC and MRO connection definitions.

What to do next
From this view you can also create, update, install, or remove ISC and MRO connection definitions.

Related tasks
Defining ISC and MRO connections using BAS
You define a resource definition for an ISC or MRO connection by creating a BAS resource object, CONNDEF.

Installing BAS ISC and MRO connection definitions
Install the BAS resource object for the CONNECTION resource definition to make the resource available in the CICS region.

**Defining ISC and MRO connections using BAS**
You define a resource definition for an ISC or MRO connection by creating a BAS resource object, CONNDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > ISC/MRO connection definitions**.
2. From the **ISC/MRO connection definitions** view, click the **Create...** button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the **Create...** button.
   - The **ISO/MRO connection definitions** create view displays.
3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **ISC/MRO connection definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
- Viewing BAS ISC and MRO connection definitions
- Installing BAS ISC and MRO connection definitions

**Before you begin**
You must have created the required CONNDEF resource object in the data repository to install the CONNECTION resource in the CICS region.

**About this task**
You can either install the connections into each CICS region manually, using the CICS Explorer or the Web User Interface, or use the SYSLINK resource object to install the required definitions automatically into target CICS regions. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > ISC/MRO connection definitions**.
2. Click the Record check box to select a CICS system and click the **Install...** button.
   - Alternatively, click a CICS system name and click the **Install...** button on the **ISO/MRO connection definitions** detailed view.
**Results**
The ISC or MRO connection is installed in the specified CICS region.

**What to do next**
After the connection installs successfully, you can inquire about the connection from the main menu by clicking CICS operations > Connection operations views.

**Related tasks**
- Viewing BAS ISC and MRO connection definitions
  You can view information about your existing ISC and MRO connection definitions using the CICS Explorer or the Web User Interface.
- Defining ISC and MRO connections using BAS
  You define a resource definition for an ISC or MRO connection by creating a BAS resource object, CONNDEF.

**Working with BAS journal model resource definitions**
Journal model definitions describe the association between a CICS journal name and the MVS system log streams or the SMF log.

**Viewing journal model definitions**
You can view information about your existing journal model definitions using the CICS Explorer or the Web User Interface.

**About this task**
The BAS resource definition that represents a journal model resource is called JRNMDEF. The Journal model definitions view in the Web User Interface displays the list of JRNMDEF definitions.

**Procedure**
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click Resource definitions to display the CICS resource definitions view.
4. Click Journal model definitions.

**Results**
The Web User Interface displays the list of journal model definitions.

**What to do next**
From this view you can also create, update, install, or remove journal model definitions.

**Related tasks**
- Defining journal models using BAS
  You define a resource definition for journal model by creating a BAS resource object, JRNMDEF.
- Installing BAS journal model definitions
  Install the BAS resource object for the journal model to make the resource available in the CICS region.
- Defining journal models using BAS
  You define a resource definition for journal model by creating a BAS resource object, JRNMDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.
Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Journal model definitions.
2. From the Journal model definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The Journal model definitions create view is displayed.
3. Complete the relevant fields and click Yes to create the definition.

Results
The Journal model definitions view is displayed showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing journal model definitions
You can view information about your existing journal model definitions using the CICS Explorer or the Web User Interface.

Installing BAS journal model definitions
Install the BAS resource object for the journal model to make the resource available in the CICS region.

Before you begin
You must have created the required JRNMDEF resource object in the data repository to install the journal model resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Journal model definitions.
2. Click the Record check box to select a journal model definition and click the Install... button.
   Alternatively, click a journal model definition name and click the Install... button on the Journal model definitions detailed view.

Results
The journal model definition installs in the specified CICS region.

What to do next
After the journal model installs successfully, you can inquire about the resource by clicking CICS operations > Journal operations views > Models.

Related tasks
Viewing journal model definitions
You can view information about your existing journal model definitions using the CICS Explorer or the Web User Interface.

Defining journal models using BAS
You define a resource definition for journal model by creating a BAS resource object, JRNMDEF.

**Working with BAS JVMSERVER resource definitions**
A JVMSERVER resource definition defines the runtime environment for a JVM server. The JVMSERVER resource defines the location of the JVM profile, the Language Environment enclave options, and other configuration information to control the initialization of the JVM.

**Viewing JVMSERVER definitions**
You can view information about your existing JVMSERVER definitions using the IBM CICS Explorer or the Web User Interface.

**About this task**
The BAS resource definition that represents a JVMSERVER resource is called JVMSVDEF. The JVMSERVER definitions view in the Web User Interface displays the list of JVMSVDEF definitions.

**Procedure**
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional resource administration.
3. Click Resource definitions > JVMSERVER definitions.

**Results**
The Web User Interface displays the list of JVMSVDEF definitions for the current context.

**What to do next**
From this view you can create, remove, or install JVMSERVER resource definitions.

**Related tasks**
- Defining JVMSERVER resources using BAS
- Installing BAS JVMSERVER definitions

**Defining JVMSERVER resources using BAS**
You define a resource definition for a JVM server by creating a BAS resource object, JVMSVDEF.

**About this task**
You can define the resource object using the IBM CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Bundle definitions to view the list of JVMSVDEF resource definitions.
2. Click the Create... button.
   - To use an existing definition as the basis for the new definition, click the check box before clicking the Create... button.
   - The Bundle definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

**Results**
The JVM server definitions view displays showing the new definition.
What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing JVMSERVER definitions
You can view information about your existing JVMSERVER definitions using the IBM CICS Explorer or the Web User Interface.

Installing BAS JVMSERVER definitions
Install the BAS resource object for the JVM server to make it available to the CICS region.

Installing BAS JVMSERVER definitions
Install the BAS resource object for the JVM server to make it available to the CICS region.

Before you begin
You must have created the required JVMSVDEF resource object in the data repository to install the JVM server in the CICS region.

About this task
You can install the BAS resource object using the IBM CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > JVM server definitions to view the list of JVMSVDEF resource definitions.
2. Click the Record check box to select a definition and click the Install... button. Alternatively, click on a JVM server definition name and click the Install... button on the JVM server definitions detailed view.

Results
The JVM server installs in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about enabled JVM servers from the WUI main menu by selecting CICS operations > Enterprise Java component operations views > JVM server.

Related tasks
Viewing JVMSERVER definitions
You can view information about your existing JVMSERVER definitions using the IBM CICS Explorer or the Web User Interface.

Defining JVMSERVER resources using BAS
You define a resource definition for a JVM server by creating a BAS resource object, JVMSVDEF.

Working with BAS LIBRARY resource definitions
LIBRARY definitions describe the attributes for dynamic program LIBRARY resources.

Viewing LIBRARY definitions
You can view information about your existing LIBRARY definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a LIBRARY resource is called LIBDEF. The LIBRARY definitions view in the Web User Interface displays information about existing LIBRARY definitions.

Procedure
1. From the main menu, click Administration views.
2. From the Administration views menu, click either Basic CICS resource administration views or Fully functional Business Application Services (BAS) administration views.

3. Click Resource definitions to display the CICS resource definitions view.

4. Click LIBRARY definitions.

Results
The Web User Interface displays the list of LIBRARY definitions.

What to do next
From this view you can also create, update, install, or remove LIBRARY definitions.

Related tasks
Defining LIBRARY resources using BAS
You define a LIBRARY resource definition by creating a BAS resource object, LIBDEF.

Installing BAS LIBRARY definitions
Install the BAS resource object for the LIBRARY resource to make the definition available in the CICS region.

Defining LIBRARY resources using BAS
You define a LIBRARY resource definition by creating a BAS resource object, LIBDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > LIBRARY definitions.

2. From the LIBRARY definitions view, click the Create... button.
   - To use an existing definition as the basis of the new definition, click the check box before clicking the Create... button.
   - The LIBRARY definitions create view displays.

3. Complete the relevant fields and click Yes to create the definition.

Results
The LIBRARY definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing LIBRARY definitions
You can view information about your existing LIBRARY definitions using the CICS Explorer or the Web User Interface.

Installing BAS LIBRARY definitions
Install the BAS resource object for the LIBRARY resource to make the definition available in the CICS region.

Before you begin
You must have created the required resource object in the data repository to install the LIBRARY resource in the CICS region.
About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > LIBRARY definitions.
2. Click the Record check box to select a program definition and click the Install... button.
   Alternatively, click a LIBRARY definition name and click the Install... button on the LIBRARY definitions detailed view.

Results
The LIBRARY resource installs in the CICS region.

What to do next
After the LIBRARY resource installs successfully, you can inquire about the resource by clicking CICS operations > Program operations views > LIBRARYs, including DFHRPL.

Related tasks
Viewing LIBRARY definitions
You can view information about your existing LIBRARY definitions using the CICS Explorer or the Web User Interface.
Defining LIBRARY resources using BAS
You define a LIBRARY resource definition by creating a BAS resource object, LIBDEF.

Working with BAS LSR pool resource definitions
LSR pool definitions describe the size and characteristics of local shared resource pools that VSAM uses for certain files.

Viewing LSR pool definitions
You can view information about your existing LSR pool definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents an LSR pool is called LSRDEF. The LSR pool definitions view in the Web User Interface displays information about existing LSR pool definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click LSR pool definitions.

Results
The Web User Interface displays the list of LSR pool definitions.

What to do next
From this view you can also create, update, install, or remove LSR pool definitions.

Related tasks
Defining LSR pools using BAS
You define an LSR pool resource by creating a BAS resource object, LSRDEF.
Installing BAS LSR pool definitions
Install the BAS resource object for the LSR pool resource to make the definition available in the CICS region.

**Defining LSR pools using BAS**
You define an LSR pool resource by creating a BAS resource object, LSRDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > LSR pool definitions**.
2. From the **LSR pool definitions** view, click the **Create...** button.
   - To use an existing definition as the basis of the new definition, click the check box before clicking the **Create...** button.
   - The **LSR pool definitions** create view displays.
3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **LSR pool definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
- Viewing LSR pool definitions
  You can view information about your existing LSR pool definitions using the CICS Explorer or the Web User Interface.
- Installing BAS LSR pool definitions
  Install the BAS resource object for the LSR pool resource to make the definition available in the CICS region.

**Installing BAS LSR pool definitions**
Install the BAS resource object for the LSR pool resource to make the definition available in the CICS region.

**Before you begin**
You must have created the required resource object in the data repository to install the LSR pool resource in the CICS region.

**About this task**
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > LSR pool definitions**.
2. Click the Record check box to select a LSR pool definition and click the **Install...** button.
   - Alternatively, click a LSR pool definition name and click the **Install...** button on the **LSR pool definitions** detailed view.

**Results**
The LSR pool resource installs in the CICS region.
What to do next
After the LSR pool resource definition installs successfully, you can inquire about the resource by clicking CICS operations > File operations views. From the File operations views menu, select either VSAM LSR pool buffers or VSAM LSR pools.
Related tasks
Viewing LSR pool definitions
You can view information about your existing LSR pool definitions using the CICS Explorer or the Web User Interface.
Defining LSR pools using BAS
You define an LSR pool resource by creating a BAS resource object, LSRDEF.

Working with BAS map set resource definitions
Map set definitions describe the characteristics of a group of related screen layouts, or maps.

Viewing map set definitions
You can view information about your existing map set definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a map set is called MAPDEF. The Map set definitions view in the Web User Interface displays information about existing map set definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Map set definitions.

Results
The Web User Interface displays the list of map set definitions.

What to do next
From this view you can also create, update, install, or remove map set definitions.
Related tasks
Defining map sets using BAS
You define a map set resource by creating a BAS resource object, MAPDEF.
Installing BAS map set definitions
Install the BAS resource object for the map set resource to make the definition available in the CICS region.

Defining map sets using BAS
You define a map set resource by creating a BAS resource object, MAPDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Map set definitions.
2. From the Map set definitions view, click the Create... button.
To use an existing definition as the basis of the new definition, click the check box before clicking the 
Create... button.

The **Map set definitions** create view displays.

3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **Map set definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
Viewing map set definitions
You can view information about your existing map set definitions using the CICS Explorer or the Web User Interface.

Installing BAS map set definitions
Install the BAS resource object for the map set resource to make the definition available in the CICS region.

**Installing BAS map set definitions**
Install the BAS resource object for the map set resource to make the definition available in the CICS region.

**Before you begin**
You must have created the required resource object in the data repository to install the map set resource in the CICS region.

**About this task**
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Map set definitions**.
2. Click the Record check box to select a map set definition and click the **Install...** button.
   Alternatively, click a map set definition name and click the **Install...** button on the **Map set definitions** detailed view.

**Results**
The map set resource installs in the specified CICS region.

**Related tasks**
Viewing map set definitions
You can view information about your existing map set definitions using the CICS Explorer or the Web User Interface.

Defining map sets using BAS
You define a map set resource by creating a BAS resource object, MAPDEF.

**Working with BAS MQCONN resource definitions**

The MQCONN resource definition for the CICS region defines the attributes of the connection between CICS and IBM MQ.

**Viewing BAS MQCONN definitions**

You can view information about your existing MQCONN resource definitions using the CICS Explorer or the Web User Interface.

**About this task**

The BAS resource definition that represents an MQCONN resource is called MQCONDEF. The IBM MQ connection definitions view in the Web User Interface displays the list of MQCONDEF definitions. Only one MQCONN resource definition can be installed and used at a time in a CICS region.

**Procedure**

1. From the main menu, click **Administration**.
2. From the Administration views menu, click either **Basic CICS resource administration** or **Fully functional Business Application Services (BAS) administration**.
3. Click **Resource definitions** to display the CICS resource definitions menu.
4. Click **IBM MQ connection definitions**.

**Results**

The Web User Interface displays the list of MQCONDEF definitions for the current context.

**What to do next**

From this view you can create, update, remove, or install MQCONN resource definitions.

**Related tasks**

- **Defining MQCONN resources using BAS**
  You define a resource definition for the connection between CICS and IBM MQ by creating a BAS resource object, MQCONDEF.

- **Installing BAS MQCONN definitions**
  Install the BAS resource object for the MQCONN resource to replace the existing IBM MQ connection definition for the CICS region with your new definition.

- **Defining MQCONN resources using BAS**
  You define a resource definition for the connection between CICS and IBM MQ by creating a BAS resource object, MQCONDEF.

**About this task**

You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**

1. From the main menu, click **Administration** > **Basic CICS resource administration** > **Resource definitions** > **IBM MQ connection definitions** to view the list of MQCONDEF resource definitions.
2. Click the **Create...** button.
   - To use an existing definition as the basis for the new definition, click the check box before clicking the **Create...** button.
   - The **IBM MQ connection definitions** view displays.
3. Complete the relevant fields and click **Yes** to create the definition.
Results
The IBM MQ connection definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing BAS MQCONN definitions
You can view information about your existing MQCONN resource definitions using the CICS Explorer or the Web User Interface.

Installing BAS MQCONN definitions
Install the BAS resource object for the MQCONN resource to replace the existing IBM MQ connection definition for the CICS region with your new definition.

Installing BAS MQCONN definitions
Install the BAS resource object for the MQCONN resource to replace the existing IBM MQ connection definition for the CICS region with your new definition.

Before you begin
You must have created the required MQCONDEF resource object in the data repository to install the MQCONN resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface. Only one MQCONN resource definition can be installed at a time in a CICS region, so when you install a second MQCONN resource definition, CICS implicitly discards the existing MQCONN definition before proceeding with the installation, unless you are reinstalling an MQCONN resource definition with the same name.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > IBM MQ connection definitions to view the list of MQCONDEF resource definitions.
2. Alternatively, click an MQCONDEF definition name and click the Install... button on the MQCONDEF definitions detailed view.

Results
The MQCONN resource is installed in the specified CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource from the main menu by clicking CICS operations > DB2, DBCTL and IBM MQ operations views > IBM MQ connection definitions.

Related tasks
Viewing BAS MQCONN definitions
You can view information about your existing MQCONN resource definitions using the CICS Explorer or the Web User Interface.

Defining MQCONN resources using BAS
You define a resource definition for the connection between CICS and IBM MQ by creating a BAS resource object, MQCONDEF.

**Working with BAS MQMONITOR resource definitions**
MQMONITOR resource definitions define attributes for WebSphere MQ message consumers, such as the trigger monitor transaction CKTI.

**Viewing BAS MQMONITOR definitions**
You can view information about your existing MQMONITOR resource definitions using the CICS Explorer or the Web User Interface.

**About this task**
The BAS resource definition that represents an MQMONITOR resource is called MQMONDEF. The WebSphere MQ monitor definitions view in the Web User Interface displays the list of MQMONDEF definitions.

**Procedure**
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click Resource definitions to display the CICS resource definitions menu.
4. Click WebSphere MQ monitor definitions.

**Results**
The Web User Interface displays the list of MQMONDEF definitions for the current context.

**What to do next**
From this view you can create, update, remove, or install MQMONITOR resource definitions.

**Defining MQMONITOR resources using BAS**
You define a resource definition for an MQ monitor, which can be a trigger monitor, an MQ bridge monitor, or a user-written monitor, by creating a BAS resource object, MQMONDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click Administration > Basic CICS resource administration or Fully functional Business Application Services (BAS) administration > Resource definitions > WebSphere MQ monitor definitions to view the list of MQMONDEF resource definitions.
2. Click the Create button.
   - To use an existing definition as the basis for the new definition, click the check box before clicking the Create button.
   - The WebSphere MQ monitor definition view displays.
3. Complete the relevant fields and click Yes to create the definition.

**Results**
The WebSphere MQ monitor definitions view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the Add to resource group button.
Installing BAS MQMONITOR definitions
Install the BAS resource object for the MQMONITOR resource to make the definition available in the CICS region.

Before you begin
You must have created the MQMONDEF resource object in the data repository to install the MQMONITOR resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > WebSphere MQ monitor definitions to view the list of MQMONDEF resource definitions.
2. Click the Record check box to select an MQMONDEF definition and click the Install button.
   Alternatively, click an MQMONDEF definition name and click the Install button on the WebSphere MQ monitor definitions detailed view.

Results
The MQMONITOR resource is installed in the CICS region.

What to do next
After the resource definition installs successfully, you can inquire about the resource from the main menu by clicking CICS operations > DB2, DBCTL and WebSphere MQ operations views > WebSphere MQ monitors.

Working with BAS partition set resource definitions
Partition set definitions describe the characteristics of a display partition configuration.

Viewing partition set definitions
You can view information about your existing partition set definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a partition set is called PRTNDEF. The Partition set definitions view in the Web User Interface displays information about existing partition set definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Partition set definitions.

Results
The Web User Interface displays the list of partition set definitions.

What to do next
From this view you can also create, update, install, or remove partition set definitions.

Related tasks
Defining partition sets using BAS
You define a partition set resource by creating a BAS resource object, PRTNDEF.

Installing BAS partition set definitions
Install the BAS resource object for the partition set resource to make the definition available in the CICS region.

Defining partition sets using BAS
You define a partition set resource by creating a BAS resource object, PRTNDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Partition set definitions.
2. From the Partition set definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The Partition set definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The Partition set definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing partition set definitions
You can view information about your existing partition set definitions using the CICS Explorer or the Web User Interface.

Installing BAS partition set definitions
Install the BAS resource object for the partition set resource to make the definition available in the CICS region.

Installing BAS partition set definitions
Install the BAS resource object for the partition set resource to make the definition available in the CICS region.

Before you begin
You must have created the required resource object in the data repository to install the partition set resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Partition set definitions.
2. Click the Record check box to select a partition set definition and click the Install... button.
   Alternatively, click a partition set definition name and click the Install... button on the Partition set definitions detailed view.
Results
The partition set resource installs in the specified CICS region.

Related tasks
Viewing partition set definitions
You can view information about your existing partition set definitions using the CICS Explorer or the Web User Interface.

Defining partition sets using BAS
You define a partition set resource by creating a BAS resource object, PRTNDEF.

Working with BAS partner resource definitions
Partner definitions enable CICS application programs to communicate with a partner application program running on a remote region using APPC protocols.

Viewing partner definitions
You can view information about your existing partner definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a partner definition is called PARTDEF. The Partition definitions view in the Web User Interface displays information about existing partner definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Partner definitions.

Results
The Web User Interface displays the list of partner definitions.

What to do next
From this view you can also create, update, install, or remove partner definitions.

Related tasks
Defining partner definitions using BAS
You define a partner resource by creating a BAS resource object, PARTDEF.

Installing BAS partner definitions
Install the BAS resource object for the partner resource to make the definition available in the CICS region.

Defining partner definitions using BAS
You define a partner resource by creating a BAS resource object, PARTDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Partner definitions.
2. From the Partner definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
The **Partner definitions** create view displays.

3. Complete the relevant fields and click **Yes** to create the definition.

**Results**  
The **Partner definitions** view displays showing the new definition.

**What to do next**  
To add the definition to a resource group, click the **Add to resource group**... button.

**Related tasks**  
Viewing partner definitions  
You can view information about your existing partner definitions using the CICS Explorer or the Web User Interface.

Installing BAS partner definitions  
Install the BAS resource object for the partner resource to make the definition available in the CICS region.

Installing BAS partner definitions  
Install the BAS resource object for the partner resource to make the definition available in the CICS region.

**Before you begin**  
You must have created the required resource object in the data repository to install the partner resource in the CICS region.

**About this task**  
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**  
1. From the main menu, click **Administration** > **Basic CICS resource administration** > **Resource definitions** > **Partner definitions**.
2. Click the Record check box to select a partner definition and click the **Install...** button.  
   Alternatively, click a partner definition name and click the **Install...** button on the **Partner definitions** detailed view.

**Results**  
The partner definition installs in the specified CICS region.

**Related tasks**  
Viewing partner definitions  
You can view information about your existing partner definitions using the CICS Explorer or the Web User Interface.

Defining partner definitions using BAS
You define a partner resource by creating a BAS resource object, PARTDEF.

**Working with BAS pipeline resource definitions**

A PIPELINE resource definition is used when a CICS application is acting as a web service provider or requester. It provides information about the message handler programs that act on a web service request and on the response.

**Viewing pipeline definitions**

You can view information about your existing pipeline definitions using the CICS Explorer or the Web User Interface.

**About this task**

The BAS resource definition that represents a pipeline definition is called PIPEDEF. The **Pipeline definitions** view in the Web User Interface displays information about existing pipeline definitions.

**Procedure**

1. From the main menu, click **Administration views**.
2. From the **Administration views menu**, click either **Basic CICS resource administration views** or **Fully functional Business Application Services (BAS) administration views**.
3. Click **CICS resource definitions** to display the **CICS resource definitions** view.
4. Click **Pipeline definitions**.

**Results**

The Web User Interface displays the list of pipeline definitions.

**What to do next**

From this view you can also create, update, install, or remove pipeline definitions.

**Related tasks**

- **Defining pipeline definitions using BAS**
  You define a PIPELINE resource by creating a BAS resource object, PIPEDEF.
- **Installing BAS pipeline definitions**
  Install the BAS resource object for the pipeline resource to make the definition available in the CICS region.

**Defining pipeline definitions using BAS**

You define a PIPELINE resource by creating a BAS resource object, PIPEDEF.

**About this task**

You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**

1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Pipeline definitions**.
2. From the **Pipeline definitions** view, click the **Create...** button.
   - To use an existing definition as the basis of the new definition, click the check box before clicking the **Create...** button.
   - The **Pipeline definitions** create view displays.
3. Complete the relevant fields and click **Yes** to create the definition.

**Results**

The **Pipeline definitions** view displays showing the new definition.
What to do next
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
- Viewing pipeline definitions
  You can view information about your existing pipeline definitions using the CICS Explorer or the Web User Interface.
- Installing BAS pipeline definitions
  Install the BAS resource object for the pipeline resource to make the definition available in the CICS region.

**Installing BAS pipeline definitions**
Install the BAS resource object for the pipeline resource to make the definition available in the CICS region.

**Before you begin**
You must have created the required resource object in the data repository to install the PIPELINE resource in the CICS region.

**About this task**
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Pipeline definitions**.
2. Click the Record check box to select a pipeline definition and click the **Install...** button. Alternatively, click a pipeline definition name and click the **Install...** button on the **Pipeline definitions** detailed view.

**Results**
The PIPELINE resource installs in the specified CICS region.

**Related tasks**
- Viewing pipeline definitions
  You can view information about your existing pipeline definitions using the CICS Explorer or the Web User Interface.
- Defining pipeline definitions using BAS
  You define a PIPELINE resource by creating a BAS resource object, PIPEDEF.

**Working with BAS PROCESSTYPE definitions**
PROCESSTYPE resource definitions describe the physical and operational characteristics of CICS business transaction services (BTS) process types.

**Viewing process type definitions**
You can view information about your existing process type definitions using the CICS Explorer or the Web User Interface.

**About this task**
The BAS resource definition that represents a pipeline definition is called PROCDEF. The **Process type definitions** view in the Web User Interface displays information about existing process type definitions.

**Procedure**
1. From the main menu, click **Administration**.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.

3. Click CICS resource definitions to display the CICS resource definitions view.

4. Click Process type definitions.

**Results**
The Web User Interface displays the list of process type definitions.

**What to do next**
From this view you can also create, update, install, or remove process type definitions.

**Related tasks**
- Defining process types using BAS
  You define a PROCESSTYPE resource by creating a BAS resource object, PROCDEF.
- Installing BAS process type definitions
  Install the BAS resource object for the PROCESSTYPE resource to make the definition available in the CICS region.

**Defining process types using BAS**
You define a PROCESSTYPE resource by creating a BAS resource object, PROCDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Process type definitions.
2. From the Process types definitions view, click the Create... button.
   - To use an existing definition as the basis of the new definition, click the check box before clicking the Create... button.
   - The Process types definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

**Results**
The Process types definitions view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the Add to resource group... button.

**Related tasks**
- Viewing process type definitions
  You can view information about your existing process type definitions using the CICS Explorer or the Web User Interface.
- Installing BAS process type definitions
  Install the BAS resource object for the PROCESSTYPE resource to make the definition available in the CICS region.

**Installing BAS process type definitions**
Install the BAS resource object for the PROCESSTYPE resource to make the definition available in the CICS region.

**Before you begin**
You must have created the required resource object in the data repository to install the PROCESSTYPE resource in the CICS region.
About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Process type definitions**.
2. Click the Record check box to select a process type definition and click the **Install...** button.
   Alternatively, click a process type definition name and click the **Install...** button on the Process type definitions detailed view.

Results
The PROCESSTYPE resource installs successfully in the specified CICS region.

Related tasks
Viewing process type definitions
You can view information about your existing process type definitions using the CICS Explorer or the Web User Interface.

Defining process types using BAS
You define a PROCESSTYPE resource by creating a BAS resource object, PROCDEF.

Working with BAS profile resource definitions
Profile definitions control the interactions between transactions and terminals or logical units.

Viewing profile resource definitions
You can view information about your existing profile definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a profile definition is called PROFDEF. The Profile definitions view in the Web User Interface displays information about existing profile definitions.

Procedure
1. From the main menu, click **Administration**.
2. From the Administration views menu, click either **Basic CICS resource administration** or **Fully functional Business Application Services (BAS) administration**.
3. Click **CICS resource definitions** to display the CICS resource definitions view.
4. Click **Profile definitions**.

Results
The Web User Interface displays the list of profile definitions.

What to do next
From this view you can also create, update, install, or remove profile definitions.

Related tasks
Defining profiles using BAS
You define a PROFILE resource by creating a BAS resource object, PROFDEF.

Installing BAS profile definitions
Install the BAS resource object for the PROFILE resource to make the definition available in the CICS region.

**Defining profiles using BAS**
You define a PROFILE resource by creating a BAS resource object, PROFDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Profile definitions**.
2. From the **Profile definitions** view, click the **Create...** button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the **Create...** button.
   - The **Profile definitions** create view displays.
3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **Profile definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
- **Viewing profile resource definitions**
  You can view information about your existing profile definitions using the CICS Explorer or the Web User Interface.

- **Installing BAS profile definitions**
  Install the BAS resource object for the PROFILE resource to make the definition available in the CICS region.

- **Installing BAS profile definitions**
  Install the BAS resource object for the PROFILE resource to make the definition available in the CICS region.

**Before you begin**
You must have created the required resource object in the data repository to install the PROFILE resource in the CICS region.

**About this task**
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Profile definitions**.
2. Click the Record check box to select a profile definition and click the **Install...** button.
   - Alternatively, click a profile definition name and click the **Install...** button on the **Profile definitions** detailed view.

**Results**
The PROFILE resource installs successfully in the specified CICS region.
Related tasks
Viewing profile resource definitions
You can view information about your existing profile definitions using the CICS Explorer or the Web User Interface.

Defining profiles using BAS
You define a PROFILE resource by creating a BAS resource object, PROFDEF.

Working with BAS PROGRAM resource definitions
PROGRAM resource definitions describe the control information for a program that is stored in the program library and used to process a transaction.

Viewing program definitions
You can view your existing program definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource definition that represents a program definition is called PROGDEF. The Program definitions view in the Web User Interface displays information about existing program definitions.

Procedure
1. From the main menu, click Administration views.
2. From the Administration views menu, click either Basic CICS resource administration views or Fully functional Business Application Services (BAS) administration views.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Program definitions.

Results
The Web User Interface displays the list of program definitions.

What to do next
From this view you can also create, update, install, or remove program definitions.

Related tasks
Defining programs using BAS
You define a PROGRAM resource by creating a BAS resource object, PROGDEF.

Installing BAS program definitions
Install the BAS resource object for the PROGRAM resource to make the definition available in the CICS region.

Defining programs using BAS
You define a PROGRAM resource by creating a BAS resource object, PROGDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Program definitions.
2. From the Program definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The Program definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.
Results
The Program definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing program definitions
You can view your existing program definitions using the CICS Explorer or the Web User Interface.

Installing BAS program definitions
Install the BAS resource object for the PROGRAM resource to make the definition available in the CICS region.

Installing BAS program definitions
Install the BAS resource object for the PROGRAM resource to make the definition available in the CICS region.

Before you begin
You must have created the required resource object in the data repository to install the PROGRAM resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Program definitions.
2. Click the Record check box to select a program definition and click the Install... button.
   Alternatively, click a program definition name and click the Install... button on the Program definitions detailed view.

Results
The PROGRAM resource installs successfully in the specified CICS region.

What to do next
After the resource installs, you can inquire on the resource by clicking CICS operations > Program operations views.

Related tasks
Viewing program definitions
You can view your existing program definitions using the CICS Explorer or the Web User Interface.

Defining programs using BAS
You define a PROGRAM resource by creating a BAS resource object, PROGDEF.

Working with BAS session resource definitions
Session definitions describe the nature of logical links between regions or systems that communicate using intersystem communication (ISC) or multiple region operation (MRO).

Viewing session definitions
You can view your existing session definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource object that represents a session definition is called SESSDEF. The Session definitions view in the Web User Interface displays information about existing session definitions.
Procedure

1. From the main menu, click **Administration**.
2. From the **Administration views menu**, click either **Basic CICS resource administration** or **Fully functional Business Application Services (BAS) administration**.
3. Click **CICS resource definitions** to display the **CICS resource definitions** view.
4. Click **Session definitions**.

Results

The Web User Interface displays the list of session definitions.

What to do next

From this view you can also create, update, or remove session definitions.

Related tasks

**Defining sessions using BAS**

You define a SESSION resource by creating a BAS resource object, SESSDEF.

**Defining sessions using BAS**

You define a SESSION resource by creating a BAS resource object, SESSDEF.

About this task

You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure

1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Session definitions**.
2. From the **Session definitions** view, click the **Create...** button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the **Create...** button.
   - The **Session definitions** create view displays.
3. Complete the relevant fields and click **Yes** to create the definition.

Results

The **Session definitions** view is displayed showing the new definition.

What to do next

To add the definition to a resource group, click the **Add to resource group...** button.

Related tasks

**Viewing session definitions**

You can view your existing session definitions using the CICS Explorer or the Web User Interface.

**Working with BAS TCPIPSERVICE resource definitions**

TCPIPSERVICE resource definitions define which TCP/IP services are to use internal sockets support.

**Viewing TCP/IP service definitions**

You can view your existing TCPIPSERVICE resource definitions using the CICS Explorer or the Web User Interface.

About this task

The BAS resource object that represents a TCPIPSERVICE definition is called TCPDEF. The **TCP/IP service definitions** view in the Web User Interface displays information about existing TCPIPSERVICE definitions.
Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click TCP/IP service definitions.

Results
The Web User Interface displays the list of TCPIPSERVICE definitions.

What to do next
From this view you can also create, update, install, or remove TCPIPSERVICE definitions.

Related tasks
Defining TCP/IP services using BAS
You define a TCPIPSERVICE resource by creating a BAS resource object, TCPDEF.

Installing a BAS TCP/IP service definition
Install the BAS resource object for the TCPIPSERVICE resource to make the definition available in the CICS region.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > TCP/IP service definitions.
2. From the TCP/IP service definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The TCP/IP service definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The TCP/IP service definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing TCP/IP service definitions
You can view your existing TCPIPSERVICE resource definitions using the CICS Explorer or the Web User Interface.

Installing a BAS TCP/IP service definition
Install the BAS resource object for the TCPIPSERVICE resource to make the definition available in the CICS region.

**Installing a BAS TCP/IP service definition**

Install the BAS resource object for the TCPIPSERVICE resource to make the definition available in the CICS region.

**Before you begin**

You must have created the required resource object in the data repository to install the TCPIPSERVICE resource in the CICS region.

**About this task**

You can install the BAS resource object using the CICS Explorer or the Web User Interface. The following procedure uses the Web User Interface.

**Procedure**

1. From the main menu, click **Administration** > **Basic CICS resource administration** > **Resource definitions** > **TCP/IP service definitions**.
2. Click the Record check box to select a TCP/IP service definition and click the **Install...** button.
   Alternatively, click a TCP/IP service definition name and click the **Install...** button on the **TCP/IP service definitions** detailed view.

**Results**

The TCPIPSERVICE installs in the specified CICS region.

**What to do next**

After the resource installs successfully, you can inquire on the resource by clicking **CICS operations** > **TCP/IP service operations views**

**Related tasks**

Viewing TCP/IP service definitions
You can view your existing TCPIPSERVICE resource definitions using the CICS Explorer or the Web User Interface.

Defining TCP/IP services using BAS
You define a TCPIPSERVICE resource by creating a BAS resource object, TCPDEF.

**Working with BAS transient data queue resource definitions**

Transient data queue definitions describe intrapartition, extrapartition, indirect, and remote transient data destinations.

**Viewing transient data queue definitions**

You can view information about your existing TDQUEUE resource definitions using the CICS Explorer or the Web User Interface.

**About this task**

The BAS resource object that represents a TDQUEUE definition is called TDQDEF. The **Transient data queue definitions** view in the Web User Interface displays information about existing TDQUEUE definitions.

**Procedure**

1. From the main menu, click **Administration**.
2. From the **Administration views menu**, click either **Basic CICS resource administration** or **Fully functional Business Application Services (BAS) administration**.
3. Click **CICS resource definitions** to display the **CICS resource definitions** view.
4. Click **Transient data queue definitions**.

**Results**
The Web User Interface displays the list of TDQUEUE definitions.

**What to do next**
From this view you can also create, update, install, or remove TDQUEUE definitions.

**Related tasks**
- Defining transient data queues using BAS
  You define a TDQUEUE resource by creating a BAS resource object, TDQDEF.
- Installing BAS transient data queue definitions
  Install the BAS resource object for the TDQUEUE resource to make the definition available in the CICS region.

**Defining transient data queues using BAS**
You define a TDQUEUE resource by creating a BAS resource object, TDQDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Transient data queue definitions**.
2. From the **Transient data queue definitions** view, click the **Create...** button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the **Create...** button.
   - The **Transient data queue definitions** create view is displays.
3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **Transient data queue definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
- Viewing transient data queue definitions
  You can view information about your existing TDQUEUE resource definitions using the CICS Explorer or the Web User Interface.
- Installing BAS transient data queue definitions
  Install the BAS resource object for the TDQUEUE resource to make the definition available in the CICS region.

**Installing BAS transient data queue definitions**
Install the BAS resource object for the TDQUEUE resource to make the definition available in the CICS region.

**Before you begin**
You must have created the required resource object in the data repository to install the TDQUEUE resource in the CICS region.
About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click **Administration** > **Basic CICS resource administration** > **Resource definitions** > **Transient data queue definitions**.
2. Click the Record check box to select a transient data queue definition and click the **Install...** button.
   Alternatively, click a transient data queue definition name and click the **Install...** button on the **Transient data queue definitions** detailed view.

Results
The TDQUEUE resource installs in the specified CICS region.

What to do next
After the resource installs successfully, you can inquire about the resource by clicking **CICS operations** > **Transient data queue (TDQ) operations views**.

Related tasks
- **Viewing transient data queue definitions**
- **Defining transient data queues using BAS**

Working with BAS terminal resource definitions
Terminal resource definitions describe the unique characteristics of the terminal devices, including visual display units, printers, and operating system consoles, with which CICS communicates.

Viewing terminal definitions
You can view information about your existing TERMINAL resource definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource object that represents a TERMINAL definition is called TERMDEF. The **Terminal definitions** view in the Web User Interface displays information about existing TERMINAL definitions.

Procedure
1. From the main menu, click **Administration**.
2. From the **Administration views menu**, click either **Basic CICS resource administration** or **Fully functional Business Application Services (BAS) administration**.
3. Click **CICS resource definitions** to display the **CICS resource definitions** view.
4. Click **Terminal definitions**.

Results
The Web User Interface displays the list of TERMINAL definitions.

What to do next
From this view you can also create, update, install, or remove TERMINAL definitions.

Related tasks
- **Defining terminals using BAS**
- **Installing BAS terminal definitions**
Install the BAS resource object for the TERMINAL resource to make the definition available in the CICS region.

**Defining terminals using BAS**
You define a TERMINAL resource by creating a BAS resource object, TERMDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Terminal definitions.
2. From the Terminal definitions view, click the Create... button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   - The Terminal definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

**Results**
The Terminal definitions view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the Add to resource group... button.

**Related tasks**
Viewing terminal definitions
You can view information about your existing TERMINAL resource definitions using the CICS Explorer or the Web User Interface.

Installing BAS terminal definitions
Install the BAS resource object for the TERMINAL resource to make the definition available in the CICS region.

**Installing BAS terminal definitions**
Install the BAS resource object for the TERMINAL resource to make the definition available in the CICS region.

**Before you begin**
You must have created the required resource object in the data repository to install the TERMINAL resource in the CICS region.

**About this task**
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Terminal definitions.
2. Click the Record check box to select a terminal definition and click the Install... button.
   - Alternatively, click a terminal definition name and click the Install... button on the Terminal definitions detailed view.

**Results**
The TERMINAL resource installs in the specified CICS region.
What to do next
After the TERMINAL resource installs successfully, you can inquire on the resource by clicking CICS operations > Terminal operations views.

Related tasks
Viewing terminal definitions
You can view information about your existing TERMINAL resource definitions using the CICS Explorer or the Web User Interface.

Defining terminals using BAS
You define a TERMINAL resource by creating a BAS resource object, TERMDEF.

Working with BAS transaction resource definitions
Transaction definitions describe how transactions are to run in a CICS region.

Viewing transaction definitions
You can view information about your existing transaction resource definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource object that represents a transaction definition is called TRANDEF. The Transaction definitions view in the Web User Interface displays information about existing transaction definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Transaction definitions.

Results
The Web User Interface displays the list of transaction definitions.

What to do next
From this view you can also create, update, install, or remove transaction definitions.

Related tasks
Defining transactions using BAS
You define a transaction resource by creating a BAS resource object, TRANDEF.

Installing BAS transaction definitions
Install the BAS resource object for the transaction resource to make the definition available in the CICS region.

Defining transactions using BAS
You define a transaction resource by creating a BAS resource object, TRANDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Transaction definitions.
2. From the Transaction definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
The **Transaction definitions** create view is displayed.
3. Complete the relevant fields and click **Yes** to create the definition.

**Results**
The **Transaction definitions** view displays showing the new definition.

**What to do next**
To add the definition to a resource group, click the **Add to resource group...** button.

**Related tasks**
Viewing transaction definitions
You can view information about your existing transaction resource definitions using the CICS Explorer or the Web User Interface.

Installing BAS transaction definitions
Install the BAS resource object for the transaction resource to make the definition available in the CICS region.

**Installing BAS transaction definitions**
Install the BAS resource object for the transaction resource to make the definition available in the CICS region.

**Before you begin**
You must have created the required resource object in the data repository to install the transaction resource in the CICS region.

**About this task**
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click **Administration** > **Basic CICS resource administration** > **Resource definitions** > **Transaction definitions**.
2. Click the Record check box to select a transaction definition and click the **Install...** button.
   Alternatively, click a transaction definition name and click the **Install...** button on the **Transaction definitions** detailed view.

**Results**
The TRANSACTION resource installs in the specified CICS region.

**What to do next**
After the resource installs successfully, you can inquire on the resource by clicking **CICS operations** > **Transaction operations views**.

**Related tasks**
Viewing transaction definitions
You can view information about your existing transaction resource definitions using the CICS Explorer or the Web User Interface.

Defining transactions using BAS
You define a transaction resource by creating a BAS resource object, TRANDEF.

**Working with BAS transaction class definitions**
Transaction class definitions describe the operational characteristics for transactions belonging to the class.

**Viewing transaction class definitions**
You can view existing information about your transaction class definitions using the CICS Explorer or the Web User Interface.

**About this task**
The BAS resource object that represents a transaction class definition is called TRNCLDEF. The Transaction definitions view in the Web User Interface displays information about existing transaction class definitions.

**Procedure**
1. From the main menu, click Administration views.
2. From the Administration views menu, click either Basic CICS resource administration views or Fully functional Business Application Services (BAS) administration views.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Transaction definitions.

**Results**
The Web User Interface displays the list of transaction class definitions.

**What to do next**
From this view you can also create, update, install, or remove transaction class definitions.

**Related tasks**
Defining transaction classes using BAS
You define a transaction class resource by creating a BAS resource object, TRNCLDEF.

Installing BAS transaction class definitions
Install the BAS resource object for the transaction class resource to make the definition available in the CICS region.

Defining transaction classes using BAS
You define a transaction class resource by creating a BAS resource object, TRNCLDEF.

**About this task**
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

**Procedure**
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Transaction class definitions.
2. From the Transaction class definitions view, click the Create... button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   - The Transaction class definitions create view is displayed.
3. Complete the relevant fields and click Yes to create the definition.

**Results**
The Transaction class definitions view displays showing the new definition.
What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
- Viewing transaction class definitions
  - You can view existing information about your transaction class definitions using the CICS Explorer or the Web User Interface.
- Installing BAS transaction class definitions
  - Install the BAS resource object for the transaction class resource to make the definition available in the CICS region.

Installing BAS transaction class definitions
Install the BAS resource object for the transaction class resource to make the definition available in the CICS region.

Before you begin
You must have created the required resource object in the data repository to install the transaction class resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Transaction class definitions.
2. Click the Record check box to select a transaction class definition and click the Install... button.
   Alternatively, click a transaction class definition name and click the Install... button on the Transaction class definitions detailed view.

Results
The resource installs into the specified CICS region.

Related tasks
- Viewing transaction class definitions
  - You can view existing information about your transaction class definitions using the CICS Explorer or the Web User Interface.
- Defining transaction classes using BAS
  - You define a transaction class resource by creating a BAS resource object, TRNCLDEF.

Working with BAS temporary storage model definitions
Temporary storage definitions describe the attributes that govern the characteristics of CICS temporary storage queues.

Viewing temporary storage model definitions
You can view existing information about your temporary storage model definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource object that represents a transaction class definition is called TSMDEF. The Temporary storage model definitions view in the Web User Interface displays information about existing transaction class definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Temporary storage model definitions.

Results
The Web User Interface displays the list of temporary storage model definitions.

What to do next
From this view you can also create, update, install, or remove temporary storage model definitions.

Related tasks
Defining temporary storage models using BAS
You define a temporary storage queue by creating a BAS resource object, TSMDEF.

Installing BAS temporary storage model definitions
Install the BAS resource object for the TSMODEL resource to make the definition available in the CICS region.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Temporary storage model definitions.
2. From the Temporary storage model definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The Temporary storage model definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The Temporary storage model definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing temporary storage model definitions
You can view existing information about your temporary storage model definitions using the CICS Explorer or the Web User Interface.

Installing BAS temporary storage model definitions
Install the BAS resource object for the TSMODEL resource to make the definition available in the CICS region.

Before you begin
You must have created the required resource object in the data repository to install the TSMODEL resource in the CICS region.
About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Temporary storage model definitions.
2. Click the Record check box to select a temporary storage model definition and click the Install... button.
   Alternatively, click a temporary storage model definition name and click the Install... button on the Temporary storage model definitions detailed view.

Results
The temporary storage model resource installs in the specified CICS region.

What to do next
After the temporary storage definition installs, you can inquire about the resource by clicking CICS operations > Temporary storage queue (TSQ) operations views

Related tasks
Viewing temporary storage model definitions
You can view existing information about your temporary storage model definitions using the CICS Explorer or the Web User Interface.

Defining temporary storage models using BAS
You define a temporary storage queue by creating a BAS resource object, TSMDEF.

Working with BAS typeterm resource definitions
Typeterm definitions are partial terminal definitions that describe a set of common attributes for a group of terminals.

Viewing typeterm definitions
You can view existing information about your typeterm definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource object that represents a typeterm definition is called TYPTMDEF. The Typeterm definitions view in the Web User Interface displays information about existing typeterm definitions.

Procedure
1. From the main menu, click Administration.
2. From the Administration views menu, click either Basic CICS resource administration or Fully functional Business Application Services (BAS) administration.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click Typeterm definitions.

Results
The Web User Interface displays the list of typeterm definitions.

What to do next
From this view you can also create, update, install, or remove typeterm definitions.

Related tasks
Defining typeterms using BAS
You define a typeterm resource by creating a BAS resource object, TYPTMDEF.

Installing BAS typeterm definitions
Install the BAS resource object for the TYPETERM resource to make the definition available in the CICS region.

Defining typeterms using BAS
You define a typeterm resource by creating a BAS resource object, TYPTMDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Typeterm definitions.
2. From the Typeterm definitions view, click the Create... button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   - The Typeterm definitions create view displays.
3. Complete the relevant fields and click Yes to create the definition.

Results
The Typeterm definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing typeterm definitions
You can view existing information about your typeterm definitions using the CICS Explorer or the Web User Interface.

Installing BAS typeterm definitions
Install the BAS resource object for the TYPETERM resource to make the definition available in the CICS region.

Installing BAS typeterm definitions
Install the BAS resource object for the TYPETERM resource to make the definition available in the CICS region.

Before you begin
You must have created the required resource object in the data repository to install the TYPETERM resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Typeterm definitions.
2. Click the Record check box to select a typeterm definition and click the Install... button.
   - Alternatively, click a typeterm definition name and click the Install... button on the Typeterm definitions detailed view.
Results
The TYPETERM resource installs in the specified CICS region.

What to do next
After the resource installs successfully, you can inquire on the resource by clicking CICS operations > Terminal operations views

Related tasks
Viewing typeterm definitions
You can view existing information about your typeterm definitions using the CICS Explorer or the Web User Interface.

Defining typeterms using BAS
You define a typeterm resource by creating a BAS resource object, TYPTMDEF.

Working with BAS URIMAP resource definitions
A URIMAP resource definition matches the URIs of HTTP or web service requests.

Viewing URI mapping definitions
You can view information about your existing URIMAP resource definitions using the CICS Explorer or the Web User Interface.

About this task
The BAS resource object that represents a URIMAP resource definition is called URIMPDEF. The URI mapping definitions view in the Web User Interface displays information about existing typeterm definitions.

Procedure
1. From the main menu, click Administration views.
2. From the Administration views menu, click either Basic CICS resource administration views or Fully functional Business Application Services (BAS) administration views.
3. Click CICS resource definitions to display the CICS resource definitions view.
4. Click URI mapping definitions.

Results
The Web User Interface displays the list of URIMAP definitions.

What to do next
From this view you can also create, update, install, or remove URIMAP definitions.

Related tasks
Defining URIMAP definitions using BAS
You define a URIMAP resource by creating a BAS resource object, URIMPDEF.

Installing BAS URI mapping definitions
Install the BAS resource object for the URIMAP resource to make the definition available in the CICS region.

Defining URIMAP definitions using BAS
You define a URIMAP resource by creating a BAS resource object, URIMPDEF.

About this task
You can define the resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.
Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > URI mapping definitions.
2. From the URI mapping definitions view, click the Create... button.
   To use an existing definition as the basis of the new one, click the check box before clicking the Create... button.
   The URI mapping definitions create view is displayed.
3. Complete the relevant fields and click Yes to create the definition.

Results
The URI mapping definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing URI mapping definitions
You can view information about your existing URIMAP resource definitions using the CICS Explorer or the Web User Interface.

Installing BAS URI mapping definitions
Install the BAS resource object for the URIMAP resource to make the definition available in the CICS region.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > URI mapping definitions.
2. Click the Record check box to select a URI map definition and click the Install... button. Alternatively, click a URI map definition name and click the Install... button on the URI mapping definitions detailed view.

Results
The URIMAP resource installs in the specified CICS region.

Related tasks
Viewing URI mapping definitions
You can view information about your existing URIMAP resource definitions using the CICS Explorer or the Web User Interface.

Defining URIMAP definitions using BAS
You define a URIMAP resource by creating a BAS resource object, URIMPDEF.

**Working with BAS web service resource definitions**

A web service resource definition defines aspects of the runtime environment for a CICS application program deployed as a web service, where mapping between application data structure and SOAP messages has been generated using the CICS web services assistant.

**Viewing web service definitions**

You can view information about your existing WEBSERVICE resource definitions using the CICS Explorer or the Web User Interface.

**About this task**

The BAS resource object that represents a WEBSERVICE resource definition is called WEBSVDEF. The **Web service definitions** view in the Web User Interface displays information about existing web service definitions.

**Procedure**

1. From the main menu, click **Administration views**.
2. From the Administration views menu, click either **Basic CICS resource administration views** or **Fully functional Business Application Services (BAS) administration views**.
3. Click **CICS resource definitions** to display the **CICS resource definitions** view.
4. Click **Web service definitions**.

**Results**

The Web User Interface displays the list of WEBSERVICE definitions.

**What to do next**

From this view you can also create, update, install, or remove WEBSERVICE definitions.

**Related tasks**

- Defining web service definitions using BAS
  You define a URIMAP resource by creating a BAS resource object, WEBSVDEF.
- Installing BAS web service definitions
  Install the BAS resource object for the WEBSERVICE resource to make the definition available in the CICS region.
- Defining web service definitions using BAS
  You define a URIMAP resource by creating a BAS resource object, WEBSVDEF.

**About this task**

You can define the resource object using the CICS Explorer or the Web User Interface. This procedure uses the Web User Interface.

**Procedure**

1. From the main menu, click **Administration > Basic CICS resource administration > Resource definitions > Web service definitions**.
2. From the **Web service definitions** view, click the **Create...** button.
   - To use an existing definition as the basis of the new one, click the check box before clicking the **Create...** button.
   - The **Web service definitions** create view displays.
3. Complete the relevant fields and click **Yes** to create the definition.
Results
The Web service definitions view displays showing the new definition.

What to do next
To add the definition to a resource group, click the Add to resource group... button.

Related tasks
Viewing web service definitions
You can view information about your existing WEBSERVICE resource definitions using the CICS Explorer or the Web User Interface.

Installing BAS web service definitions
Install the BAS resource object for the WEBSERVICE resource to make the definition available in the CICS region.

Installing BAS web service definitions
Install the BAS resource object for the WEBSERVICE resource to make the definition available in the CICS region.

Before you begin
You must have created the required resource object in the data repository to install the WEBSERVICE resource in the CICS region.

About this task
You can install the BAS resource object using the CICS Explorer or the Web User Interface. These instructions explain the procedure for the Web User Interface.

Procedure
1. From the main menu, click Administration > Basic CICS resource administration > Resource definitions > Web service definitions.
2. Click the Record check box to select a web service definition and click the Install... button.
   Alternatively, click a web service definition name and click the Install... button on the Web service definitions detailed view.

Results
The WEBSERVICE resource installs in the specified CICS region.

Related tasks
Viewing web service definitions
You can view information about your existing WEBSERVICE resource definitions using the CICS Explorer or the Web User Interface.

Defining web service definitions using BAS
You define a URIMAP resource by creating a BAS resource object, WEBSVDEF.

Customizing the Web User Interface

The WUI offers a number of customization facilities.

You should be familiar with the operation of the Web User Interface menus and views before customizing the menus and views.
Managing user favorites

User favorites gives all WUI users the ability to save tabular and detail views on an ad hoc basis to an easily-accessible and editable menu of favorites. This allows you to reach frequently used views with just one click. Administrators have the additional authority to update the favorites of other users.

Hyperlinks to user favorites are displayed under the heading Favorites in the navigation frame of WUI views and menus.

The favorites function is available on WUI tabular and detailed views but not on map screens. You cannot hyperlink to a map screen directly.

To create a new user favorite item, click the Add to favorites icon at the top right of the work frame. The Add to favorites screen opens. Optionally, type a title for the new favorite, then click OK to add it to your favorites list.

Note: If you open another WUI window for the same user ID, locking problems might prevent you from updating your favorites in either session.

You can perform more operations on your favorites using the favorites editor. This allows you to specify opening context and scope settings and to update other information such as link titles. To access the favorites editor, click the hyperlink in the navigation frame. See “Managing favorites with the favorites editor” on page 198 for guidance on using the favorites editor to manage your own user favorites. See “Creating and managing favorites for other WUI users” on page 200 for guidance on managing the favorites of other WUI users.

The information for user favorites is held in an object called user. The user object holds a menu group that contains hyperlinks for the favorites of a user. There are two ways of creating a user object:

• It can be created the first time a user creates a favorite. When a user creates a favorite, the WUI searches for a user object that has an ID matching the user's ID. If a matching user object cannot be found, the WUI server automatically creates a matching user object for that user.

• It can be created by an administrator in the user editor.

Managing favorites with the favorites editor

As well as being able to add views to your own favorites list using the add to favorites icon, you can also work with your favorites using the favorites editor.

To open this editor, click Favorites editor under Special in the WUI navigation frame.

Figure 22. The favorites editor

The Favorites Editor screen gives you a number of options:
Move
Alter the listed position of an existing favorite:

Click **Move**, select a favorite from the list and click **OK**. Now select a new position favorite and click **OK**. To move the selected favorite to the end of the list, click **OK** without first selecting a new position.

Copy
Copy an existing favorite and give it a new title:

Click **Copy**, select a favorite from the list, and click **OK**. This opens a **Copy Favorite** screen.

![Copy Favorite screen](image)

Now you can give the copy a new title and select its position on your favorites list by selecting the existing favorite from the list above which the new copy will be positioned. If you want to position the new copy at the bottom of the list, do not select an existing favorite. Click **OK** to confirm the operation.

Edit
Change the components of a favorite including title, destination, context and scope, and filter settings.

From the **Favorites Editor** screen, click **Edit**. Select the favorite you want to edit from the list, then click **OK** to open the **Components of Favorite** screen. This gives you two options:

- Click **Title and annotation** to alter the text of the link to a selected favorite. Enter new text in the **Title** field, and click **OK**.
- Click **Destination** to alter context and scope settings or filter attributes and parameters.
  - Clicking on **Context and Scope settings** opens the **View Link Context and Scope Settings** screen. You can enter new values for context and scope or chose to inherit values from the current menu or view.
  - Clicking **Filter attributes and parameters** opens the **View Link Filters** screen. This allows you to work with attribute and parameter filter settings of the selected favorite. You can append, insert, edit or delete filter expressions. However, ensure you do not include more than one filter.
expression for any particular attribute. Specifying multiple filter expressions for the same attribute will lead to unexpected results. See Filtering data for more information about filters.

**Delete**

Remove an item from your list of favorites.

Click **Delete**, select one of your favorites from the list and click **OK** to confirm.

The favorites editor allows you to edit your own list of favorites. It does not allow you to manage the favorites of other users. Only WUI administrators with access to the user editor have the authority to do this.

**Creating and managing favorites for other WUI users**

To create and manage the favorites of other WUI users you need to be an administrator with at least update access to the ESM facility profile EYUWUI.wui_server_applid.USER.

If you have the necessary access, the hyperlink that starts the user editor appears in the **Special** section of the navigation frame. Clicking this hyperlink starts the **CICSPlex SM Web User Interface User Editor** in a new web browser window. To work with favorites, select **Users**. This opens the **User Editor** screen.  

**Figure 24 on page 201** Illustrates screens in the user editor used to edit user favorites.
Figure 24. User screens in the user editor

This screen gives you the following options:

**Create**
Use this option to create a user object in the repository. Each user needs a user object to hold a list of favorites. The WUI automatically creates a user object the first time a user creates a favorite (if one does not already exist), so most existing users will already have one. Once the user object is created, the Favorites editor screen is displayed to enable you to create and edit favorites for the new user.

**Edit**
Use this option to work with the favorites of an existing user. It allows you to create, move, copy, edit, and delete a user’s favorites.

**Delete**
Use this option to delete a user object from the repository. This also deletes any existing favorites for that user.
You can use the user editor to create a user object and add some favorites as follows:

1. Create the new user object:
   a. Click User editor in the navigation frame to open a new CICSPlex SM Web User Interface User editor window.
   b. Click User to open the User Editor screen.
   c. Click Create, and in the Create user screen, type in the new user name. User names are restricted to a maximum of eight characters. Valid characters are A-Z, 0-9, # (X'23'), $ (X'24') and @ (X'40').
   d. Click OK. This confirms the operation and opens the Favorites Editor screen used to create and manage a user's list of favorites.

2. Create a new favorite item:
   a. In the Favorites Editor screen, click Create. This opens the edit screen that is used by the user editor for editing detail items. From this screen you can perform all of the actions on a favorite that you can on a menu item in the view editor.
   b. Complete this screen by giving the new favorite a title and type in the target view or menu, the context and scope settings, and the filter settings.
   c. Click Save. This saves the updates in the repository and returns you to the User screen. If you click Abandon, all of your changes, including the new user object, are discarded.

3. Create more favorites and add them to the new user object:
   a. From the User screen, click Edit. This opens the Edit user screen.
   b. Select the newly created user ID and click OK. This takes you back to the Favorites Editor screen.
   c. Create a new favorite item as before, and save your updates.
   Repeat this step for each favorite you want to add to the new user object.

User group profiles

What individual users see and do when they log on to the WUI can be controlled by the user group profile to which they belong.

This gives WUI administrators the ability to tailor the WUI to the needs of various groups of users. You can, for example, use the view editor to create a new WUI menu containing only operations views and make this the default menu for a group of users. This would provide a simplified operational WUI for users who only need to carry out this kind of task.

A user group profile can contain the following information:

- Result set warning count
- Name of the default main menu
- Name of the default navigation menu
- Default context
- Default scope
- Default CMAS context
- Force filter confirmation flag
- Default map objects

If a profile does not have some of these values specified; for example if the default menu value is blank, the corresponding WUI parameter value specified in the JCL is used. This is also the case for any invalid values set in the profile, for example if the specified default menu does not exist.

User group profiles are created and managed using the user editor, which can be accessed by administrators with the necessary authority from the WUI navigation menu. See "Controlling access to Web User Interface resources"
To facilitate this CICSPlex SM uses an object called a user group. User group objects, like view and menu objects, can be imported and exported using the COVC transaction.

User group profiles can be used only if security is active in the Web User Interface. A user group object relates to a group name in the external security manager (ESM). When a user signs on to the Web User Interface, the user group object is assigned in different ways depending on the SIGNONPANEL Web User Interface system parameter.

**SIGNONPANEL(ENHANCED)**
This is the default. The GROUP option is displayed on the sign-on screen:

- If the user does not enter a value, the user group profile is set according to the user's default group.
- If the user does enter a value, the signon proceeds.
- If the user ID is connected to the specified group, this group is used as the WUI user group profile.
- If the user ID is not connected to the specified group, or the group name is not valid, the signon continues but the WUI User group profile is set based on the default group of the user and when sign-on is complete message EYVC1227W is issued to the WUI user and message EYUVS0024W is written to the WUI server's EYULOG.

**Note:** The GROUP option does not change the current connect group of the user being signed on. The security environment built by the WUI is always based on the user's default group. The only effect that the group option on the WUI signon screen has is to specify which WUI user group profile the user should be associated with. It does not change any security decisions that might be made by the External Security Manager.

**SIGNONPANEL(BASIC):**
- The GROUP option is not displayed on the sign-on screen.
- The user group profile is set according to the user's default group.

Whether the Web User Interface user group profile is set based on the default group, or specified on the GROUP option, if no matching Web User Interface group profile is found, the values normally set via a user group profile is set based on system defaults.

**Note:** The Web User Interface supports user group names that contain only the following characters:

- A through Z (you can enter lowercase characters but they are folded to uppercase)
- 0 through 9
- # (X’7B’), £ (X’5B’), @ (X’7C’), * (X’5C’), & (X’50’) = (X’7E’) and ? (X’6F’)

Depending on the ESM in use, not all of these characters can be specified in a group name.

Use of * (X’5C’) in a user group name causes some restrictions if the COVC EXPORT function is used. See the description of the Name field in Exporting WUI definitions for details.

In order to manage user group profiles an administrator needs update access to a new ESM facility profile named EYUWUI.wui_server_applid.USER where wui_server_applid is the application ID of the WUI server to which this profile relates.

**Creating and managing user group profiles**
Setting up a new user group involves three steps.

**About this task**
1. Creating a new user group profile in the WUI using the user editor.
2. Creating a user group with the same name in the ESM.
3. Setting the user group as one or more users' default user group in the ESM.

This section describes how to create and manage user group profiles in the user editor. The user editor is also used to create user profiles.
The hyperlink that launches the user editor appears in the **Special** section of the navigation frame. A signed on user can see a user editor hyperlink only if he or she has at least update access to the ESM facility profile EYUWUI.wui_server_applid.USER where **wui_server_applid** is the application ID of the WUI server. Clicking on this hyperlink launches a new web browser window.

When you launch the user editor you can choose to edit user groups or users. Figure 25 on page 204 illustrates the relationships between the screens in the user group section of the user editor.

![Diagram of user editor screens](image)

**Figure 25. User group screens in the user editor**

Using the user editor is straightforward. For example to create a new user group profile follow this procedure:

1. Navigate to the **Create Group** screen:
   a. Click **User editor** in the navigation frame to open a new **CICSPlex SM Web User Interface User editor** window.
   b. Click **User Groups** to open the **User Group Editor** screen. This screen gives you options to create, edit or delete a profile.
   c. Click **Create** to open the **Create New User Group** screen.

2. Name the new group profile:
a. Type in the name of the new group. Names are restricted to a maximum of eight characters. As in the ESM, the allowed characters are A-Z (upper case) 0-9, #, $ and @.

b. Click OK. This confirms the operation and opens the Edit User Group Profile screen.

3. Type in the user group details. You need to provide some or all of the following information. Any fields that you leave blank or complete incorrectly revert to existing defaults.

**Warning record count**
- Maximum number of records displayed without a warning message. Values can be in the range 0 to 99999999.

**Default main menu**
- Name of the default main menu

**Default navigation menu**
- Name of the default navigation menu

**Default context**
- Default 8–character context setting

**Default scope**
- Default 8–character scope setting

**Default CMAS context**
- Default 8–character CMAS context setting

**Force filter confirmation**
- Flag that forces users to specify filter criteria before a view is displayed

**Map collapse count**
- Maximum number of records displayed on a map screen when it is opened. If there are more than this number of records, the map is displayed in a collapsed state. Values can be in the range 0 to 99999999.

**Default WLM map**
- Name of the map object to be used to generate workload management type resource maps
- Map names can consist of up to 16 alphanumeric characters

**Default MON map**
- Name of the map object to be used to generate monitoring type resource maps

**Default RTA map**
- Name of the map object to be used to generate real-time analysis type resource maps

**Default BAS map**
- Name of the map object to be used to generate business application services type resource maps.

4. Click **Save** to create the new profile or **Abandon** to cancel the operation.

**Note:** Before using a user group, there needs to be a matching user group name defined in the ESM.

To edit a group, click **Edit** in the User Group Editor screen to open the Edit User Group screen. Select an existing group and click **OK**. This opens an Edit User Group Profile screen containing details of the selected group. Make your changes and click **Save** to update the profile.

To delete a group, click **Delete** in the User Group Editor screen to open the Delete User Group screen. Select an existing group and click **OK** to open the Confirm User Group Delete screen. Click **OK** again to confirm the operation.

**Customized WUI menus, views and maps**

You can customize WUI menus, views and maps to create a unique working environment.

The CICSPlex SM WUI includes a set of supplied views and menus that you can use either as supplied or as the basis from which to create your own customized WUI. For example, you might want to create views that apply to a specific task or set of data.
You can create your own version using a supplied menu, view or map object as a model, or you can start from scratch.

**Customized view sets and views**

A view set is a number of related views that are used together to manage the same managed object, that is, a CICS or a CICSPlex SM resource represented by a resource table. You can create as many view sets for a particular managed object as you like.

A view is a display that is used to interact in a particular way with the managed object. Each view is contained within a view set, and is always displayed in the work frame of the Web User Interface display. There are several types of view:

- Tabular view, see “Tabular views” on page 206
- Detail view, see “Detail views” on page 207
- Confirmation panel, see “Confirmation panels” on page 208
- Maps, see How to map CICSPlex SM definitions.

For general use, view sets and views are identified by names of up to 16 alphanumeric characters. View set names must be unique within the server repository. View names are unique within a view set. It is recommended that you adopt a naming convention for the naming of view sets and views.

**Note:** For IBM use, and for use by independent software vendors (ISVs) an underscore (_) is permitted in view set names. View set and menu names beginning with IBM_ and with EYU are reserved for IBM use.

The Web User Interface includes a set of view sets that you can use either as supplied or as the basis from which to create your own customized views.

**Tabular views**

You use a tabular view to display:

- Selected attributes from multiple instances of a managed object.
- Summarized records based on one selected attribute of the managed object.

When you create a tabular display, you first select the managed object and then the attributes you want to display. The view editor offers you the choice of all the attributes available for that managed object. You can create one or more tabular views for each managed object, each tabular view containing attributes that are relevant to a specific task.

Fields in a tabular display can be defined as text or graphical representations. They are display only and cannot be modified. You can specify whether the data for that attribute can be sorted in ascending and descending order, and whether the attribute can be used as the basis for a summarized view. Depending on the type of data in the column, you can also indicate how this attribute should be summarized on a summarized view when another attribute in the same view is used as the basis of a summary view.

**Note:** Specifying a summary type for an attribute, will set the same summary type for all fields using the same attribute name on the view.

You can link from a tabular view to one or more tabular and detail views, depending on the task you want the user to perform. For example, from a tabular view of task resources, you could link to detail views showing clock settings, terminal details, and so on. See “Components of a view” on page 209 for details of how you might do this.

You can add buttons to a tabular view that perform an action immediately, or you can choose to display a confirmation panel. See “Confirmation panels” on page 208 for details.

You can control the display options available to each tabular view. These display options allow you to:

- Make this tabular view the default view for the view set. If you select this option, this view will be used for view links that do not target a specific view within the view set. See “Default views” on page 209 for information about default views.
- Choose whether the automatic refresh option will be available for this view.
• Choose whether all object instances on this view can be selected at once so that an action can be performed against them all, or if each object instance should be selected in turn.
• Select the maximum number of rows that should be displayed on a single page of this view.
• In the case of views related to definitional objects, choose whether or not to include a Map button in order to generate a map of associated definitions. See How to map CICSPlex SM definitions for information about the map function.

The summarized view is a special case of the tabular view. When you create a tabular view, you specify which of the attributes in the view may be used as the basis of the summary view. You can select as many attributes as you like, or none at all. When a tabular view is summarized, the same view is used to display the summarized data.

### Detail views

You use a detail view to display a selection of attribute information for a particular instance of a resource and also to allow the user to change attribute values.

You can opt to display the information in one or two columns. Two-column detail views increase the amount of data that can be displayed on your screen and reduce the need for screen scrolling. Each column includes the attribute name, the attribute value, and an optional annotation. See “Creating a two-column detailed view” on page 232 for guidance on creating a two-column view.

You can define an attribute value field to be:

• A read-only, textual representation of the attribute value.
• A modifiable field, so that the user can enter another value.
• A graphical representation of the attribute value.

The optional annotation text appears next to the attribute value and can be used to provide additional information, such as names, valid values, and warnings.

It is advisable to keep the annotation text short, otherwise the contents of the detail view may become less clear.

You can include white space (blank lines) in a detail view to separate groups of attributes. You may also include static text that can be used to provide titles for groups of related attribute fields, or to form explicitly labeled links to other views.

A detail view can be used to provide information for the user, but you can also use a detail view to implement a SET action, allowing the user to change one or more attributes for the selected instance of the managed object.

You can link from a detail view to one or more detail or tabular views, depending on the task you want the user to perform. For example, from a detail view of a task resource, you could link to other detail views showing clock settings, terminal details, and so on. See “Components of a view” on page 209 for details of how you might do this.

You can add buttons to a detail view that perform an action immediately, or you can choose to display a confirmation panel. See “Confirmation panels” on page 208 for details.

You can control the display options available to each detail view. These display options allow you to:

• Make this detail view the default view for the view set. If you select this option, this view will be used for view links that do not target a specific view within the view set. See “Default views” on page 209 for information about default views.
• Choose whether the automatic refresh option will be available for this view.
• In the case of views related to definitional objects, choose whether or not to include a Map button in order to generate a map of associated definitions. See How to map CICSPlex SM definitions for information about the map function.
**Confirmation panels**

Confirmation panels have a similar appearance to detail views.

Confirmation panels are used to:

- Confirm the action that has been selected on the previous view
- Provide any parameter values
- Create panels that allow one or more attributes to be SET on many instances of a resource.
- Provide an opportunity to confirm or override filter values before data retrieval is initiated.

**Note:** Some actions have parameters that are required or are optional. For example, the SNAP action on the CICSREGION managed object requires the parameter DUMPCODE. In order to determine if a particular parameter is required or optional, you can check the CICSPlex SM resource tables.

The **No to all**, **Yes**, and **No** action buttons are added automatically by the view editor, and you can add a **Yes to all** button if you want. You can also include a list of parameters for an action on a confirmation panel.

For example, since shutting down a CICS region may have a significant impact on users of the system, you may decide to have a tabular view from which the user can select a CICS region for shutdown. Also on the tabular view you could have an action button labeled **Shutdown** that links to a confirmation panel. On the confirmation panel you could list the parameters, such as IMMEDIATE and NORMAL, for the shutdown action.

Confirmation panels that invokes the definitional actions create and update are somewhat different from those associated with other actions. When you use the view editor to design a confirmation panel for the create action, you can also use the same panel for the update action. The action button, which launches the panel, determines which action it is used for. This avoids any potential problems involved in keeping separate but identical create and update screens in step during the design process.

**Filter confirmation screens**

A filter confirmation screen allows you to specify filter criteria before the WUI retrieves the data for a view.

When designing views in the view editor, you have the option to specify that a filter confirmation screen should be displayed before the data retrieval is executed. There are no filter confirmation screens associated with supplied views. A typical filter confirmation screen is shown in Figure 26 on page 208.

![Filter confirmation screen](image)

**Figure 26. Filter confirmation screen**
See “Creating a filter confirmation screen” on page 235 for guidance on setting up filter confirmation.

**Default views**
A default view is a view that is displayed when a view set is opened and no specific view has been named on the link. One view within a view is set as the default view.

The default view is normally a tabular view, but can be a detail view, if you want. When you build a link from menus to view sets, or from one view set to another, you can specify that the default view is displayed. If you do not name an explicit view on the link, because you have chosen to display the default view set, you could change or replace the default view without having to amend all of the links to the view set.

The default view set is used for external requests that specify an object name but do not specify a view set name. The default view set is named on the Web User Interface server initialization operation options parameter, that represents the specified object.

**Components of a view**
You can define some or all of the components of a view.

**Contents of the view**
The columns or items of data that are to be displayed in the view.

**Title**
The title of the view is displayed at the top of the page.

**View annotation**
You can add text as an annotation to any view. It will appear below the data display. An annotation can be any text and may be in your national language. You could, for instance, provide guidance for the user on what to do next, if the view forms part of a procedure.

**Action buttons**
You can add as many action buttons as you want to a view. You select the action you want to perform, and the text that you want to appear on the button. See “Action buttons” on page 214 for more information.

**Link to customizable view and menu help**
This link, if defined, is located alongside the view title. For more details about the customizable view and menu help, see “Customizable view and menu help” on page 214.

**Selection criteria**
Selection criteria are the context and scope settings and any filters available to the user. You can define whether the context and scope fields are to be hidden, read-only, or modifiable by the user.

You can also specify any attributes or parameters that will always be available to the user as filters.

**Automatic refresh**
Users with Javascript-enabled browsers can update views periodically. If automatic refresh is defined as available, an entry field and a check box appear in the Selection criteria and refresh area. The user is then able to turn the automatic refresh facility on or off, and change the refresh interval.

**Links**
Links connect a field in one view with related information in another view, which may or may not be in the same view set.

**Link to a view in the same view set**
You can create a link from a specific attribute, such as a transaction name, to a detail view in the same view set. As the views are in the same view set the details displayed will reflect the status of the transaction at the time the original view was created. That is, the data is not refreshed.

**Link to a view in another view set**
You can create a link to related resources, for example, from a task to a transaction, in another view set. In this case, new data is collected, and filters can be defined on the link. For example, you can set the scope for the target view.
Conditional links
You can specify whether a link is always to be available on a view or, is conditional based on an attribute value at the source of the link. The conditions that the attribute value can be tested against are:

- If the attribute is valid at this release of CICS, and the attribute value is equal to the specified value.
- If the attribute is valid at this release of CICS, and the attribute value is not equal to the specified value.
- If the attribute is valid at this release of CICS.

You can specify only one condition for each link but you can define many links.

For an example of setting up a conditional link, see “Using view links and attribute filters” on page 229.

Customized menus
A menu is a list of related topics from which the user can select one or more items.

Menus are identified by names of up to 16 alphanumeric characters (but see note below). Menu names must be unique within the server repository, but a menu may have the same name as a view set. It is recommended that you adopt a naming convention for the naming of menus.

Note: For IBM use, and for use by independent software vendors (ISVs) an underscore (_) is permitted in menu names. View set and menu names beginning with IBM_ are reserved for IBM use.

Components of a menu
You can define a number of components for a work frame menu, but some components are not used when the menu is a navigation frame:

Title
The title to be displayed at the top of the menu. This component is not used for a navigation frame menu.

Link to customizable view and menu help
This link, if defined, is located alongside the menu title. For more details about the customizable view and menu help, see “Customizable view and menu help” on page 214. This component is not used for a navigation frame menu.

Context and scope
You can define whether the context and scope fields are to be hidden, read-only, or modifiable by the user. This component is not used for a navigation frame menu.

Menu group titles
You can group the menu choices by providing a group title for each group.

Menu choices
Each menu choice is a link and may be:

- A link to another menu, possibly setting context and scope.
- A link to a view, possibly setting selection criteria, including context and scope.
- An external link to a location served by an external web server. The contents of an external location are displayed in a separate web browser window.

In addition to the type and destination of a link, you can define context and scope settings for each menu choice, so that you can build, for example:

- A menu of CICSp lex names. Each CICSp lex name linking to the same menu but with a different context.
- A menu of application names. Each application goes to the same menu but with a different logical scope.

You can define other selection criteria for each menu choice, so that you can display, for example:
• An active workload view for a specific workload
• A view of terminals matching a generic name

Menu annotation
You can add general annotations to a menu. The menu annotation, that appears above the menu contents, may be used to provide, for example, instructions on how to use the menu or comments explaining the menu.

Menu choice annotation
You can add annotations to individual menu choices. Menu choice annotation appear below the menu choice and may be used for explaining the menu choice or the effect of selecting it.

Navigation frame
Usually menus are displayed in the work frame, but you can select one menu to be displayed in the navigation frame.

This menu is the same for all users so you can group the menu choices to reflect different user roles or tasks. You can group the menu choices by providing a group title for each group. The groups are automatically displayed as expandable and collapsible groups. The menu to be displayed in the navigation frame is named on the DEFAULTNAVIGATE Web User Interface server initialization environment options parameter.

Customized map objects
You can use the view editor to create, edit, copy, or delete your own customized map objects. Customized map objects can include hyperlinks to views you specify. You can also enable the map function for customized definitional views by adding a map button.

You can use the view editor for the following map-related tasks
• Enable the map function on a customized view.
  The map function is available on both tabular and detail views that are related to definitional objects.
• Create or edit a customized map object.
  By default the map generated from a particular view is the IBM-supplied map object for the selected resource type. However you can create your own map objects using the view editor and then link these to particular resources by setting WUI server initialization parameters, or for particular groups of users, in user group profiles.

  When you create a map object you can specify the destination of the hyperlinks from the resource names displayed on the generated map. In this way you can specify links to customized views from generated maps.

Presenting data
In many cases, you can control the way that data is presented, changed, and selected on views.

Display-only fields
Data can be presented as a display-only field that cannot be changed.

Entry fields
Entry boxes allow the user to enter an attribute or parameter value.

Selection lists
Selection lists contain all the values available to the user for a given attribute or parameter, on this view. Where the user is asked to enter a value, you can create a selection list of appropriate values. Creating selection lists can make a view easier to use and provides an additional level of confirmation of the data by offering a choice of acceptable values to the user.

Graphical presentations
Depending on the type of attribute, you can choose to display your data graphically either as warning lights or as bar gauges.
Warning lights
You can use different colored warning lights to indicate the value of an attribute. You can set presentation thresholds (a single value or, for numeric attributes only, a range of values), and have a different color for each one. You can also have a flashing warning light as an extra alert for the user. Optionally, you can also display the value of the attribute next to the warning light.

For example, you could indicate the severity of system availability monitoring events in your CICS regions by using flashing red for Very High Severe (VHS) and High Severe (HS), orange for High Warning (HW) and Low Warning (LW), and yellow for the lowest levels of severity, Low Severe (LS) and Very Low Severe (VLS). For an example of how to do this, see “Using warning lights” on page 230.

Bar gauges
Only attributes with numeric data types can use bar gauges. A bar gauge is a horizontal bar that represents the value of the attribute. You can also display the numerical value of the attribute, or the size of the bar gauge as a percentage of the full range, or both.

You specify values for the upper and lower limits of the range, which may be either a specified fixed value or the value of the numeric attribute in the same managed object (resource table). For example, you can display the load in a CICS region as a bar gauge, by comparing current task with maximum tasks.

Within the limits, you can specify threshold values and allocate display colors in the same way as for warning lights.

Numeric data types
You can determine an attribute's data type by consulting the CICSPlex SM Resource Tables Reference.

The resource tables reference data types shown in the following table are considered numeric and are displayed as a decimal value to one or three decimal places, using the decimal separator configured for the server:

<table>
<thead>
<tr>
<th>1-decimal names</th>
<th>3-decimal names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVG</td>
<td>AVG3</td>
<td>Average</td>
</tr>
<tr>
<td>PCT</td>
<td>PCT3</td>
<td>Percentage</td>
</tr>
<tr>
<td>RATE</td>
<td>RATE3</td>
<td>Consumption rate</td>
</tr>
<tr>
<td>SUM</td>
<td>SUM3</td>
<td>Sum of values</td>
</tr>
</tbody>
</table>

The following resource tables reference data types are considered numeric and are displayed as a decimal integer value:

**BIN**
Binary value

**CODEBIN**
CICS coded binary value

**DEC**
Decimal value

**SCLOCK and SCLOCK12 ("Count" format only)**
CMF interval store clock, 8 byte and 12 byte. These data types are only considered numeric if the "Count" formatting option is selected for the attribute. When one of the time formatting options is used, as is usually the case, the data type is not considered numeric.

The following resource tables reference data types are considered numeric and are maintained internally as a packed decimal value:

**DEC**
Decimal value
Attributes

Attributes provide field values in WUI views.

Attribute fields

You can use an attribute field to contain the attribute value of an object instance.

When you create a view, you can:

• Create an empty view and add individually selected attributes later.
• Initialize the view with the key attributes. Later, you can add extra attributes and delete the ones that you do not need.
• Initialize the view with all available attributes and delete the attributes that you do not need later.

For some types of attribute, such as clock data, different display formats are available. When you add an attribute to a view, attributes with multiple display formats available appear multiple times in the list of available attributes. You can select the attribute in the appropriate display format.

Display formats for time fields

Clock data can be displayed in up to four different formats, depending on the data type.

Attributes with the data type SCLOCK12, which use the 12-byte CMF interval store clock, can be displayed in any of the time formats. For attributes with the data type SCLOCK (the 8-byte store clock), you can use only certain time formats.

In the time formats that include fractions of a second, \( t \) is tenths of seconds, \( h \) is hundredths of seconds, \( m \) is milliseconds, \( i \) is ten-thousandths of seconds, \( j \) is hundred-thousandths of seconds, and \( u \) is microseconds.

• \( HHHH:MM:SS.tmi\(u \), which shows a 4-digit count for hours, and displays the time to 6 decimal places (down to one microsecond). This format is the default for the data type SCLOCK12. It is not available for SCLOCK. This format is the same as the format used in the CICS statistics reports.

• \( DDD.HH:MM:SS.tmi\(u \), which shows a count for days, and displays the time to 6 decimal places (down to one microsecond). This format is available for the data type SCLOCK12. It is not available for SCLOCK.

• \( HH:MM:SS.tmi \), which shows a 2-digit count for hours, and displays the time to 4 decimal places (down to one ten-thousandth of a second). This format is the default for the data type SCLOCK, and it is also available for SCLOCK12.

• \( HH:MM:SS \), which shows a 2-digit count for hours and no decimal places. This format is available for both the data types SCLOCK and SCLOCK12.

Choose one of the longer time formats for larger time values, such as those for long-running tasks, or for time values where you need maximum precision.

For attributes with the data types SCLOCK12 and SCLOCK, you can also display a count. The count is taken from the last 4 bytes of the clock data. It gives the number of measurement periods during which the time recorded by the timer component of the clock was accumulated.

Attribute filters

You use attribute filters to select the records displayed in a view. The filter for an attribute may be either an entry field or a selection list of possible attribute values. You can edit the selection list to suit the circumstances under which the view will be used. These attribute filters will always be available to users of this view.

Note: You cannot specify the EYU_CICSNAME or EYU_CICSREL attributes, or attributes with a maximum length over 256 bytes as attribute filters.
Parameters
Parameters are available for each managed object in CICSPlex SM.

Action parameter fields
You can include action parameters on a confirmation panel and ask the user to select one before the action is implemented.

Parameter filters
Parameter filters are available only for certain resource types. You use parameter filters to select the records that are displayed in a view. You can display the parameter filter as either an entry field, into which the user can type a value, or a selection list, from which the user selects a value. These parameter filters will always be available to users of this view.

Action buttons
Action buttons allow you to operate on resources and are available on tabular views and detail views.

All action buttons except the create action button operate on those objects on a view selected by the user. For example, on a CICS region tabular view, selecting one or more CICS regions for shutdown and selecting the Shutdown action button would shut down all of the selected regions. On a detail view, the action affects only the managed object displayed in the view. For example, to allow a user to enable or disable a file resource, you could create a detail view with the file attribute FILESTATUS, and the attribute CVDA values of ENABLED and DISABLED displayed in a selection list. The user could select the value required, and select a SET action button. The action button is labeled Set, by default, but you can customize the label to display any text, possibly in your national language.

The create action is not related to objects selected on a view. When present on a view, the create action is always available, and functions even on views that present no data.

Action buttons can either:
- Issue an appropriate command. This is in the case of a direct action which requires no confirmation, or
- Display a panel to confirm the action, perhaps with fields for further input. These action buttons automatically have an ellipsis appended to the end of their label.

Customizable view and menu help
In addition to the Web User Interface help provided with the CICSPlex SM Web User Interface, you can create help that is tailored to your customized views and menus, and that provides information relevant to your business procedures.

The help text may be in your national language and might include, for example, site-specific contact names and telephone numbers, or special procedures. You can create your customizable view and menu help in a number of ways. For example:
- You can edit HTML using a text editor or an HTML editor.
- You can export it from a word processor.
- You can link to a server that provides access to a database via a Web browser, for example, Lotus® Domino®.

The help pages can be served either by the Web User Interface server or by an external server.

You can use the View Editor to include a link to the customizable view and menu help when you create a view. The options are:
- Default view-specific help.
- Member name of a help page to be served by the Web User Interface from DFHHTML.
- URL of an external help page to be served by another HTTP server. The external help page should not target the Web User Interface server.
Considerations when creating pages to be served by the Web User Interface server
When creating your help pages to be served by the Web User Interface server, you should consider the following:

• The names of the help pages must be no more than 8 characters and consist of uppercase letters and numerical digits.

• When developing the help pages on a workstation, name the files with one of the following extensions as appropriate for your platform:
  – .htm
  – .html
  – .HTM
  – .HTML

• When uploading the help pages to the DFHHTML data set, use the 8-character page name (with the extension removed) as the member name.

You may link between your help pages if you want, perhaps to create a contents page. To do this, you must specify the page name (including the extension) without any path. For example,

```html
<A HREF="PAGE2.HTM">Another Page</A>
```

This allows you to test your help pages and the links between them before you upload the pages to the DFHHTML data set.

When uploading the help pages to the DFHHTML data set, you do not need to change any of the links as the Web User Interface server will recognize the page regardless of the extension you used.

Using the view editor
The CICSPlex SM Web User Interface view editor is the tool for customizing your menus, views and map objects.

The navigation frame of the Web User Interface display contains a link to the view editor. However, if your Web User Interface server is running with security active, the view editor is restricted to nominated users. You will not see the link to the view editor unless you have the required authority.

You should leave the view editor by returning to the CICSPlex SM Web User Interface Editor screen or by signing off.

Note:
1. If your web browser session times out, because the INACTIVETIMOUT period is reached, any changes not saved before the session being timed out are lost.

2. This information uses supplied views to provide examples that show how the view editor can be used to edit views. However, you cannot save changes to the supplied views and menus. You must copy the required view set and edit your copy. See “Example tasks” on page 229.

3. A view set, menu, or map object is locked whenever it is opened for edit. Changes are not committed until the view set or menu is finally saved or the edit is abandoned. While locked other users cannot edit the same view set or menu. Users may continue to use the view set or menu while it is being edited, in which case the original version of the view set or menu will be used until it is opened after the changes have been committed.

Accessing the view editor
To access the view editor, select View editor in the navigation frame.

A view editor session is opened in a new window and you are presented with the CICSPlex SM Web User Interface Editor screen. You can have more than one view editor session running at any one time.
Web User Interface supplied views and menus
The CICSPlex SM Web User Interface includes a set of views and menus that you can use either as supplied or as the basis from which to create your own customized views and menus.

When you work with either menus or views, the supplied menus and view sets are listed in a selection box. You can select the one that you want to base your customized view on.

**Note:** You cannot save changes to the supplied view sets and menus. View set and menu names beginning with EYU are reserved for IBM use. You must copy the required supplied view set or menu then edit your copy.

All supplied views are named EYUSTARTobject, where object is a CICSPlex SM resource table name.

Working with customized menus
To work with menus, select the **Menus** option from the **CICSPlex SM Web User Interface Editor** screen.

You have the options of creating a new menu, editing an existing menu, copying an existing menu, or deleting a menu.

Working with customized view sets
To work with views, select the **View sets** option from the **CICSPlex SM Web User Interface Editor** screen.

This opens the **View Set Editor** screen, as shown in Figure 27 on page 216. You have the options of creating a new view set, editing an existing view set, copying an existing view set, or deleting a view set.

![View Set Editor](image)

*Figure 27. View Set Editor screen*

Each view set that you create is based on a single managed object, such as an operations view, or a resource type. When you have created a view set, you can create one or more views based on the selected object.
To edit an existing view click the Edit link on the View Set Editor screen. You are presented with the Open View Set screen as shown in Figure 28 on page 217.

From the Open View Set screen you can select the view set that you want to edit to be presented with the View Set Contents screen similar to the screen shown in Figure 29 on page 218. This screen shows that the selected view set EJBS contains a tabular view and a detail view.
From the **View Set Contents** screen, you can add a new view, edit, copy, or delete an existing view from the view set that you are working with.

**Working with customized views**

To edit an existing view you select the view from the **View Set Contents** screen by selecting the radio button against the view and clicking **Edit**. You will return to this screen and can select other views later. Click **Save** to save all your changes. Click **Abandon** to discard all your changes.

![Figure 29. View Set Contents screen](https://example.com)

For example, by selecting the Tabular view from the **View Set Contents** screen, you will be presented with the **Tabular View Components** screen shown in Figure 30 on page 219.
From the Tabular View Components screen you select the component that you want to edit and a new screen is displayed. When you have finished editing your selection you are returned to the Tabular View Components screen, from where you can select another component to edit, click OK to return to the View Set Contents screen, or Cancel to lose all the changes that you have made to this view and return to the View Set Contents screen.

For example, to edit the columns and contents of the EJBS tabular view, select the Table contents component. This displays the Table Contents screen shown in Figure 31 on page 220.
Figure 31. Table Contents screen

From the Table Contents screen you can:

- Click Append to add a new column to the end of the table, even if a column has been selected.
- Select a column and click Insert to add a new column before the one that you have selected.
- Select a column and click Edit to edit the contents of the column.
- Select a column and click Delete to delete the column.

A column is selected by selecting the radio button in the title box of the column.

When you have finished editing the Table Contents screen, click OK to return to the Tabular View Components screen from where you may decide to work with the action buttons available on the Journal Name view.

To edit the action buttons that are available on the EJBS view select the Action buttons component. This displays the View Buttons screen.
From the **View Buttons** screen you may want to add a new button. Click the **Append** button, as instructed on this screen, to display the **New View Button**.

From the **New View Button** screen you can select the button action:

- Select the **Immediate Action** radio button to perform an action without delay.
Select the confirmation screen radio button to display a confirmation screen before the action is performed.

If you select the confirmation screen option you are presented with the View Button With Confirmation screen.

![View Button With Confirmation screen](image)

**Figure 34. View Button With Confirmation screen**

From the View Button With Confirmation screen specify the name of the button, and either select an existing confirmation screen from the list of available views or enter a new confirmation screen name, as instructed on the View Button With Confirmation Panel. If the new confirmation panel does not exist it can be created later.

If your new button is to be used for the create action, you can set it to be used for the update action also by selecting the check box in the confirmation panel usage section of the screen.

Once you have edited the tabular view click the OK button on the Tabular View Components screen shown in Figure 30 on page 219 and the View Set Contents screen shown in Figure 29 on page 218 is redisplayed where you can save your changes to the tabular view or work with another view in the view set.

**Note:** Some attribute fields are derived from CICS CMF performance class monitoring data. In order for these fields to function correctly, you need to ensure that the CICS monitoring facility is active by setting the CICS system initialization parameters MNPER and MNRES to YES.
Working with view components

From the Tabular View Components screen you select the component that you want to edit and a new screen is displayed.

When you have finished editing your selection you are returned to the Tabular View Components screen, from where you can select another component to edit, click OK to return to the View Set Contents screen, or Cancel to lose all the changes that you have made to this view and return to the View Set Contents screen.

For example, to edit the columns and contents of the EJBS tabular view, select the Table contents component. This displays the Table Contents screen shown in Figure 35 on page 223.

![Figure 35. Table Contents screen](image)

From the Table Contents screen you can:

- Click Append to add a new column to the end of the table, even if a column has been selected.
- Select a column and click Insert to add a new column before the one that you have selected.
- Select a column and click Edit to edit the contents of the column.
- Select a column and click Delete to delete the column.

A column is selected by selecting the radio button in the title box of the column.

When you have finished editing the Table Contents screen, click OK to return to the Tabular View Components screen from where you may decide to work with the action buttons available on the Journal Name view.

To edit the action buttons that are available on the EJBS view select the Action buttons component. This displays the View Buttons screen shown in Figure 36 on page 224.
Figure 36. View Buttons screen

From the View Buttons screen you may want to add a new button. Click the Append button, as instructed on this screen, to display the New View Button screen shown in Figure 37 on page 224.

Figure 37. New View Button screen

From the New View Button screen you can select the button action:

- Select the Immediate Action radio button to perform an action without delay.
• Select the confirmation screen radio button to display a confirmation screen before the action is performed.

If you select the confirmation screen option you are presented with the **View Button With Confirmation screen** shown in Figure 38 on page 225.

![Image of View Button With Confirmation screen](image.png)

**Figure 38. View Button With Confirmation screen**

From the **View Button With Confirmation screen** specify the name of the button, and either select an existing confirmation screen from the list of available views or enter a new confirmation screen name, as instructed on the **View Button With Confirmation Panel**. If the new confirmation panel does not exist it can be created later.

If your new button is to be used for the create action, you can set it to be used for the update action also by selecting the check box in the confirmation panel usage section of the screen.

Once you have edited the tabular view click the **OK** button on the **Tabular View Components** screen shown in Figure 30 on page 219 and the **View Set Contents** screen shown in Figure 29 on page 218 is redisplayed where you can save your changes to the tabular view or work with another view in the view set.

**Note:** Some attribute fields are derived from CICS CMF performance class monitoring data. In order for these fields to function correctly, you need to ensure that the CICS monitoring facility is active by setting the CICS system initialization parameters MNPER and MNRES to YES.
Working with customized map objects
You can use the view editor to create and edit customized map objects.

Enabling the map function on a customized view
To enable the map function on a customized view, use the view editor to add a map button.

Before you begin
You can add a map button to any tabular or detail view that relates to a definitional object.

About this task
The following task describes how to add a map button to a tabular view. The task assumes that you have already created a tabular view as a target for this operation. If you want to add a map button to a detailed view the procedure is the same but the Tabular View Components screen is replaced by the Detailed Form Components screen.

Procedure
1. Open the view editor, click View sets > Edit, and select the view set containing your target view from the list.
2. Click OK to open the View Set Contents panel, which lists all of the views in your selected view set.
3. Select the target view from the list and click Edit to open the Tabular View Components panel.
4. Click Tabular View display options to open the View display options panel. The panel displays a number of headings.
5. Scroll to the Map button section and select Map button available. Click OK to return to the Tabular View Components panel.
6. Assuming you are not making any more changes to the view, click OK to return to the View Set Contents panel and then Save to confirm the operation.

Results
Your view now includes a map button. If the selected resource type can generate more than one type of map, for example Monitoring and RTA in the case of a time period definition, the view also contains a drop-down box next to the map button listing the available choices.

What to do next
When you click Map on your newly customized view, a map of associated definitions is generated. Unless you have specified otherwise, the map generated is based on the default supplied map object for that resource type. You can alter this behavior by specifying a customized map in the WUI server initialization parameters during system setup, or for a particular group of users in a user group profile.

Creating a customized map object
You can create your own map objects for resource types to customize the map's hyperlinks. This process is in two-stages. First you create the map using the view editor, and then associate it with resources to make it accessible.

Before you begin
The view editor includes a number of panels to enable you to create and edit your own maps as shown in Figure 39 on page 227.
Maps contain mostly standard elements that cannot be changed. The purpose of creating your own map objects is to customize the map's hyperlinks. On a supplied map, clicking one of the displayed resource names takes you to a detailed view of that resource definition. On a customized map object, you can change this behavior to link to any detailed view, including customized views, that relates to the same object type. For example, you can link from a CSYSDEF resource to any CSYSDEF-related view. However, you cannot link from a CSYSDEF resource to a PROGDEF-related view, for example.

Before you can create and edit maps, you must have update authority to the security profile that most closely matches the map object. A security profile of the form `EYUWUI.wui_server_applid.MAP.mapname` governs access to map objects in an external security manager.

You can import and export customized map definitions using the COVC transaction.

**About this task**

You can create a new map object in two ways; you can either copy and rename an existing one, or create a new one from scratch. The procedures are very similar. Follow this procedure to create one from scratch:
Procedure

1. Open the view editor and click **Maps** to open the main Map Editor panel from which you can choose to create, edit, copy, or delete a map.

2. Click **Create** to open the Create Map panel.

3. Type in a name for your new map object.
   Map object names consist of letters and digits and have a maximum length of 16 characters.

4. Select the type of map you want to create from workload management (WLM), real-time analysis (RTA), business application services (BAS) or monitoring (MON). Choose one and click **OK** to continue.
   The Edit Hyperlinks panel opens, which shows the resource columns in your new map. The number of columns varies according to the type of map you are creating; BAS, WLM, and monitoring maps have five resource columns, RTA maps have six.

5. Select a column and click **Edit** to set its hyperlink.
   The Target view set panel opens.

6. Select the view set that includes the target view for the hyperlink, or enter the name of the view set, and then click **OK**.

7. This opens the Target View panel. This panel gives you three choices:
   - Select **Default View name** to link to the supplied view that is the default for the resource type.
   - Select **Use an existing View** and select a view from the list to link to an existing supplied or customized view.
   - Select **Use a specified View** and type in a view name to link to a new view that has not been created yet.
   Make your selection and click **OK** to continue. This takes you back to the Edit Hyperlinks panel. The hyperlink for the column you selected in step 7 is now set. You can now continue to set the other columns by repeating steps 5 to 7.

8. When you have finished setting the hyperlinks, click **Save** on the Edit Hyperlinks panel to save your new map screen in the data repository. Message EYUVE1030I confirms that the operation has been successful.

Results

The alternative method of creating a new map object is to copy an existing one and edit it. To do this, select **Copy** from the Map Editor panel, select an existing map and give it a new name. Now you can select **Edit** from the Map Editor panel to update the new map's hyperlinks.

Having created a map object, you must associate it with the appropriate resource type before you can use it. You can do this in two ways:

- You can specify the association when you are configuring your WUI using the following WUI server initialization parameters:
  
  - DEFAULTMAPBAS for a BAS map
  - DEFAULTMAPMON for a monitoring map
  - DEFAULTMAPRTA for an RTA map
  - DEFAULTMAPWLM for a WLM map.

- You can specify the association in a user group profile so that you can specify different map associations for different groups of users. Using this method means that you do not have to stop and reconfigure your WUI server.

Applying or rejecting updates

The view editor provides buttons that allow you to commit or cancel updates.

**Cancel**
- Cancel the operation represented by the screen and any changes made as part of the operation.

**OK**
- Submit the changes and continue.
Finish
Return to the previous screen.

Save
Save the changes associated with a view set or menu in the Web User Interface server repository.

Abandon
Do not save the changes associated with a view set or menu in the Web User Interface server repository.

The Cancel and OK buttons appear together, as do the Save and Abandon buttons, on view editor panels.

Note: If your web browser session times out, because the INACTIVETIMEOUT period is reached, any changes not saved before the session being timed out are lost. For information about the INACTIVETIMEOUT Web User Interface server initialization parameter, see Web User Interface server initialization parameters.

Example tasks
Two typical tasks illustrate some of the customization facilities offered by the Web User Interface view editor. In both cases, the starting point is a supplied view set.

The view editor guides you with additional on-screen instructions.

Using view links and attribute filters
This sample task describes how to link from a tabular view of task resources to a detail view displaying terminal information, when the principal facility is a terminal.

The task involves editing a copy of the supplied view to add a new column for the FACILITY attribute, setting up a conditional link and supplying an attribute filter.

The FACILITY attribute column will be defined to link to a view for the TERMNL resource when the attribute contains a terminal ID. This is achieved by making the link conditional on the value of the FACILITYTYPE attribute and using an attribute filter to specify that the TERMID of the target resource is equal to the FACILITY of the source.

For information on the attributes, see CICSPlex SM resource tables.

1. Prepare the view set
   a. Copy the supplied view set EYUSTARTTASK with the new name TASKVIEWSET (This name is an example only).
   b. On the View Set Editor screen, click Edit and, from the Open View Set screen, select TASKVIEWSET from the list.
   c. On the View Set Contents screen, select the view called TABULAR and click the Edit button.

2. Add a column
   a. On the Tabular View Components screen, select Table contents. The table layout is displayed.
   b. Select the User ID column by selecting the radio button in the column heading. Click the Insert button. This inserts the new column before the User ID column.
   c. On the New Table Column Attribute screen, select FACILITY from the attribute list and click the OK button.

3. Create a conditional link
   a. On the Table Column Components screen, click View links.
   b. On the View Links screen, click Append.
   c. On the New View Link Type screen, select the View set radio button to link to a view within another view set and click OK.
   d. On the View Link Condition screen, the View link conditional on Attribute check box is selected by default. Select FACILITYTYPE and click OK.
   e. On the View Link Components screen, select Condition test.
   f. On the View Link Condition screen, select the condition attribute test radio button Is valid and equal to and select TERM in the selection list. Click OK.
4. Specify the target view set and view
   a. On the View Link Components screen, select Target.
   b. On the Local Target Link screen, the Target view set selected from list radio button is selected by default. Select the name of the supplied view EYUSTARTTERMNL from the selection list and click OK.
   c. On the Confirm Object for View Set screen, confirm that the object type TERMNL is already highlighted and click OK.
   d. From the Target View screen, select the Target view selected from list radio button, select the view called DETAILED and click OK.

5. Specify target selection criteria
   a. On the View Link Components screen, select Context and Scope.
   b. On the View Link Context and Scope Settings screen, retain the context and CMAS context defaults. Change the scope setting by selecting the Set to value of attribute radio button. Select EYU_CICSNAME and click OK.
   c. On the View Link Components screen, select Filter attributes and parameters.
   d. On the View Link Filters screen, click the Append button. On the View Link Filter Type screen, the Attribute filter radio button is selected by default. Click OK.
   e. On the View Link Filter screen, select the TERMID filter attribute and click OK.
   f. On the View Link Filter Settings screen, the equals operator is selected by default. If the FACILITYTYPE field contains the value TERM, the FACILITY field contains a terminal ID. Select the Value of attribute radio button and select filter value FACILITY from the selection list. (The FACILITY field contains a terminal ID if the FACILITYTYPE field contains TERM.) Click OK.

6. Save your changes
   a. Return to the View Set Contents screen by selecting the appropriate buttons on the screens to save your changes. The buttons have different names depending on the function, and may be labeled OK or Finish.
   b. On the View Set Contents screen, you have the choice of saving or abandoning your changes.

You can test your view by creating a link from a menu, or see Providing access to WUI views and menus for information on how to display your view directly.

Using warning lights
This sample task describes how you can replace the textual representation of event severity data in a tabular view with warning lights.

Figure 40 on page 231 shows detail of the Real Time Analysis (RTA) outstanding events view (EYUSTARTEVENT.TABULAR) as supplied, which is used as the basis for this task. This sample task sets a flashing red warning light for the Very High Severity level. You can make your own choice for the other event severity levels.
1. Prepare the view set

   a. Copy the supplied view set EYUSTARTEVENT with the new name EVENTVIEWSET.

   b. On the View Set Editor screen, click Edit, and on the Open View Set screen, select EVENTVIEWSET from the view set list.

   c. On the View Set Contents screen, select the view called TABULAR and click Edit. On the Tabular View Components screen, select Table contents. The table layout is displayed.

---

**Figure 40. Detail of view with text representation of event severity levels**

<table>
<thead>
<tr>
<th>Select record</th>
<th>Event name</th>
<th>Current event target</th>
<th>Event severity</th>
<th>Event priority</th>
<th>Event sequence number</th>
<th>Name of context to which event applies</th>
<th>Event description</th>
<th>Date and time when event was created</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IISAMSDM</td>
<td>IYCSST20</td>
<td>VHS</td>
<td>255</td>
<td>4</td>
<td>HYPERION</td>
<td>ID=XS0001 CIRP KENSCHILD</td>
<td>2001/10/10 15:18:40</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQSQ22</td>
<td>LWV</td>
<td>240</td>
<td>303</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 09:24:43</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQST22</td>
<td>VLS</td>
<td>240</td>
<td>297</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 08:54:38</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQST23</td>
<td>LWV</td>
<td>240</td>
<td>298</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 08:23:43</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQST24</td>
<td>VLS</td>
<td>240</td>
<td>294</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 08:54:38</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQST25</td>
<td>LS</td>
<td>240</td>
<td>295</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 08:23:43</td>
</tr>
</tbody>
</table>

6 records, page 1 of 1

---

**Figure 41. Detail of view with warning light representation of event severity levels**

<table>
<thead>
<tr>
<th>Select record</th>
<th>Event name</th>
<th>Current event target</th>
<th>Event severity</th>
<th>Event priority</th>
<th>Event sequence number</th>
<th>Name of context to which event applies</th>
<th>Event description</th>
<th>Date and time when event was created</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IISAMSDM</td>
<td>IYCSST20</td>
<td>VHS</td>
<td>255</td>
<td>4</td>
<td>HYPERION</td>
<td>ID=XS0001 CIRP KENSCHILD</td>
<td>2001/10/10 15:18:40</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQSQ22</td>
<td>LWV</td>
<td>240</td>
<td>303</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 09:24:43</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQST22</td>
<td>VLS</td>
<td>240</td>
<td>297</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 08:54:38</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQST23</td>
<td>LWV</td>
<td>240</td>
<td>298</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 08:23:43</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQST24</td>
<td>VLS</td>
<td>240</td>
<td>294</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 08:54:38</td>
</tr>
<tr>
<td></td>
<td>WLMJTCB</td>
<td>IYCQST25</td>
<td>LS</td>
<td>240</td>
<td>295</td>
<td>HYPERION</td>
<td>Actual JVMTCB level</td>
<td>2001/10/11 08:23:43</td>
</tr>
</tbody>
</table>

6 records, page 1 of 1

---

Resource name: EVENT. View name: EVENTVIEWSET.TABULAR

1. Prepare the view set
2. **Add warning lights to the Event Severity column**
   a. Select the **Event Severity** column by selecting the radio button in the column heading. Click **Edit**.
   b. On the **Table Column Components** screen, select **Presentation options**.
   c. On the **Presentation type** screen, select the **Warning lights** radio button and click **OK**.
   d. On the **Presentation Options** screen, select the **Show value** radio button. It is good practice to have the value displayed as well as the colored lights. Click **OK**.

3. **Set the color thresholds**
   a. On the **Presentation thresholds** screen, click the **Append** button, and on the **Presentation Threshold Components** screen, select **Threshold range**.
   b. On the **Presentation Threshold Range** screen, the **Equal to** field is selected by default. In the entry field, type the attribute value VHS. This is the value that will cause this color. Click **OK**.
   c. On the **Presentation Threshold Components** screen, select **Threshold color**.
   d. On the **Presentation Threshold Color** screen, select the color RED. Select the **Flashing** check box and click **OK**.
   e. On the **Presentation Threshold Components** screen, click **Finish** to return to the **Presentation Thresholds** screen.
   f. Repeat these steps for each value that you want to define a color for, selecting the color required.
      When you have created all your presentation thresholds, click the OK button on the **Presentation Thresholds** screen.
      When no color is specified for a particular value, the color on the display will be grey.

4. **Save your changes**
   a. Return to the **View Set Contents** screen by selecting on the appropriate buttons on the screens to save your changes. The buttons have different names depending on the function, and are either labeled **OK** or **Finish**.
   b. On the **View Set Contents** screen, you have the choice of saving or abandoning your changes.

You can test your view by creating a link from a menu, or see Providing access to WUI views and menus for information on how to display your view directly. Your view might look like the example in Figure 41 on page 231.

*Creating a two-column detailed view*

You can create a two-column detailed views using the WUI view editor.

**Procedure**

1. Open the view editor and navigate to the **Add View** screen.
   a) From the main menu navigation screen, click **View editor > View sets > Edit**.
      The **Open View Set** screen is shown.
   b) Select the view set to which your new detailed view will belong, and click **OK** to open the **View Set Contents** screen.
   c) Click **Add**.
      The **Add View** screen is shown, which you can use to create a new view for the selected view set.

2. Name the new view and define its display type.
   a) Type in a name for your new view in the **View name** field.
   b) Select **Two column detail form** from the list of view types.
   c) Select **Key attributes** from the list of pre-fill options, and click **OK**.
      The **Detailed Form Components** screen is shown.

3. Add an attribute to the left column.
When you choose to add an item to a two-column detail view, the new element is placed in the left column. In order to maintain left right alignment, a white space element is automatically placed in the right column opposite the new item.

a) Select **Form contents**.

This opens a **Form Contents** screen like the one shown in Figure 42 on page 233.

![Figure 42. Form contents screen for a two-column detail view](image)

Notice it contains a Space element type, which is necessary in the creation of two column screens in order to balance the right and left columns.

b) Click **Append**.

The **Form Item Type** screen is shown.

c) Select **Attribute field** and click **OK** to open the **Form Attribute Field** screen.

This screen contains a list of attributes including the attribute name, data format, and a short description.

d) Select an attribute from the list and click **OK** to open the **Form Item Components** screen.

e) Check the radio button of the attribute, and complete the definition of the new attribute as follows:

1) Type in the attribute title and any annotation.
2) Select the display options, either normal or graphical.
3) Add any view links.

f) Click **Finish** to add the new attribute to your new view.

You are back to the **Form Contents** screen.

4. Add an attribute to the right hand column of the view.

In order to add an element to the right hand column, you need to select a white space element and then edit it to change it to the type of element required.

a) Select the white space element created in step 3 and click **Edit**.

The **Form Item Type** screen is shown.

b) Select the type of element you want to add to the right hand column, and follow the procedure outlined in step 3 to define it.

c) Click **Finish** to add the right hand element to the view.
**Note:** You can repeat steps 3 and 4 as many times as necessary to add more elements to the left and right columns.

If you want to remove an item from the right hand column, select it and click **Delete item.** This converts the item back to a white space element.

**Note:** You cannot delete an individual white space element but you can remove adjacent elements in both columns by clicking **Delete row.**

5. Complete the view definition as follows:
   a) Click **OK** on the **Form Contents** screen to return to the **Detailed Form Components** screen.
   b) Add the rest of the components of the new view including a title, action buttons, filters, context and scope and so on.
   c) When you have added all the required components, click **OK** to save the new view and return to the **View Set Contents** screen.

**Example**

*Figure 43 on page 235* shows an example of a two-column detail view.
Creating a filter confirmation screen

You can use the view editor to set up filter confirmation for an existing (user designed) view.

1. Start the view editor and click **Menus** to open the **Menu Editor**.
2. Click **Edit** and select the menu containing the hyperlink to the intended view from the list. This opens the **Menu Components** screen.
3. Click **Menu Contents**, then scroll to the bottom of the **Menu Contents** screen and click **Append**. This opens the **New Menu Item** screen.
4. Select the **Menu choice** radio button and click **OK**. This opens the **Menu Choice Components** screen.

Figure 43. Example of a two-column detail view
5. Click **Destination** to open the **Menu Choice Type** screen then select the **View link** radio button. This opens the **Target View Set** screen similar to the one shown in Figure 44 on page 236.

![Target View Set screen](image)

**Figure 44. Target View Set screen**

6. Select the view set that includes the target view and click **OK**. This opens the **Confirm Object for View Set** screen.

7. Just for confirmation, select the object associated with your selected view set and click **OK**. This opens a **Target View** screen similar to Figure 45 on page 237.
To create a filter confirmation screen associated with the selected view, scroll to the bottom of the screen and select the box labelled **Use filter confirmation before get**. Click **OK** to confirm.

Now, before opening the target view, a filter confirmation screen is displayed allowing users to specify filter criteria before data retrieval takes place.

**Configuring workload management**

CICSPlex SM workload management optimizes processor capacity in your enterprise by dynamically routing transactions and programs to whichever CICS region is the most appropriate at the time, taking into account any transaction affinities that exist.

**Before you begin**

1. Ensure that you are familiar with the concepts involved with workload management and the dynamic routing of transactions and programs. For details, see *Workload management*.

2. You have determined the extent to which you can use CICSPlex SM workload management in your enterprise. This includes identifying the workloads processed in your enterprise and inter-transaction affinities. Follow the instructions in *Planning for WLM*.

3. Ensure that you follow the implementation process described in *Implementing WLM*. 
About this task
When you establish a workload, you are associating the work itself and the CICS systems (acting as requesting, routing, and target regions), to form a single, dynamic entity. Within this entity, you can route the work:

- To a target region selected on the basis of its availability. This type of routing, known as *workload balancing*, allows you to balance work activity across all of the target regions associated with a workload. See “Management of the work in a workload” on page 239 for additional information.
- To a subset of the target regions based on specific criteria. This type of routing, known as *workload separation*, allows you to separate transaction and program occurrences and direct them to different target region subsets, where activity is balanced across the target regions within the subset.

The criteria you use to separate transactions or programs can be based on:
- The terminal ID and user ID associated with a transaction or program occurrence.
- The process type associated with the CICS BTS activity.
- The transaction.

See “Separating the work in a workload” on page 242 for additional information.
- To a selected target region based on its affinity relationship and lifetime. This type of routing, based on the *transaction affinity* of the target region, allows you to route specific transaction occurrences to the same target region for a designated period of time. For additional information, see “Taking affinity relations into consideration” on page 249.

Workload routing and workload separation can be active concurrently in the same or different workloads associated with a CICSplex.

Note:
1. You can use the CICSPlex SM real-time analysis functions to produce data that will help in the selection of a target region during workload management. See Using real-time analysis to select a target region for workload routing for details.
2. For additional information about how CICSPlex SM handles dynamic routing and how you can customize this facility, see Dynamic routing with CICSPlex SM.

Procedure

Workload requirements
Any CICS system can act as a requesting region, a routing region, or a target region, under certain conditions.

- All the CICS systems associated with a workload are either part of the same CICSplex, or, for BTS processes and activities, part of the same BTS-set. They do not have to reside in the same MVS image.
- For dynamic routing of both terminal-related and non-terminal-related EXEC CICS START commands, requesting, routing, and target regions must be a supported release of CICS Transaction Server.
- For dynamic routing of DPLs, routing regions must be a supported release of CICS Transaction Server; target regions can be any level of CICS.
- For CICS BTS activities, the routing region (which is also the requesting region) and the target region must be a supported release of CICS Transaction Server. They must also be in the same sysplex.
- For dynamic routing of transactions and static routing, the CICS system acting as the routing region must be running CICS Transaction Server. The CICS systems acting as target regions can be running any version of any CICS platform supported by CICSPlex SM.
- For dynamic routing of enterprise bean-related transactions, the CICS system acting as the routing region and the target region must be running a supported release of CICS Transaction Server.
- The routing region must be defined as local to a CMAS involved in managing the CICSPlex. It must use CICSPlex SM facilities to communicate with that CMAS.
For Link3270 bridge requests the target regions must be a supported release of CICS Transaction Server.

The regions involved in workload management must have an in-service and ACQUIRED connection to each other.

A CICS system can act as a target region in one or more workloads; however, it can act as a routing region in only one workload.

**Note:** A CICS system can act as a routing region and a target region in the same workload.

When a CICS system acting as a target region is combined with other target regions to form a CICS system group, each of the target regions must have access to all the resources required by any transactions that might be routed to that CICS system group. In the case of a CICS BTS workload, they must all be in the same sysplex.

**Establishing a workload**

The criteria used to identify a workload are based on the information provided by a workload specification, one or more workload definitions and their optional transaction groups, and one or more workload groups.

- A **workload specification** identifies the CICS systems or CICS system groups in a CICSplex that are to be treated as routing regions and the default target regions. You can also use a workload specification to identify a default affinity relationship and lifetime.

  A CICS region can be associated with none, or one, workload specification (WLMSPEC). For the CICS region to be a CICSplex SM routing region, it must be associated with a workload. For the CICS region to be a CICSplex SM target region, it depends on the type of routing being used:
  
  - For dynamic routing, the target region is not associated with a workload (WLMSPEC). The target region can be a target for one or more workloads.
  
  - For distributed routing, the target region must be associated with a workload (WLMSPEC). The target region can be a target for one workload.

If you currently use only dynamic routing, it is advisable that a target region is a target for only one workload. This simplifies the situation if you decide to implement distributed routing later.

The name of a workload specification becomes the name of the workload itself.

- A **workload definition** includes specific or generic terminal and user names, or a specific or generic process type, that are used when attempting to match a transaction occurrence to a workload definition. It also identifies the target region to which transaction occurrences matching the criteria are to be routed.

- A **transaction group** identifies one or more related transaction identifiers and indicates whether the terminal id or the user id specified in the workload definition is to be used as the primary selection criterion in determining which transactions are to be routed to the set of target regions identified in the workload definition. A transaction group is also used to define affinities.

- A **workload group** is a collection of workload definitions that are to be treated as a single entity.

  **Note:** When no workload definitions are installed in a workload, all transactions and programs are routed to a target region in the default target scope identified by the workload specification. However, when a workload definition is installed in a workload, all transactions and programs that match the criteria in that workload definition are routed to a target region in the target scope identified by the definition itself. A dynamic routing request that is not associated with any workload definition is routed to a target region in the default target scope of the workload specification.

**Management of the work in a workload**

All dynamic transactions and programs that are initiated from a set of requesting regions can be routed by a routing region to a specific set of target regions in the same CICSplex.

The specific target region to which each request is routed is determined by the activity and availability of all target regions in that set.
To establish workload routing, you need to define only a workload specification. The dynamic routing processes are explained using Figure 46 on page 240, which illustrates the Starter Set configuration. For dynamic transaction routing, any transaction initiated from a terminal associated with the requesting region EYUMAS1A (a TOR) is routed to the most appropriate target region (an AOR) in the CICS system group EYUCSG01.

For dynamic transaction routing of **EXEC CICS START TRANSID TERMID** commands, any transaction initiated in the requesting region EYUMAS2A (an AOR) is sent to EYUMAS1A (a TOR), the routing region associated with the terminal identified in the TERMID option of the START command. The routing region sends the transaction to the most appropriate target region (an AOR) in the CICS system group EYUCSG01.

For dynamic program linking, there are two possible scenarios. For an inbound client request, the request is received in TOR EYUMAS1A, which acts as the requesting region and the routing region. The target region is any AOR in the CICS system group EYUCSG01. For a peer-to-peer request, the request is initiated by a transaction running in EYUMAS2A (an AOR). EYUMAS2A acts as the routing region, and the target region may be any AOR in the CICS system group EYUCSG01.

**Using the queue algorithm**

During workload processing using the queue algorithm, CICSPlex SM routes all transactions and programs initiated in the requesting region to the most appropriate target region in the designated set of target regions. See **The queue algorithm**.

**Using the link neutral queue algorithm**

The link neutral queue (LNQUEUE) algorithm corresponds to the queue algorithm, except that the type of connection between the routing and target region is not considered. See **The link neutral queue algorithm**.
Using the goal algorithm

CICSPlex SM supports the z/OS goal algorithm. The goal algorithm selects the target region that is best able to meet the defined, average, or percentile response-time goals for all work in a workload.

The goal is defined by associating transactions, using the z/OS Workload Manager, to a service class. Service classes are assigned on a transaction, LU name, and user ID basis. Service classes can define several types of response-time goals. However, CICSPlex SM recognizes average and percentile response-time goals only. If transactions are given velocity or discretionary goals, they are assumed to be meeting their goals. CICSPlex SM manages at the service-class level; that is, it has no internal knowledge of the transaction characteristics. By consistently allocating service classes to sets of target regions, it minimizes the amount of resource reallocation by the z/OS Workload Manager.

You can use goal mode to provide efficient routing decisions, where routers and targets are managed by the same CMAS, in the following scenarios:

- Dynamic routing using DTRPGM for dynamic transactions
- Dynamic routing using DTRPGM for EXEC CICS START TERMID over APPC or MRO connections
- Distributed routing using DSRTPGM for business transaction service routing

For additional information about the goal algorithm, see The goal algorithm and z/OS MVS Planning: Workload Management.

The service level administrator must define goals that are realistic for the underlying capacity of the target systems. Transactions of like attributes (for example, transactions that have similar resource consumption, or pseudoconversational transactions) must be assigned to distinct service classes. The response-time goals can be the same for several service classes. Use CICS statistics to help you define these transaction sets. See Improving performance for information about CICS statistics.

Using the link neutral goal algorithm

The link neutral goal (LNGOAL) algorithm corresponds to the goal algorithm, except that the type of connection between the routing and target region is not considered. See The link neutral goal algorithm.

Control level for workload routing

To use workload routing, you must specify a default routing algorithm for the workload at the workload specification (WLMSPEC) level. You can optionally specify a routing algorithm at the transaction group (TRANGRP) level. An algorithm specified in a transaction group overrides the default algorithm that is associated with the workload specification.

The default routing algorithm is applied to every routed dynamic transaction in the workload, except those transactions that are associated with a transaction group that has a routing algorithm specified. You can specify one of the following routing algorithms:

- QUEUE
- LNQUEUE
- GOAL
- LNGOAL

To change the routing algorithm specified at the workload specification level, you must close down all regions that participate in the workload so that workload is refreshed with the new algorithm specification.

At the transaction group level, you can specify a routing algorithm dynamically. The specified dynamic routing algorithm is applied to every routed dynamic transaction that is associated with the transaction group. Therefore, you can apply an alternative routing algorithm to specific transaction codes in the same workload.

If you specify an alternative routing algorithm at the transaction group level, you can change workload routing characteristics for specific target regions dynamically without stopping your routing region. If you modify an installed transaction group, you must discard its associated WLM definition (WLMDEF) and then
reinstall it, so that the transaction group named by the WLM definition is also refreshed. To change the routing algorithm type immediately without discarding and reinstalling the associated WLMDEF, you can use the Active workload transaction groups (WLMATGRP) views and the SET command to change the ALGTYPE attribute.

You can specify one of the following routing algorithms:

- INHERIT
- QUEUE
- LNQUEUE
- GOAL
- LNGOAL

INHERIT means that transaction group uses the routing algorithm that is associated with the workload specification for the workload.

**Separating the work in a workload**

You can separate the work in a workload using the name of the user, the terminal, or both that are associated with a transaction or program, the transaction itself, or the BTS process-type associated with the transaction.

You can separate a workload using either LU name and user ID, or process type. You cannot separate a workload using, for example, a generic process type and a user ID. Separation of enterprise bean workloads may be implemented only through the user ID.

**Separating by terminal or user name**

You can create a workload that routes requests from a set of requesting regions to different subsets of target regions based on the name of the terminal, user, or both associated with each occurrence of a transaction.

For example, you might want to route all requests initiated by certain individuals from specific terminals to a special subset of target regions.

Figure 47 on page 243 illustrates what such a workload might look like. In this case, if the user and terminal names associated with a transaction begin with SM and NET, respectively, the transaction is routed to the set of target regions identified as EYUCSG05. If either the user or terminal name begins with any other characters, the transaction is routed to the default set of target regions identified as EYUCSG01 on the workload specification.
Figure 47. Sample definition separating a workload by terminal and user name

Chapter 2. Setting up CICSpinx SM 243
During workload processing, CICSPlex SM evaluates the terminal and user names associated with each occurrence of a request to determine where the request should be routed.

- If the terminal and user names associated with the transaction match the selection criteria specified in an installed workload definition, the request is routed to the target regions identified in that definition.
- If either the terminal or user name does not match the selection criteria, the request is routed to the default set of target regions identified in the workload specification.

After determining the appropriate set of target regions, CICSPlex SM selects one based on the status of the active target regions in that set.

**Separating by process type**

You can create a CICS BTS workload that routes requests associated with a certain process type to a specific target region or set of target regions. For example, you may want to route all the requests associated with the STOCK process type to a special subset of target regions.

Figure 48 on page 245 illustrates what such a workload might look like, if the process type associated with a CICS BTS transaction is STOCK, the transaction is routed to a set of target regions identified as EYUCSG05. If the process type is anything other than STOCK, the transaction is routed to the default set of target regions identified as EYUCSG01 in the workload specification.
Figure 48. Sample definition separating a workload by process type
If you choose to separate a workload by process type, you must set the Luname and Userid fields to *. If you separate a workload by LU name and user ID, you must set the Process Type field to *. If you want to separate an enterprise bean workload, the Luname and Process Type fields must be set to *. You can separate a workload only either by process type or by LU name and user ID.

You can specify either a specific or a generic process type. During workload separation processing, CICSPlex SM evaluates the process type supplied by CICS to determine to where the transaction should be routed.

- If the process type matches the selection criteria specified in an installed definition, the request is routed to the target regions identified in the definition.
- If the process type does not match the selection criteria, a match may be found based on the transaction's associated LU name and user ID. If a match is found based on these criteria, the request is routed to the target regions identified in the associated definition.
- If no match is found using the process type, LU name and user ID, the request is routed to the default set of target regions identified in the specification.

**Note:** Separation by process type takes precedence over separation by LU name and user ID. Thus, if a transaction's associated process type, LU name and user ID mean that it satisfies the selection criteria specified in two workload definitions, one specifying separation by process type and the other separation by LU name and user ID, the transaction is routed to a region in the target scope specified in the workload definition specifying separation by process type.

**Separating by transaction**

You can also separate the work in a workload based on the transactions themselves. For example, you might want all occurrences of payroll-related transactions initiated from terminals in an accounting department to be routed to a specific set of target regions for processing.

Figure 49 on page 248 illustrates how you might separate the work in a workload based on transaction identifiers. In this case, if the user and terminal names associated with any transaction identified in transaction group EYUWMT01 begin with SM and NET, respectively, the transaction is routed to the target regions identified as EYUCSG05. If the transaction identifier, user name, or terminal name does not match the criteria, the transaction is routed to the default target regions identified as EYUCSG01.

During workload processing, CICSPlex SM evaluates the transaction identifier supplied by CICS to determine which transaction group to use.

- If the transaction is defined to a transaction group, CICSPlex SM notes whether the match key for that group is USERID or LUNAME.
- If the transaction is not part of a transaction group, CICSPlex SM uses the match key from the default transaction group for the specification. The match key is the value specified with the associated specification. For additional information, see Transaction group definitions - TRANGRP.

CICSPlex SM uses the match key value to establish the order in which the terminal and user names associated with the transaction are to be evaluated. The evaluation is used to determine where the transaction should be directed:

- If the terminal and user names associated with the transaction match the selection criteria specified in an installed workload definition, the request is routed to the target regions identified in that definition.
- If the terminal and user names do not match the selection criteria, the request is routed to the default set of target regions identified in the workload specification.

After determining the appropriate set of target regions, one is selected based on the status of the active target regions in that set.

**Note:** If you are adding new transaction codes to a transaction group, or removing transaction codes from a transaction group, you do not need to discard the WLM definition that refers to the transaction group if no other attributes of the transaction group are being changed. New transaction codes added to a transaction group can be dynamically activated within an active workload by reinstalling the WLM definition that refers to the transaction group.
A transaction (a DTRINGRP object) can be associated with one parent transaction group (TRANGRP) only, regardless of any parent workload association and irrespective of whether the transaction group is in active use or not. Changes at the transaction group level, and at the WLM definition (WLMDEF) level, can be dynamically activated without terminating an active workload. Only changes at the WLM specification (WLMSPEC) level normally require an active workload to be terminated.
Figure 49. Sample definition separating a workload by transaction
Separating Link3270 bridge workloads

Link3270 bridge workloads can be separated by user ID, LU name, and transaction group.

For Link3270 bridge workloads the LU name can be produced in three different ways:

1. It can be supplied by the user in the BRIH-NETNAME parameter on the Link3270 call.
2. It can be generated randomly by the Link3270 bridge facility.
3. The CICS autoinstall user replaceable program can be used in conjunction with either of the other two methods to accept, reject or modify the supplied or generated NETNAME.

You can separate Link3270 bridge workloads by LU name only if you are using methods 1 or 3 of those listed, so that the LU name is known in advance. If you are using the method 2, the LU name is not known in advance and cannot be used for workload separation.

To separate by the bridge facility NETNAME and not the name associated with the client program that started the Link3270 bridge, you must modify the EYU9WRAM module. You can use the CICS API commands `EXEC CICS ASSIGN USERID()` and `EXEC CICS ASSIGN BRFACILITY NETNAME()` to assign the user ID and LU name. You can use the NETNAME returned from the `INQUIRE BRFACILITY()` command rather than the NETNAME passed via the DFHDYPDS commarea parameter DYRNETNM to separate the workload.

For more information about Link3270 bridge facility definitions, see Overview of CICS external interfaces.

Taking affinity relations into consideration

An affinity is a relationship that you define between two or more transactions for the duration, or lifetime, of that relationship.

When an affinity relationship exists between transactions, those transactions must be processed by the same target region. You can use affiliities to route transactions from one or more requesting regions to a specific target region based on the rules applying to a particular combination of an affinity relation and lifetime. For a list of affinity relation and lifetime values, see Affinity relations and affinity lifetimes.

When multiple CMASs in the CICSPlex manage affinities for the workload, and one of these CMASs is brought down and the local MASs stay up, the workload becomes frozen. When the workload is frozen, it cannot be changed, however the current workload remains active.

When a CMAS is down, and you have any of the following affinity life times and affinity relationships, a new affinity instance cannot be created, and the transaction cannot be routed to the target MAS associated with the affinity, because the local TORs cannot be informed of the workload changes while the workload is frozen.

<table>
<thead>
<tr>
<th>Affinity relation</th>
<th>Affinity lifetime</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAPPL</td>
<td>• SYSTEM</td>
</tr>
<tr>
<td></td>
<td>• PERMANENT</td>
</tr>
<tr>
<td></td>
<td>• ACTIVITY</td>
</tr>
<tr>
<td></td>
<td>• PROCESS</td>
</tr>
<tr>
<td>GLOBAL</td>
<td>• SYSTEM</td>
</tr>
<tr>
<td></td>
<td>• PERMANENT</td>
</tr>
<tr>
<td>LOCKED</td>
<td>• UOW</td>
</tr>
<tr>
<td>LUNAME</td>
<td>• SYSTEM</td>
</tr>
<tr>
<td></td>
<td>• PERMANENT</td>
</tr>
<tr>
<td>USERID</td>
<td>• SYSTEM</td>
</tr>
<tr>
<td></td>
<td>• PERMANENT</td>
</tr>
</tbody>
</table>
When the CMAS is brought back up and reconnects to the MASs, the workload is unfrozen and is able to be changed.

You can use the IBM CICS Interdependency Analyzer for z/OS to detect existing affinities between transactions and between BTS processes and activities. The output from the Reporter component of that utility can be used as input to the CICSPlex SM batched repository-update facility. For more information, see CICS Interdependency Analyzer for z/OS Overview.

**Note:** You cannot use CICS Interdependency Analyzer to detect affinities between non-terminal-related EXEC CICS START commands, and between DPLs that are not associated with either a user ID or a terminal ID. For these request types, you should try to remove or avoid all affinities, and ensure that your applications can honor any remaining affinities.

**CICS BTS considerations**

Although BTS itself does not introduce any affinities, and discourages programming techniques that do, it does support existing code that may introduce affinities.

You must define such affinities to workload management. It is particularly important to specify each affinity’s lifetime. Failure to do this may restrict unnecessarily the workload management routing options.

It is important to note that a given activity can be run both synchronously and asynchronously. Workload management is only able to honor invocations that are made asynchronously. Furthermore, you are strongly encouraged not to create these affinities, particularly activity and process affinities, because these affinities are synchronized across the BTS-set. This could have serious performance impacts on your systems.

You should also note that, with CICSPlex SM, the longest time that an affinity can be maintained is while a CMAS involved in the workload is active; that is, an affinity of PERMANENT. If there is a total system failure, or a planned shutdown, affinities will be lost, but activities in CICS will be recovered from the BTS RLS data set.

**Link3270 bridge considerations**

For Link3270 bridge transactions, affinities are managed by CICS and not by CICSPlex SM. Transaction affinity relation and lifetime fields in the workload management views should be left blank.

**Adding affinities into a workload**

For non-Link3270 bridge transactions, affinities are managed by CICSPlex SM **Transaction affinity relation** and **lifetime** fields in the workload management views. You specify these fields to isolate transactions to particular systems and to define affinity types and lifetimes.

Figure 50 on page 251 illustrates how you might separate the work in a workload based on transaction identifiers and then associate an affinity relation and lifetime with those transactions. With this example, the first occurrence of a transaction named PAY1, where the associated terminal and user names are NET1 and SMITH, respectively, is directed to the appropriate target region within the set of target regions identified as EYUCSG05. The specific target region receiving the transaction and the affinity relation and lifetime associated with the transaction group to which PAY1 belongs are noted. All subsequent occurrences of any transaction in the transaction group that meet the terminal and user name criteria are directed to the same target region for the designated period of time.

**Note:** If you do not specify a default affinity relation and lifetime, then you can use the same workload specification for workload routing and separation.
**Figure 50. Sample definition adding transaction affinity to a workload**

**Note:** During workload processing, CICSPlex SM evaluates the transaction identifier supplied by CICS to determine which transaction group to use.

- If the transaction is defined to a transaction group, CICSPlex SM notes the match key for that group.
- If the transaction is not part of a transaction group, CICSPlex SM uses the match key from the default transaction group for the workload specification.

CICSPlex SM uses this value to establish the order in which the terminal and user names associated with the transaction are to be evaluated. The evaluation is to determine where the transaction is to be directed:

- If the terminal and user names associated with the transaction match the selection criteria specified in an installed workload definition, CICSPlex SM checks to see if an affinity relation and lifetime are associated with the transaction group.
  - When an affinity relation and lifetime are associated with the transaction group:
    - If it is the first occurrence, CICSPlex SM notes the affinity relation and lifetime. Based on target region availability, CICSPlex SM then selects a target region and directs the transaction to it.
    - If it is not the first occurrence, CICSPlex SM routes the transaction to the previously selected target region. As long as the affinity relation and lifetime are applicable, subsequent occurrences of any transaction in the transaction group are directed to the same target region.
  - When no affinity relation and lifetime are associated with the transaction group, the transaction is routed to the most appropriate target region in the designated set of target regions.
- If the terminal and user names do not match the selection criteria, the transaction is routed to the default set of target regions identified in the workload specification. One is selected based on the status of the active target regions in that set.
**Note:** When transactions in a series of terminal-initiated transactions are associated with separate transaction groups, affinities for each transaction group follow the rules defined for that transaction group.

**Abend probabilities and workload management**

CICSPlex SM can evaluate the health and the activity (or load) of each region identified by the target scope. CICSPlex SM uses this information with the acceptable abend load threshold value (ABENDTHRESH) and the acceptable level of abend probability value (ABENDCRIT) that you provide when defining transaction groups to CICSPlex SM, in determining to which target region a transaction is routed.

In CICSPlex SM, the abend probability for transactions that are associated with a transaction group is calculated either for each transaction individually or for the entire group.

- If the transaction is associated with a transaction group that either has no defined affinity relation and lifetime, or uses the default values defined in a workload specification, the abend probability is calculated individually for that transaction.
- If the transaction is associated with a transaction group that has a defined affinity relation and lifetime, the abend probability for that transaction is calculated for the entire group of transactions.

The abend probability for transactions that are not associated with a transaction group is derived from the default abend probability values defined in the workload specification.

The acceptable abend load threshold value (ABENDTHRESH) and the acceptable level of abend probability value (ABENDCRIT) that you provide apply to both the health and the load of a potential target region. You can specify these values either in the workload specification (default rule) or a transaction group definition (associated with a specific rule) by using WUI or CICS TS Explorer, as shown in the following table:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>WUI</th>
<th>CICS Explorer</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABENDTHRESH</td>
<td>Acceptable abend load threshold</td>
<td>Threshold</td>
</tr>
<tr>
<td>ABENDCRIT</td>
<td>Acceptable level of abend probability</td>
<td>Critical</td>
</tr>
</tbody>
</table>

When an unhandled abend occurs in a target region:

- For the transaction, or transactions associated with the transaction, that abends, the abend probability percentage is set to 100% in the target region, which is immediately considered unhealthy as a result.
- CICSPlex SM then gradually reduces the abend probability percentage. When the abend probability percentage is below the specified acceptable level of abend probability (ABENDCRIT) yet above the specified acceptable abend load threshold (ABENDTHRESH), the target region is no longer considered unhealthy. However, the region's perceived load is doubled, making it proportionally less attractive as a target for routing than other equally loaded regions.
- CICSPlex SM continues to reduce the abend probability percentage. When the abend probability percentage falls below the acceptable abend load threshold, the target region's load is set to normal, making it equally attractive as a target for routing as other equally loaded target regions.
- If a further unhandled abend occurs at any point, the process is reset and the abend probability is recalculated from the initial starting point, where the region is considered unhealthy.
- If the target region is considered unhealthy, CICSPlex SM attempts to avoid routing the transaction to that target region. However, if there is no healthier target region, the transaction might be routed to that target region.

**Notes:**

1. Abend probabilities are taken into account only if you are using the dynamic routing exit DTRPGM. Abend probabilities are not considered if you are using the distributed routing exit DSRTFPGM.
2. If an affinity is active, all subsequent transactions are routed to the same target region for as long as the affinity remains active, regardless of its abend probability.

3. If a transaction abends in a target region where the **EXEC CICS HANDLE ABEND** command is active, CICSPlex SM does not receive the information that the abend has occurred. Therefore, CICSPlex SM cannot take such abends into account when calculating the abend probability for the transaction in that target region. The abend probability might stay low in this situation, even though abends occurred.

4. If an application avoids making calls to resource managers because it knows the connection to the resource manager is not active, or it processes an error return code as a result of the connection being unavailable, and proceeds to issue an error message and return normally rather than abend, it could delude the workload manager into routing more work to the CICS region. This situation is called the “storm drain effect”. See Avoiding the storm drain effect.

**Activating workload management**

To activate workload management, you must associate a workload specification with the CICS system and update the CICS system to use the dynamic routing or distributed routing program.

**Before you begin**

You must identify the CICS systems that you want to use for dynamic routing of your workloads. The requesting regions are where the requests are initiated, for example a terminal-owning region; the routing regions decided where to route transactions or programs; the target regions are where the transaction or program run, for example an application-owning region. Together, the requesting, routing, and target regions form a single entity within which you can route work.

**About this task**

For more information about dynamic routing, see Dynamic routing with CICSPlex SM.

**Procedure**

1. Associate a workload specification with the CICS system, using the WLMSPEC view, as described in Associating a CICS system or system group with a workload specification.

2. Identify the dynamic routing program EYU9XLOP to the CICS systems acting as requesting regions and any routing region:
   - If the CICS system is not active, you can make workload management processing available the next time the CICS system starts up. Set the DTRPGM system initialization parameter in the requesting region and in any target region that acts as a routing region:
     
     ```
     DTRPGM=EYU9XLOP
     ```

     For non-terminal-related **EXEC CICS START** commands, BTS activities, and for all regions in a logical server, set the DSRTPGM system initialization parameter in the region that initiates the request and in all potential target regions:

     ```
     DSRTPGM=EYU9XLOP
     ```

   - If the CICS system is active, you can use the **CICS regions** detailed view, as described in CICS regions - CICSRGN, to set the name of the dynamic routing program and the distributed routing program.

3. Activate workload management for the CICS system.
   
   You can do this using the following views:

   - Use the **CICS system definitions** view to change the CICS system definition in the data repository.
   - Use the **MASs known to CICSpex** view to temporarily activate workload management for an active CICS system.
Results

When either the first routing region associated with a CICSpex is started, or you use the MASs known to CICSpex detailed view to activate workload management for the first routing region in a CICSpex, the appropriate workload specifications are installed automatically. All CMASs involved in managing the CICSpex are also notified. All workload definitions and transaction groups, associated with the specification by workload groups, are also installed automatically. As long as the CICS system remains active, additional workload definitions can be installed manually in the CICS system.

**Note:** When a requesting region associated with a CICSpex, and defined with either DTRPGM=EYU9XLOP or DSRTPGM=EYU9XLOP, is starting, it connects to its target CMAS and workload management is activated. However, if the target CMAS is not active when the routing region is starting, any transactions initiated from that routing region and processed by the EYU9XLOP program wait indefinitely until the CMAS becomes active and the requesting region fully connects to it. After the requesting region connects to the CMAS and workload management is activated, the CMAS can become inactive and workload management remains active.

When a workload is active, subsequent changes to workload definitions and transaction groups are noted in the data repository. To include these changes in an active workload, you must use action commands to install or discard them.

Installed workload definitions become active immediately and remain active as long as the workload is active or until you discard them. To verify that the definition is installed in the workload and that all of the CMASs involved in managing the CICSpex using that workload know about the definition, you can use the Active workload definitions view.

How long a workload remains active depends on the affinity lifetime associated with the workload:

- When an affinity lifetime of PERMANENT is in effect, the workload remains active as long as any CMAS involved in managing the workload is active.
- When any other affinity lifetime, or no affinity lifetime, is associated with the workload, the workload remains active as long as any CICS system that is associated with that workload remains connected to a CMAS that manages the CICSpex to which that CICS system belongs.

**What to do next**

When workload management is active, do not attempt to deactivate it while any workloads are active. When CICSpex SM is routing or separating the work in a workload, unpredictable results might occur if you attempt to deactivate workload management. Unacceptable results occur if you attempt this action when affinity relations are associated with active workloads. For details, see Discarding an active transaction from a workload.
Configuring dynamic routing

You can define a transaction to CICS as either local or remote. Local transactions always run in the requesting region; remote transactions can be routed to any CICS system connected to the routing region. Routing of remote transactions can be dynamic, static, or ATI-controlled.

Dynamic routing with CICSPlex SM

When a remote transaction is initiated, the CICS relay program is invoked. The CICS relay program links to the dynamic routing program EYU9XLOP. EYU9XLOP creates the environment necessary for CICSPlex SM-based dynamic routing and sets up the CICSPlex SM runtime environment.

For a routing region, specify EYU9XLOP in the system initialization table (SIT) parameter:

**DTRPGM**
For static routing, ATI, and dynamic routing, set EXU9XLOP on the DTRPGM system initialization parameter that is associated with the requesting region that initiates the transaction. Any target region that is also to act as a routing region must also specify DTRPGM in the SIT and must be set up as a routing region as described in Associating a CICS system or system group with a workload specification.

**DSRTPGM**
For non-terminal-related EXEC CICS START commands, BTS activities, or enterprise beans, set EYU9XLOP on DSRTPGM system initialization parameter in:

- The requesting region that initiates the request.
- All potential target regions if the DYROPTER field in the communications area or container for the routing program (mapped by the DFHDYPDPS copybook) is to be set to Y.

If you use CICSPlex SM to route non-terminal-related EXEC CICS START commands, the DYROPTER field is always set to Y. You must therefore always specify DSRTPGM=EYU9XLOP and ensure that the target region is part of the workload. Failing to ensure that the target region is defined to the workload results in the started transaction waiting for the workload to become available and the transaction hangs.
Note: If the target region is not going to be set up as a routing region, do not specify EYU9XLOP in the DTRPGM and DSTRPGM SIT parameters. Specifying this parameter causes an endless loop for routed transactions in EYU9XLOP waiting for the workload, which never arrives.

CICS notifies EYU9XLOP of all routing requests. These requests are as follows:

- Route selection, route selection error, and transaction termination.
- For BTS (all supported releases of CICS), transaction initiation, transaction abend, and routing attempt complete.
- For non-terminal EXEC CICS START requests (all supported releases of CICS), transaction initiation, transaction abend, and routing attempt complete.

When CICS links to EYU9XLOP, it passes the CICS communication area DFHDYPDS to it.

Control then passes to the CICSPlex SM workload management facilities. CICSPlex SM initializes the workload management MAS agent code and engages its routing action process. This process is called internally if any of the following conditions are true:

- The EYU9WRAM user-replaceable module is not defined to CICS
- EYU9WRAM is defined to CICS, but is not available
- EYU9WRAM is defined to CICS, is available, and the load module is the assembly language version of the module as distributed with CICSPlex SM.

The internal routing action process produces the same results as running the assembly language version of EYU9WRAM as it is distributed with CICSPlex SM. If no additional dynamic routing control is required at your enterprise, the internal process provides better performance.

The EYU9WRAM module, or its equivalent internal process, receives the CICSPlex SM-based communication area EYURWCOM. An entry for EYU9WRAM is added to the CICS system definition file, DFHCSD, for each CICS system during installation. As distributed with CICSPlex SM, EYU9WRAM drives CICSPlex SM workload management processing. EYU9WRAM does this by first obtaining the appropriate
list of target region candidates, based on the transaction group, and the terminal ID, LU-name, user ID, or process type. Then, EYU9WRAM selects a target region from the list of candidates.

For most situations, the supplied EYU9WRAM module provides workload management capabilities. However, if it is ever needed, you can customize CICSPlex SM workload management processing by modifying EYU9WRAM. For more information, see Creating a user-replacement module for EYU9WRAM.

CICS release requirements for dynamic routing
Here are CICS release requirements for regions involved in dynamic routing.

<table>
<thead>
<tr>
<th>Release requirement for:</th>
<th>Routing regions</th>
<th>Target regions</th>
<th>Requesting regions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic transaction routing</td>
<td>Any supported release of CICS</td>
<td>Any supported release of CICS</td>
<td>-</td>
</tr>
<tr>
<td>EXEC CICS START commands</td>
<td>Any supported release of CICS</td>
<td>Any supported release of CICS</td>
<td>Any supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>release of CICS</td>
</tr>
<tr>
<td>CICS Business Transaction Services (BTS)</td>
<td>Any supported release of CICS</td>
<td>Any supported release of CICS</td>
<td>Any supported</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>release of CICS</td>
</tr>
<tr>
<td>Distributed program link (DPL)</td>
<td>Any supported release of CICS</td>
<td>Any supported release of CICS</td>
<td>-</td>
</tr>
<tr>
<td>Enterprise beans</td>
<td>CICS Transaction Server for z/OS, Version 4 Release 2 or earlier</td>
<td>CICS Transaction Server for z/OS, Version 4 Release 2 or earlier</td>
<td>-</td>
</tr>
<tr>
<td>Link3270 bridge</td>
<td>Any supported release of CICS</td>
<td>Any supported release of CICS</td>
<td>-</td>
</tr>
</tbody>
</table>

Sample source programs and copy books
Following installation, the module EYU9WRAM is loaded into CICSPlex SM.

It is an assembler-language, command-level program; its corresponding copy books are:

**EYURWCOM**
Defines the communication area

**EYURWCOD**
Defines literals for EYURWCOM

**EYURWSVE**
Defines each element of a target region scope list

**EYURWSVD**
Defines literals for EYURWSVE

To assist you in your customization effort, sample source programs and copy books for assembler, C, COBOL, and PL/I are distributed with CICSPlex SM. Copy books are located in language-specific libraries. All samples programs are located in the SEYUSAMP library. The names of the sample programs and copy books, and the CICSPlex SM libraries in which they can be found are listed in Table 17 on page 257.

<table>
<thead>
<tr>
<th>Language</th>
<th>Member name</th>
<th>Alias</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembler:</td>
<td>EYUAWRAM</td>
<td>EYU9WRAM</td>
<td>SEYUSAMP</td>
</tr>
</tbody>
</table>

Table 16. Release requirements for regions involved in dynamic routing.
Table 17. Table 1. Sample programs and copy books
### Table 17. Sample programs and copy books (continued)

<table>
<thead>
<tr>
<th>Language</th>
<th>Member name</th>
<th>Alias</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copybook 1</td>
<td>EYUAWCOM</td>
<td>EYURWCOM</td>
<td>SEYUMAC</td>
</tr>
<tr>
<td>Copybook 2</td>
<td>EYUAWCOD</td>
<td>EYURWCOD</td>
<td>SEYUMAC</td>
</tr>
<tr>
<td>Copybook 3</td>
<td>EYUAWSVE</td>
<td>EYURWSVE</td>
<td>SEYUMAC</td>
</tr>
<tr>
<td>Copybook 4</td>
<td>EYUAWSV</td>
<td>EYURWSVD</td>
<td>SEYUMAC</td>
</tr>
<tr>
<td>COBOL:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>EYULWRAM</td>
<td>EYU9WRAM</td>
<td>SEYUSAMP</td>
</tr>
<tr>
<td>Copybook 1</td>
<td>EYULWCOM</td>
<td>EYURWCOM</td>
<td>SEYUCOB</td>
</tr>
<tr>
<td>Copybook 2</td>
<td>EYULWCO</td>
<td>EYURWCOD</td>
<td>SEYUCOB</td>
</tr>
<tr>
<td>Copybook 3</td>
<td>EYULWSVE</td>
<td>EYURWSVE</td>
<td>SEYUCOB</td>
</tr>
<tr>
<td>Copybook 4</td>
<td>EYULWSD</td>
<td>EYURWSVD</td>
<td>SEYUCOB</td>
</tr>
<tr>
<td>PL/I:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>EYUPWRAM</td>
<td>EYU9WRAM</td>
<td>SEYUSAMP</td>
</tr>
<tr>
<td>Copybook 1</td>
<td>EYUPWCOM</td>
<td>EYURWCOM</td>
<td>SEYUPL1</td>
</tr>
<tr>
<td>Copybook 2</td>
<td>EYUPWCO</td>
<td>EYURWCOD</td>
<td>SEYUPL1</td>
</tr>
<tr>
<td>Copybook 3</td>
<td>EYUPWSVE</td>
<td>EYURWSVE</td>
<td>SEYUPL1</td>
</tr>
<tr>
<td>Copybook 4</td>
<td>EYUPWSV</td>
<td>EYURWSVD</td>
<td>SEYUPL1</td>
</tr>
<tr>
<td>C:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>EYUCWRAM</td>
<td>EYU9WRAM</td>
<td>SEYUSAMP</td>
</tr>
<tr>
<td>Copybook 1</td>
<td>EYUCWCOM</td>
<td>EYURWCOM</td>
<td>SEYUC370</td>
</tr>
<tr>
<td>Copybook 2</td>
<td>EYUCWCO</td>
<td>EYURWCOD</td>
<td>SEYUC370</td>
</tr>
<tr>
<td>Copybook 3</td>
<td>EYUCWSVE</td>
<td>EYURWSVE</td>
<td>SEYUC370</td>
</tr>
<tr>
<td>Copybook 4</td>
<td>EYUCWSV</td>
<td>EYURWSVD</td>
<td>SEYUC370</td>
</tr>
</tbody>
</table>

**Implementing optimized dynamic workload routing**

CICSplex SM provides dynamic workload management for CICS. CICSplex SM can augment its workload management decisions using current status information posted directly from CICS by using a region status (RS) server.

**Before you begin**

Full workload optimization can be achieved with sysplex optimized workload routing. However, this capability requires that all workload regions are migrated to CICS TS for z/OS, Version 4.1 and later.

Sysplex optimized workload routing takes place automatically when all workload regions are running at CICS TS 4.1 and later, and when a region status (RS) server is started in the same z/OS image as each region in the workload in the CICSplex.

You can mix CICS TS for z/OS, Version 4.1 and later regions in a workload with regions at a level earlier than CICS TS 4.1. However, workloads will run in a nonoptimized state.

For details about sysplex optimized workload routing, see *Sysplex optimized workload routing overview*. 

---

258  CICS TS for z/OS: CICSplex SM Concepts and Planning
About this task

To optimize workload routing in a sysplex, you must configure and monitor a region status (RS) server, as part of a coupling facility data table. For instructions, see Setting up and running a region status server and Security for coupling facility data tables.

Procedure

In the CICSplex definition, you can set the coupling facility (CF) tuning parameters for the region status (RS) server, which provide sysplex optimized workload routing. You define and modify CICSplexes using the EYUSTARTCPLEXDEF view set. The coupling facility (CF) tuning parameters are in the CPLEXDEF detail view.

Note: You can also modify the default region status (RS) pool name that will be used by all regions in the CICSplex. When you do not to use the default name DFHRSTAT, you must change the name before starting any other regions in the CICSplex. CICSPlex SM will not prevent you from changing the pool name while the CICSPlex is active. If you make a change while the CICSPlex is active, all CMAS and MAS regions in the CICSPlex must be restarted as soon as possible. Failure to do so can result in inconsistent data in the CICSPlex SM WLM views and WLM optimization is deactivated until all the regions in the CICSPlex are restarted.

Configuring for workload routing

You can set the following configurations:

• How long region status data is cached by a routing region before requesting a refresh for sysplex optimized workload routing.
  
  See Region status server, read interval parameter (READRS).

• How often the coupling facility is updated with task throughput data for sysplex optimized workload routing.
  
  See Region status server, update frequency parameter (UPDATERS).

• The task load range that triggers workload distribution updates to the coupling facility (CF) during periods of low throughput.
  
  See Region status server, bottom-tier parameter (BOTRSUPD).

• A task load top tier that controls the workload when the region is close to the MAXTASK (MXT) setting during periods of high throughput.
  
  See Region status server, top-tier parameter (TOPRSUPD).

Viewing optimization status

• For a workload, view the Active workloads list view in the CICSPlex SM Web User Interface (WUI).

• For a CICS region, view the Routing regions or Target regions views located in the Active workloads menu.

  For more information, see “Optimization status” on page 262.

Region status server, read interval parameter (READRS)

You use the region status server read interval parameter in the CPLEXDEF, CSYSDEF, and MAS views to control how long region status data is cached by a routing region before requesting a refresh for sysplex optimized workload routing.

READRS={200|number}

In a workload running in optimized mode, the READRS value specifies the minimum interval, in milliseconds, between refreshes of a target region status from a CICS region status (RS) server. These refresh requests are issued by a routing region that is evaluating a target region for a dynamic routing request.

Note: You should only change the READRS value after considering the impact that the change might have on your workload and coupling facility throughput.
The value range is from 0 - 2000:
• A value of 0 means that a routing region requests a status update of a target region on every occasion that it examines the status of the target region.
• Values from 1 - 2000 specify the minimum time interval that must expire before the status of a target region can be refreshed.

A low interval value means that the RS server is polled more often for a status update. For workloads in QUEUE mode, this low value results in a smoother task load spread across the CICS regions in the workload target scope, *assuming all other health and link factors are equal*. However, the utilization of the RS server is correspondingly increased, which might result in higher utilization of your z/OS coupling facility.

The default value of the `READRS` parameter is 200 milliseconds.

The value specified in the EYUSTARTCPLEXDEF view set sets the read interval at the CICSpool level. However, you can override the interval at the CICS definition level to allow fine tuning of the value on an individual CICS target region basis.

You specify both the `UPDATERS` and the `READRS` parameters at the CICSpool definition (CPLEXDEF) level to establish default values for all regions in the CICSpool. You can override these values at the CICS system definition (CSYSDEF) level or at the MAS agent runtime (MAS) level.

At the CICS definition level, the value for `UPDATERS` and `READRS` is INHERIT, so that the values are adopted from the CICS system definition. By changing these values to explicit numeric values, the CICS system adopts the values specified on each successive restart. To implement a change to a running CICS region, the values must be applied using the MAS base tables or view sets. When the target region is restarted, it reemploys the specification from its CSYSDEF.

**Region status server, update frequency parameter (UPDATERS)**

You use the region status server update frequency parameter in the CPLEXDEF, CSYSDEF, and MAS views to control how often the coupling facility is updated with task throughput data for sysplex optimized workload routing.

**UPDATERS={15|number}**

In a workload running in optimized mode, the `UPDATERS` value indicates the frequency that the CICS region status (RS) server is called to modify the value of the task load in a target CICS region. This value is the default frequency value for all target CICS regions in the current CICSpool definition.

**Note:** You should only change the `UPDATERS` value after considering the impact that the change might have on your workload and coupling facility throughput.

The value range is from 0 - 25:
• A value of 0 means that the RS server is not notified of any task load count changes, because the optimized workload function for target regions in this CICSpool is not enabled.

  **Note:** A value of 0 does not suppress optimization of the workload routing function; a value of 0 suppresses only the target region RS domain broadcasting process.

• Values from 1 - 25 are applied as an arithmetic percentage to the MAXTASKS setting for a target. The resulting task count value is used as a numeric threshold to drive an update call to the RS server.

Specifying a value of zero effectively disables the optimized routing function for the target regions. For an optimized routing decision to be made, both the router and target must be in optimized mode.

For example, with a MAXTASKS setting of 120, and the `UPDATERS` set to 20, the RS server is called to update the WLM load count when the task count for a target region changes between these numbers of tasks:
• 23 and 24 tasks (20% of 120)
• 47 and 48 tasks (40% of 120)
The RS server is updated when the task load for a target region increments or decrements across these boundaries.

If you set the **UPDATERS** parameter to a low value, the frequency of updates to the RS server increases across the task load range. For workloads in QUEUE mode, this low value results in a smoother task load spread across the target CICS regions in the workload scope, *assuming all other health and link factors are equal*. However, the utilization of the RS server is correspondingly increased, which might result in higher utilization of your z/OS coupling facility.

The default value for the **UPDATERS** parameter is 15.

The value specified in the EYUSTARTCPLEXDEF view set sets the update interval at the CICSPlex level. However, you can override the interval at the CICS definition level to allow fine tuning of the value on an individual CICS target region basis.

You specify both the **UPDATERS** and the **READRS** parameters at the CICSPlex definition (CPLEXDEF) level to establish default values for all target regions in the CICSPlex. You can override these values at the CICS system definition (CSYSDEF) level or at the MAS agent runtime (MAS) level.

At the CICS definition level, the value for **UPDATERS** and **READRS** is INHERIT, so that the values are adopted from the CICS system definition. By changing these values to explicit numeric values, the CICS system adopts the values specified on each successive restart. To implement a change to a running CICS region, the values must be applied using the MAS base tables or view sets. When the target region is restarted, it uses the specification from its CSYSDEF.

**Region status server, bottom-tier parameter (BOTRSUPD)**

You use the region status server bottom-tier tuning parameter in the CPLEXDEF, CSYSDEF, and MAS views to control the workload distribution updates to the coupling facility (CF) during periods of low throughput.

**BOTRSUPD={1|number}**

For sysplex optimized workloads, the **BOTRSUPD** value is converted from a task load percentage to a real task count. That count is used to define the bottom-tier task load range, from zero up to this value.

**Note:** You should only change the **BOTRSUPD** value after considering the impact that the change might have on your workload and coupling facility throughput.

The value range is from 1 - 25. When the task load for a region falls within this range, the task load is then broadcast to the coupling facility (CF) for every change in the task load. When the load reaches this value, the RS server update frequency task rules are activated.

The default value of the **BOTRSUPD** parameter is 1%.

Change this value only after considering the impact that the change might have on your workload and coupling facility throughput. The **BOTRSUPD** parameter provides a smoother distribution of the workload during periods of low throughput. When your CICSPlex consists of many target regions and you increase this value too much, you risk overloading the CF with update requests, which can result in degraded WLM and general z/OS subsystem performance.

When you need to modify the **BOTRSUPD** value, ensure that you monitor the performance of your coupling facility and WLM throughput capabilities for at least several days after modification.

**Region status server, top-tier parameter (TOPRSUPD)**

You use the region status server top-tier tuning parameter in the CPLEXDEF, CSYSDEF, and MAS views. It controls the workload when the workload management (WLM) max task health indicator is switched off
for a target region, to limit updates to the coupling facility (CF) when the region is close to the MAXTASK (MXT) setting during periods of high throughput.

**TOPRSUPD={5|number}**

For sysplex optimized workloads, the **TOPRSUPD** value is converted from a task load percentage to a real task count. That count is subtracted from the **MAXTASKS** value for the region to determine the top-tier task load range.

**Note:** You should only change the **TOPRSUPD** value after considering the impact that the change might have on your workload and coupling facility throughput.

The value range is from 1 - 25. The value is applied as an arithmetic percentage to the **MAXTASKS** setting for a region. The task count value is then subtracted from the **MAXTASKS** setting for the region to establish a task load top tier. When the task load in a region runs up to its **MAXTASKS** limit, the task load must then drop back below this value before the **MAXTASKS** state for the region is switched off and broadcast to the coupling facility.

The default value of the **TOPRSUPD** parameter is 5%.

Change the **TOPRSUPD** value only after considering the impact that the change might have on your workload and coupling facility throughput. When you increase this value too much, you see a workload batching effect in the upper load range of the workload. When you decrease the value too much, the upper-tier batching effect is reduced, but updates to the coupling facility can be significantly increased.

When you need to modify the **TOPRSUPD** value, ensure that you monitor the performance of your coupling facility and WLM throughput capabilities for at least several days after modification.

**Optimization status**

You can use the Active workloads list view in the CICSPlex SM Web User Interface (WUI) to view the status of workloads.

**Optimization status of the workload**

You can use the Active workloads list view in the CICSPlex SM Web User Interface (WUI) to view the status of each workload active in the CICSpelx.

The **Optimization status** attribute reports the sysplex optimization status of the current workload. The value is a combination of all of the workload router optimization statuses and all of the workload target optimization statuses.

These values are possible:

- **ACTIVE:** All targets and routers in the workload are running in optimized workload state.
- **PARTIAL:** At least one target and one router are running in optimized workload mode. Use the **Active routing regions** and **Active target regions** hyperlinks to determine which regions are not running in optimized state.
- **INACTIVE:** The workload is not running in an optimized state, for one or more of the following reasons:
  - No routing regions in the workload are running in an optimized state.
  - No target regions in the workload are running in an optimized state.
  - No regions in the workload are running in an optimized state.
  - The workload is designated as being nonoptimized by specifying a value of 0 for the RS server update frequency on the CICSpelx definition or on all target CICS system definitions for this workload.

**Optimization status for a CICS region**

You can use the Routing regions or Target regions views located in the Active workloads menu to view the optimization status for the region.

The **Optimization status** attribute reports the status of the current target region for the optimized workload routing function.
These values are possible:

- **ACTIVE**: This target region is running in an optimized workload state.
- **INACTIVE**: This region can run in an optimized workload state; however, it is not currently optimized for one or more of the following reasons:
  - The region has no connection to an RS server.
  - The region is connected to an RS server; however, the server cannot connect to the z/OS coupling facility.
  - The optimization enablement setting for the region is set to *Disabled*. The enablement setting for the region must be set to *Enabled* before any optimized routing functions can be activated.

  **Note**: You can reset the optimization enablement setting in the CICS system definition view to change the value in preparation for the next region startup. The enablement setting can also be changed in an active region using the MAS view, but will revert to the setting in the CICS system definition when the region is restarted.

- The RS server update frequency value for this region is 0, which means that the optimization capabilities for this region when acting as a routing target are not enabled.

  **Note**: You can set the `UPDATERS` value to 0 for regions that are used as dynamic routers only. Setting this value to 0 prevents the region from making unnecessary region status broadcasts to the Region Status (RS) server.

- **N_A**: The target region is not at a CICS release that supports region status recording. Only nonoptimized WLM routing decisions can be made.

**Nonoptimized workload routing**

In releases before CICS TS for z/OS, Version 4.1, for nonoptimized workload management, and when a coupling facility is not available, workload routing is managed by CICSPlex SM Workload Manager using a data space owned by a CMAS to share cross-region load and status data.

Every CMAS manages a single WLM data space that it shares with every user CICS region (MAS) that it directly manages. When the CMAS initializes, it verifies and formats the data space with the structures necessary for all workloads associated with the CICS regions that it manages. When the user CICS regions begin routing dynamic traffic, the state of those CICS regions is recorded in this data space. Every 15 seconds, the CICSPlex SM agent in the user CICS region determines the task count at that time and reports to its owning CMAS. The CMAS updates the load count in the target region descriptor of its WLM data space and broadcasts that value to other CMASs participating in workloads associated with the user CICS region.

In an environment in which all user CICS regions are managed by the same CMAS, all routing and target regions refer to the same physical structures in the WLM data space. Dynamic routing decisions are based on the most current load data for a potential routing target region. A routing decision is based on a combination of factors. For details, see How CICSPlex SM WLM chooses where to route work.

Workloads are spread across multiple z/OS images, so additional CMASs are configured to manage the user CICS regions on the disparate LPARs. Each WLM data space must maintain a complete set of structures to describe every CICS region in the workload, not just the CICS regions for which each CMAS is responsible. The WLM data space owned by each CMAS must be periodically synchronized with the WLM data spaces owned by other CMASs that are participating in the workload. This synchronization occurs every 15 seconds from the MASs to their CMASs, and then out to all other CMASs in the workload.

The behavior of CICSPlex SM is different for DTRPGM and DSRTPGM requests:

- For DTRPGM requests, the routing region calls, from CICS, to decide if the target regions are synchronized with the execution of the request at the selected target, which is then followed by a call back from CICS on completion of the dynamic request. This call allows the router to increment the task load count before informing CICS of the target region system ID, and also to decrement the count on completion of the request.

- For DSRTPGM requests, the routing region calls, from CICS, to decide if targets are not synchronized with the selected target. Typically, these dynamic requests are asynchronous CICS starts. The router
has no notification of when the routed transaction starts or finishes. Because of a lack of notification, CICSPlex SM stipulates that a DSRTPGM target region must also have the workload associated with the region, which transforms the targets into logical routing regions. This call allows the CICSPlex SM routing processes to determine that they are being called at the DSRTPGM target and, therefore, allows the task load count to be adjusted at transaction start and finish.

CICSPlex SM routing regions count the dynamic transaction throughput in a CICSpex, introducing an additional problem that transactions started locally on the target regions remain unaccountable by the routing regions until a heartbeat occurs. The router transaction counts are not accurately synchronized until two heartbeats have occurred, the first to increment the count, and the second to decrement it again. This discrepancy, however, is not considered as severe as when a router and target are managed by different CMASs.

For multiple CMASs, the router regions evaluate status data for a target region as described in its local WLM data space. If that target region is managed by a different CMAS to that owned by the router, status data describing that target region can be up to 15 seconds old. For DTRPGM requests, this latency does not have a severe effect. For DSRTPGM requests, however, the effect can be significant, particularly when the workload throughput increases. The effect is known as workload batching.

For more information, see “Workload batching” on page 264.

**Workload batching**

Workload batching occurs in heavily used workloads in multiple CMAS environments, where dynamic distributed (DSRTPGM) routing requests are being processed.

A target region and its routing regions can be managed by different CMASes. This is always the case when the router runs in a different LPAR to the targets. In this scenario, the router is using a different descriptor structure to evaluate the target status from the real descriptor structure employed by the target itself.

The target descriptor reviewed by the router is synchronized with the real descriptor at 15-second intervals by the CICSPlex SM heartbeat. The task count for the target region, as seen by the router, is refreshed at the same time. During a 15-second heartbeat interval, the router regards the target as being relatively busy, or relatively quiet, when compared to other potential target regions in the workload. Therefore, for that 15-second duration, the router continues to divert work towards, or away from, the target, depending on how busy it seems to be, because the current task count in the target is not seen to change until the next heartbeat. This routing, based on the previous status, can make the target very busy or unused. The router reacts to this situation by more actively routing work towards, or away from, the target, so the batching cycle continues. This state continues until activity in the workload throughput declines, which settles down the batching cycle until the throughput activity increases.

If you are monitoring the task load across the CICSpex, you see some regions running at their MAXTASKS limit and being continually given dynamically routed traffic, and others remain unused. A snapshot taken 15 seconds later might show a reversal of utilization; the busy regions might be idle and the idle regions might now be at the MAXTASKS limit.

When you start your region status servers and optimize workloads, the effects of workload batching are removed.

**Modifying dynamic routing**

You can customize CICSPlex SM workload management processing by modifying the module EYU9WRAM. EYU9WRAM uses the CICSPlex SM dynamic routing application programming interface (API), which is a special-purpose, call-level interface that provides the mechanism needed to request workload management actions. All calls are constructed using standard CALL statements. The CALL statement generates the linkage between the EYU9WRAM module and the CICSPlex SM Workload Manager component. The format of the CALL statement is shown here:

```call
CALL WAPIENPT(DA_TOKEN,function)
```

where:
DA_TOKEN
Identifies the dynamic routing API token supplied via the EYURWCOM communication area. This
token is used by EYU9WAPI and must not be altered.

**Function**

Is the function to be performed, specified as:

- **SM_SCOPE**
  Returns a list of eligible target regions.

- **SM_BALANCE**
  Selects a target region from the list of eligible target regions.

- **SM_ROUTE**
  Routes a transaction to a specific target region.

- **SM_CREAFF**
  Creates an affinity.

- **SM_DELAFF**
  Deletes an active affinity.

You can use SM_SCOPE and SM_BALANCE together to obtain a list of target regions and then select the
target region to which a transaction is to be routed.

If you know that a transaction is always to be directed to a specific target region, you can use just
SM_ROUTE.

As distributed, EYU9WRAM issues SM_SCOPE and SM_BALANCE calls. It does not include any
SM_ROUTE calls. It includes unexecuted calls to SM_CREAFF and SM_DELAFF. You can modify the
program to issue these calls.

Although all the examples use the assembler language form of the dynamic routing API verbs, you can
also use these verbs in programs written in C, COBOL, and PL/I. Sample programs distributed with
CICSPlex SM contain examples of the CALL statements for each of these languages.

**Note:** If you are modifying dynamic routing, be aware that:

- If they are not set, the values for application context are either zero (for the version) or nulls/low-values
  (for platform, application, and operation).
- String fields are padded with nulls, not spaces.

**Important:** As distributed, EYU9WRAM handles the workload routing and separation established via the
workload management definitions by using the API verbs. Any changes you make to EYU9WRAM,
therefore, might adversely impact the CICSPlex SM workload management facilities. For example, if you
do not use SM_SCOPE, SM_BALANCE, or SM_ROUTE, each transaction occurrence is routed to the default
target region identified when the transaction was defined to CICS. Thus, all CICSPlex SM workload
management definitions are bypassed.

**Nondynamic transaction considerations**

You do not have to include any calls through the API if a transaction is statically routed or is started by
ATI. In these cases, the target region cannot be changed. The routing function is route notify. The route
notify function is intended to notify the EYU9WRAM program that such a transaction is being routed.

If you do include any of these functions, the following occurs:

- An SM_SCOPE call returns a single entry in the SCOP_VECT. The entry is the target region associated
  with the statically defined transaction when it was defined, or with the destination specified on the
  EXEC CICS START command for ATI transactions.
- An SM_BALANCE call selects the target region associated with the transaction when it was defined to
  CICS. The CICSPlex SM Workload Manager will not create any affinity for the transaction.
- An SM_ROUTE call returns an exception response.

When EYU9WRAM is called for:

- Notification, any existing affinity relations are ignored and none are created.
- Route selection error, any existing affinity relations are ignored and none are created. In addition, the EYU9WRAM program as delivered will write a terminal message and terminate.

- Routing attempt complete, for CICS BTS transactions only. Any existing affinities are ignored. Any dynamic routing API function call results in a bad response. See “Non-terminal-related STARTs and CICS BTS considerations” on page 266.

- Transaction initiation, for CICS BTS transactions only. Any existing affinities are ignored. Any dynamic routing API function call results in a bad response. See “Non-terminal-related STARTs and CICS BTS considerations” on page 266.

- Transaction termination, any existing affinities are ignored. Any dynamic routing API function call results in an error response.

- Transaction abend, any existing affinities are ignored. Any dynamic routing API function call results in an error response.

**Non-terminal-related STARTs and CICS BTS considerations**

When routing a transaction associated with either a CICS BTS activity or a non-terminal-related EXEC CICS START command, the routing program, identified in the DSRTPGM SIT parameter, is invoked for both static and dynamic routing.

In the case of statically routed transactions, the EYU9WRAM program cannot alter the target region; see “Nondynamic transaction considerations” on page 265. In the case of dynamically routed transactions, the EYU9WRAM program may alter the target region; see “Selecting a target region from a set of target regions” on page 266. However, in both cases, the EYU9WRAM program is invoked only for:

- In the requesting region:
  - Notification
  - Route selection
  - Route selection error
  - Route attempt complete
- In the target region:
  - Transaction initiation
  - Transaction termination
  - Transaction abend

For details of the function of route initiation, see Dynamically routing DPL requests.

**Selecting a target region from a set of target regions**

As distributed, EYU9WRAM uses SM_SCOPE and SM_BALANCE to select a target region from the list of target regions defined for a transaction. The options that you set affect the way that the target region is chosen.

- SM_SCOPE returns a list of target regions for the current transaction occurrence. The target regions are those that are explicitly or implicitly associated with the requesting region by a workload specification.
- SM_BALANCE selects a target region from the list of candidate target regions returned by SM_SCOPE.

After an SM_SCOPE or SM_BALANCE call, the result of the operation is indicated in the response and reason fields of the EYURWCOM communication area.

**Actions during route selection**

A dynamic route selection occurs when a transaction or program is scheduled for routing.

- When SM_SCOPE is issued, the EYURWCOM communication area Scope Vector pointer is updated with the address of the target region scope list description area, SCOP_VECT. Also, the element count field is updated to contain the count of elements in the scope vector. Each element in the scope vector identifies a candidate target region and indicates its current status.
During SM_BALANCE processing, the target region appearing first in the ordered list is selected for routing, unless the scope vector element EYURWSVE is marked ignore.

- When no affinity is associated with the current transaction occurrence, an SM.Scope call sorts the SCOP_VECT elements so that the target region that is the best candidate is placed first in the list.

During SM_BALANCE processing, the APPLID and SYSID of the most suitable target region are placed in the fields WCOM_SEL_AOR and WCOM_SEL_SYSID, respectively. Typically, this will be the first target region represented in the scope vector. However, if the EYU9WRAM program has marked the WSVE-IGNORE field on some of the SCOP_VECT elements to denote that the target region is to be ignored, the first target region in the scope vector that is not marked to be ignored will be selected.

**Note:**

1. If the transaction identifier and the ids of the terminal and user associated with that transaction match a transaction group to which an affinity is defined, the affinity is made active during SM_BALANCE processing.
2. With DPL, you can update the transaction id before the SM_SCOPE call.

- When an affinity is associated with the current transaction occurrence, an SM_SCOPE call normally causes only the target region with which the affinity exists to be identified in SCOP_VECT. An SM_BALANCE call then selects that target region. If the target region is not available for routing, the SM_BALANCE function will set a warning indicator. It will not attempt to select another target region.

- If the transaction is defined as a DTRTRAN, the EYURWCOM communication area will contain indicators denoting that the transaction is a DTRTRAN and that it will not be rejected by the Workload Manager. Processing is generally identical to the normal, non-DTRTRAN, case. Issuing SM_SCOPE returns a SCOP_VECT. Issuing SM_BALANCE selects a target region.

The EYU9WRAM module might opt to reject the transaction before issuing the SM_SCOPE call. In this case, the Workload Manager returns to CICS with the reject indicator set to Y in the DFHDYPDS communication area. The sample EYU9WRAM program causes a DTRTRAN transaction to be rejected only if the transaction identifier is all blanks.

**Actions during notification**

Notification occurs when a static transaction or ATI transaction is being scheduled for routing.

- For statically routable transactions, ATI transactions, and BTS static routing requests, issuing SM_SCOPE causes the scope vector to contain a single target region. This is the target region associated with the transaction.

**Actions during routing attempt complete**

None, but you can tidy up and release any resources at this stage.

**Actions during route selection error**

A route selection error call occurs if the CICS link between the requesting region and target region is not available or is not defined.

- When no affinity is active: issue SM_SCOPE again. The candidate target regions identified by the SCOP_VECT it returns will not include the target region that caused the error. You can then use SM_BALANCE to select a new target region.

- When affinity became active as a result of the previous route selection:
  - If the lifetime associated with the affinity is PERMANENT, SYSTEM, ACTIVITY, or PROCESS, the target region causing the error will be included in scope list returned by SM_SCOPE. SM_BALANCE is required by affinity rules to select that target region. It also returns a warning to EYU9WRAM. EYU9WRAM should then notify the user that an error has occurred.
  - If the lifetime associated with the affinity is SIGNON, LOGON, DELIMIT, or PCONV, the active affinity status is removed before control returns to EYU9WRAM. When you reissue SM_SCOPE, the target region causing the error will not be included in the scope list. If the workload specification is defined...
with Create Affinity YES for the transaction group, EYU9WRAM is notified that an affinity is defined and will be activated when you issue SM_BALANCE.

• When affinity was activated by a previous transaction instance, and you issue SM_SCOPE again, the scope list returned contains the previously selected target region. Since SM_BALANCE is required by affinity rules to select that target region, a warning is returned to EYU9WRAM. EYU9WRAM should then notify the user that an error has occurred.

Actions during transaction termination
Transaction termination occurs when a transaction has terminated normally.
• EYU9WRAM should release any resources it may have acquired.
• Issuing SM_SCOPE or SM_BALANCE or SM_ROUTE causes an exception response to be returned.

Actions during transaction abend
Transaction abend occurs when a transaction has terminated abnormally.
• EYU9WRAM should release any resources it may have acquired.
• Issuing SM_SCOPE or SM_BALANCE or SM_ROUTE causes an exception response to be returned.

Actions during transaction initiation
Transaction initiation occurs when a CICS BTS-related transaction, or an enterprise bean-related transaction, has been routed to the target region. No specific action is taken. The call is issued for information purposes only.

Selecting a specific target region
SM_ROUTE requests that a specific target region is selected for routing. Use SM_ROUTE when you have application- or data-dependent requirements for explicit routing. For example, you might want to route a transaction associated with a specific user ID to a specific target region.

After an SM_ROUTE call, the result of the operation is stored in the response and reason fields of the EYURWCOM communication area.

A sample SM_ROUTE call is show here:

```
CALL WAPIENPT(DA_TOKEN,SM_ROUTE)
```

DA_TOKEN identifies the dynamic routing API token supplied via the EYURWCOM communication area. This token is used by EYU9WAPI and must not be altered.

Actions during route selection
The actions during route selection are:

• If there is only one connection between a requesting region and the target region, you can supply either the SYSID or the APPLID of the target region (CICSPlex SM will determine the appropriate, corresponding ID). Place the APPLID in the WCOM_SEL_AOR field of the EYURWCOM communication area. Place the SYSID in the WCOM_SEL_SYSID field.

If there are multiple connections between a requesting region and the target region, supply both the SYSID and the APPLID, as described previously, to ensure that the correct target region is selected. Note that when both the SYSID and APPLID are supplied, they are not validated.

The target region need not be defined to CICSPlex SM. The affinity status is not checked. Thus, no affinity is established as a result of this call and, if an affinity was in effect, it is ignored.

• Issuing SM_ROUTE during Route Notify processing causes an exception response to be returned.

Actions during routing attempt complete
None, but you can tidy up and release any resources at this stage.
**Actions during route selection error**
The EYU9WRAM program may issue a message and terminate. You may then issue SM_ROUTE again specifying a different target region, or issue SM_SCOPE and SM_BALANCE.

**Actions during transaction termination**
- EYU9WRAM should terminate any resources it may have acquired.
- Calling any API function causes an exception response to be returned.

**Actions during transaction abend**
- Calling any API function causes an exception response to be returned.

**Actions during transaction initiation**
At transaction initiation:
- EYU9WRAM should terminate any resources it may have acquired.
- Calling any API function causes an exception response to be returned.

**Creating an affinity**
You can use SM_CREAFF to create an affinity if one does not already exist in the transaction group established for the transaction.

The transaction group must be defined with an affinity type and lifetime. The affinity created will have the same affinity type and lifetime as defined in the transaction group.

You should review “Affinity considerations” on page 270 before using SM_CREAFF.

Before calling SM_CREAFF, you must first call SM_SCOPE to obtain a scope list. SM_CREAFF will not create an affinity to a target region that is not in the scope list. In addition, you should set the EYUWRCOM communication area fields WCOM_SEL_AOR and WCOM_SEL_SYSID to the APPLID and SYSID, respectively, of the target region for which you want the affinity created.

EYU9WRAM contains a fragment of unexecuted code that you can use as a template for implementing the SM_CREAFF function.

The SM_CREAFF function cannot be called during:
- Route termination
- Route abend
- Route notify
- Route initiate
- Route complete

**Deleting an affinity**
You can use SM_DELAFF to delete an active affinity.

You should review “Affinity considerations” on page 270 before using SM_DELAFF.

Before calling SM_DELAFF, you must first call SM_SCOPE to obtain a scope list. The WCOM_AFF_STAT field in the EYUWRCOM communication area contains a value indicating whether an affinity is active or committed. An active affinity can be deleted using SM_DELAFF. A committed affinity has a lifetime of SYSTEM or PERMANENT and cannot be deleted using SM_DELAFF.

EYU9WRAM contains a fragment of unexecuted code that you can use as a template for implementing the SM_DELAFF API function.

The SM_DELAFF function cannot be called during:
- Route notify
- Route initiate
Affinity considerations
When you define an affinity, you must specify its lifetime. The affinity normally persists until its specified lifetime expires.

You can define one of the following types of lifetime:

Activity
Expires when the CICS BTS activity ends

Delimit
Expires when the PCONV mode of the transaction is END

Logon
Expires when the terminal user logs off.

Pconv
Expires when a transaction uses EXEC CICS RETURN specifying no NEXTTRANSID or the PCONV mode of the transaction is END.

CICS does not support pseudoconversations for APPC (LUTYPE6.2) devices.

Permanent
Expires when the workload of which the target region is a part terminates

Process
Expires when the CICS BTS process ends

Signon
Expires when the terminal user signs off.

System
Expires when the target region terminates

UOW
Expires when the unit of work associated with the transaction ends. The unit of work ends either when a CICS SYNCPOINT or ROLLBACK request is run, or when the originating task terminates.

There are circumstances when SM_SCOPE generates a scope list containing a single affinity target region, but the target region is not available for routing. This happens when:

• The target region is down.
• The CICS link to the target region is down.
• The target region is currently active but it was shutdown and restarted after the affinity was created.

In these cases, the EYU9WRAM default processing issues a terminal message indicating that the affinity target region is not available and causes the transaction to terminate. If the affinity lifetime is PCONV (pseudoconversation), CICSPlex SM automatically deletes the affinity because it has expired (there is no NEXTTRANSID). However, the default EYU9WRAM processing does not delete any other affinities because the characteristics of the actual affinity to the target region are unknown. For example, a LOGON affinity may involve the use of the TCTUA to pass information to the target region. If the affinity is deleted when the target region is not available, the next transaction for the transaction group would cause a new target region to be selected. The transaction might fail upon using the TCTUA contents when routed to the new target region.

The sample EYU9WRAM program, which implements the default processing, contains a subroutine that checks on affinity status after a call to SM_SCOPE. When an affinity is active to a target region, but not committed, and the affinity target region status is not OK, the subroutine sends a message to the terminal user and then exits so that the EYU9WRAM program terminates. The subroutine contains an unexecuted code fragment that can be used to delete the affinity using the SM_DELAFF call. Before the unexecuted code fragment is a series of tests for the affinity lifetime of the active affinity. One or more of the branches can be changed to jump to the code fragment. The code fragment itself deletes the affinity, issues a message, and then returns so that the EYU9WRAM program exits, thereby causing the transaction to terminate. This processing can be modified so that the affinity is deleted, no message is issued, and the
subroutine exits causing the mainline process to reexecute the SM_SCOPE call. In that case, a new set of
target regions is received for use by SM_BALANCE.

The same subroutine also contains an unexecuted code fragment that can be enabled to create an
affinity. In this case, the subroutine has determined that an affinity is defined but not active. It then
checks the WCOM_AFF_AUTO indicator to determine whether CICSPlex SM should automatically create
affinities during SM_BALANCE. The subroutine exits normally no matter what the answer is. You can
enable the SM_CREAFF fragment in order to cause an affinity to be created. The SM_CREAFF call may be
used regardless of whether WCOM_AFF_AUTO does or does not indicate the automatic creation of
affinities during SM_BALANCE. The SM_CREAFF call can therefore be used to:

• Create an affinity when CICSPlex SM will not.
• Create an affinity to a target region that CICSPlex SM would ordinarily not select.

The SM_CREAFF code fragment creates an affinity to the target region that appears first in the scope list
returned by SM_SCOPE.

The following fields in the EYURWCOM communication area provide information regarding CICSPlex SM
affinity processing.

• WCOM_AFF_STAT
• WCOM_AFFAOR_STAT
• WCOM_AFF_TYPE
• WCOM_AFF_LIFE
• WCOM_AFF_AUTO
• WCOM_WORK_NAME
• WCOM_TGRP_NAME

**CICSPlex SM data areas**
The EYU9WRAM program uses two data areas, communication area EYURWCOM and scope vector
element EYURWSVE.

Literals for EYURWCOM are defined in EYURWCOD and literals for EYURWSVE are defined in EYURWSVD.

The names of the copy books that you can use to map these data areas are identified in Sample programs
and copy books.

The scope vector element, EYURWSVE, contains information about the individual target regions
associated with the list of candidate target regions returned by SM_SCOPE.

**Creating a user-replacement module for EYU9WRAM**
You can use the sample procedures provided in CICSTS55.CPSM.SEYUPROC to create replacement
modules for EYU9WRAM.

The procedure members are as follows:

<table>
<thead>
<tr>
<th>Assembler</th>
<th>EYUEITAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>EYUEITDL</td>
</tr>
<tr>
<td>PL/I</td>
<td>EYUEITPL</td>
</tr>
<tr>
<td>COBOL</td>
<td>EYUEITVL</td>
</tr>
</tbody>
</table>

1. Copy these procedures to a cataloged system procedure library. You can use the samples in Sample
   user-replacement modules.

2. Use the JCL samples to run the procedure and create the replacement module for EYU9WRAM.
   Replace the lower case values shown in the sample JCL with the appropriate values for your site. Also,
   you cannot use the CICSPlex SM API in EYU9WRAM.
Requesting additional dynamic routing support

This section contains Product-sensitive Programming Interface Information.

You can access the CICSPlex SM workload management facilities directly from an application program.

Note: If you are running CICS Transaction Server for OS/390® Version 1 Release 3 and later, it is recommended that you use the CICSPlex SM-supplied program EYU9XLOP for all your dynamic routing requirements. You need the information in this section only if you want to continue to use this function during migration to CICS Transaction Server for OS/390 Version 1 Release 3.

If your routing regions are CICS Transaction Server for OS/390 Version 1 Release 3 and later, or if you are using CICS BTS or enterprise beans, you do not need the information in this section. You should use the distributed routing facilities described in Dynamic routing with CICSPlex SM.

To write such a program, you should be familiar with:

- The interface between the CICS relay program and the defined dynamic routing program.
- CICSPlex SM workload management processing, as described in Workload management.
- The CICSPlex SM workload management routing action module, EYU9WRAM, as described in Dynamic routing with CICSPlex SM.

The primary method of invoking CICSPlex SM workload management is by defining module EYU9XLOP to CICS as the dynamic routing program. This causes EYU9XLOP to be invoked by the CICS relay program, allowing CICSPlex SM workload management to make a routing decision about each work request that can be sent to another CICS system.

If necessary, CICSPlex SM workload management can be invoked directly from an application program, without going through the CICS relay program. For CICS releases prior to CICS Transaction Server for OS/390 Version 1 Release 3, you can use CICSPlex SM Workload Management to determine the best target region for a distributed program link (DPL) from a requesting region. The application program you write must follow certain guidelines:

- The program must run in a CICS system that is defined and running as a routing region. You cannot access CICSPlex SM workload management from a target region.
- The program must issue its INIT and TERM calls from the same task. CICSPlex SM expects the program to imitate the processing done by the CICS relay program, which always calls at route initiation and route termination.

Note: Accessing workload management through a program that issues an EXEC CICS START command is not recommended with an asynchronous transaction start. Furthermore, EXEC CICS START commands that are not related with either a terminal or a user should not be used for transactions that have affinity relationships, as those relationships cannot be correctly resolved using this interface.

Accessing workload management from a program using a dynamic program load is not supported. CICSPlex SM workload management uses the CICS application programming interface to gather information about the current environment in which it is running. Due to DPL restrictions some of that information is not available, and unpredictable results may occur.

In order to make a routing decision, CICSPlex SM workload management needs certain information that is normally supplied by the CICS relay program. The CICS relay program derives the information from data available to CICS for the instance of the transaction being relayed. When you invoke CICSPlex SM workload management directly, you need to provide this information, including terminal-oriented data and the equivalent of a transaction name to identify the work to be routed.

How to start CICSPlex SM workload management

To start the CICSPlex SM workload management facilities, use an EXEC CICS LINK command, specifying EYU9XLOP as the program and identifying EYURWTRA as the communication area.

The format of the command is:

```
EXEC CICS LINK
    PROGRAM(EYU9XLOP)
```
Much of the data normally passed from the CICS relay program to the dynamic routing program in the DFHDYPDS communication area must be generated by your program and passed to CICSPlex SM workload management. Other data that is normally derived by CICSPlex SM workload management from a transaction- and terminal-oriented environment must also be provided by your program. The assembler copy book EYURWTRA provides a map of the communication area to be passed to CICSPlex SM workload management.

The corresponding copy books and the CICSPlex SM libraries in which they can be found are:

<table>
<thead>
<tr>
<th>Language</th>
<th>Member name</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembler</td>
<td>EYUAWTRA</td>
<td>SEYUMAC</td>
</tr>
<tr>
<td>COBOL</td>
<td>EYULWTRA</td>
<td>SEYUCOB</td>
</tr>
<tr>
<td>PL/I</td>
<td>EYUPWTRA</td>
<td>SEYUPL1</td>
</tr>
<tr>
<td>C</td>
<td>EYUCWTRA</td>
<td>SEYUC370</td>
</tr>
</tbody>
</table>

Before invoking CICSPlex SM workload management, you must initialize the EYURWTRA communication area.

For a list of the possible response and reason code values that can be returned in WTRA_API_RESP and WTRA_API_REAS, refer to the assembler copy book member EYURWCOD.

**Processing considerations**

After CICSPlex SM workload management processing, the WTRA_RESPONSE field contains a return code of either zero (0) or 8.

If the return code is 0, WTRA_SYSID contains the SYSID of the selected target region, and WTRA_APPLID contains its APPLID. With that information, you can proceed to route the unit of work to the target region.

If the return code is 8, you should inspect the WTRA_API_RESP and WTRA_API_REAS fields for more information. These fields contain the last response and reason codes returned to the CICSPlex SM workload management routing action module (EYU9WRAM). In most cases, the response and reason codes describe what caused CICSPlex SM workload management to generate the return code of 8. Based on that information, you can decide how to proceed.

In some cases, however, the WTRA_RESPONSE field may contain a return code of 8, while the WTRA_API_RESP and WTRA_API_REAS fields have not been set by CICSPlex SM workload management. In those cases, an error was detected before invoking the routing action process. CICSPlex SM user trace records are written to the CICS trace data set for those types of errors. When this happens, your program should terminate processing.

When the return code is 8, you should also inspect the WTRA_OPTER field. If its value is WTRA_CALLYES:

1. Set the WTRA_FUNC field to WTRA_FUNCTRM for route termination.
2. Reinvoke CICSPlex SM workload management.
3. Terminate processing for the proposed unit of work.

If the WTRA_OPTER field contains a value of WTRA_CALLNO, terminate further processing for the proposed unit of work.

After the unit of work has completed in the target region, set the WTRA_FUNC field according to how the unit of work completed. If the unit of work completed successfully:

1. Set the WTRA_FUNC field to WTRA_FUNCTRM for route termination.
2. Optionally, set the WTRA_NEXTTRAN field to the ID of the next transaction to be used in the process. If there is no next transaction, set the field to all blanks.
3. Reinvoke CICSPlex SM workload management to request termination processing for the transaction.

If the unit of work abended or generated an error that you consider abnormal:
1. Set the WTRA_FUNC field to WTRA_FUNCABD to notify CICSPlex SM workload management that the routed transaction abended.

2. Reinvoke CICSPlex SM workload management to request abnormal termination processing for the transaction.

**Route error considerations**

After you receive the SYSID and APPLID of a target region, you can attempt to route the unit of work to the target region.

However, the routing attempt may result in an error condition if the system is unavailable. When this happens, you should:

1. Set the WTRA_FUNC field to WTRA_FUNCERR to indicate a routing error.

2. Specify the reason for the error in the WTRA_ERR field.

3. Reinvoke CICSPlex SM workload management.

CICSPlex SM workload management provides another target from the scope list, if possible. If no other systems are available, the WTRA_RESPONSE field is set to 8 and the WTRA_API_RESP and WTRA_API_REAS fields describe the reason for the failure. You may have to invoke CICSPlex SM workload management more than once for routing errors until you receive a valid target region.

**Transaction affinity considerations**

If the WTRA_TRANID, WTRA_USERID and WTRA_LUNAME fields cause CICSPlex SM workload management to select a transaction group that includes an affinity, the rules of transaction affinities are obeyed.

In this case, you should ensure that the WTRA_NEXTTRAN field is initialized with the ID of the next transaction before calling the route termination function.

If your units of work, or any subset of them, have an affinity relation defined, be careful in how you define that affinity. Since your program cannot provide SIGNOFF or LOGOFF processing, an affinity lifetime of SIGNON or LOGON, though valid, may cause an affinity relation to be built that is not removed until either the requesting region or the target region terminates.

The WTRA_NEXTTRAN field is most useful for pseudo-conversation affinities. For this affinity lifetime, CICSPlex SM workload management normally issues the EXEC CICS ASSIGN NEXTTRANSID command to retrieve the next transaction ID, if any, for the facility. Since that command is not available when CICSPlex SM workload management is invoked by your program, it is your responsibility to provide the ID of the next transaction.

For a description of CICSPlex SM workload management affinity processing, see Taking affinity relations into consideration. For details on specifying affinity relation and lifetime values, see Creating a transaction group.

**Abend compensation considerations**

If the target region is running CICS TS, transactions initiated by your program can participate in abend compensation processing, provided that the active CICSPlex SM workload specifies it.

You should note that, if the work requests are either non-terminal-related EXEC CICS START commands, or BTS activities, the routing and target regions must be within the same MVS image for the routing region to detect that an abend has occurred.

Your program should notify CICSPlex SM workload management that a particular unit of work abended by specifying WTRA_FUNCABD in the WTRA_FUNC field. Then, if possible, CICSPlex SM workload management will tend to avoid selecting the same target region for the transaction (or set of transactions, if an affinity is defined) on subsequent route select functions.

For a description of CICSPlex SM workload management abend compensation processing, see Abend probabilities and workload management. For details on requesting abend compensation, see Creating a workload specification.
CMAS availability considerations

If your program issues an EXEC CICS LINK for the EYU9XLOP program, but the requesting region in which your program is running has not yet fully connected to its target CMAS, you see message EYUXL0020I, indicating that an ESSS connection is in progress.

Your program waits indefinitely until the CMAS becomes available and the requesting region is joined to a workload. If you have connected successfully to the CMAS and the MAS, but the CMAS has not installed any workload definitions to the MAS, you see a message indicating that the requesting region is waiting for a workload. You may need to set up and install workloads to rectify this situation.

Note: Once the requesting region has successfully connected to the CMAS, the CMAS can become inactive and workload management remains active.

Sample calling sequence

This code example illustrates a sample calling sequence for a program that accesses CICSPlex SM workload management facilities. It is not intended to be used as a sample program and is, therefore, not complete in every detail.

```
*---------------------------------------------------------------------*
DFHEISTG ,                   Define Workarea
WRK_WTRA       DS   CL(WTRA_LENGTH)
DS   0D
WRK_UOWCOMM    DS   0C
WRK_UOW_RESP   DS   F
WRK_UOWCOMM_L EQU  *-WRK_UOWCOMM
COPY  EYURWTRA                Include DSECT to map WTRA
SRVPGM   DFHEIENT EIBREG=R11,DATAREG=R13,CODEREG=R12

* Initialize the WTRA COMMAREA.                                       *
*---------------------------------------------------------------------*
LA    R8,WRK_WTRA             --> WTRA
USING EYURWTRA,R8             *** USING WTRA ***
MVC   WTRA_SLENGTH,=AL2(WTRA_LENGTH) Set length of block.
MVI   WTRA_ARROW,C'>'         Set arrow.
MVC   WTRA_NAME,=C'EYURWTRA'  Set the name.
MVI   WTRA_BLANK,C' '         Set blank delimit.
MVC   WTRA_PGMNAME,=CL8'SRVPGM' Set program name.
MVC   WTRA_TERMID,=CL4'TRM1'  Set TermID.
MVC   WTRA_USERID,=CL8'USR1'  Set USERID.
MVC   WTRA_LUNAME(8),=CL8'.NET1'
MVC   WTRA_TRANID,=CL8'TRN1'  Set TRANID.
MVC   WTRA_SYSID,=C'SYS1'     Set SYSID.
MVC   WTRA_APPLID,=C'APPLID1' Set Applid.
* Set Application Context

MVC   WTRA_PLATFORM,=CL64'PLATFORM_1.0.0'
MVC   WTRA_APPLICATION,=CL64'APPLICATION_1.0.2'
MVC   WTRA_MAJORVER,=F'1'
MVC   WTRA_MINORVER,=F'1'
MVC   WTRA_MICROVER,=F'1'
MVC   WTRA_OPERATION,=CL64'PLEASE_ROUTE'
MVI   WTRA_FUNC,WTRA_FUNCSEL  Set the Route Select Function.
MVI   WTRA_DYRTYPE,WTRA_DYRTYPE_DYN

*---------------------------------------------------------------------*
* Invoke the WLM MAS Agent for Route Select.                          *
*---------------------------------------------------------------------*
ROUTE_SELECT   DS  0H
BAS   R5,=F'0'               Go do it.
CLC   WTRA_RESPONSE,=F'0'     Call go OK?
BNE   CHECK_OPTER             ..no.
BAS   R5,START_UOW             Go Start the UOW.
LTR   R15,R15                 Work Completed?
BZ    ROUTE_TERM                ..yes.
BP    ROUTE_ABND               UOW gave non zero return code.
C    R15,=F'4'                SYSID error?
BNE   ROUTE_ABND              ..no.

*---------------------------------------------------------------------*
* Invoke the WLM MAS Agent for Route Error.                           *
*---------------------------------------------------------------------*
```
ROUTE_ERROR DS 0H
MVI WTRA_FUNC,WTRA_FUNCERR  Set the Termination Function.
MVI WTRA_ERR,WTRA_ERROUT  Say out of service.
B ROUTE_SELECT  Go Get another system.

* Invoke the WLM MAS Agent for Route Abend.
*---------------------------------------------------------------*
ROUTE_ABND DS 0H
MVI WTRA_FUNC,WTRA_FUNCABD  Set the Abend function.
BAS R5,LINK_WLM  Go terminate.
CLC WTRA_RESPONSE,=F'0'  OK?
BE EXIT_ABD  ..yes.
CHECK_OPTER DS 0H
CLI WTRA_OPTER,WTRA_CALLYES Call WLM for Term?
BNE WLM_CALLERR  ..no.

* The WLM MAS AGENT returned an 8 in WTRA_RESPONSE  *
*---------------------------------------------------------------*
WLM_CALLERR DS 0H

* Process completed successfully  *
*---------------------------------------------------------------*
EXIT_TERMOK DS 0H

* Route Abend Call returned a 0  *
*---------------------------------------------------------------*
EXIT_ABD DS 0H
EXIT DS 0H
EXEC CICS RETURN

* LINK_WLM : Link to the WLM MAS AGENT  *
*---------------------------------------------------------------*
LINK_WLM DS 0H
EXEC CICS LINK PROGRAM(EYU9XLOP)  X
COMMAREA(EYURWTRA) LENGTH(=AL2(WTRA_LENGTH))  X
BR R5  Exit routine.

* START_UOW : Start the Unit Work.  *
*---------------------------------------------------------------*
START_UOW DS 0H
EXEC CICS LINK PROGRAM(UOWPGM)  X
COMMAREA(WRK_UOWCOMM) LENGTH(=AL2(WRK_UOWCOMM_L))  X
SYSID(WTRA_SYSID)  X
RESP(WRK_EIBRESP)  X
CLC WRK_EIBRESP,DFHRESP(NORMAL)  X
BE START_UOWL  Did call go ok?
L R15,=F'-4'  Assume SYSIDERR
CLC WRK_EIBRESP,DFHRESP(SYSIDERR)  X
BE START_UOWX  ..yes.
L R15,=F'-8'  Load Failure code.
B START_UOWX  Go exit.
START_UOWL DS 0H
L R15,WORK_UOW_RESP  Load Response Code.
START_UOWX DS 0H
BR R5  Exit routine.
Routing program-link requests

"Traditional" CICS-to-CICS distributed program link (DPL) calls, instigated by EXEC CICS LINK PROGRAM commands, can be daisy-chained from region to region by defining the program as remote in each region except the last (server) region, where it is to execute.

**Important:** For detailed information about routing program-link requests, see CICS distributed program link. This appendix is an overview of how program-link requests received from outside CICS can be routed to other regions.

The same applies to program-link requests received from outside CICS. For example, all of the following types of program-link request can be routed:

- Calls received from:
  - CICS Web support
  - The CICS Transaction Gateway
- Calls from external CICS interface (EXCI) client programs
- External Call Interface (ECI) calls from any of the CICS Client workstation products
- ONC/RPC calls.

**Static routing**

A program-link request received from outside CICS can be statically routed to a remote CICS region by specifying the name of the remote region on the REMOTESYSTEM option of the installed program definition.

**Dynamic routing**

A program-link request received from outside CICS can be dynamically routed by defining the program to CICS as DYNAMIC(YES), and coding your dynamic routing program to route the request.
Chapter 3. Administering resources with CICSPlex SM

You can manage all of your CICS and CICSPlex SM resources through any of the following interfaces; the CICS Explorer, the CICS Management Client Interface (CMCI), a WUI view, or using the CICSPlex SM API.

Manage your resource definitions in the following ways:

- Using the CMCI, which accepts HTTP requests from your application.
- Using the CICS Explorer, which takes advantage of CMCI.
- Using the CICSPlex SM Web User Interface (WUI).
- Adding CICSPlex SM API commands directly to your application.

Managing and installing resources

Use Business Application Services (BAS) to manage and install CICS resources that are stored on the CICSPlex SM data repository.

Use CSD to manage and install CICS resources that are stored on the CICS System Definition (CSD) repository.

You must define a CSDGROUP for a CSD resource and a DEFVER for a BAS resource.

Managing resources using Business Application Services (BAS)

Business Applications Services is the component of CICSPlex SM that you use to manage the CICS resource definition and installation process for business applications at your enterprise.

What is Business Application Services (BAS)?

Business Application Services (BAS) is an alternative to resource definition online (RDO) that enables you to manage CICS resources in terms of the business application to which they belong, rather than their physical location in the CICSpex.

A business application can be any set of resources that represent a meaningful entity in your enterprise. Within the application, you can group together resources of a particular type and define the run-time characteristics of that group. At run-time, you can refine the selection of resources to be installed by using a filter expression, and you can change the resource attributes by using an override expression.

Limitations of RDO

RDO is the traditional CICS method of defining resources to CICS systems.

With RDO, resource definitions are tied to a single group and groups that are processed sequentially from a group list. Any duplicate definition found later in the process overrides any earlier one. In addition, the very nature of the definitions that RDO requires and the extent to which they are available to multiple CICS systems can prove limiting. RDO has several disadvantages in a CICSPlex SM environment:

- Resources are assigned to groups that are assigned to specified CICS systems.
- Resource definitions have to be duplicated across CICS systems, unless the CSD is shared.
- Each end of every communications link has to be defined explicitly.
**BAS concepts**
BAS enables you to view and manage your resources in terms of their use in your business, and independently of their physical location.

This section introduces the basic concepts of the BAS function.

**Logical scoping**
Once your CICS resources are defined to CICSPlex SM, you can monitor and control resources in terms of their participation in a named business application, rather than their physical location in the CICSplex.

Logically-related resources can be identified and referred to as a set, regardless of where they reside at any given time.

Sets of definitions can be reused and associated with any number of other logical associations of resources that reflect your business needs, rather than your system configuration.

If you set the scope to be your application, any operation or monitoring views will display only those resources that satisfy your selection criteria. This gives you the power to control precisely how those resources are managed.

**Multiple versions of a resource definition**
With BAS, you can have multiple versions of the same resource.

Each time you create a new definition for the same resource and the same name, BAS allocates a new version number. Note that a new version number is not created if you update the resource. You can specify a specific version of a resource definition by its version number.

Version support allows you to develop resource definitions as your business applications develop. You can then have, for example, a single version of a resource in multiple groups, or multiple versions of the resource throughout the CICSplex. Note that you can install only one version of a resource in a CICS system at one time.

**Centralized resource definition**
RDO definitions are held in a CICS System Definition (CSD) file. BAS resources are held on a central data repository that is accessed by all the CICS systems in the CICSplex.

The CICSPlex SM data repository (EYUDREP) serves as the central repository for all your CICS resource definitions. This minimizes the number of resource definitions you need for your CICSplex by:

- Providing a single system image approach to defining CICS resources across all supported platforms.
- Producing both local and remote instances of a resource from a single definition.
- Managing multiple versions of a definition. For example, you can have different versions of the resources for an application as it progresses through a number of test phases.
- Generating multiple CICS communication links from a single set of connection and session definitions.

**CICS system links**
With Business Application Services, you can create one set of BAS resource objects to define the connection definitions and reuse them in many CICS regions by using a system link (SYSLINK) object. The established method of defining connections between CICS regions is to use RDO to manually create and install definitions that describe the connection. Each resource definition is unique to the CICS region and cannot be reused in other regions.

The system link definition describes the type of connection and connection definitions that are required to create a connection between a pair of CICS regions. You can use these connection definitions as a model to create any number of system links that share the same characteristics.

You can define different types of connections using SYSLINK objects:

- MRO or ISC connections require CONNDEF and SESSDEF resource objects to describe the CONNECTION and SESSION resources.
- IPIC connections require IPCONDEF and TCPDEF resource objects to describe the IPCONN and TCPIPSERVICE resources.
When you install a SYSLINK that uses these model definitions, the resource definitions are installed in the CICS regions automatically to create the connection.

**Distributed resource installation**

Resources that are defined to CICSPlex SM must still be installed in the appropriate systems, either by CICS or by CICSPlex SM.

You can use BAS to install your resources either automatically, at CICS initialization, or dynamically, while a system is running. A single resource can be installed in multiple CICS systems either locally or remotely, as appropriate.

**Two forms of BAS**

You can use BAS in two ways; The migration form, or in the full-function form. You can use either or both of these forms, depending on the situation and degree of precision you require.

- Migration form, in which resource groups are associated with resource descriptions. In this form, resource descriptions are similar to group lists. See Figure 51 on page 282 and “Using migration form BAS” on page 289.
- Full-function form, in which resource assignments are used to qualify the contents of resource groups and resource descriptions, and to control the assignment of resources to CICS systems. See Figure 52 on page 283 and “Using full-function form BAS” on page 289.

The simplest form is the migration form using resource descriptions. You create resource definitions and resource groups, and associate them with one or more resource descriptions. It is the resource description that defines the logical scope for the resources. The resources are assigned to specific CICS systems and you therefore still need separate definitions for a resource that is local to one system and remote to another. This approach to BAS is similar to using RDO, in that the resource description is analogous to the group list. You in effect create a version of your CSD on the CICSPlex SM data repository. Though this is a good position from which to establish your CICSPlex SM resources environment, you cannot take advantage of all the facilities offered by BAS.

To take advantage of the facilities offered by BAS to manage your resources in terms of the business application rather than location, you need to use resource assignments. A resource assignment selects resources of a particular type from a group, and assigns them to the appropriate CICS system. A resource assignment is associated with a resource description. The resource description then no longer functions like a group list, but becomes a user-defined, logical set of resources, such as an application.

Using resource assignments allows you to manage your individual resources and change their attributes for individual systems, or to suit special circumstances. You can:

- Control resources of a given type in a given group.
- Identify resources as either local or remote, and assign them to various CICS systems with a single resource definition.
- Process selected resources from a group by specifying a filter expression.
- Modify resource attributes for a particular use by specifying override expressions.
Figure 51. Migration form BAS
Advantages of using BAS
The BAS approach to the management of resources offers several advantages over RDO.

The advantages are as follows:

- A familiar, RDO-like definition process with a choice of interfaces (WUI, batch or API).
- Logical scoping, that allows you to handle your resources in terms of business application rather than location.
- A common definition repository for all resources in a CICSpex, across all supported CICS platforms.
- A reduction in the number of definitions required, with the ability to reuse definitions and override individual attributes as needed.
- Consistent resource definitions and a great deal of control over the definition process.
- A resource can be added to additional regions by adding it to the groups that define where the application will run.
- Because the application is known to CICSPlex SM, commands can be directed to a scope that matches the application, not to an arbitrary group of regions.

Managing BAS
Your BAS environment is set up and managed using these WUI view sets and resource administration objects.
### Table 18. WUI view sets and resource administration objects

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource assignment definitions</td>
<td>RASGNDEF</td>
<td>A resource assignment describes the characteristics of the selected resource definition type, and how those resources are to be assigned to CICS systems. The assigned resources must all be of one type, for example, files, and must belong to a resource group. A resource can be assigned as both local and remote in one or more CICS systems. Before you can use the resource assignment, you must associate with a resource description; see the <strong>Resource description definitions</strong> (RESDESC) view. This object is also used to identify the attributes to be used in selecting the resources to be assigned and any attribute values to be changed when the resources are assigned.</td>
</tr>
<tr>
<td>Resource assignments in resource description</td>
<td>RASINDSC</td>
<td>This view displays information about resource descriptions, and the resource assignments associated with them. This information includes, for each resource, its resource group and any assigned CICS system to CICS system group.</td>
</tr>
<tr>
<td>Resource selected by resource assignments</td>
<td>RASPROC</td>
<td>This view displays the resources that will be processed when the specified resource assignment is processed. The resources displayed are selected from those in the associated resource group, using any supplied selection criteria.</td>
</tr>
<tr>
<td>Resource selected by resource description</td>
<td>RDSCPROC</td>
<td>This view displays the resources that will be selected when a specified resource description is processed. The resources can be selected from resource groups that are directly related to the resource description, as in migration form BAS, and from resource assignments, using any selection criteria currently in effect.</td>
</tr>
<tr>
<td>Resource description definitions</td>
<td>RESDESC</td>
<td>A resource description identifies a set of resource groups, and hence resource definitions. You use this object to specify whether or not you want to use logical scoping for this resource description, and the CICS systems for the associated resource groups.</td>
</tr>
<tr>
<td>Resource group definitions</td>
<td>RESGROUP</td>
<td>This object is used to associate one or more related resource definitions. The resource definitions may be of the same or different types.</td>
</tr>
<tr>
<td>Resource groups in descriptions</td>
<td>RESINDSC</td>
<td>This view displays information about existing resource descriptions and the resource groups associated with them.</td>
</tr>
<tr>
<td>Resource definitions in resource groups</td>
<td>RESINGRP</td>
<td>This view displays information about existing resource groups and the resource definitions associated with them.</td>
</tr>
<tr>
<td>CICS system link definitions</td>
<td>SYSLINK</td>
<td>This view displays information about the links that exist between CICS systems in the CICSPlex. The information includes the names of the CICS systems and the names of the connection and session definitions used in defining the link.</td>
</tr>
<tr>
<td>CICS system resources</td>
<td>SYSRES</td>
<td>This view displays the resources that will be assigned to a specified CICS system. The resources are selected on the basis of the resource descriptions currently associated with the CICS system.</td>
</tr>
</tbody>
</table>
Table 18. WUI view sets and resource administration objects (continued)

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource definitions</td>
<td>resDEF</td>
<td>For each resource definition type, there is a resource definition object that defines the attributes for that definition. The available resource types (shown in parentheses) and the WUI views used to define them for CICSPlex SM are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Atomservice definitions view (ATOMDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• BUNDLE definitions view (BUNDDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CICS-deployed jar file definitions view (EJDJDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DB2 connection definitions view (DB2CDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DB2 entry definitions view (DB2EDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• DB2 transaction definitions view (DB2TDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Deployed enterprise java archive definitions view (EJCODEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Document template definitions view (DOCDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• FEPI node list definitions view (FENODDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• FEPI pool definitions view (FEPOODEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• FEPI property definitions view (FEPRODEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• FEPI target list definitions view (FETRGDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• File definitions view (FILEDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• File segment view (FSEGDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Global enqueues view (ENQMDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IPIC connection definitions (IPCONDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ISC/MRO connection definitions view (CONNDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Journal definitions view (JRNLEDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Journal model definitions view (JRNMDDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• LIBRARY definitions view (LIBDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• LSR pool definitions view (LSRDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Map set definitions view (MAPDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Partner definitions view (PARTDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pipeline definitions view (PIPELINE object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Process type definitions view (PROCDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Profile definitions view (PROFDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Program definitions view (PROGDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Partition set definitions view (PRTNDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Request model definitions view (RQMDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Session definitions view (SESSDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• TCPIP service definitions view (TCPDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Transient data queue definitions view (TDQDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Terminal definitions view (TERMDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Transaction definitions view (TRANDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Transaction class definitions view (TRNCLDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Temporary storage model definitions view (TSMDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tuneterm definitions view (TYPTMDEF object)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• IBM MQ connection definition view (MQCONDEF object)</td>
</tr>
</tbody>
</table>
The object models showing the relationships between these objects are shown in Figure 53 on page 286 and Figure 54 on page 287. The view titles are followed by the resource name in parentheses.

Figure 53. The migration form BAS object model
Migrating your resource definitions

You do not have to re-create your resource definitions and resource groups in BAS. You can migrate your existing CSD structures.

About this task

To move your resource definitions and resource groups from your CSDs to the data repository, use the following process. This process maintains the relationship between resources and groups. You can migrate all or part of a CSD, or more than one CSD, at any one time.

Procedure

1. Use the EXTRACT command of the DFHCSDUP utility routine to read the CSD records.
2. Use the CICSPlex SM extract routine EYU9BCSD to create batched repository-update facility commands.

3. Input these commands to The batched repository-update facility to create resource definitions and resource groups, and the objects that link them.

**Defining resources**

You can use BAS to define and maintain resource definitions across a CICSPlex. By creating resource definition objects in the data repository, you can use these objects as templates for creating large numbers of resource definitions.

The definition of resources for CICSPlex SM is similar to CICS RDO. To define a resource, you create a resource definition object. You describe the attributes of the resource in the definition but you do not have to define every occurrence of every resource; you can use a small number of resource definitions as templates for the creation of large numbers of resources. The resource definitions are stored in the data repository for the CICSPlex.

The differences between CICSPlex SM resource definition objects and CICS resource definitions are:

- The same resource definition can be used by any CICS region in the CICSPlex, across all supported platforms.
- You can define to CICSPlex SM all the attributes of each resource, including both local and remote values. CICSPlex SM determines the correct subset of attributes to use when the resource definition is assigned to a CICS region.
- You do not have to define every instance of your resources from scratch. You can create a resource definition as a “template” for many resources with similar, even identical, attribute values. You can specify temporary or permanent variations, called overrides, for CICSPlex SM to create resources with different sets of values.
- You can create multiple versions of the same named resource definition. Each version is effectively a different resource definition, and can be used by different CICS systems or for different system requirements. For example, you might have different resource requirements for development and test systems. See “Validating resources” on page 288.

You can create resource definition objects in three ways:

- Use the administration views in CICS Explorer or the BAS administration and definition views in the Web User Interface.
- Use the batched repository-update facility; see The batched repository-update facility.
- Use the CICSPlex SM API; see Developing CICSPlex SM applications.

**Validating resources**

BAS performs many of the same resource definitions checks as RDO does.

As individual resources are defined and installed, BAS checks:

- Individual attributes of a resource
- Interdependent resources attributes
- Release-specific resource attributes

In addition, BAS checks that each set of resources is consistent. Every time you make a change to a resource set, BAS checks that the resource being added or updated is not in conflict with a resource already in the CICS system. For example, you would get an inconsistent set error if you tried to assign different versions of the same resource to the same CICS system, or assign a resource as both local and remote.

BAS also provides a MAP function that allows you to check that your resource associations are what you want. You use this facility to display the structure of your resource associations, starting at any point in hierarchy.
Defining resource groups

A resource group is a set of related resource definitions that you want to manage as a unit. Resources groups are defined using the Resource group view (RESGROUP object). The resource definitions in a group may be of the same type or of different types, but usually have something in common. They might be logically related by their use in a given application or communications network, or geographically related by their use at a given site.

There is no real limit to the number or combination of resource definitions that can make up a group. However, only one version of any given resource can be included in a resource group at one time. You have to maintain each version of a resource definition in a different resource group.

Using migration form BAS

With migration form BAS, your resource groups are associated directly with resource descriptions.

A resource description specifies whether or not you are using logical scoping, and the CICS systems for the resource groups associated with the resource description. See Figure 53 on page 286.

When you have migrated or defined your resources and resource groups, you need to create resource descriptions to define your applications. Resource descriptions are defined using the RESDESC object. A resource description is directly related to one or more resource groups that are to be managed as an entity. In the migration form BAS model, this relationship can be considered to represent a logical scope, but the resource description is really analogous to a RDO group list, in that all the resources are tied to a given CICS system or CICS system group.

Using full-function form BAS

With full-function form BAS, resource groups are not associated directly with resource descriptions.

An additional object, the resource assignment (RASGNDEF), defines the characteristics and usage of a selected resource type from a resource group. The resource assignment is associated with a resource description, which can then be used to represent a business application. See Figure 54 on page 287.

These objects are used to define your resources in terms of their business application.

Using resource assignments

Power and flexibility in the management of resources is offered by the resource assignment (RASGNDEF) object.

Note: If you are using the migration form of BAS, you do not use resource assignments.

Each resource assignment relates to one resource type within a resource group, and it must be associated with a resource description, if it is to be used in logical scoping or automatically installed. Each resource group can be in more than one resource assignment.

You can further refine the selection of resources within the type specified by the resource assignment by using a filter expression, and you can change the resource attributes using an override expression. You can combine in the expression an unlimited number of attribute values, using the logical operators AND, OR, and NOT. When the resource description is specified as the scope, CICSPlex SM processes only those resources that meet the specified selection criteria. This gives you a great deal of control over the management of your resources.

Each resource assignment must be added to a resource description, if it is to be installed and used in logical scoping. Creating resource assignments and adding them to a resource description enables you to manage sets of resources with a logical scope that can span many CICS systems. In this case, the resource description becomes, in effect, a user-defined, logical set of resources, such as an application. You might have several different resource descriptions associated with a given CICS system, each one representing a different set of resources.

For example, with a resource assignment, you can:

• Select specific resources from a resource group.
• Identify the CICS systems where local and remote instances of a resource should be assigned.
• Temporarily override the values of specific resource attributes.

The resources selected by a resource assignment cannot be managed independently. The resources must be members of a resource group and the resource assignment must be associated with at least one resource description.

Using resource descriptions
With full-function BAS, a resource description represents an application, that is, a set of logically-related resources that can span more that one CICS system. The resource description thus identifies the logical scope of the application.

Each resource group to be used as part of the application must be added to the resource description. You can associate whole resource groups with a resource description to create a larger set of resources (much like a CSD group list). This allows you to manage the resources more efficiently. The set of resources identified in a resource description can be:

• Identified as a logical scope (such as an application) for use in subsequent CICSPlex SM requests
• Installed either automatically, when the CICS system identifies itself to CICSPlex SM as a MAS, or dynamically, while the CICS system is up and running.

The BAS objects that are used for creating and managing these resource associations shown in Figure 53 on page 286 and their functions are summarized in Table 18 on page 284.

Installing applications and resources
Optionally, as an alternative to installing resources from the CSD, you can use BAS to install your resources, from the data repository.

BAS allows you to install all the resources associated with an application, by installing the resource description, or one resource group. BAS applies any resource assignments you have associated with the application resource description or resource group, and selects the actual resources to be installed on the basis of those criteria. Alternatively, you can install an individual resource into one or more CICS systems, either locally or remotely, as appropriate.

BAS can install resources either automatically at system initialization time or dynamically into an active CICS system. Before installing a resource, CICSPlex SM performs checks to determine whether the resource already exists in the CICS system. The normal situation is that if the resource exists, the new resource is considered a duplicate and is not installed. However, when you dynamically install resources, BAS offers the option of bypassing the duplicate resource checking and forcing the unconditional installation of resources.

Automatic installation
When a CICS system initializes and identifies itself to a CMAS, BAS reviews the resources associated with that system and decides the set of resources to be installed.

Dynamic installation
You can install resources dynamically into an active CICS system by clicking the install button either from the appropriate resource definition view, or from one of the following views:

• Resource group definitions view.
• Resource description definitions view.
• System link definitions view.

Security considerations
Because of the importance of resource definitions to your CICSPlex SM environment, you need to consider carefully the implications of allowing users access to certain types of resource or to certain functions.

You can allow a user to have access to all resource definition views and their related administration views, or you can restrict access to the definition views for a particular resource type. You can also define the type of access a user has, for example, one user might have read-only access to ISC/MRO connection definitions views (CONNDEF object) and Session definitions views (SESSDEF object), but update access
(which permits creation and administration of resources) to all other resource types. You need to make sure that the BAS views are adequately protected, so that unauthorized users cannot create and administer resources.

You should also take care if you are running CICS TS, and are using the EXEC CICS CREATE command to build new resources. Any definition created with the CICSPlex as the context is automatically distributed to all CMASs in the CICSPlex. Therefore, giving a user authority to create BAS objects is potentially equivalent to giving authority to install resources on any CICS system in the CICSPlex. When the CICS system starts, there is no check on who installed the resource in the system.

For details on setting up security for CICSPlex SM at your enterprise, see BAS security considerations.

**Planning for BAS**

BAS allows you to create CICSPlex SM objects that define your resources and to group them in such a way that you have close control over the running of your applications.

You do not have to transfer all your CSD resources to CICSPlex SM at the same time, neither do you have to decide at the outset which approach you will use. You can extract the resource definition records from one or more CSDs, or only a subset of records from one CSD. You can move directly to using full-function BAS, or you can use migration form BAS, and gradually move towards full-function BAS. You can use RDO, migration form BAS, and full-function BAS in the same CICSPlex.

This section poses some of the questions you might like to consider when you start planning to implement BAS in your enterprise:

- If you are going to use the extract facilities:
  - In what order do you want to extract your CSDs?
  - Do you want all the records from a CSD or a subset?
  - Are you going to extract more than one CSD at a time?
- Are you going to use the migration form approach?
- Are you going to implement full-function BAS? You then need to think about how your business applications use resources and the assignments you need to create.
- Which resources are to be installed automatically and which are to be installed dynamically?
- Which definitions are required before PLT processing? Definitions required before PLT phase 2 processing must be in the CSD.
- Where are the resources to be installed?
- Do you need to define manually any resources that are not defined in the CSD?
- What security measures do you need to implement? (See “Security considerations” on page 290).

The CICS Interdependency Analyzer can assist you in the planning and understanding of your application resource flow; it shows you:

- Transaction resource dependencies; that is, the sets of resources used by individual CICS transactions, and on which the transactions depend in order to run successfully
- Transaction affinities; that is, those groups of transactions that have affinities with each other, meaning that the whole group must be installed in the same region, or in a particular region

For more information about CICS Interdependency Analyzer, see **CICS Interdependency Analyzer for z/OS Overview**.
Implementing BAS
This section describes a route you could take to implement BAS on your CICSpix.

Creating migration for BAS
The first stage in the process of moving to using BAS is to migrate your resources from CICS to CICSPlex SM:

• Move your resource definitions, resource groups, and the relationships between them, from the CSD to the CICSPlex SM data repository. This process, which is described in “Migrating your resource definitions” on page 287, gives you an intermediary resource hierarchy that is very like CEDA, in that each resource definition is in a resource group.

• Create definitions and groups for any resources that are not held on the CSD.

• Create applications by associating each resource group with a resource description.

There are no resource assignments and, although you can now run your CICSPlex SM system perfectly satisfactorily, you will not be taking advantage of the special functionality offered by BAS.

Once you have extracted your CEDA definitions, you can proceed to migrate your resource definitions to full BAS function, as described in “Migrating to the use of resource assignments” on page 292.

Migrating to the use of resource assignments
You don’t have to migrate all your resources to resource assignments at the same time.

You can identify certain resources in which you are interested, remove them from direct association with resource definitions, and create resource assignments, using the Resource assignment definitions view (RASGNDEF object) for them. When you are happy with the resource assignments, you can move on to defining another set of resource definitions.

As you move towards processing your resource definitions more full-functionally, you should remove resource groups from direct association with a resource description and identify them instead in one or more resource assignments.

Note: You can use the same resource description to manage both whole resource groups and selected resources identified in resource assignments. As you begin to take advantage of the resource assignment capabilities, you may have to update some of the underlying resource definitions. For example, a resource definition that was previously associated as is with a CICS system might require additional attributes before it can be assigned as both a local and remote resource in different CICS systems.

A recommended approach
When you decide to implement BAS functions in your enterprise, you should begin by defining the appropriate objects.

This section summarizes the preceding sections. You should:

• Extract resource definitions and resource groups from the CSD, as described in “Migrating your resource definitions” on page 287. Alternatively:
  – Use the appropriate resource definition views to create resource definitions.
  – Use the Resource group definitions view to create resource groups (RESGROUP objects).
• Use the Resource assignment definitions view to create resource assignments (RASGNDEF object).
• Use the Resource description definitions view to create a resource description to associate the definitions and assignments just created (RESDESC object).

Then, to create associations between these objects:

• Use the appropriate resource definition view to add resource definitions to a resource group (RESINGRP object).
• Use the Resource group definitions (RESGROUP) view to add the resource group to a resource description (RESINDESC object).
• Use the Resource assignment definitions view (RASGNDEF object) to associate the resource assignment with a resource description (RASINDSC object).
• Use the **Resource assignment definitions** view (RASGNDEF object) to associate the resource assignment with a CICS system or CICS system groups.

You can use the **Map** action button to display a visual map of the BAS definitions in your data repository. If you want to see a list of the objects and associations you have already defined, use the **Resource definitions in resource groups** view (RESINGRP object).

**Where next?**

Once you have identified your BAS requirements, you need to set up your resources and their associations.

This is described in [Creating resources with BAS](#).
Chapter 4. Monitoring CICSPlex SM

There are several methods you can use to monitor CICSPlex SM.

Monitoring using real-time analysis (RTA)

Real-time analysis is the component of CICSPlex SM that you use to define and manage notification of exception conditions at your enterprise.

When you have identified your RTA requirements, define them to CICSPlex SM as described in Working with real-time analysis administration views.

What is real-time analysis?

CICSPlex SM real-time analysis (RTA) function provides automatic, external, notification of conditions in which you have expressed an interest.

Real-time analysis is not concerned solely with commonly recognized error conditions: you can ask to be notified about any aspect of a resource's status.

The RTA functions are:

- System Availability Monitoring (SAM): see “System Availability Monitoring (SAM)” on page 296
- RTA resource monitoring, which includes:
  - MAS resource monitoring (MRM): see “MAS resource monitoring (MRM)” on page 297
  - Analysis point monitoring (APM): see “Analysis point monitoring (APM)” on page 298

For example, if you tell CICSPlex SM that all files used by CICS systems AORPAY1 must be in ENABLED status, CICSPlex SM sends out warning messages when the status of any of those files is other than ENABLED. However, CICSPlex SM isn't restricted to telling you about a problem only after it has occurred. CICSPlex SM real strength lies in its ability to detect potential problems with CICS resources. Indeed, CICSPlex SM is unrivaled in its ability to detect and warn of the slightest change in the status of a CICS resource. For example, CICSPlex SM can tell you that resource contention is growing, or that the dynamic storage area (DSA) free space is falling, or that the number of users of a particular transaction is high: these can all be indicators of future problems that you could avoid by taking preventive action.

The notification can take the form of a console message, or of a generic alert to NetView, or both. The CICSPlex SM application programming interface (API) makes it possible for automation products actively to gather status information from CICSPlex SM, rather than waiting for CICSPlex SM to send out MVS messages and SNA generic alerts.

Why automate?

The CICSPlex SM operator can monitor RTA messages and take appropriate action.

For example, the CICSPlex SM operator can change the status of a file from DISABLED to ENABLED using the CICSPlex SM Local files view set (LOCFILE object). However, this approach is becoming less satisfactory as CICS availability and performance requirements grow. Most enterprises are using more and more CICS systems, often via cloning, to process a growing workload. This factor alone has made the CICSPlex SM operator's task more difficult and error prone. At the same time, however, service-level agreements are setting performance and availability targets that are more demanding than ever before. Consequently, the ideal environment is one in which the CICSPlex SM operator is presented with problems only in the most exceptional circumstances. Such an environment is now possible, because most actual and potential problems detected by CICSPlex SM can be corrected or prevented by intelligent use of automation products, such as:

- NetView
• Automated Operations Control/MVS (AOC/MVS)
• Automated Operations Control/MVS CICS Automation (AOC/MVS CICS Automation)
• CICSPlex SM itself. (Not only does CICSPlex SM provide detailed and timely information about CICS resource status to other automation products, it is also capable of correcting many of the problems it detects.)

The RTA external notifications
An RTA external notification is generated when the status of a CICS resource is not as expected. The notification can take the form of either an external message or an SNA generic alert, or both.

External messages
External messages are operator messages that are written to the MVS console by default. External messages can also be viewed from the CICSPlex SM RTA outstanding events view (EVENT object) while a condition is active.

When a condition has been resolved, it disappears from the RTA outstanding events view (EVENT object). (However, external messages written to the RTA outstanding events view (EVENT object) view are also written to the CICSPlex SM EYULOG to provide a record of the contents of the RTA outstanding events view (EVENT object).) In the RTA outstanding events view (EVENT object), external messages are sorted in order of urgency, with the message about the most urgent condition at the top of the list. The urgency of a condition is user-defined.

External messages are issued in pairs: one message is issued at the start of a condition, and another is issued when the condition ends. The messages all have the prefix “EYUPN”. External messages can be intercepted by automation products, such as NetView, AOC/MVS, and AOC/MVS CICS Automation.

SNA generic alerts
CICSPlex SM can construct SNA generic alerts and transmit them, via the NetView program-to-program interface (PPI), to NetView for processing.

NetView can trap SNA generic alerts in its automation table, which can either take action itself to resolve the problem, or start some automation code from a command list (CLIST) or command processor.

Advantages of RTA
There are a number of advantages of using RTA. These are as follows:
• Actions can be taken within CICS, removing the requirement to use external automation products.
• Potential problems are detected and corrected before they become critical.
• Performance to the end-user is improved by the early detection of bottlenecks that could affect response time.
• The volume of information presented to operators is reduced by filtering out unnecessary messages.

System Availability Monitoring (SAM)
CICSPlex SM has a system availability monitoring (SAM) function that monitors CICS systems during their planned hours of availability.

If any of a set of predefined conditions occurs while a CICS system is being monitored, CICSPlex SM sends out external notifications at the start of the condition and also when it is resolved. The conditions are:

SAMMAX
CICS has reached maximum tasks.

SAMOPS
The CICS system is not available.

SAMNRM
A CMAS has lost contact with an active MAS that it is managing.
The SAMNRM event is raised after the MAS fails to respond to a query from the CMAS for a period of 60 seconds. Unlike other SAM conditions, this event can be detected only when the CMAS interacts with the MAS. The condition is not detected if no CMAS to MAS interaction occurs.

**SAMSDM**
A CICS system dump is in progress.

**SAMSOS**
A CICS dynamic storage area (DSA) is short on storage.

**SAMSTL**
One or more tasks in a CICS system are stalled because of contention for resources such as DBCTL, DL/I, transient data, files, journals, and temporary storage.

**SAMTDM**
A CICS transaction dump is in progress.

For example, if CICS system AORPAY2 must be active from 0900 hours to 1200 hours and CICSPlex SM finds it inactive at 0930 hours, CICSPlex SM issues external messages by default. A typical response, from the CICSPlex SM operator or from an automation product, would be to try to restart the CICS system, or perhaps to start another.

**Customizing the SAM external notifications**
When any of the SAM conditions occurs, CICSPlex SM issues an external message by default.

Each of the SAM conditions has a default severity and priority value that determines the position of the external message, relative to other external messages, in the EVENT view. For example, the SAMTDM condition has a severity of HW (High Warning) and a priority of 128, whereas the SAMSOS condition has a severity of HS (High Severe) and a priority of 255 (the highest priority), so SAMSOS precedes SAMTDM in the RTA outstanding events view (EVENT object).

You can customize the default SAM notifications for any CICS system by creating a CICSPlex SM action definition. Using an action definition, you can change:

- The type of notification that is issued for a SAM condition. For example, you could specify that, for a particular CICS system, the SAMSOS condition will cause an SNA generic alert to be sent to NetView (so that NetView can take corrective action), and that no external message is to appear in the RTA outstanding events view (EVENT object).
- The severity value and the priority value of a SAM condition. For example, you could specify that the SAMTDM condition must have a severity of LW (Low Warning) in a particular CICS system, and that the SAMSOS condition must have a priority of 128.

You can also use the action definition to request that CICS TS systems affected by a condition are to be cancelled and restarted using the MVS automatic restart manager (ARM). This might be a suitable automation action for the SAMOPS condition, for example.

**Automation and SAM**
An automation product, such as AOC/MVS or NetView, can intercept SAM notifications and take corrective action, such as starting up or shutting down a CICS system, disabling a transaction, or requesting a dump.

For example, if a CICS system becomes unavailable, one of the automation products could attempt to restart the system, or perhaps start another.

However, most of the SAM notifications relate to actual problems that are already having an effect on users, so your scope for preventive action is small. Consequently, the best automation option for most SAM conditions is usually to request a dump, which can provide more information about a problem and its causes.

**MAS resource monitoring (MRM)**
Using CICSPlex SM MAS resource monitoring (MRM) function, you can monitor the status of any specific or generic CICS resource, and be informed when its status deviates from a specified norm.

(SAM, by contrast, is the monitoring and evaluation of a “default” resource, the CICS system itself. Although you can tailor the type of notification you receive from SAM, the condition that triggers the
notification is defined by CICSPlex SM.) Using MRM, you can select both the resource status you are interested in and the type of external notification it generates. Here are some examples of the ways in which MRM can be used:

• You can use MRM to inform you of changes in the absolute status of a resource. For example, if the status of an LU6.2 connection is ever RELEASED at a time when you have specified it must be ACQUIRED, external notifications can be issued so that the CICSPlex SM operator or an automation product can attempt to reacquire the connection. MRM can warn you of changes in the absolute status of many resources. For example, you can ask to be informed when a journal is CLOSED, when a transient data queue is DISABLED, when a FEPI node or a terminal is OUTSERVICE, when a transaction is DISABLED, and so on.

• In addition to monitoring absolute status values of CICS resources, CICSPlex SM can provide information about subtle changes in a resource status, such as degradations in the response time of a transaction, or increases in the number of users of a program, or changes in the number of Db2 threads in a CICS system. These are all examples of trends in resource behavior that might be indicators of incipient problems.

• Using MRM, you can specify complex conditions. For example, you can ask for an external notification to be issued when the number of users of a particular transaction reaches a specified level and the dynamic storage area (DSA) free size is falling. Only when both conditions are true is the notification issued. Conditions can be of any complexity.

• MRM even supports the monitoring of non-CICS resources, such as Db2, and of other members of the CICS family, such as CICS/400, by invoking user-written programs called status probes.

As its name suggests, MAS resource monitoring operates at the CICS system level. That is, if a resource’s status changes in two regions, two sets of external notifications are issued, one for each region.

Automation and MRM
MRM offers great scope for automation of CICS resource management, because it can alert you to both actual and potential problems.

In alerting you to actual problems, MRM provides you with an opportunity to take remedial action; in alerting you to potential problems, MRM provides you with an opportunity to take preventive action. Furthermore, an automated response is possible to all MRM-detected problems.

When changes in the absolute status of a resource occur (for example, when a file that should be ENABLED becomes DISABLED, or when a connection that should be INSERVICE goes OUTSERVICE), remedial action is usually required. CICSPlex SM itself can correct the status of such resources automatically, as can any of the automation products, such as NetView or AOC/MVS CICS Automation.

When more subtle changes in a resource’s status occur, an automation product such as NetView can tailor its response to the severity of the problem. For example, CICSPlex SM could monitor the DSA free size in a CICS system every five seconds. If CICSPlex SM finds the DSA free size to be:

- Between 86KB and 100KB 4 times in succession, it issues an SNA generic alert to NetView with a severity of LW (low warning)
- Between 71KB and 85KB three times in succession, it issues an SNA generic alert to NetView with a severity of LS (low severe)
- 70KB or less twice in succession, it issues an SNA generic alert with a severity of VLS (very low severe).

In response to any of these alerts, the NetView automation table could issue an MVS modify command to the affected region to increase the DSA size dynamically, thereby preventing a short-on-storage condition (the SAMSOS condition, in fact) from occurring. The amount by which the DSA is increased in each case could vary according to the severity attached to the SNA generic alert by CICSPlex SM.

Analysis point monitoring (APM)
CICSPlex SM has an analysis point monitoring (APM) function which is the same as its MRM function, except that when resources are monitored in multiple CICS systems (a CICS system group or an entire
CICSplex), the occurrence of the same problem in any number of those CICS systems can result in one external notification rather than several.

APM is especially useful in environments that use cloned AORs, where regions are identical and one notification is sufficient to alert you to a general problem. APM does not support the use of status probes for monitoring non-CICS resources. In all other respects, however, APM offers the same opportunities as MRM for early detection of potential problems, and for an automated response in such situations.

Managing RTA

RTA is set up and managed using the WUI view sets and resource objects.

This is described in Table 19 on page 299.

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installed analysis definitions associated with an analysis point specification</td>
<td>APACTV</td>
<td>This object shows information about RTA definitions associated with an RTA point specification.</td>
</tr>
<tr>
<td>Action definitions</td>
<td>ACTION</td>
<td>An action definition designates the type of external notification that is to occur when the condition or conditions identified in an RTA definition are true.</td>
</tr>
<tr>
<td>RTA analysis point specifications</td>
<td>APSPEC</td>
<td>This object shows information about RTA point specifications. An RTA analysis point specification identifies one or more CMASs that are to be responsible for analyzing CICS systems within the CICSplex identified as the context.</td>
</tr>
<tr>
<td>RTA specifications in primary CMASs</td>
<td>CMDMPAPS</td>
<td>This object shows the association between RTA specifications and a primary CMAS.</td>
</tr>
<tr>
<td>RTA specifications in secondary CMASs</td>
<td>CMDMSAPS</td>
<td>This object shows the association between RTA specifications and secondary CMASs.</td>
</tr>
<tr>
<td>Evaluation definitions</td>
<td>EVALDEF</td>
<td>This object shows information about evaluation definitions. An evaluation definition identifies the resources in one or more CICS systems that are to be sampled and evaluated. When the result of the evaluation is true, an associated RTA definition is used to determine if a notifiable condition has occurred.</td>
</tr>
<tr>
<td>Real Time Analysis (RTA) outstanding events</td>
<td>EVENT</td>
<td>This object shows information about outstanding changes in the status of a CICSplex or one of its CICS systems.</td>
</tr>
<tr>
<td>Specifications to system group links</td>
<td>LNKSRS CG</td>
<td>This object shows CICS system groups associated with analysis specifications.</td>
</tr>
<tr>
<td>RTA specifications to CICS system links</td>
<td>LNKSRS CS</td>
<td>This object shows CICS systems associated with analysis specifications.</td>
</tr>
<tr>
<td>Real Time Analysis (RTA) installed analysis and status definitions</td>
<td>RTAACTV</td>
<td>This object shows information about RTA and status definitions installed in CICS systems known to the CICSplex identified as the current context.</td>
</tr>
<tr>
<td>WUI view set</td>
<td>Object name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RTA definitions</td>
<td>RTADEF</td>
<td>An RTA definition identifies the evaluations to be performed on a periodic basis and the actions to be taken should a notifiable condition occur.</td>
</tr>
<tr>
<td>RTA groups</td>
<td>RTAGROUP</td>
<td>An RTA group is used to associate one or more related RTA definitions, status definitions, or both.</td>
</tr>
<tr>
<td>RTA group in analysis point</td>
<td>RTAINAPS</td>
<td>This object displays the names of RTA groups associated with RTA point specifications.</td>
</tr>
<tr>
<td>RTA groups in RTA specifications</td>
<td>RTAINSPC</td>
<td>This object shows the names of RTA specifications and the RTA groups associated with them.</td>
</tr>
<tr>
<td>RTA specifications</td>
<td>RTASPEC</td>
<td>An RTA specification identifies the default control attributes that are used for system availability monitoring and provides an anchor for all RTA definitions and status definitions associated with a CICS system.</td>
</tr>
<tr>
<td>Status definitions in RTA groups</td>
<td>STAINGRP</td>
<td>This object shows status definitions in RTA groups.</td>
</tr>
<tr>
<td>Status probe definitions</td>
<td>STATDEF</td>
<td>A status probe definition identifies a user-program that is to be called by CICSPlex SM at specific intervals.</td>
</tr>
</tbody>
</table>

The RTA object model is shown in Figure 55 on page 301. This figure shows the titles of the WUI views with the names of the resources in parentheses.
Figure 55. The real-time analysis object model
Planning for RTA

When you are planning to implement RTA, you might consider the following points:

- You will probably want to use SAM, because not only is it very easy to implement (see “Implementing system availability monitoring (SAM)” on page 302) but you will need to be aware when any of your CICS systems are not active when they should be. You need to:
  - Decide whether you want to customize any of the default conditions
  - Identify the primary CMAS for each CICS system

- To use MRM and APM, you need to identify:
  - The resources you are interested in
  - The point at which their status becomes of interest to you
  - How you want to be notified of an interesting status
  - The interval at which you require resource evaluations
  - The interval at which you require data analysis
  - The primary CMAS

Note: For APM only, you may also specify one or more secondary CMASs.

Implementing RTA

Real-time analysis should be implemented gradually and in response to an established need for the resultant information, especially if you are not planning to automate your responses to exception conditions.

You are recommended to begin by implementing SAM, and to implement MRM after having analyzed records, such as problem logs, that give you some indication of where MRM would be useful.

Implementing system availability monitoring (SAM)

You are recommended to implement SAM as follows:

1. Use the Time period definitions view to create time-period definitions (PERIODEF objects) for the expected availability times of each CICS system to be managed by CICSPlex SM. For example, if seven of your CICS systems should be active from 0800 hours through 1900 hours, create one time-period definition for that part of the day.

2. When you define each CICS system to CICSPlex SM, supply the name of the time-period definition that defines the system’s hours of availability.

These two actions are sufficient to activate SAM and to cause the default external notifications to be generated when a noteworthy condition occurs. As you can see, you can implement SAM as soon as CICSPlex SM is installed in your enterprise, and with very little additional effort. You are recommended to continue using SAM with the default notifications, at least until you have had an opportunity to see the default notifications of all SAM conditions. If you decide to customize any of the notifications, start by creating an action definition for one of the SAM conditions and apply it to a single CICS system to test the effects. When you are happy with the change, apply it to other SAM conditions and other CICS systems, as appropriate.

The overheads associated with SAM are not high, so you can activate it throughout the enterprise CICSpliceses without affecting the general performance of CICSPlex SM or the CICS systems it manages.

Implementing MAS resource monitoring (MRM)

You should start by implementing MRM on a system-by-system basis. Select a single resource type, such as connections or files, in a single CICS system, and create these CICSPlex SM objects:
• An evaluation definition, to identify the instances of the resource you are interested in, the frequency with which CICSPlex SM is to evaluate the resource status, how CICSPlex SM is to interpret its findings, and the severity to be assigned to a true condition

• An analysis definition, to identify the frequency with which CICSPlex SM is to analyze the results and the point at which an external notification should be issued

• An action definition, to identify the type of external notification to be issued

The interval between resource evaluations (as specified in the evaluation definition) and the intervals at which data is to be analyzed (as specified in the analysis definition) should be intelligently matched (and ideally the same). In particular, do not analyze the data more frequently than it is evaluated. Also, resource evaluations should be performed as infrequently as possible while still providing useful data: the more frequently data is collected, the greater the cost of its collection.

Begin by installing the analysis definition manually in the active CICS system. When you are satisfied that MAS resource monitoring is working as you expected, consider whether automatic installation of the analysis definition would be useful. If it would, add the analysis definition to an analysis group, and associate the analysis group with an analysis specification. At this point, decide whether to monitor additional resources in the same CICS system. To extend MAS resource monitoring to other resources, an additional evaluation definition would be required, an additional analysis definition might be required, but the original action definition could probably be reused.

Implementing analysis point monitoring (APM)
When you are happy with the MAS resource monitoring results, progress to analysis point monitoring (APM), which is applied to a logical grouping of CICS systems. You should consider which CICSpixels are affected by your analysis point monitoring requirements, and identify the CMASs involved in management of those CICSpixels.

As most of the CICSPlex SM definitions required for MAS resource monitoring can be reused for analysis point monitoring, the cost of staging the implementation in this way is not high. For example, a single action definition is likely to be usable by multiple analysis definitions. However, for analysis point monitoring you must create at least one analysis point specification. As in the case of MAS resource monitoring, you should start analysis point monitoring with simple definitions, and move gradually to using more complex definitions.

A recommended approach
When you decide to implement RTA functions in your enterprise, you should begin by defining the appropriate objects.

You should:
• Use the RTA definitions view to create an analysis definition (RTADEF object).
• Use the Evaluation definitions and Action definitions views to create the required subcomponents of an analysis definition (EVALDEF and ACTION objects).
• Use the RTA groups view to create an analysis group (RTAGROUP object).
• Use the RTA specifications view to create an analysis specification (RTASPEC object).

Then, to create associations between these objects:
• Use the RTA definitions view to add the analysis definition to the analysis group (RTAINGRP object).
• Use the RTA groups view to add the analysis group to the analysis specification (RTAINAPS object).
• Use the RTA specifications to CICS system links view (LNKSRS object) or the RTA specifications to CICS system groups links view (LNKSRSG object) to associate the analysis specification with a CICS system or CICS system group. For more information about the LNKSxSCG parameters, see Special attribute and resource table considerations: LNKSxSCG Records (LNKSMSCG, LNKSRSRCG, LNKSWSRCG).

You can use the Map action button to display a visual map of the real-time analysis definitions in your data repository. If you want to see a list of the objects and associations you have already defined, use the RTA definitions in RTA groups view (RTAINGRP object), the RTA groups in RTA specifications view.
Collecting statistics using CICSPlex SM monitoring

Monitoring is the component of CICSPlex SM that you use to define and manage the collection of performance-related data in your enterprise.

What is monitoring?

CICSPlex SM monitoring supports the collection of performance-related data, at user-defined intervals, for named resource instances within a set of CICS systems.

CICSPlex SM monitoring offers the following advantages:

- Summary and detailed information on resources is readily available, enabling you to provide an improved help-desk service.
- System availability and performance are improved by allowing operators to be more effective in investigating problems and seeking out bottlenecks.

At user-defined intervals, monitoring gathers status information and statistics for selected resources, wherever they exist in the CICSplex, and makes them available at any point of control. CICSPlex SM gathers information using standard CICS interfaces (EXEC CICS INQUIRE, EXEC CICS COLLECT STATISTICS) and can be used instead of the CICS Monitoring Facility (CMF). If CMF is running, CICSPlex SM exploits the information provided. Monitoring need not be specified for resources being overseen by real time analysis (see “Implementing RTA” on page 302), as these are monitored separately.

The CICSPlex SM monitoring functions are:

- Monitoring of resources: see “Monitoring of resources” on page 304
- Monitoring interval: see “The monitor interval” on page 304
- Sampling interval: see “The sample interval” on page 305

Monitoring of resources

CICSPlex SM has monitor functions that can periodically monitor the performance of CICS resources.

The data collected by this monitoring activity is either the type of data that is collected by the CICS command EXEC CICS COLLECT STATISTICS, or is derived from such data, that is, CICSPlex SM calculates rates, totals, averages, and percentages from the raw statistics data. For local MASs only, CICSPlex SM can also obtain some detailed monitoring data via the CICS monitoring facility (CMF).

The monitor interval

When you monitor the activity of a particular resource, you are usually interested in its performance over a specific period of time. Therefore, when you define a CICSplex to CICSPlex SM, you specify a monitor interval for the CICSplex.

Use the CICSpIx definitions view (CPLEXDEF object) to define a CICSplex. The monitor interval is a period of time, at the end of which counters holding derived monitoring data are reset to zero. For example, if you set the monitor interval to 60 minutes, counters are incremented for 60 minutes, then are reset to zero and the accumulation of monitoring data starts again. This sequence is repeated while monitoring is active. The interval is specified in minutes (15 through 1440), and defaults to 480 minutes (8 hours). Values derived by CICSPlex SM during the monitor interval are prefixed with the letters "MI" in relevant views.
**The sample interval**

For each type of resource you monitor (such as files or connections), you specify a *sample interval*. The sample interval governs the frequency with which CICSPlex SM collects performance-related data for selected instances of that resource type.

For example, you can specify a sample interval of 300 seconds for files used in a particular group of CICS systems. Values derived by CICSPlex SM during the latest sample interval are prefixed with the letters "CS" in relevant views. Thus, the CS values allow you to identify rapid rates of change, whereas the MI values are more useful in identifying longer-term trends.

**Managing monitoring functions**

The monitoring functions are set up and managed using the WUI view sets and resource objects. These are described in Table 20 on page 305.

<table>
<thead>
<tr>
<th>WUI view set</th>
<th>Object name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor definitions</td>
<td>MONDEF</td>
<td>A monitor definition qualifies a resource type identified in a monitor specification by indicating the occurrences of the resource that are to be included in or excluded from monitoring. A monitor definition also identifies which resources are to be reported to the resource status facility when it is activated.</td>
</tr>
<tr>
<td>Monitor groups</td>
<td>MONGROUP</td>
<td>A monitor group is used to associate one or more related monitor definitions.</td>
</tr>
<tr>
<td>Monitor definitions in groups</td>
<td>MONINGRP</td>
<td>This object displays the names of monitor groups, the monitor definitions associated with them, and the time period during which the monitor definitions are to be active.</td>
</tr>
<tr>
<td>Monitor groups in monitor specifications</td>
<td>MONINSPC</td>
<td>This object displays the names of monitor specifications and the monitor groups associated with them.</td>
</tr>
<tr>
<td>Monitor specifications to system group links</td>
<td>LNKSMSGCG</td>
<td>This object shows CICS system groups associated with monitor specifications.</td>
</tr>
<tr>
<td>Monitor specifications to CICS system links</td>
<td>LNKSMSCS</td>
<td>This object shows CICS systems associated with monitor specifications.</td>
</tr>
<tr>
<td>Active monitor specifications</td>
<td>POLMON</td>
<td>This object shows information about monitor definitions installed in CICS systems known to the CICSpex identified as the current context.</td>
</tr>
</tbody>
</table>

The monitoring object model is shown in Figure 56 on page 306. The titles of the WUI views are followed by the resource names in parentheses.
Planning CICSPlex SM monitoring

When you are planning what to monitor in your enterprise using CICSPlex SM, the following recommendations can help you make best use of the monitoring functions that are available.

Always have a use for the monitor data you request

Each resource class with a sample interval greater than zero has a CICS task in each MAS (that is, in each managed CICS system) for which monitoring is required. So, for example, if you activate monitoring of transactions in every CICS system in a CICSplex, each MAS is supporting a CICS task to monitor transactions at the specified interval. Also, CMAS processing is required to maintain the monitor-data cache. You can see that general and unrestricted monitoring would very quickly become...
an unacceptable overhead. Therefore, do not activate monitoring for any CICS system nor for any CICS resource class without being aware of why you want the data.

Identify resources as specifically as possible

CICSPlex SM monitoring is a specialized function that provides detailed usage and performance data. In general, it will be most useful to you for short-term trend analysis, in anticipating future problems, or dealing with actual problems. For example:

- Resources that are limited in quantity can be candidates for monitoring if their use levels are high, because the monitor data will help you to decide whether to increase quantities of the resource.
- Resources for which there is contention are also good candidates. Such data can help you to assess the impact of contention on throughput.

However, you should give some thought to understanding which resources are of greatest interest to you. For example, are you really interested in CICS-supplied resources? Often it is tempting to supply an asterisk (*) as the resource name, which effectively means any instance of the specified resource. If you are not interested in every occurrence, use generic name patterns; for example, you can ask for monitoring of all transactions beginning "PAY" by specifying the resource name "PAY*". Similarly, resources whose status is being reported to the resource status facility should be identified as fully as possible.

Specify as long a sample interval as you can

The shorter the sample interval you specify for a resource class, the greater the cost of gathering the monitoring data. For example, if you set the sample interval to one second for every resource, no other CICSPlex SM work is going to get done at all. Therefore, always specify the longest possible sample interval at which you can obtain useful data. To determine exactly what this interval should be, you must apply what you already know about any particular resource instance. In general, the sample interval should reflect the probable level of use of the resource: if you find that successive sampling of a resource is not showing significant changes, you should increase the sample interval. The sample interval should also have some relationship to the frequency with which the CICSPlex SM or NetView operator will be looking at the monitor data.

Specify as long a monitor interval as you can

The monitor interval determines the frequency with which counters holding accumulated monitor data are reset to zero. You should set it to a value that is significant in your enterprise, so that the information you get from it is also significant. For example, the interval could be a shift duration, or some other time during which a particular workload is being processed.

You are recommended not to make the interval too short, not only because CICSPlex SM overheads grow as the monitor interval reduces, but also because too short an interval is unlikely to provide you with useful statistics.

Do not define more monitor specifications than you really need

Avoid having too many monitor specifications, not only because of the extra work involved in creating them and associating them with CICS systems, but also because a CICS system can belong to only one monitor specification at a time. The more monitor specifications you define, the smaller the opportunity for establishing a general-purpose monitoring policy.

Specify a suitable retention period

You don't have to specify a retention period. However, the retention period defaults to zero minutes, and so as soon as monitoring stops for any CICS system, that system's monitor data is lost. If some unexpected event occurs, the data could be invaluable, so setting the retention period greater than zero is advisable. Note, however, that if a CICS system stops, monitor data is lost when you restart the system regardless of any retention period you may have specified. In this case, it's important to look at the monitor data before you restart the CICS system.

You can set the retention period to any value between 1 and 1440 minutes (24 hours). You can specify a retention period on the monitor specification, in which case that period applies to every CICS system associated with the monitor specification. Alternatively, you can specify a retention period in the CICSPlex SM CICS system definition.
Decide when to activate monitor definitions

When you add a monitor definition to a monitor group, you can specify the part of the day during which it is to be active. You should make considered use of this feature. For example, you probably will not want monitoring active overnight, or during any period when general use is low and no one is around to view the data, so ensure that monitor definitions are not in effect at those times. Also, if you're monitoring resources for which there is contention, think about when this contention occurs. Is it constant, or does it occur only between 0900 and 1100 hours? If the latter, limit your monitoring to that period.

Implementing CICSPlex SM monitoring

Possibly the best way to implement CICSPlex SM monitoring is to start with no monitoring at all, and to implement it piecemeal for particular CICS systems and CICS resource instances.

That is:

1. Create a monitor specification, and associate it with every CICS system in the CICSPlex. However, ensure that every sample interval remains at its default value of zero, and that monitor status remains set to “OFF”. This is because the one thing you must have in place before you can gather any monitoring data is a monitor specification. If you follow these instructions, monitoring will be enabled, but not activated.

2. When you decide to monitor a particular resource instance, as used by one of the CICS systems in the CICSPlex, you must:
   a. Update the CICS system definition to switch monitoring on, and to specify a sample interval for the resource. You make this change to an active CICS system, using the Topology Runtime MAS display view (MAS object), and it applies for the current execution of the CICS system only.
   b. Create a monitor definition to name the resource instance, and install it manually in the CICS system.

3. Repeat this piecemeal approach to monitoring until it becomes apparent that you have some regular requirements. At that point, consider installing the monitor definitions automatically (and for every execution of the CICS system) by adding the monitor definitions to a monitor group, and associating the monitor group with the monitor specification. You can make the sample interval and monitor status permanent by setting them either in the monitor specification—in which case, they apply to all CICS systems associated with the monitor specification and for which an appropriate monitor definition has been provided—or in the CICS system definition, in which case they affect no other CICS system.

You can refine your approach to monitoring gradually, by creating additional monitor specifications for the CICSPlex, for example, and by using timed monitor definitions, which are installed automatically for a specified duration. Remember that:

• Although you can make changes to a monitor specification while it is in use, the effect of those changes is not felt until the CICS system is next started. Note, however, that you can use the MAS view to change monitoring values for an active CICS system.

• A CICS system can be associated with only one monitor specification at a time.

• You can associate a monitor specification with a CICS system that is already running, but the effect of that new association is not felt until the CICS system is next started.

Aim to ensure that any monitor specifications and monitor definitions you provide support the normal situation, and that CICS system overrides are used for the exceptions.

Activating the resource status facility

To activate the resource status facility you must do the following:

• Update the CICSPlex SM definitions of those CICSPlexes whose resources are to be reported to the resource status facility.

• Update or create monitor definitions to set the resource status facility Status flag to YES and to identify resource instances.
• Update or create monitor specifications to set the sample interval for each resource type. Instructions for all of these tasks are provided in Administering CICSPlex SM and Resource monitoring. For more information about the resource status facility see the description of the RESSTATUS parameter in CICSPlex SM system parameters.

Using the CICS Monitoring Facility (CMF) with CICSPlex SM
Some classes of monitoring data for CICSPlex SM, in particular detailed task-related data that is displayed in some transaction monitoring views, cannot be collected unless CICS performance class data monitoring is active in the monitored CICS system.

You can activate performance class data monitoring for an active CICS region using the CICSPlex SM operations functions, the CICS monitoring facility transaction CEMN, or the SET MONITOR command. Alternatively, you can activate performance class data monitoring permanently using CICS system initialization parameters.

CICS monitoring data is usually written to an SMF data set. However, if you prefer, you can collect monitoring data for use by CICSPlex SM without having it written to an SMF data set, by specifying the CICSPlex SM system parameter SUPPRESSCMF. For more information about this parameter, see CICSPlex SM system parameters.

For more information about the different classes of monitoring data, and about controlling the CICS monitoring facility, see Introduction to CICS monitoring.

A recommended approach
When you decide to implement monitoring functions in your enterprise, begin by defining the appropriate objects.

1. Create the following objects:
   • Use the Monitor definitions view to create a monitor definition (MONDEF object).
   • Use the Monitor groups view to create a monitor group (MONGROUP object).
   • Use the Monitor specifications view to create a monitor specification (MONSPEC object).

2. Create associations between these objects:
   • Use the Monitor definitions view to add the monitor definition to the analysis group (MONINGRP object).
   • Use the Monitor groups view to add the monitor group to the analysis specification (MONINSPC object).
   • Use the Monitor specifications to CICS system links view (LNKSMSCS object) and the Monitor specifications to CICS system group links view (LNKSMSCG object) to associate the monitor specification with a CICS system or CICS system group. For more information about the LNKSxSCG parameters, see Special attribute and resource table considerations: LNKSxSCG Records (LNKSMSCG, LNKSRSCG, LNKSWSCG).

You can use the Map button to display a visual map of the monitor definitions in your data repository. If you want to see a list of the objects and associations you have already defined, use the Monitor definitions in groups view (MONINGRP object), the Monitor groups in monitor specifications view (MONINSPC object), the Monitor specifications to CICS system links view (LNKSMSCS object), and the Monitor specifications to CICS system group links view (LNKSMSCG object) view.

Where next?
Once you have identified your monitoring requirements, you should define them to CICSPlex SM. This is described in Resource monitoring.
Notices

This information was developed for products and services offered in the U.S.A. This material might be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property rights may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
United States of America

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in certain transactions, therefore this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who want to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119 Armonk,
NY 10504-1785
United States of America
Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Programming License Agreement, or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to actual people or business enterprises is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Programming interface information

CICS supplies some documentation that can be considered to be Programming Interfaces, and some documentation that cannot be considered to be a Programming Interface.

Programming Interfaces that allow the customer to write programs to obtain the services of CICS Transaction Server for z/OS, Version 5 Release 5 are included in the following sections of the online product documentation:

• Developing applications
• Developing system programs
• CICS security overview
• Developing for external interfaces
• Reference: application development
• Reference: system programming
• Reference: connectivity

Information that is NOT intended to be used as a Programming Interface of CICS Transaction Server for z/OS, Version 5 Release 5, but that might be misconstrued as Programming Interfaces, is included in the following sections of the online product documentation:

• Troubleshooting and support
• Reference: diagnostics

If you access the CICS documentation in manuals in PDF format, Programming Interfaces that allow the customer to write programs to obtain the services of CICS Transaction Server for z/OS, Version 5 Release 5 are included in the following manuals:

• Application Programming Guide and Application Programming Reference
• Business Transaction Services
• Customization Guide
• C++ OO Class Libraries
• Debugging Tools Interfaces Reference
• Distributed Transaction Programming Guide
• External Interfaces Guide
• Front End Programming Interface Guide
• IMS Database Control Guide
• Installation Guide
• Security Guide
• Supplied Transactions
• CICSPlex SM Managing Workloads
• CICSPlex SM Managing Resource Usage
• CICSPlex SM Application Programming Guide and Application Programming Reference
• Java Applications in CICS

If you access the CICS documentation in manuals in PDF format, information that is NOT intended to be
used as a Programming Interface of CICS Transaction Server for z/OS, Version 5 Release 5, but that
might be misconstrued as Programming Interfaces, is included in the following manuals:

• Data Areas
• Diagnosis Reference
• Problem Determination Guide
• CICSPlex SM Problem Determination Guide

Trademarks
IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon,
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or
its subsidiaries in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability
These terms and conditions are in addition to any terms of use for the IBM website.

Personal use
You may reproduce these publications for your personal, noncommercial use provided that all
proprietary notices are preserved. You may not distribute, display or make derivative work of these
publications, or any portion thereof, without the express consent of IBM.
Commercial use
You may reproduce, distribute and display these publications solely within your enterprise provided that all proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, distribute or display these publications or any portion thereof outside your enterprise, without the express consent of IBM.

Rights
Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either express or implied, to the publications or any information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the publications is detrimental to its interest or, as determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

IBM online privacy statement
IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally identifiable information. If this Software Offering uses cookies to collect personally identifiable information, specific information about this offering’s use of cookies is set forth below:

For the CICSPlex SM Web User Interface (main interface):
Depending upon the configurations deployed, this Software Offering may use session and persistent cookies that collect each user’s user name and other personally identifiable information for purposes of session management, authentication, enhanced user usability, or other usage tracking or functional purposes. These cookies cannot be disabled.

For the CICSPlex SM Web User Interface (data interface):
Depending upon the configurations deployed, this Software Offering may use session cookies that collect each user's user name and other personally identifiable information for purposes of session management, authentication, or other usage tracking or functional purposes. These cookies cannot be disabled.

For the CICSPlex SM Web User Interface ("hello world" page):
Depending upon the configurations deployed, this Software Offering may use session cookies that collect no personally identifiable information. These cookies cannot be disabled.

For CICS Explorer:
Depending upon the configurations deployed, this Software Offering may use session and persistent preferences that collect each user’s user name and password, for purposes of session management, authentication, and single sign-on configuration. These preferences cannot be disabled, although storing a user's password on disk in encrypted form can only be enabled by the user's explicit action to check a check box during sign-on.

If the configurations deployed for this Software Offering provide you, as customer, the ability to collect personally identifiable information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, see IBM Privacy Policy and IBM Online Privacy Statement, the section entitled Cookies, Web Beacons and Other Technologies and the IBM Software Products and Software-as-a-Service Privacy Statement.
Index

Special Characters
, introduction to 1
(CMASD object 38)

A
abend compensation
when accessing workload management directly 274
abend health
ABENDCRIT 252
abend load
ABENDTHRESH 252
abend probability 252
accessibility options 90
action buttons 2, 214
Action definitions view 299
action parameters 214
activating workload management 253
Active monitor specifications 305
adding a CICS system to a CICS system group 74
address space (CMAS)
add CICS system definitions 46
administering 38
CICS SIT parameters 117
CICS system initialization parameters 47, 52
configuration 38
create data repository 45
defining 38
definitions 37
links to other CMASs 27
maintenance point 31
NetView 8
performance considerations 26
restarting 62
START command for a CMAS 58
starting
as a batch job 43
from the system console 43
use of ESSS 8
where to install 26
ADMCONFG menu 39
administering the CMAS configuration 38
administering the topology of a CICSplex 38
affinity lifetimes 270
affinity, workload
description of 249
agent code, MAS 7
aggregation
group 12
alerts to IBM Tivoli NetView
preparing IBM Tivoli NetView to receive 43
analysis definition 300
analysis group 300
analysis point monitoring (APM)
attribution and 295
description of 299

analysis point monitoring (APM) (continued)
 implementing 303
analysis specification 300
AOC CICS Automation 296
APPC 270
application programming interface (API) 3
assigning a CMAS to a CICSplex definition 75
associating a CMAS with a CICSplex 75
associating CICS system with CICS system group 74
ATOMDEF object 131, 285
Atomservice definitions view
ATOMDEF 131
ATOMSERVICE definitions view 285
attribute filters 213
attributes 213
auto-import options 85
AUTOIMPORTDSN 85
AUTOIMPORTMEM 85
AUTOIMPORTTDO 85
automatic installation
of a monitor definition 308
of an analysis definition 303
of resources 290
AUTOREFRESH 87
AUTORESETTIME 78
auxiliary storage usage 42

B
backing up the data repository 51
bar gauge 212
batched repository-update facility
description of 4
EXTRACT routine 292
batched repository-update job view 38
BATCHREP object 38
BBACTDEF DD statement
with CMAS startup JCL 43
BUNDDEF object 285
BUNDLE definitions view 285
Business Application Services (BAS)
creating resource definitions 288
definition of 2
description of 279
EXTRACT routine 292
functions 279
objects 9
resource installation 279
resource versions 280

C
CHS 79
CHS1 79
CHS2 79
CICS business transaction services (BTS)
BTS-set 238
CICS business transaction services (BTS) (continued)
CICSplex considerations 238
dealing with affinities 238
release requirements 250, 257
CICS management client interface
  CICS region setup 114
  CMCIPORT WUI server initialization parameter 85
  DFH$WUTC sample 114
  DFH$WUUR sample URI map 114
  security set up 116
  set up 93, 114, 116
  storage requirements 111
CICS monitoring data 222, 225
CICS Monitoring Facility (CMF) 69, 304, 309
CICS SIT parameters 117
CICS storage in a CMAS 57
CICS system
  as part of CICS system group
    adding to 74
  CICS system definition 73
  CICS system definitions view 40
  CICS system group
    adding member to 74
    creating 74
    defining 40
    identifying 40
    using instead of CICSplexes 23
  CICS system initialization parameters
    CPSMCONN 78
    CWAKEY 78
    INITPARM
      EYU9VKEC 78
      EYU9VWAN 78
    MNPER 222, 225
    MNRES 222, 225
    WRKAREA 78
    z/OS MAS-related 67
CICS system objects 20
CICS system resources view 284
CICS-deployed jar file definitions view 285
CICS-deployed JAR file definitions view 136
CICSplex
  CMASs associated with
    adding 75
    definition 6
    definitions 39
    identifying 22
    when to have more than one 23
  CICSplex definitions
    assigning a CMAS to 75
    creating 73
  CICSplex definitions view 38, 39
  CICSplex SM
    initialization parameters 73
  CICSplex SM address space (CMAS)
    release level 8
  CICSPLEX system parameter 121
  CICSplex topology
    administering 38
    defining 38
  CICSPLEX) view object 38
  CICSplexes managed by CMAS view 38
  CMAS
    create data sets 56
CMAS (continued)
customize data sets 56
CMAS (address space)
  add CICS system definitions 46
  CICS SIT parameters 117
  CICS system initialization parameters 47, 52
  restarting 62
  START command for a CMAS 58
CMAS (address space)
  create data repository 45
  starting
    as a batch job 43
    from the system console 43
CMAS (CICSPlex SM address space)
  controlling CICS storage 57
  controlling tasks 55
CMAS configuration administration view 38
CMAS detail view 38
CMAS in CICSPlex definitions view 38
CMAS journaling 58
CMAS object 38
CMAS to CMAS link definitions view 38
CMAS to CMAS link detail view 38
CMAS to CMAS link view 38
CMAS to MAS link detail view 38
CMAS to MAS link view 38
CMAS-specific JCL requirements
  BBACTDEF 43
  CICS EXEC 43
  DFHRPL 43
  EYUCMASP 43
  EYUDREP 43
  EYULOG 43
  EYUPARM 43
  STEPLIB 43
CMASNAME parameter of EYU9XDUT 46
CMASPLEX object 38
CMASs known to local CMAS view 38
CMASs managing CICSPlex view 38
CMASSYSID system parameter 121
CMCI
  CMCIPORT WUI server initialization parameter 85
  DEFAULTWARNCNT 106
  set up 93
  setting record count warnings 106
  storage requirements 111
CMCIPORT 85
CMTCMDEF object 38
CMTCMLND) object 38
CMTCMLNK object 38
CMTPMLND object 38
CMTPMLNK object 38
code page
  CHS1 79
  CHS2 79
  ENU1 79
  JPN1 79
code page conversion table 79
COIRTASKPRI system parameter 122
COLG 91
color of screens 90
COLORINK 91
COLORINKBANNER 91
COLORINKLINK 91
data repository
backing up 51
creating 45
defining forward recovery log for 51
for each CMAS 45
identified in CMAS startup JCL 43
upgrading 45
data-repository initialization job 36
dateformat 86
dateseparator 86
daylight parameter of EYU9XDUT 47
DB2 connection definition view 285
DB2 connection definitions view 135
dB2 entry definitions views 285
DB2 transaction definitions view 138, 285
DB2CDEF object 135, 285
DB2EDEF object 136, 285
DB2TDEF object 138, 285
deCIMALSEPARATOR 86
default values, setting 202, 203
default view 209
defaulttCICSSPLEX 89
defaulttCICSRGN 89
defaulttCMSCTX 87
defaulttCONNE 89
defaulttCONTEXT 87
defaulttCSYSGRP 89
defaulttdb2SS 89
defaultteJCOBEAN 89
defaultteJDBEAN 89
defaultteVENET 89
defaulttLOCFILE 89
defaulttLOCTRAN 89
defaulttMAPBAS 88
defaulttMAPCOLL 88
defaulttMAPMON 88
defaulttMAPRTA 88
defaulttMAPWLM 88
defaulttMENU 88
defaulttNAVIGATE 88
defaulttPROGRAM 89
defaulttREMFILE 89
defaulttREMTRAN 89
defaulttSCE 88
defaulttTASK 89
defaulttwARNCONT 88
defining resources
connections 157
DB2 entries 136
DB2 transactions 138
document template 140
enqueue model 152
FEPI nodes 142
FEPI pools 143
FEPI property sets 145
FEPI targets 147
file key segments 151
files 149
IPIC connections 154
journal models 158
defining resources (continued)
LIBRARYs 162
LSR pools 164
map sets 165
partition sets 171
partners 172
pipelines 174
process types 176
profiles 178
programs 179
sessions 181
TCP/IP service 182
temporary storage model 191
terminal 186
transaction 187
transaction class 189
transient data queue 184
URIMAPs 194
web services 196
defining the CMAS configuration 37, 38
defining the topology of a CICSplex 38, 39
Deployed enterprise java archive definition view 285
derived MONITOR data 304
detail view
two-column 207
detailed views
creating 232
DFH$WUTC sample TCP/IP service 114
DFH$WUUR sample URI map 114
DFHCNV 79
DFHTML 82, 92
DFHISTAR
CMASNAME parameter 46
customizing CMAS postinstallation jobs 57
customizing MAS postinstallation jobs 65
customizing WUI postinstallation jobs 82
DSINFO 46
postinstallation members for a CMAS 56
postinstallation members for a MAS 64
postinstallation members for a WUI 81
DFHRPL (dynamic transaction routing exit)
in CMAS startup JCL 43
in MAS startup JCL 66
DFTUSER system initialization parameter
for z/OS MAS 68
distributed program link (DPL)
release requirements 257
DOCDEF object 140, 285
Document template definition view 140
document template definitions view 140, 285
DSRTPGM SIT parameter 253
DTRPGM SIT parameter 253
DTRPROG API 264
dynamic installation of resources 290
dynamic routing
customizing CICSPlex SM processing
CICSPlex SM data areas 271
installing user-replacement programs 271
modifying the DTR program 264
non-dynamic transactions 265
overview of CICSPlex SM processing 255
release requirements 257
sample programs 257
selecting an target region 266
dynamic routing (continued)
customizing CICSPlex SM processing (continued)
transaction routing actions 266, 268
requesting additional support
abend compensation considerations 274
EYURWTRA communication area 273
invoking CICSPlex SM workload management 272
overview 272
processing considerations 273
route error considerations 274
sample calling sequence 275
transaction affinity considerations 274

E
ECLOGMSG system parameter 126
ingedit view sets 217
EJCODEF object 285
EJDJDEF object 285
ENQMDEF object 152
ENQMODE object 285
Enqueue model definitions view 152
enterprise beans
workload routing 239
entity types
CICSPlex SM 33
target box 211
target field 211
ENU 79
ENU1 79
Environment Services System Services (ESSS) 8
Evaluation definitions view 299
expanding the data repository 51
external messages, RTA 296
external notifications, RTA 296
EXTRACT routine 292
EYU$CNV1 79
EYU9DXDUT 36
EYU9VKEC 78
EYU9VWAN 78
EYU9WRAM routing action module
copy books 257
creating a user-replacement 271
EYU9XDUT 46
EYU9XLOP dynamic routing program 253, 272
EYUCHS1 79
EYUCHS2 79
EYUCMS01
CICS system initialization parameters 48, 52
EYUCMS1A 87
EYUCOVE 91, 92
EYUCOVI 91, 92
EYUDREP data set
creating the data repository 46
in CMAS startup JCL 43
EYUNUM1 79
EYUHISTx DD statement 70
EYUHISTx DD statement 66
EYUJPN1 79
EYUJWRP 80
EYULOG 91, 92
EYULOG DD statement
CMAS startup JCL 43
EYUPARM DD statement
EYUPARM DD statement (continued)
in CMAS startup JCL 43
in MAS startup JCL 66
EYUPARM parameters
description of 120
summary of 117
topology requirements 73
EYURLX01 87
EYURWCODE copy book 257, 271
EYURWCOCM communication area 257, 271
EYURWSDV copy book 257, 271
EYURWSVE copy book 257, 271
EYURWTRA communication area 273
EYURWREP (Web User Interface server repository) 80, 92
EYUWUI 91, 92

F
favorites
creating 202
editing 198
favorites editor 198
FENODEF object 142, 285
FEPI node list definitions view 142, 285
FEPI pool definitions view 143, 285
FEPI property definitions view 285
FEPI property set definitions view 145
FEPI target definition 147
FEPI target list definitions view 147, 285
FEPOODEF object 143, 285
FEPRODEF object 145, 285
FETRGDEF object 147, 285
file definitions view 149
File definitions view 149, 285
File key segment definitions view 150
file segment definitions view 151
File segment definitions view 285
FILEDEF object 149, 285
filter confirmation screen 208
filtering data
in user favorites 199
forward recovery log for data repository 51
FSEGDEF object 150, 151, 285
functions of 1

G
generic alert, SNA
CMAS considerations 26
genric names
CICSPlex SM 33
global enqueue model definitions view 152
global enqueues view 285
globalization 77
globalization support 31
GLOBALPREFILTER 88
GMMTEXTMSG 87
goal algorithm
description 239
graphical presentation of data 211
graphql
api 12
group, CICS system 25, 40, 296
GRPLIST
z/OS MAS parameter 68

H
help
customizable view and menu help 82
history recording 70
HISTRECSMSG 70
hostname 79, 92
HTML help files 215
http 79, 92

I
IBM CICS Explorer 4
IBM Tivoli NetView
sending generic alerts to 43
import options 85
INACTIVETIMEOUT 89
inconsistent set 288
initialize CMAS 43
initialize data repository 46
initialize z/OS MAS 64, 66
INITPARM
EYU9VKEC 78
EYU9VWAN 78
installation of resources
automatic 290
dynamic 290
installation planning 35
Installed analysis definitions associated with an analysis
description 299
installing resources
IPIC connections 155
installing typeterms 193
installing URIMAPs 195
installing user-replacement program 271
installing web services 197
inter-transaction affinity
creating 269
deleting 269
description of 249
IPCONDEF object 154, 285
IPIC connection definitions view 154, 285
IPIC connections 280
ISC/MRO connection definitions view 156, 285

J
Journal definition view 285
Journal model definitions view 158, 285
journal records, CMAS 58
JPN 79
JPN1 79
JRLNDEF object 285
JRLNDEFCH system parameter 122
JRNLOPACT system parameter 122
JRNLRTEAV system parameter 122
JRNMDEF object 158, 285
K
key segment definition 150

L
language 78
Language identifiers
CHS 79
ENU 79
JPN 79
language support 31, 77
LIBDEF object 161
LIBRARY definitions view 161
LIBRARY definitions view 285
Link between CICS system and CICS system group view 40
links, communication
CMAS-to-CMAS 27
LNKSMSCG object 305
LNKSMSCS object 305
local MAS 7, 77
LSR pool definitions view 163, 285
LSRDEF object 163, 285
LU6.2 connection definition 156
LUTYPE6.2 270

M
maintenance point 73
maintenance point CMAS 31
managed application system (MAS) definition 7
local 73
remote 73
map function
adding a map button to a view 226
customized maps 226
security profile 227
map objects
customizing 226
map of CICS systems, producing 20
Map set definitions view 165, 285
MAPDEF object 165, 285
maps
creating and editing 226
customized map objects 211
editing map objects 226
MAS
create data sets 64
customize data sets 64
MAS (managed application system)
local 73
remote 73
MAS agent code 7
MAS resource monitoring (MRM)
automation and 298
description of 297
implementing 302
MAS-related parameters
CICS system initialization 67
MAS-specific JCL requirements
DFHRPL DD 66
EYUPARM DD 66

MAS-specific JCL requirements (continued)
STEPLIB DD 66
MASALTLCNT system parameter 122
MASALTLRPRI system parameter 123
MASALTLLTTIM system parameter 123
MASINIMTTIME system parameter 123
MASPLTWAIT system parameter 123
MASTASKPRF system parameter 124
MAX USERS 89
menu
ADMCONFIG 39
CMAS configuration administration menu 38
Topology administration 39
menus
customized 210
customizing 216
message log (EYULOG)
with CMAS JCL 43
MONDEF object 305
MONGROUP object 305
MONINGRP object 305
MONINSPC object 305
monitor definition 305
Monitor definitions in groups view 305
Monitor definitions view 305
monitor group 305
Monitor groups in monitor specifications view 305
Monitor groups view 305
monitor interval 304, 307
Monitor specifications to CICS system links 305
Monitor specifications to system group links 305
monitoring
CICS Monitoring Facility (CMF) 309
definition of 3
introduction to 304
monitor interval 304, 307
sample interval 305, 307
MQCONDEF object 167, 285
MRO connections
transient error message DFHIR3788 76
MRO/ISC connections 280
MSGCASE 87

N
NAME system parameter 125
naming convention
entities 33
Starter Set 33
navigation frame menu 211
NetView 8, 26
notifications, external, RTA 296

O
object
ACTDEF 299
APACTV 299
APSPEC 299
ATOMDEF 285
BATCHREP 38
BUNDEF 285
CICS SPLEX 38
object (continued)
CMAS 38
CMASD 38
CMASPLEX 38
CMDMPAPS 299
CMDMSAPS 299
CMTCMDEF 38
CMTCMLND 38
CMTCMLNK 38
CMTPMLND 38
CMTPMLNK 38
CONNDEF 285
CPLEXDEF 38, 39
CPLXCMAS 38
CSYSDEF 40
CSYSDEF object 40
CSYSGRP 40
CSYSGRP object 40
DB2CDEF 285
DB2EDEF 285
DB2TDEF 285
DOCDEF 285
EJCODEF 285
EJDJDEF 285
ENQMDEF 285
FENODDEF 285
FEPOODEF 285
FEPRODEF 285
FETRGDEF 285
FILEDEF 285
FSEGDEF 285
IPCONDEF 285
JRNLD 285
JRNMDEF 285
LIBDEF 285
LINKSMSCG 305
LINKSMICS 305
LINKSRSCG 299
LINKSRSCS 299
LSRDEF 285
MAPDEF 285
MAS 41
MONDEF 305
MONGROUP 305
MONINGRP 305
MONINSPC 305
MQCONDEF 285
PARTDEF 285
PERIODEF 36, 40, 302
PIPELINE 285
POLMON 305
PROCDEF 285
PROFDEF 285
PROGDEF 285
PRTNDEF 285
RASGDEF 284
RASINDSC 284
RASPROC 284
RDSCPROC 284
RESDESC 284
RESGROUP 284, 289
RESINDSC 284
RESINGRP 284

object (continued)
RQMDEF 285
RTAACTV 299
RTADEF 300
RTAGROUP 300
RTAINAPS 300
RTAINGRP 300
RTAINSPC 300
RTASPEC 300
SESSFDEF 285
STAINGRP 300
STATDEF 300
SYSLINK 40, 284
SYSRES 284
TCPDEF 285
TDQDEF 285
TERMDEF 285
TRANDEF 285
TRNLDEF 285
TSMDEF 285
TYPTMDEF 285

object model, recommended usage
business application services 292
monitoring 309
real-time analysis 303
operating objects 9
operations views 2

P
parameter filters 214
parameters
  CICS system initialization
    for z/OS MAS 67
  CICS system initialization parameters
    for CMAS 47, 52
  CICSPlex SM system 117
    in CMAS startup JCL 117
    in MAS startup JCL 117
PARTDEF object 172, 285
Partition set definitions view 170, 172, 285
Partner definitions view 172, 285
performance considerations
  CMAS 26
  CMAS-to-CMAS links 27
  of monitoring 306
PERIODEF object 36, 40
PIPEDEF object 174
Pipeline definitions view 174, 179, 285
PIPELINE object 285
planning WUI servers 31
POLMON object 305
port 79, 92
postinstallation jobs
  EYUCMASP 43
presentation thresholds, view editor 212
PROCDEF object 175, 285
process type (BTS) 239
Process type definitions view 175, 285
PROFDEF object 177, 285
profile definitions view 177
Profile definitions view 177, 285
PROGDEF object 179, 285
Program definitions view 179, 285
Q
queue algorithm description 239

R
RASGNDEF object 284
RASINDSC object 284
RASPROC object 284
RDSCPROC object 284
real-time analysis (RTA)
  analysis point monitoring (APM) 299, 303
  AOC CICS Automation 296
definition of 3
  implementing 302
  introduction to 295
  MAS resource monitoring (MRM) 297, 302
  planning 302
  SNA generic alert 296
  system availability monitoring (SAM) 296, 302
record count warnings 106
release requirements 257
release synchronization of CMAS and CICS 42
remote MAS
description of 73
removing
  a transaction affinity 269
  routing region scope from specification 257
Request model definitions view 285
requesting region
  release requirements 257
RESDESC object 284
RESGROUP object 284
RESINDSC 284
RESINGRP object 284
resource assignment
  migrating toward using 292
Resource assignment process view 284
Resource assignment view 284
Resource assignments in resource description view 284
resource checking 288
Resource definition in resource group view 284
resource definition views (continued)
  file segment definitions 151
  global enqueue model definitions 152
  IPIC connection definitions view 154
  ISC/MRO connection definitions 156
  Journal model definitions 150
  LIBRARY definitions 161
  LSR pool definitions 163
  Map set definitions 165
  Partition set definitions 170, 172
  Partner definitions 172
  Pipeline definitions 174
  Process type definitions 175
  profile definitions 177
  Profile definitions 177
  program definitions 179
  Program definitions 179
  session definitions 180
  Session definitions 180
  TCP/IP service definitions 181
  temporary storage definitions 190
  Temporary storage model definitions 190
  Terminal definitions 185
  Transaction class definitions 189
  Transaction definitions 187
  Transient data queue definitions 183
  typeterm definitions 192
  Typeterm definitions 192
  URI mapping definitions 194
  URIMAP definitions 194
  web service definitions 196
  WEBSERVICE definitions 196
  WebSphere MQ connection definitions 167
Resource description process view 284
Resource descriptions view 284
Resource group (RESGROUP) view 289
Resource groups in description view 284
Resource groups view 284
Resource Object Data Manager (RODM)
  activating the interface to 308
resource status facility
  activating 308
resource versions 280
RESOURCENEF 88
resources
  automatic installation of 290
dynamic installation of 290
RESSTATUS system parameter 125
restarting CMAS 62
restarting MVS MAS 71
result set warning counts 106
retention period
  monitoring 307
route selection 268
route selection error 268
routing attempt complete 268
routing region
  activating workload management
    when CICS system active 253
    when CICS system not active 253
    when CMAS not active 254
RQMDEF object 285
RTA analysis point specifications view 299
RTA definitions in RTA groups view 300
RTA definitions view 300
RTA group in analysis point specifications view 300
RTA groups in RTA specifications view 300
RTA groups view 300
RTA installed analysis and status definitions view 299
RTA specifications in primary CMASs view 299
RTA specifications in secondary CMASs view 299
RTA specifications to CICS system links view 299
Runtime MAS display (MAS) view 41

S

sample interval
  monitoring 305, 307
sample JCL
  CMAS 43
  MAS 66
sample programs
  EYU$CNV1 79
  EYUJWREP 80
SEC system parameter 125
SECRPTLVL system parameter 126
SECTIMEOUT system parameter 126
security
  BAS 290
  for CICS management client interface 116
  planning 35
security considerations
  map objects 227
selecting a target region
  from a set 266
  notification (route) 266
  route selection 266
  route selection error 266
  routing attempt complete 266
  specific 268
  transaction abort 266
  transaction initiation 266
  transaction termination 266
selection list 211
server 76
SESSDEF object 180, 285
Session definitions view 180, 285
setting up
  CICSPlex SM 72
  CMAS 41
  MVS MAS 63
setting up CICSPlex SM 19
shutting down a CMAS 61
SIGNONPANEL 89
single point of control
  definition of 2
  single-system image (SSI)
    definition of 1
    role of CMAS in providing 8
SIT 47, 52
SIT parameters, CICS 117
SM_BALANCE 265–267
SM_CREAFF 269
SM_DELAFF 269
SM_ROUTE 265, 268
SM_SCOPE 265, 266
SMSS
  set up 114

SMSS (continued)
  set up with security 116
SNA generic alert
  CMAS considerations 8, 26
  Specifications to system groups view 299
  Specifications view 300
  SPOOLCLASS system parameter 126
  staged implementation 35
  STAAL system parameters 127
START command
  CMAS 58
START commands
  dynamic routing of 239
START commands, dynamic routing of
  release requirements 257
starting
  CMAS
    as a batch job 43
    from the system console 43
    sample procedure 43
  z/OS MAS 66
STATDEF view 300
Status definitions in RTA groups view 300
stopping
  MVS MAS 71
storage requirements
  for the CICS management client interface 111
summarized view 207
supplied views and menus 216
SUPPRESSCMF system parameter 69, 130
suppressing CMF records 69, 130
synchronization of CMAS and CICS releases 42
SYS1.PARMLIB library
  COMMNDaa member with operator commands 43
SYS1.PROCLIB
  CMAS startup procedure 43
SYSID parameter of EYU9XDUT 46
SYSLINK object 40, 284
SYSLINK view 40
SYSRES object 284
system availability monitoring (SAM)
  automation and 297
  customizing external notifications 297
  description of 296
  implementing 302
system group 25
System group definition view 40
System group definitions view 40
system initialization parameters, CICS
  z/OS MAS-related 67
System link view 284
system parameters
  description of 120
  summary of 117
  topology requirements 73

T

tabular view 206
target region
  CICSPlex requirements 74
  release requirements 257
TCP/IP service
  DFH$WUTC sample 114
TCP/IP service definition 181
TCP/IP service definitions view 181
TCPDEF object 181
TCPIP object 285
TCPIP service definitions view 285
TCPIPADRESS 84
TCPIPHOSTNAME 79, 83, 92
TCPIPPORT 79, 83, 92
TCPIPSL 84
TCPIPSLCERT 84
TCPIPPSSL_CIPHERS 84
TDQDEF object 183
temporary storage definitions view 190
Temporary storage model definitions view 190, 285
TERMDEF object 185
terminal definitions view 185, 285
THOUSANDSEPARATOR 87
time format 213
time period definitions view 36
Time period definitions view 40, 302
time zone 4, 36
TIMESEPARATOR 87
TIMEZONE parameter
EYUIINST EXEC 46
TOBATCHREQ
CICSpixl SM system parameter 130
TOONLINEREQ
CICSpixl SM system parameter 130
TOPOLLINT
CICSpixl SM system parameter 131
topology
administration 39
Topology administration menu 39
topology and configuration
establishing CMAS-to-CMAS connections 75
topology definitions
creating
CICSpixl system groups 74
TRANDEF object 187, 285
transaction abend 268
transaction affinity
creating 269
deleting 269
description of 249
Transaction class definitions view 189, 285
Transaction definitions (TRANDEF) view 285
Transaction definitions view 187
transaction group
description of 239
transaction initiation 268
transaction termination 268
transient data queue definitions
COLG 91
COVE 91
COVI 91
COVP 91
Transient data queue definitions view 183, 285
TRNCLDEF object 189, 285
TSMDEF object 190, 285
two-column detail views 207
two-column detailed views
creating 232
typeterm definitions
validating resources 288
view
CMAS configuration administration 38
Time period definitions 36
View display options screen 226
view editor
abandon button 229
accessing 215
action buttons 214
attributes 213
bar gauge 212
cancel button 228
conditional links 210
confirmation panel 208
creating a detailed view 232
creating view sets 216
customized map objects 211, 226
customized view sets and views 206
data presentation 211
default view 209
defining view components 209
detail view 207
editing view sets 217
editing views 218
finish button 229
graphical presentations 211
menus 210, 216
navigation frame menu 211
OK button 228
parameters 214
presentation thresholds 212
save button 229
view editor (continued)
  summarized view 207
  supplied views 216
  tabular view 206
  using 215
  view sets 216
  warning lights 212
  writing customizable view and menu help 214
View Link Context and Scope Settings screen 199
View Link Filters screen 199
view sets
  customizing 216
view, default 209
view, detail 207
view, summarized 207
view, tabular 206
views
  adding a map button 226
  customized 206
  customizing 218

W
warning lights, view editor 212
warning record count
  setting in user group profile 205
web browser connection 92
Web service definitions
  installing 197
web service definitions view 196
Web User Interface 4
Web User Interface (WUI)
  globalization support 31
  where to locate 31
Web User Interface server
  create data sets 81
  customize data sets 81
Web User Interface server initialization optional parameters 83
Web User Interface server initialization parameters
  AUTOREFRESH 87
  CMCIPORT 85
  COLORINK 91
  COLORINKBANNER 91
  COLORINKLINK 91
  COLORINKVLINK 91
  COLORPAPER 90
  COLORPAPERALT 91
  COLORPAPERERROR 90
  COLORPAPERHEAVY 90
  COLORPAPERLIGHT 90
  COLORPAPERRULE 91
  COLORPAPERWARN 90
  CVDASTYLE 86
  DATEFORMAT 86
  DATESEPARATOR 86
  DECIMALSEPARATOR 86
  DEFAULTCICSplex 89
  DEFAULTCICSrgn 89
  DEFAULTCMASctxt 87
  DEFAULTConnect 89
  DEFAULTCONTEXT 87
  DEFAULTCSysgrp 89
  DEFAULTDB2SS 89

Web User Interface server initialization parameters (continued)
  DEFAULTTEJC0BEAN 89
  DEFAULTTEJ0D3BEAN 89
  DEFAULTEVENT 89
  DEFAULTL0CFILE 89
  DEFAULTL0CTRAN 89
  DEFAULTMAPBas 88
  DEFAULTMAPColL 88
  DEFAULTMAPMon 88
  DEFAULTMAPRTA 88
  DEFAULTMAPWLM 88
  DEFAULTMENU 88
  DEFAULTNAVIGATe 88
  DEFAULTtPROGRAM 89
  DEFAULTTREMFILE 89
  DEFAULTTRENTRAN 89
  DEFAULTSCOPE 88
  DEFAULTtASK 89
  DEFAULTTWARNCNT 88
  GLOBALPREFILTER 88
  GMMtextMSG 87
  INACTIVETIMEOUT 89
  MAXUSERS 89
  MSGCASE 87
  RESOURCESLIMIT 88
  SIGNONPANEL 89
  TCPiPAddress 84
  TCPiPHOSTname 79, 83, 92
  TCPiPHTTPHOST 84
  TCPIPport 79, 83, 92
  TCPiPSSL 84
  TCPiPSSLcert 84
  TCPiPSSLciphers 84
  THOUSANDSEPARATOR 87
  TIMESePARATOR 87
  WUItrace 91
Web User Interface server initialization required parameters 83
Web User Interface server repository (EYWREP) 80, 92
WEBService definitions view 196
WebSphere MQ connection definition view 285
WebSphere MQ connection definitions view
  MQCONDEF 167
WEBSVDEF object 196
workload affinity
  description of 249
workload definition
  description of 239
workload group
  description of 239
workload management
  activating in routing region
    when CICS system is active 254
    when CMAS not available 254
workload management (WLM)
  definition of 2
workload routing
  description of 239
workload separation
  description of 242
WRKAREA 78
WUI
WUI (continued)
importing data repository definitions 85
WUI parameter of EYU9XDUT 47
WUIAPPLID parameter of EYU9XDUT 47
WUINAME parameter of EYU9XDUT 47
WUIPLEX parameter of EYU9XDUT 47
WUISYSID parameter of EYU9XDUT 47
WUITRACE 91

Z
ZONEOFFSET parameter of EYU9XDUT 46